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How NetWitness Investigate Works

NetWitness Investigate provides the data analysis capabilities in RSA NetWitness® Suite, so
that analysts can analyze packet, log, and endpoint data and identify possible internal or external
threats to security and the IP infrastructure.

Note: In Version 11.1, the Hosts and Files views are part of the NetWitness Suite for analysts
to investigate endpoint data.

Metadata, Meta Keys, Meta Values, and Meta Entities

RSA NetWitness Suite audits and monitors all traffic on a network. One type of service, a
Decoder, ingests, parses, and stores the packets, logs, and endpoint data traversing the network.

The configured parsers and feeds on the Decoder create metadata that analysts can use to
investigate the ingested logs and packets. Another type of service, called a
Concentrator, indexes and stores the metadata.

The metadata is in the form of a meta key and meta values for the key. For example, ip.src is
a meta key, and an IP address that is the source of the traffic is tagged as ip.src. When you
view data in Investigate, you see the meta key ip.src and all of the IP addreses (values) that
are tagged with that key. Some meta keys are built-in and others may be custom keys defined by
the administrator.

Meta entities are available in Version 11.1 and later. A meta entity is an alias that groups
together the results from other meta keys. Meta entities organize similar meta keys into a single,
easier to use, meta type. Some meta entities are already included by default, and the
administrator can create custom meta entities. In Investigate, analysts can use a meta entity in a
query, a meta group, a column group, and a profile. Parallel coordinates visualizations do not
support meta entities. Administrators can use meta entities to define a query prefix to apply to a
user role and a user. The Decoder Configuration Guide provides additional information about
creating meta entities and how they can be used in rules.

For example, the default Core database language includes distinct meta keys for IP source and
IP destination. One of the built-in meta entities named ip.all represents the combined set of
all IP sources and destinations.

Analysts usually query the Concentrator to discover threats. The Concentrator handles queries,
only going to the Decoder when a full reconstruction of sessions or raw logs is required. ESA,
Malware Analysis, and Reporting Engine also query the Concentrator, where they can quickly
get all the pertinent metadata associated with an event and generate information on the event
without having to go to each Decoder. In some special cases, analysts may query a Decoder.

15 How NetWitness Investigate Works
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Note: While a hybrid appliance can perform the Concentrator function, a separate
Concentrator appliance is required for any large environment that needs greater bandwidth or
events per second (EPS). The Concentrator appliance has storage layout that uses solid state
drives for the index, which increases read performance.

Triggers for an Investigation

These are a few examples of triggers for an investigation:

o Youreceive intelligence from a third party about a new active directory hack. Starting in the
Events view, you use that intelligence to run a search across all of your raw Active Directory

log data for the last 24 hours.

o You are asked by the SOC manager to find any Pokemon Go malware due to its current
popularity. Starting in the Navigate view, you craft a query to look for an HTTP session using

a specific user agent related to the malware he found on a security blog.

o An incident responder escalates a ticket that shows some odd indicators related to a host.

Starting in the Hosts view, you examine that host to find specific details.

o You are looking for the next zero day attack and start pivoting through network metadata in

the Navigate view to find any abnormal automated sessions leaving the enterprise.

e You are asked by your SOC manager to find any information related to user jarvis, an
employee who was just let go. Starting in the Hosts view, you query against the past week for

that username.

Workflow of an Investigation

Analysts can investigate data captured by NetWitness Suite, and deep dive from information on
a NetWitness Suite dashboard, a NetWitness Respond incident or alert, a report created by the
NetWitness Suite Reporting Engine, or a third-party application. During the course of an
investigation, analysts can move seamlessly between the views in Investigation: the Navigate
view, the Events view, the Event Analysis view, the Hosts view (Version 11.1 and later), the
Files view (Version 11.1 and later), and the Malware Analysis view.

This figure illustrates the NetWitness Investigate submenus.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis

How NetWitness Investigate Works 16
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Note: Specific user roles and permissions are required for a user to conduct investigations and
malware analysis in NetWitness Suite. If you cannot perform an analysis task or see a view,
the administrator may need to adjust the roles and permissions configured for you.

You can access each view from the Investigate submenu and from other Investigate views. You
can also go directly into an Investigate view from NetWitness Respond, and go directly from
NetWitness Investigate to NetWitness Respond and standalone NetWitness Endpoint. Your use
case determines the starting point for your investigation. This table provides general guidance on
the starting view for different use cases.

Navigate view All meta keys and meta values for logs, endpoints, and packets,
grouped by meta key. You can pivot through the data to refine results,
then go to the Events view or Event Analysis view, or look up in
Malware Analysis or Live. This is the default NetWitness Investigate

view. (See Investigating Metadata in the Navigate View.)

Events view Events are listed in order by time. You can view the raw event and
related metadata, view a reconstruction, and download events and
files. You can go to the Event Analysis view. (See Analyzing Raw

Events and Metadata in the Event Analysis View)

Event Analysis view Events are listed in the order by time. You can view all meta keys and
meta values for logs, endpoints, and packets. You can view the raw
event and related meta data, view a reconstruction that offers helpful
cues to identify points of interest in a reconstruction. You can go to the
Hosts view, pivot to standalone Endpoint, look up in Live, and do
external lookups. External lookups allow you to search the internet for
meta values that you interacted with, determine passive DNS
information related to an IP address, ascertain if a URL is blacklisted,

and other third-party context integrations. (See Analyzing Raw Events

and Metadata in the Event Analysis View

17 How NetWitness Investigate Works
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(Version 11.1 and

later) Hosts view

(Version 11.1 and

later) Files view

Malware Analysis

view

Hosts on which the NetWitness Endpoint Insights Agents are running
are listed. For every host, you can view processes, drivers, DLLs, files
(executables), services, and autoruns that are running, and information
related to logged-in users. From the Hosts view, you can go to the

Navigate and Event Analysis views. (See Investigate Hosts)

Unique files such as PE, Macho, and ELF in your deployment are
listed. For each file, you can view details such as, file size, entropy,
format, company name, signature, and checksum. From the Files view,
you can go to the Navigate and Event Analysis views. (See Investigate
Files)

If you are running a Malware Analysis appliance, you can
automatically or manually scan files and see the results of four types of
analysis: network, static, community, and sandbox. If a file is

malware, you can go to the Hosts view to see which hosts downloaded

the file. (See Conducting Malware Analysis
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Every situation is unique in terms of the types of information the analyst is attempting to find.
Many investigations start in one view, and end in a different view as the analyst learns
something and then needs to follow that result to a different line of questioning. This figure
shows the high-level workflow of an investigation.

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event . . Triage an Incident
Investigate Endpoints

(Hosts View)

Metadata
(Navigate View)

(Pivot from Respond
View)

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Analyze Raw Events Scan Files and Events
and Metadata for Malware
(Events Analysis (Malware Analysis
View) View)

¢

Act on an Event or Endpoint

Perform Internal Create an Incident in

R struct an E fi
econstruct an Even e vesra

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups

Focus on Metadata, Query, and Time

Analysts use NetWitness Investigate to hunt for events that drive the incident response workflow

and to do strategic analysis after another tool has generated an event. Beginning in the Navigate

view, Events view, or Event Analysis view:

o You start by executing a query on a service for a specific time range, then filter using
metadata to a subset of events, reconstruct or analyze an event, and repeat the process to

reconstruct or analyze another event.

o When you encounter an event that bears a closer look, you view the context around the event,

and decide whether to create an incident or add the event to an incident. If you decide not to
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add the event to an incident, you run another query to gain further insight, which starts again

at the beginning of the workflow.

« If you notice suspicious activity or files on a specific host in the network, you can gather
additional information about the host and files found on the host in the Hosts and Files view,

or in a stand-alone NetWitness Endpoint server.

o If you find a file or event that potentially contains malware, you can do a Malware Analysis
scan of the file or you can open Malware Analysis and start a scan of the service on which

the event was seen.

For example, if there is a concern regarding suspicious traffic with foreign countries,

the Destination Country meta key reveals all destinations and the frequency of the contact.
Drilling into those values yields the specifics of the traffic, such as the IP address of the
originator and the recipient. Checking other metadata can expose the nature of attachments
exchanged between the two IP addresses.

Focus on Endpoint Analysis

Analysts use the Hosts and Files view to investigate or perform analysis on the hosts or files
using various attributes, such as IP address, host name, Mac address, and so on.

o During an incident triage in the Respond view, review the key information (such as,

hostname, filename), and view the context highlights.

o Pivot to Investigate to open the Navigate view. Select the Endpoint Analysis meta group and

review the metadata created.

o View the metadata in the Event Analysis view to analyze the events. Select the host lookup

using the Event Meta panel.

o Inthe Hosts view, click on the hostname to view the summary of the endpoint data,

snapshots, security configurations, and so on.
o Perform an on-demand scan to get the most recent information (if required).
o Search on all snapshots for a specific filename, path, or hash to narrow the search.

« Review the processes, autoruns, files, libraries, drivers, and system information to investigate
further.

o In the Files view, filter the files using a few indicators (such as, file name, file size, entropy,
format, company name, signature, checksum) and pivot to the Navigate view to see if it exists

on other hosts in the network.

How NetWitness Investigate Works 20
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Focus on NetWitness Respond Incidents and Alerts

An analyst who is working on an incident or an alert in NetWitness Respond can open it in

NetWitness Investigate (Navigate view) to do a deeper analysis of the event or alert.

o The workflow to respond to an incident typically begins in the Respond view, where the
analyst who is investigating an incident needs to gather intelligence about the incident in
NetWitness Investigate. After you launch an investigation from NetWitness Respond, defined
meta keys are queried and the contents of captured packets, logs, and endpoint events is

displayed in the Navigate view.

« If you find events that are relevant to the incident, you can add the events to the incident in
Respond. You can also create a new incident in Respond based on one or more events found

in Investigate.

NetWitness Investigate Views

This section provides a brief description and example of each main view (Navigate, Events,
Event Analysis, Hosts, Files, and Malware Analysis) and introduces views that provide two
deep-dive capabilities: additional context for data found and event reconstruction.

Navigate View

The Navigate view provides the capability to drill into and query contents of captured packets,

logs, and endpoint events on a Broker, Concentrator, or Decoder (though investigating a Decoder

is not typical).

o When you select a service, the defined meta keys for that service are queried, and values are
returned along with the number of events. Clicking on a value at any given level, reveals the

results in detail.

o For certain configured meta keys, such as IP address, or hostname, you can search for
additional context information around a value using the Context hub. The additional context

may include incidents, alerts, and other sources where the value was mentioned.

o The Navigate View also provides a sequential visualization of the data in a timeline. Here

you can zoom in on a selected time period.

21 How NetWitness Investigate Works



NetWitness Investigate User Guide

This figure illustrates the Navigate view.
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Events View

The Events view provides a view of packet, log, and endpoint events in list form so that you can
view events sequentially and reconstruct events safely.

e You can open the Events view for a meta value that you see in the Navigate view.

« For analysts without sufficient privilege to navigate a service, the Events view is a standalone
investigation view in which analysts can access a list of network, log, and endpoint events

from a NetWitness Suite Core service without having to drill down through metadata first.

o The Events view presents event information in three standard forms, a simple grid listing of

events, a detailed listing of events, and a log view.

e You can export events and associated files, and create an incident from an event.
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This figure illustrates the Events view.
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Event Analysis View

The Event Analysis view is an interactive tool to help analysts see the packets, text, or files in
an event with visual cues for certain types of information. Depending on the type of
reconstruction, for example, packets, text, or files, different information is relevant.

o When viewing files, you can export files in a zip archive to your local file system.

o You can download logs from the Text view, and export packets from the Packet view.
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This figure is an example of the Event Analysis view.
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Hosts View

The Investigate > Hosts view lists all hosts with an agent. By default, the hosts are listed based
on the last scan time, with the most recently scanned hosts at the top of the list. It provides the
capability to drill into the details of the host for investigation.

This figure is an example of the Hosts view.

INVESTIGATE

In this view, you can:

o Filter and sort hosts to narrow down on the host investigation
o Export the host attributes to a CSV file
« Start or stop a scan for the selected hosts

o Drill-down for host details
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« Pivot to the Navigate or Event Analysis view to investigate on the host

o Delete hosts

Note: If you have NetWitness Endpoint 4.4.0.2 or later in your deployment, the hosts on which
the 4.4.0.2 agent is installed are listed, and can be identified using the agent version. For more

information on how you can investigate these hosts, see Investigate NetWitness Endpoint 4.4.0.2

or Later Hosts.

To view details of a host, click on the hostname. The following screen is displayed:
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Agent
<ID 8DDEG001-05S
031057201
03/05/2018 09:55:27.8
1320
userModeOnly
Alphabetical O Status on 11100

Allow Access Datasource Domain IEDep Task Manager
ixed Content «  IEEnhanced Security e Microsoft Windows 7 Enterprise
Intranet Zone Notification
LA
P Registry Tools
Site Script Filter ‘Smart Screen Filter

Firewall System Restore

You can:

Search on all snapshots (file name, file path, and file SHA-256 checksum are the supported

search fields).

o View multiple snapshots. By default, the data for the latest snapshot is displayed.

o View additional host information in the following tabs: Overview, Processes, Autoruns, Files,

Driver, Libraries, and System Information.

o Export all categories of endpoint data for the selected host for a specific snapshot in the
JSON format.

Files View

The Files view provides a list of unique files found in your deployment and their associated
properties. By default, the files are listed based on the first seen time. The following file types,
loaded in the memory, are collected during the scan.

« Portable Executable (PE) (Windows) - These are exe, dll, and sys files. You can view the
following properties for each file - checksum, compile details, different sections present in
the file, imported libraries, and certificate details (signer, thumbprint, company name).
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o Macho (Mac) - These are app bundles, dylibs, and kernel extensions. You can view the
following properties for each file - checksum, different sections present in the file, imported

libraries, and certificate details (signer, thumbprint, company name).

o Executable and Linkable Format (ELF) (Linux) - Each file contains information about
checksum, different sections present in the file, and imported libraries. You can view the
following properties for each file - checksum, different sections present in the file, and

imported libraries.

This figure is an example of the Files view.
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In the Files view, you can:

o Filter and sort files to narrow down on the investigation
« Pivot to the Navigate or Event Analysis view to investigate on the file

o Export the files to a CSV file

Malware Analysis View

The Malware Analysis view provides a means to analyze certain types of file objects (for
example, Windows portable executable (PE), PDF, and MS Office) to assess the likelihood that
a file is malicious.

e You can open the Malware Analysis view directly or you can use a context menu action to

Scan for Malware from a meta value in a current drill point from the Navigate view.

o The malware analyst can leverage the multilevel scoring modules to prioritize the massive
number of files captured in order to focus analysis efforts on the files that are most likely to

be malicious.
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This figure illustrates the Malware Analysis view.
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Contextual Information for an Event

In the Navigate view and the Events view, the Context Lookup panel shows details about

elements associated with an event (IP Address, User, Host, Domain, MAC Address, Filename,

File hash) in the Context Hub.

o You can interact with the elements of an event to get further insight including related
incidents, alerts, custom lists, Archer assets, active directory details, and NetWitness
Endpoint I[IOCs.

e You can click on a data point to return to the Navigate view.

27 How NetWitness Investigate Works



NetWitness Investigate User Guide

The following figure shows the Context Lookup panel in the Navigate view.
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.
Note: For the NetWitness Endpoint, the context lookup is only available for the NetWitness

Event Reconstruction

Three NetWitness Investigate views offer the ability to reconstruct an event: Navigate view,
Events view, and Event Analysis view. When you discover an event that merits additional
investigation, you can reconstruct an event safely in a form similar to its native form. The
rendering of events restricts the use of dynamic or active code that might be contained in the
event to limit any adverse outcome to your system or browser. Cache is used to improve
performance when viewing previously viewed events. Each analyst has a separate cache of
reconstruction data, and you can only access reconstructed events in your own cache.

The Event Reconstruction in the Events view or the Navigate view presents the raw data and the
meta keys and meta values for an event in a list form .

o You can page through the reconstruction to view the next event in this form.

o Events can be reconstructed using different methods to suit the type of data: meta data, text,

hexadecimal, packets, web, mail, files, or the best reconstruction selected automatically.

e You can export packet capture files, extract files, and export the meta values for the event.

This figure is an example of the Event Reconstruction.
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sanice d ype source destination ser
conc - Concentrator 39407 Network Session : 58968 13128 BO
WY view Meta - # actions - [ Open Event in MewTab & Event Analysis

sessionid = 39407

time = 2017-08-23T14:16:37.000

size = 5832

payload = 4144

medium = 1

wth.src =

eth.dat -

eth.type = 2048

ip.src =

natname = “other src”

ip.dst =

netname = “private dst

direction = inbound”

ip.proto = &

vep. flags = 26

tep.sreport = SBIGE

tep.dstport = 3128

service = B

The Event Analysis view present a interactive event reconstruction, which includes raw data,

meta keys and values. Interactive options:

Highlight and decode information in headers and payloads.

o Identify common file signatures.

You can export events and files.

Allow you to search for locations of certain meta keys or values in the reconstruction.

This figure is an example of a reconstruction in the Event Analysis view.
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Configuring NetWitness Investigate Views and

Preferences

Analysts can configure some aspects of NetWitness Investigate views and behavior. You can
customize the way that Investigate views appear, the types of information displayed, and factors
that affect performance in returning results and reconstructing events. All configurable settings
have default values that are effective in most deployments; however, analysts have the option to
adjust these if necessary.

Analysts who conduct analysis using Investigate need to have the appropriate system roles and
permissions set up for their user accounts. An administrator must configure roles and
permissions as described in the System Security and User Management Guide. (Go to the
Master Table of Contents for NetWitness Logs & Packets 11.x to find all NetWitness Suite 11.x
documents.)

These topics provide details:

o Configure the Navigate View and Events View

o Configure the Event Analysis View

o Configure the Malware Analysis Summary of Events View
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Configure the Navigate View and Events View

Analysts can set preferences that affect performance and behavior of NetWitness Suite when
analyzing data using the Navigate view and Events view. Some of the same settings are

available in two places in NetWitness Suite, and changes made in either location are applied in

the other view:

« Investigate view > Settings dialog for the Navigate view and the Events view.

o Profiles > Preferences panel > Investigation tab.

There are also configurable settings in the Search Options drop-down from the Search field in
the Navigate view and the Events view.

Access the Navigate View and Events View Settings

To access the settings, do one of the following:
o Inthe Navigate view toolbar, select the Settings option.

The Settings dialog for the Navigate view is displayed. Version 11.0 included a setting to

Append Events in Events Panel, and this has been moved to the Events view settings panel.

I'. h Ev V[ Search -ﬁ' Settings J

Threshold 100000
Max Values Results 1000
Max Session Export 100000

Max Log View Characters 1000

Max Meta Value Characters &0

Export Log Format ~
Export Meta Format ~

[[] Use Per Device Local Cache

[ Show Debug Information

[ Autoload Values

[[] Download Completed PCAPs

[[] Live Connect: Highlight Risky Values

Apply Cancel 7]

« In the Events view toolbar, select the Settings option.

The Settings dialog for the Events view is displayed. Version 11.1 and later includes the

Configuring NetWitness Investigate Views and Preferences
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Append Events in Events Panel setting.

I Search Events v £F Settings
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| Cancel @

« In the top right corner of NetWitness Suite, go to m >, FEEER, and in thePreferences

panel click the Investigation tab.

The Investigation panel is displayed.
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Calibrate Navigate View Value Loading Parameters

Several settings influence the performance of NetWitness Suite when loading values in the
Values panel. Default values are set based on common usage, and individual analysts can adjust
these settings for their own investigations.

To adjust these settings:

1.

2.

3.

Go to the Investigation tab or to the Settings dialog for the Navigate view.
Adjust the following parameters:

Threshold: Set the threshold for the maximum number of sessions loaded for a meta key
value in the Values panel. A higher threshold allows accurate counts for a value, and

also causes longer load times. The default value is 100000.

Max Values Results: Set the maximum number of values to load in the Navigate View when
the Max Results option is selected in the Meta Key Menu for an open Meta Key. The default
value is 1000.

Max Session Export: Specify the number of events that can be exported in a single PCAP or
Log file.

Max Log View Characters: Set the maximum number of characters to be displayed on
Investigate > Events > Log Text. The default value is 1000.

Max Meta Value characters: Set the maximum number of characters in a meta value name

displayed in the Navigate view Values panel. The default value is 60.

Show Debug Information: If you want NetWitness Suite to display the where clause
beneath the breadcrumb in the Navigate view and the elapsed load time for each aggregated

service on a Broker, check this option. The default value is Off.

Append Events in Events Panel: This option affects paging in the Events panel and is

described below under "Calibrate Events View Retrieval and Default Reconstruction."

Autoload Values: If you want NetWitness Suite to automatically load values for the selected
service in the Navigate view, check this option. When not selected, NetWitness Suite
displays a Load Values button, allowing the opportunity to modify options. The default value
is Off.

Click Apply.

The settings become effective immediately and are visible the next time you load values.
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Configure Navigate View and Events View Parameters

Several settings influence the performance of NetWitness Suite when loading values in the
Navigate view and the Events view. Default values are set based on common usage, and
individual analysts can adjust these settings for their own investigations. You can set these
parameters separately in the Navigate view and the Events view. When configured in one view,
the setting does not automatically apply to the other view.

To adjust these settings:

L.

Go to the Investigation tab or to the Settings dialog for the Navigate view or the Events

view.

Adjust the following parameters:

-Live Connect: Highlight Risky Values: If you want NetWitness Suite to highlight and
display only IP addresses that are considered as risky by RSA community, check this option.
When not selected, NetWitness Suite displays all [P addresses. By default, this option is not
selected (Off).

-Use Per Device Local Cache: You can specify the use of locally cached data from the
selected service. By default, this option is not selected (Off). When unchecked, Investigate
sends a fresh query to the database rather than displaying cached data in the Investigate
views after the initial load. If checked, Investigate uses the data from local cache.
-Download Completed PCAPs: You can automate the downloading of extracted PCAPs in
the Navigate view and Events view so that the browser downloads the extracted PCAP and
opens it in the default application for opening PCAP files, such as Wireshark. By default,
this option is not selected (Off). If you are going to enable this option, ensure that

an application that can open PCAPs is installed on your local file system and that the
application is set as the default application to handle PCAP file formats.

Live Connect: Highlight Risky Values: If this option is unchecked, all the meta values that
have context available in Live Connect are highlighted in the Navigate view Values panel. If
the option is checked, among the values that have context in Live Connect, only those values
deemed Risky/Suspicious/Unsafe by the community are highlighted. By default this option is
unchecked (Off).

Click Apply.

The settings become effective immediately.
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Configure the Default Log Export Format

You can export logs from the Navigate view and Events view in different formats. Available
options are Text, XML, comma-separated values (CSV), JSON. There is no built-in default
value for the log export format. If you do not select a format here, NetWitness Suite displays a
selection dialog when you invoke export of logs.

To select the format for exported logs:

1. Go to the Investigation tab or to the Settings dialog for the Navigate view, Events view, or

Event Analysis view.
2. Select one of the options from the Export Log Format drop-down menu.

3. Click Apply.

The setting goes into effect immediately.

Configure the Default Meta Export Format

You can export meta values from the Navigate view and Events view in different formats.
Available options are Text, CSV, tab-separated values (TSV), and JSON. There is no built-in
default value for the meta export format. If you do not select a format here, NetWitness Suite
displays a selection dialog when you invoke export of meta values.

To select the format for exported meta values:
1. Go to the Investigation tab or to the Settings dialog for the Navigate view or Events view.
2. Select one of the options from the Export Meta Format drop-down menu.

3. Click Apply.

The setting goes into effect immedia tely.

Calibrate Events View Retrieval and Default Reconstruction

You can configure several parameters that control the how NetWitness Suite retrieves events
and reconstructs events in the Events view. To do so:

1. Go to the Investigation tab or to the Settings dialog for the Events view.

2. Configure the following parameters.
-Optimize Investigation page loads: Set a paging option. When optimized, results are
returned as quickly as possible, sacrificing the original ability to go to a specific page in the
event list. Unchecking this box changes the Events list pagination to allow you to go to a
specific page in the list (or to the last page). The default value is enabled.

-Default Session View: Selects the default reconstruction type for the initial reconstruction
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in the Events view. The default value is Best Reconstruction in which events are

reconstructed using the reconstruction method most appropriate to the event.

3. Navigate to the Investigation tab or to the Settings dialog for the Navigate view and set the
Append Events in Events Panel option. When this option is selected, the events displayed
in the Events Panel are added incrementally. For example, each time you click the next
page icon, the next increment of events is added, at first you see 1 to 25, then 1 to 50, then 1
to 75 and so on. This option is available only if the Optimize Investigation Page Loads

option is enabled.

4. To activate the changes immediately, click Apply.

Enable or Disable Cascading Style Sheet Rendering in Web
Content Reconstructions

Analysts can enable the use of cascading style sheets (CSS) when reconstructing web content. If
enabled, the web reconstruction includes CSS styles and images so that its appearance matches
the original view in a web browser. This includes scanning and reconstructing related events,
and searching for style sheets and images used in the target event. The option is enabled by
default. Disable this option if there are problems viewing specific websites.

Note: The appearance of the reconstructed content may not match the original web page
perfectly if related images and style sheets could not be found or were loaded from the web
browser's cache. Also, any layout or styling that is performed dynamically through the client
side javascript will not render in the reconstruction because all client side javascript is
removed for security purposes.

To enable or disable this option:

1. Go to the Investigation tab .
2. Click the Enable CSS Reconstruction for Web View checkbox.

3. Click Apply.
The setting becomes effective immediately and is visible in the next web content

reconstruction.

Configure Search Options

You can configure search options to apply when you type a search string in the Search field.

1. Click in the Search field of the Events view or the Navigate view to display the Search

Events drop-down menu.
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[¥ Case Insensitive ] Regular Expression
[ Search Indexes

E Cancel

Search Options
v

™ Meta ™ RAW .
(Metwork/Log/Endpoint)

e

2. Select one or more search options to apply to the search. Search for Text Patterns provides
detailed information about each option.

3. To save the search settings, click Apply.

The preferences are saved and effective immediately.
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Configure the Event Analysis View

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

Beginning with Version 11.1, analysts can set preferences that affect the behavior of
NetWitness Suite when analyzing data using the Investigate > Event Analysis view. The main
toolbar in Investigate has a different appearance when the Event Analysis view is open; these

two buttons give access to preferences dialogs: - and El. The User menu (-) is focused on
global user preferences such as time zone, while the Event Analysis preferences menu () is
focused on user preferences for behavior in the Event Analysis view. The rest of this section
describes both sets of preferences.
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Set the Default Investigate View

The default Investigate view is set in the global User Preferences dialog (in the upper right

corner of the NetWitness Suite browser window, select E).

The User Preferences dialog shows your current preferences for the Investigate view. You can
select the default view when you open Investigate here: Navigate view, Events view, Event
Analysis view, Hosts view, Files view, or Malware Analysis view.

@ admin  (?)

o

User Preferences X

TIME ZONE

UTC (GMT+00:00)

DATE FORMAT TIME FORMAT

MM/DD/YYYY 12hr  © 24hr

DEFAULT LANDING PAGE

RESPOND

DEFAULT INVESTIGATE VIEW

EVENT ANALYSIS

THEME

O Dark Light

The global user preferences are described in detail in the NetWitness Suite Getting Started
Guide. Go to the Master Table of Contents for NetWitness Logs & Packets 11.x to find all
NetWitness Suite 11.x documents.

Configure the Event Analysis View

In Version 11.1, you can set preferences relevant to the Event Analysis view. The preferences
selected here persist per user and are available whenever the specific user logs in to the
application.

Configuring NetWitness Investigate Views and Preferences 40


https://community.rsa.com/docs/DOC-81328

NetWitness Investigate User Guide

To set default values for working in the Event Analysis view:

1.

2.

With the Event Analysis view open, click El.

Fvent Preferences

DEFAULT EVENT ANALYSIS VIEW

PACKET ANALYSIS

DEFAULT LOG FORMAT

DOWNLOAD LOG

DEFAULT PACKET FORMAT

DOWNLOAD PCAP

TIME FORMAT FOR QUERY

Database Time © Wall Clock Time

Download extracted files automatically

In the Default Event Analysis View drop-down menu, select the default reconstruction type
when you open an event in the Event Analysis panel: Text Analysis, Packet Analysis, File
Analysis.

If you have not selected a default analysis type, when you open an event, the default
reconstruction type is the Packet Analysis, except for log and endpoint events, which open to
the Text Analysis. If you select a default reconstruction type, the reconstruction type is the
default reconstruction that you specified. In both cases, the default is the starting point, and if
you change the type while you are working, the type you choose is used for the next

reconstruction.

In the Default Log Format drop-down, select the download format for exporting logs:
Download Log, Download XML, Download CSV, or Download JSON. If you do not
select a format here, the default download format is Download Log. These options are also

available at the time of download in a drop-down menu.

In the Download PCAP drop-down menu, select the default format for downloading packets.
These options are also available at the time of download in a drop-down menu:

Download PCAP to download the entire event as a packet capture (*.pcap) file

Download All Payloads to download the payload as a *.payload file

Download Request Payload to download the request payload as a *.payloadl file

Download Response Payload to download the response payload as a *.payload? file
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5. Under Configure the Time Format for queries, choose either Database Time or Wall
Clock Time. The Event Analysis view can display results based on the database time or the
current clock time. When you set the time format here, your individual user preference is
saved until changed again. The default setting for this preference is Database Time, which
is the same time format used to display query results in the Navigate view and Events view.
When Database Time is selected, the start and end time for a query is based on the time that
the event was stored.

When Wall Clock Time is selected, the query is executed with current time in accordance

with the timezone set in user preferences.
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Configure the Malware Analysis Summary of Events View

The Summary of Events provides a summary of the scan being investigated, and below the
summary are configurable dashlets such as visualization charts and listings. By default, the
Summary of Events for a scan opens with the default dashlets displayed. You can customize the
view by adding, modifying, and deleting default dashlets. The configured customization of
dashlets persists through different scan investigations, and you can restore default dashlets at
any time. The default dashlets are:

o Summary of Events (Fixed)

o Event Timeline

o Top Listing of Highly Suspicious Malware
o Meta Treemap

o Score Wheel

o Meta Breakdowns

The following figure is an example of the default Summary of Events.

INVESTIGATE (D admin ©

MALWARE ANALYSIS

Summary of Events

= Malware Analytics  MA ~ =+ add v $F ¥ # Actions v

Scanned service rtTime Network End Time Scanned Start Time Scanned End Time

2017-07-18T14:40:59 2017-07-17706:42:26  2017-07-17T06:42:38

Total High Confidence

Events Created Files Processed Events Created

) ) 1
. B gffci Files @ I;‘DF Files I:I’E Files @ gﬂ’ce Files

Meta Treemap

High Confidence Only Events:1 Files:1

Source IP v 10 v Static v || Average Score

‘ NETWITNESS SUITE 11.0.0.0-170709005430.1.9127d8d

The rest of this topic provides instructions for managing and configuring dashlets.

Add a Dashlet

Y ou can add multiple copies of dashlets in the Malware Analysis Summary of Events. To add a
dashlet:
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1. In the toolbar, select Add.
The drop-down list of dashlets is displayed. There are four visualization options: Score
Wheel, Meta Treemap, Meta Breakdowns, and Event Timeline. The other three dashlets are
the same dashlets available in the NetWitness Suite dashboard: Malware with high
Confidence IOCs and High Scores, Top Listing of Highly Suspicious Malware, Top Listing
of Possible Zero Day Malware. Details for these common dashlets are provided in
"Dashlets" in the RSA Content for RSA NetWitness Suite.

2. Select a dashlet.
The new dashlet is added as the last dashlet below the existing dashlets.

3. If the dashlet is a duplicate of an existing dashlet, change the name of the new dashlet so

that it is unique.

Modify or Delete a Dashlet Using Toolbar Options

Each dashlet has a toolbar that offers options for modifying the dashlet. The visualization charts
have the same configuration settings, while some of the other dashlets have different additional
settings.

[Event Timeline ~@X|

To use the toolbar options:

« To close a dashlet so that only the title bar is displayed, click 2.
» To open a dashlet that is closed, click v,
o To display the configurable settings for a dashlet, click &3,
The settings dialog for the dashlet is displayed.
. To delete a dashlet, click .

Apply Threshold Filter to Multiple Dashlets

Within dashlets, you can set a threshold to show only events equal to, above, or below a certain

score in the four categories (Static, Network, Community, and Sandbox). This procedure sets the
thresholds by dashlet type for these dashlets: Event Timeline, Score Wheel, and Meta Treemap.

You can also set the threshold for individual dashlets.

1. In the toolbar, select Lo JEAPS Apply Threshold Filter.
The Apply Threshold Filter dialog is displayed.
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Apply Threshold Filter

Static 2
Network &

Community =

Sandbox &/

Apply threshold to the following dashlets

[ Score Wheel

W

W W
[] []

W

[] Event Timeline [] Meta Treemap

Cancel Apply

2. Select one or more dashlet types: Event Timeline, Score Wheel, and Meta Treemap.

3. Drag the corresponding slider or enter a numeric value, then select an operator in the drop-

down list: =, >=, or <=

4. Click Apply.

The threshold filters are applied to the selected dashlet types in the Summary of Events.

Set Title and Category Options for a Dashlet

1. To display the configurable settings for a dashlet, click
The Options dialog for the dashlet is displayed.
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Title Event Timeline

™! Influenced By High Confidence Only

Static 2 2= v
Network 2 n= v
Community &/ = w
Sandbox & == v

Cancel Apply

. Type a new title for the dashlet in the Title field.

. If you want to see only events that are influenced by a High Confidence tag, which means
there is high confidence that the event contains harmful code, check the Influenced By High
Confidence Only option.

. If you want to see only events that were given a score above a certain score in the four
categories (Static, Network, Community, and Sandbox), drag the corresponding slider or

enter a numeric value, then select an operator in the drop-down list: =, >=, or <=

. Click Apply.
The title and filters are applied to the dashlet.

Order Dashlets

To change the order of dashlets as they appear beneath the Summary of Events:

1. Inthe toolbar, select £ ' > Order Dashlets.
The Order Dashlets dialog is displayed.
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Order Dashlets

= Up 4= Down
1 Event Timeline ::
2 Top Listing of Highly Suspicicus Malware ot
3 Meta Treemap at

[

Score Wheel

k

Cancel Apply

2. Select a dashlet that you want to move up or down, and click 4= Up or 4= Down,

3. When you are satisfied with the order, click Apply.
The dialog closes and the order of dashlets below the Summary of Events is changed to

match your choices.

Restore Default Dashlets

After you have added, modified, and arranged dashlets, you can revert to the default settings for
dashlet display. To restore the default dashlets:

1. In the toolbar, select £ ' > Restore Default Configuration.

A dialog requests confirmation that you want to restore the configuration.
2. Do one of the following:
a. If you decide to keep the dashlet arrangement you have configured, click No.

b. Ifyou are sure that you want to restore the defaults, click Yes,

The dashlet display reverts to the default display.
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Beginning an Investigation

NetWitness Suite offers different starting points based on the question you are attempting to
answer: Navigate view, Events view, Event Analysis view (Version 11.1), Hosts view (Version
11.1), Files view (Version 11.1), and Malware Analysis view.

Note: Specific user roles and permissions are required for a user to conduct investigations in
NetWitness Suite. If you cannot perform an analysis task or see a view, the administrator may
need to adjust the roles and permissions configured for you. The Hosts view and Files view
are available in Version 11.1 and above. The Event Analysis view is available in Version
11.0, but the method of accessing it is through the Events view.

Focus on Metadata, Raw Events, and Event Analysis

To hunt for events that drive the incident response workflow and to do strategic analysis after
another tool has generated an event, you should begin in the Navigate view, Events view, or
Events Analysis view. You investigate the metadata for a single Broker or Concentrator. In each
of these views, you start the investigation by opening the view, where you can execute a query
and filter the results by narrowing the time range and querying metadata. These topics provide
details about beginning an investigation in each view:

e Begin an Investigation in the Navigate or Events View

e Begin an Investigation in the Event Analysis View

Focus on Hosts and Files

To hunt for information on hosts that have the agent running, begin the investigation in the Hosts
view (Investigate > Hosts). For every host, you can see processes, drivers, DLLs, files
(executables), services, and autoruns that are running, and information related to logged-in users.
(See Investigate Hosts)

You can begin the investigation on files in your deployment in the Files view (Investigate >
Files). (See Investigate Files.)

Focus on Scanning Files for Malware

To scan files for potential malware, or set up a continuous scan of a service, you begin in the
Malware Analysis view. Results are expressed as four types of analysis: network, static,
community, and sandbox with an indicator of compromise (IOC) rating. There are several ways
to begin working in Malware Analysis:
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e You can begin Malware Analysis from the Malware Analysis dashlets in the Monitor view to

quickly see the riskiest potential threats.

o You can go to Investigate > Malware Analysis to opne the Malware Analysis Summary of

Events.

e You can right-click ameta key in the Navigate view, and select Scan for Malware.

See Conducting Malware Analysis for details on working in the Malware Analysis view.
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Begin an Investigation in the Navigate or Events View

The Navigate view is the default view for Investigate unless you have selected a different view
as your opening view. This user preference is set on the application level as described in
Configuring NetWitness Investigate Views and Preferences. In these views, you are hunting for
events of interest based on a query. In the Navigate view you can also refine results by clicking
on meta keys and meta values. When you find interesting events, you can take a closer look at
the event in the other Investigate views.

To begin an investigation in the Navigate view or Events view, a service must be specified.

o NetWitness Suite opens the Navigate view or the Events view with the user-specified default

service selected.

o If no default service is currently specified and the service id is not in the URL, NetWitness

Suite presents a dialog for selecting the service or collection to investigate.

o When a service has been selected manually or by default in the Navigate view or Events
view, you can change the service or collection to investigate by selecting the service name in

the toolbar. NetWitness Suite presents the dialog for selecting the service to investigate.

Note: The Archiver service does not appear in the Navigate view to minimize user experience
of slow performance when performing investigations. The Archiver is available in the Events
view for log exports and enhanced search capabilities.

With a service or collection selected, NetWitness Suite is ready to load data for the service or
collection. It is recommended that you also select a time range so that results load faster.
Several settings in the Navigate View and Events View Settings dialog or the Profiles >
Preferences panel > Investigations tab affect the loading process: Threshold, Max Values
Results, Show Debug Information, Autoload Values, and Optimize Investigation page loads
(see Configuring NetWitness Investigate Views and Preferences).

Note: In the Events view data loads automatically. If you specified Autoload Values in the
Navigate view preferences, NetWitness Suite populates the data automatically. Otherwise,
you must select the Load Values button. NetWitness Suite populates the meta data in the
Navigate view Values panel and results become visible almost immediately.

The rest of this topic provides instructions for beginning the investigation of data on a service.

Note: Only users with the administrator role can create a collection, and only the creator of
the collection is able to investigate a collection.

After loading data in the Navigate or the Events view:
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1. Refine results, visualize data, and act on a drill point (see Investigating Metadata in the

Navigate View and Examining Raw Events in the Events View. For example, you can View

Additional Context for a Data Point, Launch a Malware Analysis Scan from the Navigate View, or

Add Events to an Incident for Response.

2. Reconstruct an Event (see Reconstruct an Event) or view the interactive Event Analysis of an

event (see Begin an Investigation in the Event Analysis View).

Begin an Investigation (No Default Service)

1. Goto INVESTIGATE > Navigate or Events.
The Investigate dialog is displayed.

Investigate
Services Collections

M Default Service

MName ~ Address Type
BrokerG3 Broker
Concentratorfd Concentrator
ConcentratorG? Concentrator
Decoder220 Decoder
Decoderts Decoder

Log Decoder22? Log Decoder

Cancel Mavigate

2. Double-click a service or select a service, usually a Concentrator, and click Navigate.
The data loads automatically in the Events view. If you are working in the Navigate view,
the resulting panel displays the activity for the selected service, but the data is not loaded

automatically.
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3. (Recommended) Select a specific time range so that results load faster.

4. If you want to modify investigation options before loading, you can create or modify a
custom profile, apply a different time range, create or apply a meta group, and perform a

custom query as described in Querying and Acting on Data in the Navigate and Events Views

You can also modify options at any time during the investigation.

5. To load data in the Navigate view, click .

The data for the selected service begins loading.
£ conc- Concentrator [N ¥ Query © E Profile © EJMeta © | TETotal © .= Descending © B EventCount © | SaveEvents® - Actions ©

2017 | 3% | 15:05:34 (+00:00) All Data 2017 | 93 | 17:47:59 (+00:00)

O Resetzoom | % Options | /A Hide

= Device Address

Closed - Click to Open

. Device Name L
Closed - Click to Open

@ . ServiceType (2 values)
OTHER (76) - NETBIOS (7)

_ Session Analysis (1 value) ©
not top 20 dst(29)

. EventTime (1value) 2
2017-Aug-17 09:32:15(1,531)

| NETWITNESS SUITE

With the service selected and data loaded, you are ready to begin analyzing the data.

Set or Clear the Default Service

You can set the default service and clear the default service in the Investigate a Service dialog.

1. Click the service name in the toolbar.

The Investigate dialog is displayed.
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Investigate
Services Collections

M Default Service

MName ~ Address Type
ErokerG3 Broker
Concentratorfd Concentrator
ConcentratorG? Concentrator
Decoder220 Decoder
Decoder6s Decoder

Log Decoder227 Log Decoder

Cancel Mavigate

2. Select a service on the Services grid, and click M Default Service .

The service becomes the default, (indicated by Default in parentheses after the service

name).

3. To clear the default service, select the default service in the grid, click M Default Service ,

and click Cancel to close the dialog.

No default service is set.

Note: The Cancel button does not cancel your selection of the default service. It simply
closes the dialog without navigating to the currently selected service in the grid. Setting
a default service that is different from the service currently being investigated, does not
refresh the Navigate view. You must explicitly select and Navigate to a different
service.

Begin an Investigation (Default Service Specified)

1. Goto INVESTIGATE > Navigate or Events.
If the Autoload Values setting is set to off, the Navigate view is displayed with the default
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service selected, and ready to load data. If the Autoload Values setting is on, the values are

loaded as shown in Step 3. In the Events view, the data is loaded automatically.

2. If you want to modify investigation options in the Navigate view before loading, you can
create or modify a custom profile, apply a different time range, create or apply a meta group,

and perform a custom query.

3. When ready, click (CHERRENS

The values for the service are loaded in accordance with the selected options.

£ conc - Concentrator ] M ¥ Query © MlProfile® EIMeta ® | f@Total @ .= Descending @ EF Event Count @ | SaveEvents © - Actions

2017 | 3| 15:05:34 (+00:00) All Data 2017 | 53 | 17:17:59 (+00:00)

D Reset Zoom || %# Options || A Hide

= Device Address
[=c4

Closed - Click to Open

_ Device Name ©
Closed - Click to Open

@ - Service Type (2 values) #
OTHER(76) - NETBIOS (7)

. Session Analysis (1 va\ue)fo
not top 20 dst (29)

. EventTime (1 value) 2
2017-Aug-17 09:32:15(1,531)

| NETWITNESS SUITE

With the service selected and data loaded you are ready to begin analyzing the data.

Change the Service or Collection to Investigate

1. In the Navigate view or the Events view, click the service name at the top of the options
panel.

The Investigate dialog is displayed.
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Investigate
Services Collections

M Default Service

MName ~ Address Type
ErokerG3 Broker
Concentratorfd Concentrator
ConcentratorG? Concentrator
Decoder220 Decoder
Decoder6s Decoder

Log Decoder227 Log Decoder

Cancel Mavigate

2. Double-click a service or select a service and click Navigate. The resulting panel displays
the activity for the selected service.
If the Autoload Values setting is on, the values are loaded as shown in Step 3.
Otherwise, the Navigate view is displayed with the default service selected, and data ready

to load. In the Events view the data is loaded automatically.
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RSA INVESTIGATE

@) admin &
NAVIGATE

= Log Decoder227 ¥ Query @ [ Profile ® EJMeta @ | TE Total @

/= Descending = EF EventCount ® | Save Events @ - Actions &

() Load Values

| NETWITN

11.0.0.0-170612140943.1 be1dd3

3. When ready, click (CHINENS

The values for the service begin loading in accordance with the selected options.

RSA INVESTIGATE @ admin®  (?)
NAVIGATE
E Decoder220 ¥ Query © EJProfile ® EJMeta® | B Total © .= Descending @ BB EventCount ® | SaveEvents ® -
<
time="2007-04-13 17:27:00"-"2017-06-15 20:14:50"
2007 5 17:27:00 (+00:00) All Data 2017  §% | 20:14:59 (+00:00)
£# Options | Hide
PES Service Type Not Indexed (12 .
| NETWITN

11.0.0.0-170612140343.1 be1dcf3

With the service selected and data loaded you are ready to begin analyzing the data.
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Investigate Workbench Restoration Collections

This procedure enables Administrators to select content from an existing collection to reprocess
for further investigation. This applies to Decoders that use Workbench services.

Note: Only a user with administrative privileges can create a collection, and you can view
only those collections that you created.

To reprocess data for further investigation:

1. Goto INVESTIGATE > Navigate or Events.
The Investigate dialog is displayed.

Investigate
Services Collections

M Default Service

MName ~ Address Type
Erokerf3 Broker
Concentratord Concentrator
ConcentratorG? Concentrator
Decoder220 Decoder
Decoder6s Decoder

Log Decoder227 Log Decoder

Cancel Mavigate

2. Select a workbench service and workbench name that you want to investigate.

3. Click Navigate to perform an investigation on your selected workbench service.
Click Cancel to select a different workbench service to investigate.
The Investigation view is displayed.

With the collection selected and data loaded you are ready to begin analyzing the data.
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Begin an Investigation in the Event Analysis View

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

The Event Analysis view offers most of the features that are available in both the Navigate view
and the Events view. Similar to the Navigate view, there is a view into meta keys and meta
values for logs, endpoints, and packets. Like the Events view, an events list shows events listed
in the order by time, and you can view the raw event, related meta data, and a reconstruction of
an event. The Event Analysis reconstruction has some helpful cues to identify points of interest
in a reconstruction. See Analyzing Raw Events and Metadata in the Event Analysis View

Note: In Version 11.0 you cannot begin an investigation in the Event Analysis view. Instead,
you begin the investigation in the Navigate or Events view, and open an event in the Event
Analysis view. In Version 11.1, an INVESTIGATE submenu gives you direct access to the
Event Analysis view along with the ability to select a different service, time range, and create
a query.

Access the Event Analysis View (Version 11.1 and Later)

Several ways to access the Event Analysis view are available in Version 11.1.

o When you use the Actions > Go to event in Event Analysis option in the Navigate view, and
enter an event ID, the Event Analysis view opens the single event as a reconstruction. To
simplify the view, the toolbar does not include the unnecessary options to expand, contract,

and close windows. You can begin working as described in Analyzing Raw Events and

Metadata in the Event Analysis View.
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When you hover over a count (the green number after a meta value) in the Navigate view and
click Open Event Analysis in new tab, the Event Analysis view opens with the list of events

for the selected drill point, and you can begin working as described in Analyzing Raw Events

and Metadata in the Event Analysis View. The list of events can be very large, and there is a

chance that the event you selected is not visible in the current page of events. In this case, a
message advises you to scroll down to view the event.
16:52:00

01/31/2018 Network NETBIOS
16:52:00

01/31/2018
16:52:00

01/31/2018 Network MNETBIOS
16:52:00

01/31/2018 Network OTHER

1£-E72.M0

O Scroll down to view the selected event
highlighted in blue

You can also access the Event Analysis view directly by going to INVESTIGATE > Event
Analysis or going to INVESTIGATE if you have made the Event Analysis view your
opening Investigate view. When you land on the Event Analysis view for the first time, you
need to select a service to begin analysis. If this is not the first time you opened Event
Analysis, the last used service is remembered until the localStorage is cleared.

When you open the Event Analysis view from one of the other Investigate views, the service
and query from that view are in effect. You can change the service, select a time range, and
enter a query if you want to refine the results before opening the Event Analysis view as

described in Filter Results in the Event Analysis View.

To access the Event Analysis view directly,

I.

Go to INVESTIGATE > Event Analysis.

The Event Analysis view opens with the first service in the service list selected and no data
displayed. The Select a service field is populated initially with the first service in the list or
the last selected service. A drop-down menu offers a list of available services in
alphabetical order. By default the list of available services is retrieved every twelve hours
and cached on the NetWitness server. If a service is added or removed from the NetWitness
server, the cache is updated with the latest list of services. At the beginning of the field an
icon provides the status of the query.

Bl and no service name = no service is selected.
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B and selected service name= the service is selected.
Il = Investigate is attempting to connect to the selected service.

M =Investigate cannot connect to the selected service or there is no data. In this state, the

service selector control also turns red, and a tooltip explains why the connection attempt

failed and advises you to choose another service.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

2. (Optional) Select a service, usually a Concentrator, from the drop-down list.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis

- Concentrator » (| (4} 02/13/2018 06:39:00 pm - 02/14/2018 06:38:59 pm v

- Broker
- Concentrator
DECODER SOUR... MEDIUM TRAEFIC FLOW ..  SERVICE TYPE
- Broker

- Decoder pd1718 Network lateral

- Log Decoder

- Concentrator | pd1718 lateral
% - Log Decoder

02/13/2018 pd1718 lateral
06:39:13 pm

The time range selector shows either the default time range of 24 hours, or the time range
that you last selected for this service. The Query Events button becomes active and you can

enter filters. If you launch a query now, the selected time is used.
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3. (Optional) To select a time range from the Time Range selector, click in the Time Range
selector and select a time range from the drop-down list. Options are Last 5, 10, 15 or 30
Minutes; the Last 1, 3, 6, 12, or 24 hours; the Last 2, 5, 7, 14 or 30 days; or all Data. (The
time range is based on preferences set for the Event Analysis view. The default basis for
time range is database time; you can change it to wall clock.)

The selected time range is stored in your browser for this service; you can set different time
ranges for different services.
RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Navigate Events Event Analysis Hosts Files Malware Analysis
- Concentrator 02/13/2018 06:39:00 pm - 02/14/2018 06:38:59 pm
Events (10023) | outbound HTTP Last 5 Minutes
Last 10 Minutes
EVENT TIME EVENT TYPE Last 15 Minutes TRAFFIC FLOW ..
02/13/2018 Network Last 30 Minutes lateral
06:39:13 pm Last 1 Hour
02/13/2018 Last 3 Hours lateral
06:39:13 pm Last 6 Hours
02/13/2018 Last 12 Hours lateral
LSt ul Last 24 Hours
02/13/2018 Last 2 Days lateral
06:39:13 pm Last 5 Days
02/13/2018 Last 7 Days lateral
06:39:43 pm Last 14 Days
02/13/2018 Last 30 Days lateral
06:39:43 pm All Data

4. Type a query by creating one or more filters that contain at a minimum a meta key or meta
entity, operator, and optional value. See Filter Results in the Event Analysis View for details on
entering queries.

5. Click Query Events.

The Event Analysis view displays the activity for the selected service and time range, in
accordance with permissions assigned to your role by the administrator. With the service
selected and data loaded, you are ready to begin analyzing the data. Refer to Analyzing Raw
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Events and Metadata in the Event Analysis View to learn how to work in the Event Analysis

view.

Access the Event Analysis View (Version 11.0)

To open and event in the Event Analysis view:

1. Go to Navigate > Events.

2. Right-click an event in the listed events, and select Event Analysis in the menu.

RSA| RESPOND INVESTIGATE MONITE

Navigate Events Event Analysis H

= - Concentrator [JERELRLIAEEY T O

O
O
O
™

Event Time Event Type Source IP Address
201B-02-14T18:10:02  Metwork
2018-02-14T16:10:02  Metwork

2018-02-14T1R1N11  Matwnrk R T
2018-02-14T1 Event Reconstruction

2018021471 Event Analysis i

o oag

2018-02-14T16:10:41  Network

201B-02-14T16:11:02  Metwork

Refer to Analyzing Raw Events and Metadata in the Event Analysis View to learn how to work in
the Event Analysis view.
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Investigating Metadata in the Navigate View

When conducting an investigation in the Navigate view, analysts have multiple methods, specific
to the Navigate view, to refine the results, visualize data, and act on data.

o Filter Results in the Navigate View

e Manage Meta Groups

o Visualize Metadata as Parallel Coordinates

e Open an Event in the Events List

e Export or Print a Drill Point

e Launch an External Lookup of a Meta Key

e Launch a Malware Analysis Scan from the Navigate View

o Visualize the Current Drill Point in Informer

In addition, you can use these methods of querying data and acting on results that are common to
the Navigate view and the Events view.

e Search for Text Patterns

o Create a Custom Query

e View and Modify Queries Using URL Integration

o Use Profiles to Encapsulate Custom Views

o Manage Context Hub Lists and List Values in Investigate

o View Additional Context for a Data Point

o Reconstruct an Event
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Filter Results in the Navigate View

When conducting an investigation in the Navigate view, there are several methods available to
refine the results displayed when meta key values are loaded in the Navigate view. Basic
filtering methods available to analysts are:

o Sct the Time Range

Set the Quantification Method and Sort Sequence of Meta Key Results

Manage and Apply Default Meta Keys in an Investigation

Drill into Data in the Navigate View Time Chart

Drill into Data in the Values Panel

The rest of this topic is focused on the basic methods of filtering data. In addition, more
advanced methods allow configuration of meta groups, profiles, and parellel coordinates
visualizations.

o Visualize Metadata as Parallel Coordinates

e Manage Meta Groups

o Use Profiles to Encapsulate Custom Views

A separate topic is provided for each of the more advanced methods.

Set the Time Range

When conducting an investigation in the Navigate view, the time range options limit the results
returned. You can select:

« A time range relative to the collection. Ranges relative to the collection are based on the last

collection time for data.
o A time range relative to the calendar.
o A custom date range.

o All data.

The selected Date Range (type) is shown in the Navigate view tool bar as the Time Range label;
by default the label is Last 3 Hours. The Time Range display shows the first and last timestamp
for the date range being used for the metadata.

Note: Time range is based on the Time Zone configured in the Profile Preferences panel as
described in "Setting User Preferences" in the RSA NetWitness Suite Getting Started Guide.
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To select a built-In time range:

1. Click the Time Range option in the Navigate view toolbar. The default time range is for the
Last 3 Hours, but a different value from the selection list, for example, All Data or Last
Hour, may already be selected and used as the label in the options panel.

The Time Range selection list is displayed.
@ Last 5 Minutes
@ Last 10 Minutes
@ Last 15 Minutes
@ Last 30 Minutes
@ Last Hour

é Last 3 Hours
4] Last & Hours

. Last 12 Hours
“ Last 24 Hours
& Last 2 Days

< Last 5 Days

Wt el WA e G

2. Do one of the following:
o If you want to see all data, select All Data.

o If you want to set a time range in minutes, hours, or days that is relative to the collection,

select a value such as Last 10 minutes, Last 3 Hours, or Last 5 days.

« If you want to set a time range relative to today, select Yesterday, This Week(Version
11.1), Last Week (Version 11.1), All Day, or a part of the day such as Early Morning,

Morning, Afternoon, or Evening.
o If you want to set a time range relat

o If you want to set a unique date range, select Custom in the Time Range menu and
follow the procedure below.

The selected time range is applied to the current results in the Values panel.

To specify a custom time range:

1. Select Custom in the Time Range menu.

Date selection options are displayed in the toolbar.
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Start Date End Date Go

2. Within the time Start Date and End Date fields, do the following to specify the date and

time:
a. Click a date from the calendar.

b. (Optional) Select the time from the Hour, Minute, Second fields or click Now. The time

selection defaults to the current time of day.

Note: If you specify custom start or end times in seconds, the value for start time in seconds
always defaults to :00, and the value for end time in seconds always defaults to :59. For
example, if you are using time to drill down into an issue, the drill time is interpreted as
"HH:MM:00 - HH:MM:59." Seconds display in this format in Investigation >

Navigate functions.

3. To apply the range, click Go.

The selected time range is applied to the current results in the Values panel.

Set the Quantification Method and Sort Sequence of Meta Key Results

You can select the way results for each meta key are quantified and sequenced in the Navigate
view.

Note: If meta entities (Version 11.1 and later) are used in meta groups, the results will show
the top 20 values that matched any of the meta keys contained in the meta entity.

Each meta key section in the Navigate view contains an ordered list of values showing each
meta key value (Value) and its count (Total). You can specify whether:

o The results in each meta key section are sorted based on Value or Total.

o The results are sorted in ascending or descending order.

o The values shown for each meta key are quantified by number of packets (Packet Count),

number of sessions or logs (Quantify by Event Count) or by the size of events (Quantify by
Event Size).

Note: If you have both a log decoder and a packet decoder for which you are viewing the
metadata, the calculation of what is actually being counted is dependent on the type of key. If
you select to Quantify by Packet Count and are looking at logs, the Navigate view output is the
same output as if you had selected Quantify by Event Count (see Navigate View for details).
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This image shows the Event Type meta key presented in order by Total in Descending order.
The value with the greatest count of matches is presented first. The value failure audit has
71 matches and is listed first. The value 1ogon has only one match and is presented last. The
quantification method is Event Count.

ji— Event Type (5values) P
failure audit (71) - select(34) - connect(32) - success audit(17) - logon (1)

This image shows the Event Type meta keys presented in order by Value in Descending
order. The value names are presented in alphabetical order starting at the end of the alphabet.
The value success audit is listed first. The value connect is presented last. The
quantification method is Event Count.

-l;' . Event Type (5 values.]uo

success audit (17) - select (34) -logon (1) - failure audit (71) - connect (32)

To select the quantification method of meta key count and ordering of meta key results
displayed in the Navigate view:

1. In the toolbar, select Event Count, Event Size, or Packet Count and choose one of the
quantification options in the drop-down menu. The label for the menu displays the selected

option.
5 Event Count &
The current view is reloaded according to your selection.

2. In the toolbar, select Total or Value and choose one of the ordering methods in the drop-

down menu. The label for the menu displays the selected option.

E3 Value &

The current view is reloaded according to your selection.

3. In the toolbar, select Ascending or Descending and choose one of the sort order options in
the drop-down menu. The label for the menu displays the selected option.

The current view is reloaded according to your selection.
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Manage and Apply Default Meta Keys in an Investigation

When analysts are conducting an investigation of captured data in Investigation, a default set of
meta keys is loaded and displayed in a default sequence in the Navigate view > Values panel.
The default content and sequence is based on the meta keys for the service being investigated.
Analysts can specify the meta keys to display during navigation by selecting the default meta
keys or by selecting a user-defined group of meta keys, which provides great flexibility to define
meta keys. This can help to drill down more directly to the desired data and to reduce the load
time by preventing the loading of meta that is not of interest in the current investigation.

Note: In Version 11.1 and later, wherever meta keys are used, you can also use configured
meta entities.

If no custom meta groups are in effect, the Navigate view is displayed with the meta key
visibility specified in the Default Meta Keys dialog. To optimize loading of meta keys in the
Navigate view > Values panel, NetWitness Suite does not open non-indexed meta keys by
default. When you open a non-indexed meta key in the Values view, NetWitness Suite begins
loading values for that meta key. If the load time is excessive, the load of the meta key times out
with a message. Title, values, and counts for non-indexed meta keys are not drillable in the
Values panel. Additional labeling in Investigation identifies the non-indexed meta keys.

To select the meta keys to apply to your investigation, you can.

o Select the default meta keys.

o Select a user-defined set of meta keys, called a meta group.

Note: Once created, user-defined meta groups can be edited, deleted, exported for use on
other services, and imported to the service you are investigation. All of these procedures are
provided in a separate topic: Manage Meta Groups.

The Default Meta Keys dialog allows you to specify the default view and display sequence for
meta keys during navigation in the Investigate > Navigate view for a specific service. For each
key or for all keys, you can set the default view to:

o Hidden: Results for default meta key are hidden and are not available to load.

o Open: Results for default meta key are open with all values and counts displayed.

o Close: Results for default meta key are closed with only the meta name visible.

o Auto: The loading of default meta keys is controlled by the index level, which must be

Indexed By Value.

When using the default meta keys, be aware that these can be modified for different services,
and you may not be seeing the same set of default meta keys when navigating to a drill point on
different services. If you do not see the expected data, you may need to change the initial view
of the default meta keys.
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When you change the initial state of default meta keys from within the Navigate view, the
change persists for that service. When new keys are added to the custom index file for a Core
service (for example, concentrator-custom-index.xml Or decoder-custom-
index.xml), the new keys are added to the default meta keys list. The changes made in the
Navigate view apply only to the current service.

To specify that the initial Navigate view opens using default meta keys:
1. Goto INVESTIGATE > Navigate.
2. Select a service and select Navigate.

3. Inthe Meta menu, select Use Default Meta Keys.
If an investigation is already in progress, the data is reloaded in the current view and an icon
highlights the selected option. If no data is loaded yet, the default meta keys are used for the

next load.

Configure Default Meta Keys
To configure the default view of default meta keys in the Navigate view:
1. In the Navigate view toolbar, select Meta > Manage Default Meta Keys.
The Manage Default Meta Keys dialog is displayed with the list of available meta keys for

the service.

Manage Default Meta Keys

Meta Key
Translated Destination Port

User Account

Secondary User Account
Destination Host

Source Hostname

All Domain Keys

All Event Catagorization Keys
All Email Address Keys

All Ethernet Address Keys

All Analysis Keys
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2. (Optional) To change the order of the keys, select one or more keys, and drag the values up

or down through the list of keys.

3. Do one of the following:

(Optional) To change the default view for all meta keys, make sure that no keys are

selected and in the toolbar, select ﬂ

(Optional) To change the default view for one or more keys, select the keys and in the
toolbar, select n

A drop-down of possible initial views for all default meta keys is displayed.

(Optional) To revert to the default view for meta keys as specified in the service index
file, make sure that no keys are selected and in the toolbar, select ﬂ > Auto.

When you modify the default meta keys for a non-indexed meta key, you cannot set the
key to OPEN. If you change the default view for a group of meta keys to OPEN and some
of the meta keys are non-indexed, the non-indexed meta keys revert to AUTO. As a
result, the meta key is automatically loaded only if it is indexed, and non-indexed meta

keys are CLOSED until opened manually.

4. Select one of the views.

5. To save the changes, click Apply.

The meta keys displayed in the Navigate view are set to your specifications. If the default

meta keys are hidden, values for the meta keys are not shown in the investigation at all. If

the default meta keys are closed, the values for the meta keys are not loaded by default, but

you can load individual meta keys manually in the Navigate view.

Drill into Data in the Navigate View Time Chart

The Time Chart visualization allows analysts to visualize activity over time. Y ou can zoom into
the data by selecting a time window then selecting the Investigate option. You can then reset the
navigation to the time range that was in effect before zooming.

1. Goto INVESTIGATE > Navigate.
The Time Chart for the current drill point and selected time range is displayed.
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el Al Data M ¥ Query© EIProfile© EMeta © | ETotal © = Descending © &5 Event Count © | SaveEvents © -

2017 % | 15:05:34 (+00:00) All Data 2017 %8| 17:17:59 (+00:00)

‘1.‘ |“— "‘: “f 1“'
0 Reset Zoom | %# Options | A Hide

= Device Address
=

Closed - Click to Open

. Device Name °
Closed - Click to Open

@ - Service Type (2values) o
OTHER (76) - NETBIOS (7)

. Session Analysis (1 value) ©
not top 20 dst(29)

. EventTime (1 value) ©
2017-Aug-17 09:32:15(1,531)

| NETWITNESS SUITE

2. To highlight a period of time on the Time Chart, click over the desired time period and drag
the mouse.
The Time Chart is redrawn for the selected time range, however the meta values are

unchanged.

3. Todrill into the data for the selected time range, click Investigate.
The URL is updated to reflect the time range override. and the Investigation options panel is
updated to reflect the custom time range. The Time Chart is redrawn and the meta values are

loaded for the selected time range.

4. To reset the Time Chart to original time range, click Reset Zoom.
The URL is updated to reflect the original URL prior to zooming into the data, and the
Investigation options panel is updated to reflect the time range selected before zoom. The
Time Chart is redrawn for the selected time range and the meta values are loaded for that

time range.

Drill into Data in the Values Panel

NetWitness Suite displays the activity and values for the selected service in the Investigation >
Navigate view. To investigate data, analysts drill into data by clicking on a meta key or a meta
value, which is treaty as a query. In the Values panel, each query is added to the breadcrumb
data in the Values panel. This results in a breadcrumb at the top with a crumb for each query.
You can edit the breadcrumb to insert or remove a query.

71 Investigating Metadata in the Navigate View



NetWitness Investigate User Guide

To drill into a subset of the metadata:

1.

Begin an investigation so that metadata is displayed in the Navigate view.

TR T All Data M ¥ Query © M Profile ® EMeta | = Total = Descending © [ Event Count © | SaveEvents © - Actions

2017 % | 15:05:34 (+00:00) All Data 2017 35| 17:17:59 (+00:00)

= Device Address
=a

_ Device Name ©
_ service Type (2 values) ©
. Session Analysis (1 value) L

. EventTime (1 value) 2

-‘k\ |‘\- w‘: -“5 1‘\'
D Reset Zoom || %# Options || A Hide

Closed - Click to Open

Closed - Click to Open

OTHER (76) - NETBIOS (7)

not top 20 dst (29)

2017-Aug-17 09:32:15 (1,531)

| NETWITNESS SUITE

To drill down into the metadata, do any combination of the following:

Click a meta key, for example, Service Type.

Click a meta value, the blue text in the results. For example, OTHER.

Each time you click a meta key or meta value, the investigation query pivots to a
narrowed focal point, or drill point, in the data. At each drill point, the Values panel is
updated and the new drill point is displayed in the breadcrumb. Below is an example of

the first breadcrumb.

=R:OCGER 2| Data s ¥ Query & [EJ Profile &

w service =0 '~
(service = 0) E& time="2007-02-09 00:17:00"-"2017-08-14 19:48:59°
02
2007 ‘ oo 09:17:00 (+00:00)

This is an example of a long breadcrumb that does not fit in the toolbar. The last query
that fits is followed by a drop-down menu that lists additional queries. To select a drill

point within the overflow, click the overflow icon and a query in the drop-down list.
city.dst = 'washington' = | »

org.src ="china telecom shanghai’ ]
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To add a query in the breadcrumb:

In the breadcrumb, you can click any of the crumbs to display the Query menu. You can insert a
new query before a crumb, and append a new query to the end of breadcrumb. After each edit in
the breadcrumb, NetWitness Suite refreshes the results.

To add a query in the breadcrumb:
1. Click a crumb.
The Breadcrumb menu is displayed.
country.dst = 'united states' ~ |
‘# Mavigate Here
o Mavigate Here [new tab)
=+ Insert Before

= Remove

4 Edit .

2. To add a query in the breadcrumb, select Append or Insert Before.
The Create Filter dialog is displayed.

Create Filter

® Simple O Advanced O Recent

Select Meta v | |Operator v | Value

™ Network [ Log

3. Create the Query as described in Create a Custom Query.

To edit a query in the breadcrumb:

In the breadcrumb, you can click any of the crumbs to display the Query menu. You can delete a
crumb and edit a query in a crumb. After each edit in the breadcrumb, NetWitness Suite
refreshes the results.

To work with queries in the breadcrumb:

1. Click a crumb.

The Breadcrumb menu is displayed.
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country.dst = 'united states’ ' |
@ Navigate Here |
i~ MNavigate Here (new tab)

== Insert Before

= Remaove

7 Edit |

2. To edit a query in the breadcrumb, select Edit.
The Create dialog is displayed with the selected query open for editing.

Edit Filter united states

) Simple ® Advanced O Recent

country.dst = "united states’

3. Edit the fields as described in Create a Custom Query.

To quick search within a meta key:
1. Move the mouse over a meta key section and click the magnifying glass.
The Quick Search form, which contains a comparator and an optional operand for the
search, is displayed.
Q Destination City (1 value) L
= v Drill

washington (354)

2. (Optional) If you want to close the search form, click the magnifying glass again.

3. Select the operation from the drop-down list on the left and type the text value to search for.
Then click Drill to perform the execution.

The metadata for that meta key is used to drill down in the current metadata.
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To view meta key Information:

To view details about a meta key, specifically the key name, index level set for displaying the
meta key, and the default view set for the meta key:

1. Click the drop-down menu next to the meta key. These two figures show the drop-down

menu for Version 11.0.0.x and 11.1 and later.

Q - Destination ¢ . Destination City (20 value
— et ee 12 — sl ioatoen (] DDFUUU = ?9%) -
More Results More Results 4) - tampa (2f
) | Max Results

vlax Results <
e Hide Results in (20 values
Hide Results Meta Key Info >1UU,DE_JD - B2%
20) - hinet.net

Meta Key Info Export Values
View as CSV waw - Destination Domain (20
and varizan et 0 20T man

2. Select Meta Key Info.
The Meta Key Info dialog is displayed.

Meta Key Information

Key Name city.dst
Index Level Value

Default View Auto

3. When finished viewing, click B.

4. (Optional for Version 11.0) To view meta names found for the meta key as a comma-
separated value list, click the drop-down menu next to the meta key and select View as

CSV.
The Showing Values in CSV Format dialog is displayed. When finished viewing, click

Close.

5. (Optional for Version 11.1) To view meta names found for the meta key in a list, click the

drop-down menu next to the meta key and select Export Values.
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The Export Values dialog is displayed.

Export Values

avastsvc.exe
avastui.exe
services.exe
maswvc.exe
chrome.exe
explorer.exe
outlook.exe
macompatsvc.exe
svchost.exe
Mmacmnsvc.exe
updaterui.exe
firesvc.exe

Close Select All

6. (Optional) If you want to hide the results for the meta key in the current drill point, click the

drop-down menu next to the meta key and click Hide Results.

To display events associated with a meta value:

The Events view provides additional details for an event in two different views: Events List and
Detail View.

1. In the Navigate view, drill into metadata that is the focus of your investigation.

2. Click the count (the number in green) next to a blue meta value.
The Events view corresponding to the current drill point is displayed.
The operations that you can perform in the events view are described in Examining Raw

Events in the Events View.

To search for specific events associated with a meta value:

1. Inthe Navigate view, drill into metadata that is the focus of your investigation (click a meta

value or add a query).

2. Type a search string in the Search box and press Enter or click Search.

You can also select and set search mode preferences. See Search for Text Patterns for detailed

search information.
The Events view opens in a new tab and shows the search results. If you do not see the

search term highlighted, click Show Additional Meta. Y our time range selection and drills
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(queries) carry forward to the Events view.

INVESTIGATE @ admin ® (3)
EVENTS
E Broker63 ¥ Query @ [ Profile ©® [J Detail View & -~ Actions © -~ Incidents & Search - Settings
1| Event Time EventType  Event Theme Size Details
<¥ sessionid : 8526933
B medium: 32
:+: aev pe: unknown
O 2017-06-14T18:46:00 Log
o d: admin
+ show Additional Meta E] View Details @ Event Analysis
©¥ sessionid : 8247862
B medium: 32
E*} device. pe: unknown
[0 2017-06-14T18:42:16 Log 146 bytes
-
| Page 1 of 1 | | C | 25 ~ eventsperpage Displaying 1 - & of 6 event matches

11.0.0.0-170612140943.1.be1ddf3

To view a selected meta value in RSA Live:

1. In the Navigate view, drill into metadata that is the focus of your investigation.

2. Right-click a meta value (the text in blue).
The Meta Value drop-down menu is displayed.

3. To look up the meta value in RSA Live, select Live Lookup.

The Live Search view is displayed with the meta value entered in the Generated Meta
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Value(s) field, and ready for a search.

RSA CONFIGURE (® admin ©

LIVE CONTENT

Search Criteria Matching Resources

Keywaords Show Results = | | X Package ©

[ | subscribed Name Created Updated Type Description

Caregory
[CIFEATURED

» [ THREAT

» CJIDENTITY

» C1ASSURANCE

» CIOPERATIONS

Resource Types
Medium

Required Meta Keys

Generated Meta Values

20

»
0 Matching Resources

NETWITNESS SUITE 11.0.0.0-170612140943.1.be1dd3

To refocus the investigation in a drill point:
1. Right-click a meta value (the text in blue).
The Meta Value drop-down menu is displayed.
Copy
Apply IEQUALS Drill

Add/Rernowve from List

Data Science >
Refocus >
Refocus New Tab >
External Lookup ]

2. Choose one of the refocus options.

The drill is refocused according to your choice.

To look at a specific count in a new tab:

To view a count for a meta value in a new tab or view a Geomap of the locations for the
selected meta value:

1. Right-click a count for a meta value (the green number following the blue meta value).

The context menu is displayed.
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2. (Optional) To open a separate investigation for the specific meta value, select Open in New
Tab.

3. (Optional) to open a geomap showing the locations where the selected meta value originated,

select Geo-Map Locations in New Tab.
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Manage Meta Groups

A meta group combines selected meta keys into a group to show only data in which the meta
keys and meta entities were found.

Note: In Version 11.1 and later, you can also use configured meta entities in meta groups.

In the Investigate > Navigate view, you can use meta groups to filter data displayed in an
investigation. A fresh installation of NetWitness Suite includes out-of-the-box (OOTB) meta
groups to help you find interesting data sets in Investigate. The OOTB meta groups are prefixed
with RSA for identification and can be duplicated but cannot be edited or deleted. You can
create your own groups and you can duplicate and edit an OOTB group to create a custom
group.

With a meta group in effect during an investigation, the information in the Values panel shows
only the meta keys in the selected group. When you open a Parallel Coordinates visualization,
the meta keys and meta entities in a group appear as axes from left to right. It may be useful to
create two versions of each custom meta group; one for analysis of meta values and one for
creating a parallel coordinates chart focusing on a smaller subset of the same use case.

Custom meta groups are visible to all users of a service and may be exported for import to any
service, limited by the available meta keys for that service.

Note: When an administrator adds custom meta groups manually by editing the custom index
file for a service, the new groups become available to Investigation after the service is
restarted.

This section describes how to add, edit, import, export, and delete custom meta groups to be
used during navigation on a specific service.

Out-of-the-Box Meta Groups

The OOTB meta groups a built-in to RSA NetWitness Suite. The default meta groups are useful
to focus an investigation on common use cases and to support threat detection using the RSA
Hunting Pack.

These are the OOTB meta groups:

o RSA Email Analysis includes meta keys that outline email interactions.

« RSA Endpoint Analysis contains meta keys that provide insight on processes, files, users, and
connections from NetWitness Endpoint (NWE) hosts.

o RSA Malware Analysis includes meta keys that mark indicators of compromise in files

contained in events.

¢ RSA Outbound HTTP includes meta keys that provide insight into outbound web traffic.
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o RSA Outbound SSL/TLS includes meta keys that focus on encrypted web traffic.

o RSA Query Hosts includes a meta keys that encompass all the meta keys to find hosts.

o RSA Query IPs includes meta keys that encompass all the meta keys to find IP addresses.
o RSA Query Mail includes meta keys that encompass all the meta keys to find email.

o RSA Query Users includes meta keys that encompass all the meta keys to find users.

o RSA Threat Analysis includes meta keys that mark potential threats in the data set.

o RSA Web Analysis includes meta keys that mark anomalies in web traffic.

Create a Meta Group and Add Meta Keys

1. While investigating a service in the Investigate > Navigate view, select Meta > Manage
Meta Groups in the toolbar.
The Manage Meta Groups dialog is displayed. Initially only OOTB groups are configured for
a service and listed under Group Name. If other custom groups have been configured, they

are also listed under Group Name.

+-B a&m
O Group Mame ~

RSA Email Analysis
RSA Malware Analysis
RSA Query Hosts
RSA Query IPs

RSA Query Mail

REA Query Users

R5A Threat Analysis

O oOoo0oooood

R5A Web Analysis

Close

2. In the grid toolbar, click +.

A new row is inserted at the top of the Meta Groups grid.
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3. Type a name for the new meta group, and press Enter.

The form to the right opens for editing.

Manage Meta Groups

MName

Meta Keys
+ - %

Display Mame Key Mame View

Click + button to select Meta Keys

Close Cancel Save Save and Apply

4. (Optional) If you want to change the name of meta group, type a new value in the Name
field.

5. Inthe Meta Keys toolbar, click +.
The Available Meta Keys dialog is displayed, with keys in alphabetical order.
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10.

Available Meta Keys

Filter *
0 Display Name ~ Meta Key
O ipvd.whatever ipvd.whatever =
[l ipvb.whatever ipvE.whatever
[] textwhatever text.whatever
[1 mac.whatever mac.whatever
[1 uint8.whatever uint®.whatev...
(1 uintl6.whatever uint16.whate...
[1 float32.whatever float32.whate...
(1 timewhatever timewhatever
(] uint32.whatever uint32.whate...
[l kig_thread kig_thread
] device.type.id device.type.id
I_I pwent.car pwvent.car M
Cancel Add

To filter the list of meta keys, type a word or phrase in the Filter field and select Enter.
The list displays matching meta keys based on a case-insensitive search. Delete the filter

text and press Enter to remove the filter.

To select meta keys to include in the meta group, click the checkboxes. To select all meta
keys, click the checkbox in the title bar and click Add.
The selected meta keys are added to the meta keys list.

(Optional) If you want to change the order in which the meta keys load and are listed in an

investigation, click and drag one or more meta keys to a new position.
To finish creating the meta group do one of the following:

a. To save the meta group, click Save.

The group is created and available for use.

b. To save and apply the meta group to the current Investigation view, click Save and

Apply.
The group is created and applied immediately to the current Investigation view.

Click Close.

&3
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Duplicate and Edit an Out of the Box Meta Group

If you want to customize an OOTB meta group, you need to duplicate the group and then edit the

duplicate.

1. Select an OOTB meta group from the Manage Meta Groups grid and click B )

The form to the right opens for editing with all of the meta keys as they are in the OOTB

group.
Manage Meta Groups

2. Enter a name for the new group and continue editing as described in "Edit a Meta Group"

below.

Edit a Meta Group

Name

‘ RSA Email Analysis 3

Meta Keys
+ -
Display Name
Service Type
Originating IP Address
Source IP Address
Destination IP address
TCP Destination Port
Destination Port
Hostname Aliases
Source Country
Destination Country
Source Organization

Destination Organization

1. Select a group from the Meta Groups grid.

The form to the right opens for editing.

Key Name
service
orig_ip
ip.src
ip.dst
tcp.dstport
ip.dstport
alias.host
country.src
country.dst
org.src

org.dst

Save and Apply
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Manage Meta Groups

+ - B = MName
] Group Name ~ RSA Email Analysis
¥ RSA Email Analysis Meta Keys
[] RSA Malware Analysis
[l RSA Query Hosts
Display Name Key Mame View
[l RSA QuerylPs R :
) Service Type service Auto -
[l RSA Query Mail
Criginating IP Address orig_i Auto
[ RSA Query Users - s =
i Source |P Address ip.src Auto
[l RSA Threat Analysis
i Destination |P Address ip.dst Auto
[ RSAWeb Analysis
TCP Destination Port tcp.dstport Auto
Destination Port ip.dstport Auto -

Close

2. (Optional) Edit the Name of the group.

3. (Optional) Add new meta keys, as described above in Create a Meta Group and Add Meta
Keys.

4. (Optional) To set the order for the keys, drag and drop one or more keys.

5. (Optional) To change the initial view of a meta key, click ¥~ and choose one of the
possible views.
When you modify the meta group, you cannot set the key to OPEN. If you change the default
view for a group of meta keys to OPEN and some of the meta keys are non-indexed, the non-
indexed meta keys revert to AUTO. As a result, the meta key is automatically loaded only if
it is indexed, and non-indexed meta keys are CLOSED until opened manually.

The value for the initial view is displayed in the View column.
6. To save, the changes, click Save.

7. To apply the changes to the current Navigation view, click Save and Apply.
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Delete a Meta Group
1. Inthe Meta Groups grid, select the group to be removed.

2. Click = .
A confirmation dialog provides an opportunity to cancel or complete the request.
3. Click OK.
The meta group is deleted. When you close the window, if the deleted group was the

currently applied meta group, it is removed and the default meta keys are used to build the

view.

Export a Meta Group

User-defined meta groups are created on individual services. To make meta groups available to
another service, you must export them to your local file system. To export one or more meta

groups:

1. Inthe Meta Groups grid, select one or more groups to be exported.

2. Click [ .
The selected groups are downloaded to your local file system as a MetaGroups.jsn file.
Every download of meta groups has the same name with a numeral appended to avoid

overwriting previous downloads.

Import a Meta Group

To make user-defined meta groups from another service available to the currently investigated
service, you must import the MetaGroups. jsn file from the local file system. When you import
meta groups, an error message is displayed if any of the groups are already present. To import a
group that is a duplicate, you must first delete the existing group. If you want to delete a meta
group, it cannot be in use by a profile.

To import meta groups:

T
1. Inthe Meta Groups grid, select a file to import and click ==,
The selection dialog is displayed.

Meta Group Import

Upload File Browse
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2. Click Browse and navigate to the directory on your local file system where the downloaded
MetaGroups.jsn files are stored. Select a file and click Open.
The filename is displayed in the Upload File field.

3. Click Upload.
The upload process begins, and a message indicates that the upload was successful. The
meta groups are added to Meta Group grid. If the file is a duplicate of an existing meta
group, a dialog tells you that the meta group already exists.
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Visualize Metadata as Parallel Coordinates

Analysts can use the parallel coordinates visualization in the Navigate view to focus the
investigation on combinations of meta keys and values that may indicate events are abnormal
and worth investigation.

Note: In Version 11.1 and later, wherever meta keys are used, you can also use configured
meta entities.

The parallel coordinates chart is a way of visualizing the current drill point in Investigation to
examine more than two meta keys simultaneously. Visualizing multiple meta keys
simultaneously can help in identifying security issues associated with multivariate patterns and
comparisons, such as when individual meta keys and values may not be of concern, but
combining them together may bring an abnormal pattern or relationship to light. Meta groups (see
Manage Meta Groups) can be used effectively to define a collection of meta keys that you want to
visualize as parallel coordinates.

Best Practices for Effective Parallel Coordinates Charts

To create effective parallel coordinates charts, follow these recommendations:

o Start from a drill point in the Navigate view rather than attempting to visualize all data.
o Limit the time range if necessary.

o Choose the smallest useful set of meta keys to display as axes.

o Specify the sequence of axes to highlight anomalies between the meta values as you follow a

line across the chart.

o When you can identify a useful set of meta keys and sequence, create a custom meta group to
use for future investigations. For example, you can create a custom meta group for Windows

executable file types.
o Use the RSA out-of-the-box (OOTB) meta groups that are included in a new installation.
o Re-use and share custom meta groups by importing and exporting groups as .jsn files.

o It may be useful to create two versions of each custom meta group. One for analysis of meta
values and one for creating a parallel coordinates chart focusing on a smaller subset of the

same usSc case.

Note: When you import meta groups, an error message is displayed if any of the groups are
already present. To import a group that is a duplicate, you must first delete the existing group.
If you want to delete a meta group, it cannot be in use by a profile.
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To help build better parallel coordinates charts, several optimizations are included in
NetWitness Suite.

o Analysts can specify that only sessions in which all meta keys exist are rendered in the chart.

e The administrator can increase the number of meta values rendered in the Parallel

Coordinates Settings in the Administration System view.

RSA Meta Groups for Parallel Coordinates Use Cases

A set of predefined meta groups is included with NetWitness Suite. If you want to get the latest
version, you can import the meta groups file, MetaGroups ootb w query.jsn, in the
Manage Meta Groups dialog. Some of the targeted activities that lend themselves well to
Parallel Coordinates visualizations are:

o Botnet Beaconing
o Covert Channels

o Email

o Encrypted Sessions
o Endpoint Analysis
o File Analysis

o Malware Analysis
e Outbound HTTP

o Outbound SSL/TLS
o SQL Injection Attacks
o Threat Analysis

o Web Analysis

View a Parallel Coordinates Visualization

From an investigation in the Investigate > Navigate view:

1. If the Visualization panel above the Values panel is closed, select Visualization.
2. In the toolbar, select Meta > Use Meta Group > File (Malware) Analysis.

3. Inthe Values panel, in the Forensic Fingerprint meta key, click windows executable
and then x86 pe, so that the breadcrumb reads filetype = 'windows executable' |

filetype = 'x86 pe'.
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Forensic Fingerprint
86 pe (328) -windows_executable (328) [windows executable (328] [ javascript (328)]- html (143) - xmi (110) - gif (77) - windows_dll (53) - wi

file (1)
Loaded in 0.839 secs. Total running time 0.845 secs.

indows dll (53

Filename £
Closed - Click to Open

Destination Country (14 values) ©
s an federation netherlands (7) - germany (7) - united kingdom korea, republic of austria canada

united

4. A default visualization for the current drill point is displayed as a timeline.

@  RSASecurity Analytics

® Navigate # Events. & Malware Analysis
& Settings

S5 IS e e - Concentrator  Last 24 Hours v | P Query © File Analysis | TS Total © 4= Descending © Z= Event Count © | SaveEvents © # Actions *

L filetype = ‘windows executable' © | filetype = ‘javascript' ©
Rty - vindows excuabie e etype = svescroe) B i 20150429 216002015 04 0201557
2015 ‘ % | 16:16:00 (:04:00) Last 24 Hours 2015 | % ‘ 16:15:59 (-04:00)

? £ Options | A Hide

Forensic Fingerprint (18 values) ©
- html (143) -xml (110) - gif (77) - windows_dll (53) - windows dll (53) - windows msi installer (38) - png (34) - jpg (34) - cab (34) - ¢ss(28) -zip (11) - swf (3) - php script (2) - apple iwork:

@
XB6 pe (328) - windows _ d
file (1)
Loaded i 0.839 secs. Total running time 0.845 secs.
_ Filename ©
W

Closed - Click to Open

¢ . Destination Country (14 values) £
united states (265) - russian federation (12) - netherlands (7) - germany (7) - united kingdom (4) - korea, republic of (4) - austria (4) - canada (3) - ukraine (2) - japan (2) - sweden (1) - denmark (1) - china (1) - australia (1)

Loaded in 0.63¢ secs. Total running time 0.638 secs.
Send Us Feedback | 10.5.0.0.17626-1

2 admin | @) english (United States) | GMT-04:00

5. Inthe Visualization panel, select Options.

The Visualization Options dialog is displayed.

6. Inthe Visualization drop-down list, select Coordinates and click Apply.
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Visualization Options

Visualization Coordinates ~

[ All Meta Keys Must Exist in an Event

+ -9
L] Meta Key
Source Country
Source Domain
Top Level Domains
Service Type

IP Protocol

>

00 0ooonf

Destination Country

Cancel Apply

The visualization is loaded. In this example, 249 events are found and 199 unique paths are

visualized.

© Navigate SEvents & Malware Analy: 0) RSA “Security Analytics
JAAAMA I e e - Concentrator  Last24 Hours v P Query © IR Profile # Event Count © | SaveEvents - # Actions - £# Settings.
| filetype = 'windows executable’ © | filetype = javascript'

(flerype - windows execurabie) & (Tletype = avascrpt) & tme="2015.04-29 20:1600"2015.04.30 2015:59"
2015 ‘ 3 ‘ 16:16:00 (-04:00) Last 24 Hours 2015 ‘ g ‘ 16:15:59 (-04:00)
Top estnaton Port canent e Souce couny [e—— Farame

Client Application

Mozilasinarso windonsiud ——
Windows

NTS ionUs — 08D 2269;
e ST
Py 1 2o il

B e
Googe Desop)

43 et

ass
ot ssptieassoer S 2tacs720017TE
VR PR e e 7 RST

N
ussan Fedsraion]

300408 e48 NET
loso727 SNERELR 210z
NET L 30 4506 2152: NET

HicosoCURS 530729)

Voziasex2r50 (vindor
Windows N1 5.1

s .
“us:
7.

i .
e —
fvmsliﬁf

Vipk nx},,v

MR s

Froiguebt 20016
RSERAEOS.

Onlya subset of events is displayed @ 249 Events Found | 199 Unique Paths

= Extension (20values) © 0
v exe (184) - <none> (69) - gif (61) - php (53) - ¢ss (38) - htm (37) - js (31) - jpg (30) - png (28) - aspx (21) - msp (20) - msi (18) -ico (17) - html (17) - cab (13) - asmx (13) - axd (8) - dI_(6) - cgi (4) - cer (4) ... show more
Loadied in 1.407 secs.Total running ime 1.414 secs

Forensic Fingerprint (13 values) ©

English (United States) | GMT-04:00 Send Us Feedback | 105.0.0.17626-1
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Select Meta Keys for a Parallel Coordinates Visualization

With a Parallel Coordinates visualization open, do the following:

1.

In the Visualization panel, select Options.

The Visualization Options dialog is displayed. In the toolbar, click @ 1o display the

recommended number of axes for a readable visualization. When a recommended count of
keys is displayed, the count changes based on the browser size. If you make the browser

window larger, the recommended count is increased.

Visualization Options

Visualization Coordinates w

] All Meta Keys Must Exist in an Event

+ -9 D
L] Meta Key
[] Source Country
[] Source Domain m
] Top Level Domains
] Service Type "
IP Protocol X

MNumber of selected axes (8) does not exceed the
recommended count of 22

Cancel Apply

If you want to change the sequence of the meta keys, drag meta keys up or down to the

desired sequence.

If you want to delete any meta keys, click in the selection box, and click ==,

The meta keys are removed, but the change has not been applied.

If you want to revert to the previous state, click b .

Any meta keys you have deleted are restored and any changes that you made are removed.

If you want to select individual meta keys, click + , select From Default keys, and in the

drop-down list, select the meta keys.
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Add Keys to Parallel Coordinates Visualization

Select Keys:

® From Default Meta Keys

Access Point

Action Event

Active Directory Domain Destination
Active Directory Domain Source

Active Directory Username Destination

Active Directory Username Source

Active Directory Workstation Source
Alert ID

Alerts

Attachment

Browsers

[ TR 0

Active Directory Workstation Destination

|

The selected keys are listed.

Add Keys to Parallel Coordinates Visualization

Select Keys:
® From Default Meta Keys

Client Application @  Source IP Address @ ~
TCP Destination Port @  Content Type @
Source Country @  Filename &

() From Meta Groups

With The Selected Meta Keys...
Append to the current list of keys v

Cancel Add

6. If you want to add all the keys in a meta group, you cannot add individual meta keys. Select

From Meta Groups, and select a group from the drop-down list.
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Add Keys to Parallel Coordinates Visualization

Select Keys:

() From Default Meta Keys

® From Meta Groups

Botnet Beaconing
Covert Channels
Email

Encrypted Sessions
File Analysis
Malware Analysis
Query Files

Query Hosts

Query IPs
Query Mail

Query Users
Query Web

[t X T G [T O S I W P

The selected meta groups are listed in the field.

7. Select the method of adding the keys or groups: Replace the current list of keys, Append

to the current list of keys (at the end), or Insert at the beginning of current list of keys.
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Select Keys:

) From Default Meta Keys

) From Meta Groups

Test
With The Selected Meta Keys...

Replace the current list of keys

Append to the current list of keys
Replace the current list of keys

Insert at beginning of current list of keys

Cancel

To complete the procedure, click Add.

Add Keys to Parallel Coordinates Visualization

The Visualization Options dialog is displayed with the meta keys or groups you selected.

To display the new visualization chart, click Apply.

©Navigate S Events % Malware Analysi

WS W - Concentrator  Last24 Hours v P Query © E Profile ile Analysis

| filetype = 'windows executable’ © | filetype = javascript'

(fletype = ‘Windows executable’) 8& (fletype = Javascript) && time="2015-04-29 20:16:00"-"2015-04-30 20:15:59"
o
2015 ‘ 29 ‘ 16:16:00 (-04:00)

Client Application

Source P Adcress

ozl ex2rs 0 (windows: -
Windows N1 5.3:an 0S:

Froioarorzo0d
oaiasHE S Bngatse
Googe Desop)

43 et

Moziasncris0 AN
s Too;

2
036
RSERAEOS.

Onlya subset of events is displayed @

| ™ Total © 4= Descending * &= Event Count ~

Last 24 Hours

TCP Destination Port:

249 Events Found | 199 Unique Paths

" e

RSA “Security Analytics

| saveEvents © % Actions - 13 Settings

2015 ‘ < ‘ 16:15:59 (-04:00)

Source Couny Fiename

ContentType. Destination Country

RN o aserzoEsRos DA AT TOTAE SEE CAY
SRR A O 5
ouphar]

//,' -

Korta, Fopubica

A~

B Wrnasseorcsadsranarily

SRR
1IBEP DICFOk ChSOUpy

iRy
NS

2aSutesetp. 70 483

*DNE @ £ Options | £~ Hide

= _ Extension (20values) 2

Loaded in 1.07 secs. Total running time 1.414 secs.

exe (184) - <none> (69) - gif (61) - php (53) - css (38) - htm (37) - s (31) - pg (30) - png (28) - aspx (21) - msp (20) - msi (18) -ico (17) - html (17) - cab (13) - asmx (13) - axd (8) -dI_(6) - cgi (4) - cer (4)

o

..show more

Send Us Feedback | 10.5.00.17626-1
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Optimize a Parallel Coordinates Visualization

L.

To optimize the visualization by removing events in which not all meta keys exist, select

Options.

Visualization Options

Visualization Coordinates v

~ All Meta Keys Must Existin an Event
+ -9

] Meta ey

)

[0 Destination Coum.r.*
[[] Destination Domain
[l Service Type

[] TCP Destination Port
[0 client Application

L Destination IP address

Cancel Apply

In the Visualization Options dialog, select All Meta Keys Must Exist in an Event. Click

Apply.
The resulting graph is more readable and useful and has fewer unique paths.

@ Investigation ® Navigate ®Events & Malware Analysis H B @ RSAsecurity Analytics
55 I s s - Concentrator  Last 24 Hours v P Query @ R Profile © I File Analysis © | [ Total © 4= Descending © ZZ EventCount = | SaveEvents © 4 Actions 2 Settings
C  filetype = 'windows executable’ © | filetype = ‘javascript'

(feype = windows executaie) 8 fetype  Jvascrip) B time=-201506.29 201600201506 0 201555
2015 | % | 16:16:00 (04:00) Last 24 Hours 2015 | % | 16:15:59 (04:00)
conte - ostatonCuney e

20818813086, AM_68219_Boa 20,

20813318 izsienen,

% oonmark

w4 oamer e o b gt
A
Wndows N1 83, 0r08: s 4t
PRCSE] b,
Geckosmzr 2007039
Froonzr 2003 s,
o1 tsnzsa
Treeoupase / awnsze

!
Y
/- sz
veeiasnr s conosmo oo
i ter 223 00]

16125321 25-

ooyt ———
Meznasazr o4
Maziassizr:40 comparoie-
S 70 oo A1 817
a1 SN SONSN 1
VSavzeE: s
i
~ N
01ma3is1s
Mezsasnzris o
1201641865
aiarese
20869 40142 oecrcsnoepz s om0
Onlya subset of events is displayed @ 37 Events Found | 30 Unique Paths £ Options | A Hide
= Extension (20values) © 0

exe (184) - <none> (69) - gif (61) - php (53) - css (38) - htm (37) - s (31) - jpg (30) - Png (28) - aspx (21) - msp (20) - msi (18) -ico (17) - html (17) - cab (13) - asmx (13) - axd (8) - dI_(6) - i (4) -cer (4) ... show more
Loaded in 1,07 secs. Total running time 1.414 secs,

Forensic Fingerprint (13 values) ©

English (United States) | GMT-04:00 Send Us Feedback | 105.00.17626-1

If you want to highlight a small set of points to see the path of the line from right to left, click

on an axis. The cursor changes to cross hairs, which you can drag to select one or more
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values. When you let go of the mouse, the lines are highlighted. In the example below, the

SSL service type is highlighted by a gray box.

@ Investigation ® Navigate < Events # Malware Analysis O B @ RSAsecurity Analytics
S5 WAL s e - Concentrator  Last 24 Hours v P Query © BB Profile © EM File Analysis © | T2 Total © 42 Descending © Z= EventCount © | SaveEvents © 4 Actions © 2 Settings
O filetype = windows executable’ © | filetype = javascript' ©
(fletype = windows executable) 8 (fletype = Javascrpt) 88 tme="2015-06-29 20:16:00"12015-04:30 20:15:55"
2015 \ = ‘ 16:16:00 (-04:00) Last 24 Hours 2015 ‘ ] | 16:15:59 (-04:00)
Cllent Aplcation Destination P Address Source P Address TCP Destination Por Content Type Source Counry Destaton County Fierame
205.188.130.85- 2N AIM_6.82.19_Beta_2.exe-
rzmoarare]
emmas e o
112500 -
Metiaocz:5.0 indons: - "“"‘/“‘é 1o12s020214 8 "
TS pyimp 101252212
Goctosnar 30676308 Untoa Kngaon: Parypocesoup o
o s 10125038208
R XPantivrus2008_vEBD181.exe-
AN/ torzsarian
. A 10125025 128 . dopspon
161, zs:\ssm - progress.gt-
7225381.106- 1612531125 buton_coso gt
7848175 128.184.213 2 1. closo_ovorgt-
161.253.35.75- Canoce T v
"Mozilad#x2 5.0 (compative: To5204%0- 1o mp3adain.exe-
Googo Deskon) srezmsazz) 1o12s022100 ]
16125921250 — Sconecasr nstal 31115610
zioszmz iz TE ko S o
1z oh1z8r
rsrzzm0n pesiaiisnl g
MorlahaFisot-. 2787817 101253 18252 Aaste
\ s = —— NF_Movie Player 211.mst
[ 128 1es2140r
e To125254100-
Waziasariao conpatte; —
i ]
ez Shmenss: ~ “ior2sa 1046
NI S wmmee— 12816412073
e _—
——— “womass 612532340
L el sz
— Y
i 120104130 1
wewiE— swseses
Onlya subset of events is displayed @ 37 Events Found | 30 Unique Paths £ Options | A Hide
= Extension (20values) © 0|
exe (184) - <none> (69) - gif (61) - php (53) - css (38) - htm (37) - s (31) - jpg (30) - png (28) - aspx (21) - msp (20) - msi (18) - ico (17) - html (17) - cab (13) -asmx (13) - axd (8) - dI_(6) - cgi (4) -cer (4) ... show more
Loaded in 1,407 secs. Total running time 1.414 secs.
Forensic Fingerprint (13 values) ©

2 admin | @ English (United states) | GMT-04:00 Send Us Feedback | 10.5.0.0.17626-1

If you want to enlarge the visualization, drag the bottom edge of the panel down and drag the

right edge of the browser window wider.

Sample Use Case

Below is an example of a parallel coordinates visualization of meta keys representing file
metadata in a session. There are three meta keys or axes from left to right: Extensions, Forensic
Fingerprint, and Filename with values listed along each axis. Values on the Extension axis show
the file extension, and values on the Forensic fingerprint axis are windows executables.
Normally the file type matches the expected forensics fingerprint; however, it is abnormal for a
gif file type to be combined with the Windows executable fingerprint. The gi f file type is
selected to highlight the correlations of that file type, x86pe , and two filenames in the third axis
so that an analyst can quickly identify the files that merit investigation.

To reach this view:

1.
2.

Order by Value and Sort in Ascending order.

Apply two filters (file type = 'windows executable' and extension = 'gif') in the Navigate

view to limit the amount of data.

Configure a parallel coordinates chart by choosing three axes: file extension,

forensic fingerprint, and filename.
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@ Investigation ©Navigate ~ SEvents A Malware Anal G A @ RSAsecurity Analytics
El WS e - Concentrator  All Data ~ ¥ Query H Profile ~ M File Analysis ~ | T Total © 4= Descending © = Event Count © | SaveEvents ~ 4 Actions £ Settings
C  filetype = 'windows executable' © |  extension ='png'
(fletype = ‘windows executable) && (extension = png) && time="2015-04-29 20:25:00°"2015-05-04 20:13:59"
[ o5
2015 ‘ 29 15:25:00 (-05:00) All Data 2015 ‘ 04 ‘ 15:13:59 (-05:00)

Extension Forensic Fingerprint Filename

i windows msi instater-{

i 2%

< .
asm s
oo Faspe
]
Wins20penssLa_9 g exo
Only a subset of events is displayed @ 71 Events Found | 32 Unique Paths £ Options | A Hide
= . Extension (20 values) £
=

png(71) -exe (61) -gif (31) - css (27) - <none> (22) -jpg (16) - htm (12) -js (11) - php (10) -ico (5) - html () -zip (2) - SWf (2) - axd (2) - aspx (2) -asp (2) - ashx (2) - xml (1) -gmanifest (1) -gg (1) ...show more
Loaded in 0.731 secs. Total running time 0.738 secs.

_ Forensic Fingerprint (17 values) £

@
= X86 pe (71) - windows_executable (71) - windows executable (71) - png (52) - xml (39) - javascript (28) - gif (22) - html (20) - ¢ss (10) - jpg (7) -Zip (2) - cab (2) - windows_dlI (1) - windows msi installer (1) - windows dll (1) - swf (1) - apple iwork file (1)
Loaded in 0.638 secs. Total running time 0.643 secs.
. Filename (20 values) ©
w

<none> (17) - nwinvestigatorsetup.exe (16) - style.css (10) - 10g0.png (10) - youtube.jpg (8) - grad-right.png (&) - grad-left.png (8) - download.png (8) - download.php () - banner_night investigator.jpg (8) - turbocap_banner.png (6)

2 admin | @ eng

Sample Visualization of a Large Data Set

This example of a parallel coordinates visualization applied to a larger set of data illustrates

several messages that help analysts to understand what has been charted.

o To create a chart, NetWitness Suite begins scanning meta values and returning results. A
typical time range could have up to 10,000,000 meta values. When the number of meta values
returned reaches the Meta Values Result Limit, the chart is rendered even if NetWitness

Suite has not scanned a number of meta values equal to the Meta Values Scan Limit.

o There is a fixed limit on the amount of data that can be rendered as a parallel coordinates
chart. In NetWitness Suite 10.4 and prior, the limit is based on the number of axes times data
values: 1000 x the number of axes to protect performance, but in NetWitness Suite 10.5 and
above the administrator configures parallel coordinates limits as part of the Investigation

settings In the Administration System view.
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@ Investigation ® Navigate < Events # Malware Analysis H B @ RSAsecurity Analytics
S ML s e - Concentrator  Last24 Hours v P Query © I Profile ~ EH File Analysis ~ | TS Total © ¥= Descending ~ 2= EventCount © | SaveEvents © 4 Actions ~ £¥ Settings
| filetype = ‘windows executable' © | filetype = javascript'

(fletype = -
2015 % | 16:16:00 (04:00) Last 24 Hours 2015 | % 16:15:59 (04:00)
Content Type

2015-04-29 20:16:00°-"2015-04-30 20:15:59"

Destiation Country Flename

Source Country

13822F 5.0 (Windows: U-
Windows NT 5.1

e

"\ ussian Fogeration]
N\

losorzrtnE ReLh:
INET GLR 3.0.4806 2152;
MicosofiCLA35:30729)

Only a subset of events is displayed @ 249 Events Found | 199 Unique Paths *DNE @ |8 Options | 2 Hide

= . Extension (20 values) £ 0

exe (184) - <none> (69) - g (61) - php (53) - css (38) - htm (37) -js (31) - jpg (30) - png (28) - aspx (21) - msp (20) - msi (18) - ico (17) - htmI (17) - cab (13) - asmx (13) - axd (8) -dI_ () - cgi (4) - cer (4) ... show more
Loaded in 1.407 secs, Total running ime 1.414 secs.

Forensic Fingerprint (18 values) ©

2 admin | @ english (United States) | GMT-04:00 Send Us Feedback | 105.0.0.17626-1

With a larger set of data, the parallel coordinates chart takes longer to process than the smaller
set of data and meta keys. To preserve performance, NetWitness Suite renders the meta values
from the Values panel below until the limits set by the Administrator are reached. An
informational message tells you: Only a subset of events is displayed.

Of all the data visualized for 249 events, there were only 199 unique parallel coordinates paths.
Some events are included though they do not include some of the meta keys; these are labeled
DNE because the meta does not exist in the event.

Open an Event in the Events List

Analysts can view a list of events associated with a session in the Investigate > Events view or
in the Event Analysis view.

To display events in the Events view do one of the following:

1. To use the default query for the default service, go to INVESTIGATE > Events.
NetWitness Suite runs a default query on the last three hours for the default service (if one is
set) or displays a dialog in which you can select a service and then runs the default query.
The default query selects all events and the Events view displays events on the selected

service, with the oldest events first.

2. To view events for a specific meta value, go to INVESTIGATE > Navigate and when
events are loaded in the Values panel, click a meta count (the meta count is in green text).
You can also right-click the meta count for a meta value . When the context menu is

displayed, click Open Events in new tab. (The Open Event Analysis in new tab option is
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available in Verison 11.1 and later.)

Decoder Source (1 value) L

pacdec (238,977
Open Event Analysis in new tab

Network Na Open Events in new tab

private src (>100,000- 28%) - private dst (1/4,155) - other misc (74,541) - other «
dst (244) - broadcast dst (228) - broadcast src (29) - loopback misc (20) - loopba:

~ Traffic Flow Direction (3 values) L
lateral (168,127) - outbound (29,964) - inbound (6,502)

The Events view displays the events for the selected meta value.

The Events view provides three built-in presentations of event data: the Detail view, the List
view, and the Log view.

This figure is an example of the Detail view.

INVESTIGATE @ admin© (@)

EVENTS

E= Broker63 ¥ Query @ [EJProfile ©® HEJ Detail View ® < Actions + Incidents

“: Settings

[0 Event Time EventType = Event Theme Size Details

> 5

€ sessionid : 8012812
# device.ip:

B medium: 32

& device.type : ciscoasa

O 20170614T16:57:32  Log Do IV 136byes @ device.class ¢ Frewall

header.id : 0001

# level: 6

# netname : private src

i# direction : outbound

+ Show Additionsl Mets B View Details B Event Analysis
> ipsre

€ sessionid : 8012813

i device.p:

B medium: 32

& device.type : msdhep

O aonrosranesiaz g YRENO™Sl i ececines: Appication Servers
header.id: 0001
eventdesc: Renew
8 netname : other src
{# direction : outbound
+ show Additional Meta B View Details B Event Analysis -
| pPage1 | } | C | 25 ~ eventsperpage

Displaying 1 - 25 of 100,000 events

| NETWITNESS SUITE

11.0.0.0-170612140943.1 be1dd3

You can use queries, the time range setting, and profiles to filter the events listed in the Events
view. From any view type in Events view, you can extract files, export events, export logs, and
open the Event Reconstruction panel by double-clicking an event. See Analyzing Raw Events and
Metadata in the Event Analysis View for detailed information about these capabilities.
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To display events in the Event Analysis view, do one of the following:

1. In Version 11.0.0.x , go to INVESTIGATE > Navigate, right-click the meta count for a
meta value (the meta count is in green text). When the context menu is displayed, select

Open Event Analysis in new tab.

Decoder Source (1 value) L

pacdec (238,977
Open Event Analysis in new tab

Network Na Open Events in new tab

private src (>1 00,000 - 28%) - private dst (174,155) - other misc (74,541) - other ¢
dst (244) - broadcast dst (228) - broadcast src (29) - loopback misc (20) - loopba:

Traffic Flow Direction (3 values) L

lateral (168,127) - outbound (29,964) - inbound (6,502)

r

The Event Analysis view displays the events for the selected meta value.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events EventAnalysis Hosts Files Malware Analysis

Events (100000+) X Network Event Details | Text Analysis Packet Analysis File Analysis  Email 7 Web 4 EOOCM|~ X

Eeerriing - Download PCAP - @ common riLe paTTERNS (U@ sHADEBYTES @ ) DISPLAY PAYLOADS ONLY

EVENT TIME EVENT TYPE DECODER SOUR. ﬂ
Nw seRvicE session 1D SOURCE IP:PORT DESTINATION 1p:PORT service FIRST PACKET TIME
0212612018 Log L A 727530 S 49204 W80 20 02/26/2018 09:40:46.107
Broker am
09:40:41 am
LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOAD SIZE CALCULATED PACKET COUNT
G - L Q2672018 034046119 2277783 bytes 2098053 bytes 3151

09:40:41 am

02/26/2018 Log L REQUEST HEADER META
240 h src = 00:00:00:00:00:

Lesien v Packet 1 Gl L ) ID 1018773  SEQ 3311600515  PAYLOAL sessionin 727539
0212672018 e 000000 . TiMe 02/26/2018 09:40:46 am
09:40:41 am 000016 4. @ L YATE size 33555892

000032 .
02/26/2018 Log 000048 Rl N — A
09:40:41 am o e

ETH.SRC 00:00:00:00:00:00
v Packet2 PAYLOAL

02/26/2018 Network .- ETH.SRC.VENDOR  XEROX CORPORATION
09:40:46 am 000000 ETH.DST 00:00:00:00-00:00

000016
02/2672018 Log 000032 . il ermres 2008
08:40:42 am G20 : = .

000064 . IP.SRC

02/26/2018 Log 1P.DST
09:40:42 am 1p.PROTO

' PAYLOAD 31549606

ETH.DST.VENDOR  XEROX CORPORATION

v Packet 3 02/26/2018 09:40:46.107 am 1D 1018787 SEQ 3059262882 PAYLOAL TCP.FLAGS
0272672018 Log

nnann TCP.FLAGS.SEEN
09:40:42 am

11 of 100000 events > » 100 v PACKETS PER PAGE  TCP.SRCPORT

For detailed information about the types of analysis that you can use in this view, see Analyzing
Raw Events and Metadata in the Event Analysis View .

Export or Print a Drill Point

In NetWitness Investigate, when you have the data for a drill point displayed in the Navigate
view, you can:
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o Extract files from a session and choose the type of files to extract: archives, audio BitTorrent,

documents, executable, images, other, video, and web.
o Export the drillpoint as a packet capture (PCAP) file, a log file or a meta data file.

o Print the drillpoint.

The details being exported are affected by both the time range and drill point at the time of
exporting.

Note: When you export the drill point as a log file, only the log sessions are exported. The job
queue message refers to the total number of sessions in the drill point rather than the number
of logs. For example, if the drill point has 505 sessions and only five log sessions, the job
queue message states that NetWitness Suite is extracting logs for 505 sessions.

To export a drill point from the Navigate view:
1. Conduct an investigation until you reach the desired drillpoint.

2. For Version 11.0, In the toolbar, select Actions > Export and select one of the export
options: PCAP, Logs, or Meta.
The drill point is extracted, and a message advises that the job is scheduled. You can check

the jobs page for the status.

3. For Version 11.1, in the toolbar, select Save Events and select one of the export options:
PCAP, Logs, Files, Meta.
A dialog gives you an opportunity to edit the default filename for the file. The default is in

the form investigation-Feb-21-15-44-33

4. A dialog allows you to select the export log format: Text, XML, CSV, JSON. A dialog
selects file types. A dilaog selecte Meta format: Text, CSV, TSV, JSON.

5. When the scheduled file extraction is complete, it is displayed in the Job Notifications tray.

Notifications

PCAP Extraction Complete X

The PCAP extraction is complete and ready for 28 seconds
download. View =

Logs Extraction Complete X

The log extraction is complete and ready for 1 minute
download. View =

Meta Extraction Complete X

The meta extraction is complete and ready for ‘9 minutes
download. View »

Wiew All

6. Click the View link in the Jobs tray sand download the specific extraction file requested.
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To print the current drill point:

In the Navigate view, you can display the contents of the current drill point in printer friendly
format in the browser window.

To display the current drill point in a print view:

1. With a drill point open in the Navigate view, select Actions > Print in the toolbar.

A new tab is created with the print view of the current drill point.

Investigation : Broker63 | NETWITNESS SUITE

ip.proto =6 > extension = "jpg

2007

0z
09

09:17:00 (+00:00) 2017 | o | 19:48:59 (+00:00)

‘
3 Ethernet Source Address(20 values)

00:17:DF:6B:C8:00(20,828) - 00:13:C3:3B:BE:00 (5,518) - 00:13:C3:3B:C7:00(3,321) - 00:90:69:FF:04:7F (2,481) -
02:D0:68:18:6E:B9 (1,819) - 00:19:D2:06:D2:00(1,700) - 00:0C:29:C3:74:F4 (854) - 00:0C:29:67:F7:BF (493) -
00:16:D3:3B:41:EC (277) - D0:0AADOD:41:11 (214) - A4BADBI02:E3:72(179) - 00:1A70:8E:69:0D (149) -
00:0D:56:DF:57:3C(95) - 0O:1F90:81:F1:62 (91) - 00:50:56:A4:1D:7D (84) - 00:0D:56:DE:AB:69 (80) - 00:50:56:80:24:03 (80)
- 00:11:0A99:60:98 (55) - 14:10:9FET:D2:ED (30) - 00:11:0A:A4:3C:98 (28) ... show more

5 Ethernet Destination Address(20 values)

00:13:C3:3B:C7:00 (26,337) - 00:09:FE:00:00:00 (2,481) - 00:03:A0:8A:F2:31 (2,457) - 00:13:C3:3B:BE:00 (2,405) -
00:21:55:98:2C:00 (1,832) - 00:1D:60:DE:BE:CC (1.438) - 00:17:DF:6B:C8:00 (916) - 00:22:6B:1A4CFF (179) -
00:AQBE:V9ITE:27 (149) - 00:00:0C:07:AC:E3 (82) - 00:26:CB:27:6C:ES (80) - FE8:E4:FB:0D:0FES (30) - 0011 A7O:BEES:0D (28)
- 00:22:56:90:54:00 (22) - 00:0F:1F68:A3:F0(20) - 00:0C:29:67:F7:BF (18) - 00:90:69:FF.04:7F (18) - 00:22:56:91:38:00(16)
- 00:24:C4:.CCCZ:0E(12) - 02:D0:68:18:6E:BS (11) ... show more

<% Ethernet Protocol(1 value)
IP (38,570)

&+ 1D Dratarali1 walias)

2. Use the print option in your browser to send the printable view to the printer.

Launch an External Lookup of a Meta Key

This topic provides instructions for using out-of-the-box Investigate plugins to launch an external
lookup of specific meta keys using tools external to NetWitness Suite while investigating data in
the Navigate view or Events view.

Analysts can use out-of-the-box NetWitness Suite Investigation external lookups to save time
during investigations. The out-of-the-box lookups are available by right-clicking one of the these
meta keys: [P address (ip-src, ip-dst, ipvé-src, ipvé-dst, orig ip), host
(alias-host, domain.dst), client, and file-hash.

For all 1P and host meta keys, the following lookups are built in to NetWitness Suite:

o Google Malware: Opens a Google Malware search in a new tab.

o McAfee SiteAdvisor: Opens a McAfee Site Advisor search in a new tab.
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o BFK Passive DNS Collection: Opens a BFK Passive DNS collection search in a new tab

o CentralOps Whois for IPs and Hostnames: Opens a CentralOps Whois search

for IPs and hostnames
o Malwaredomainlist.com Search: Opens a Malwaredomainlist.com search in a new tab
o Malwaredomains.com Search: Opens a Malwaredomains.com search for in a new tab
o Robtex [P Search: Opens a RobtexIP search in a new tab
o SamSpade Search: Opens a SamSpade search in a new tab
o ThreatExpert Search: Opens a ThreatExpert search in a new tab

o UrlVoid Search: Opens a UrlVoid Search in a new tab n a new tab

For the file-hash and alias-host meta keys, the Google lookup opens a Google search in a
new tab.

For the client meta key, the ECAT Lookup option opens an ECAT client in a new tab if the
ECAT client is installed on the same system on which the browser is being used.

Administrators can add additional external lookups and other custom actions as described in
"Add Custom Context Menu Actions" in the System Configuration Guide.

Launch an ECAT IOC Lookup

To launch an ECAT lookup of data from the Navigate view:

1. Right-click a meta value for one of the following meta keys: ip-src, ip-dst, ipvé6-

src, ipvé-dst, orig ip, alias-host, domain.dst, client.

2. Select External Lookup in the context menu.

A submenu of external lookup options is displayed.

Investigating Metadata in the Navigate View 104



NetWitness Investigate User Guide

Google Malware Diagnostic for IPs and Hostnames

SANS IP History
256) -SCPS(196) - GRE(119)
McAfee SiteAdvisor for Hostnames

Copy ECAT I0C Lookup

Live Lookup BFK Passive DNS Collection

Scan for Malware CentralOps Whois for IPs and Hostnames

Context Lookup Malwaredomainlist.com Search

Add/Remove from List Malwaredomains.com Search

Data Science ? Raobtex IP Search
Investigation > SamSpade Search
External Lookup a3 ThreatExpert Search

3. Select ECAT I0C Lookup.

A dialog asks you to choose an application.

4. Select ECAT and click OK.
The RSA ECAT Configuration dialog is displayed.

B Configuration X

Dratabase Server Mame: 1a,
Database Instance Mame:
Database Mame: ECATS
| se 5l Security

User Mame: B3t

Passwrord: tiiiiiiitil

Test Cannect Lawe Cancel

5. Enter the user name and password required to log on to the ECAT client, and click Connect.
The drill point opens in RSA ECAT.

105 Investigating Metadata in the Navigate View



NetWitness Investigate User Guide

@ RSA ECAT S

i Database Tools Tabs

Configure About -

Admin Status: Show Winitelisted

Seore: s7

Hide Good Files Summany All
= WIN Last Seen: 242014 5:40:13 AM e o
b ' . Hide Signed Files =
" comment: 10C saore.5core ST
summary | IOCHistory | Downioaded | ECATEvents | ScanData Machine ECAT :
Dashboard T Agent ID 54432834-52£3- 4201316033,
(i Driver Error Code 0x00000231
d: Filename Threat Level | Score = Module Count | Signature Hash Laokup con ECAT Driver Compile Timi 6/19/2014 11:53:35 PM
wsocklin.dll [ 43 2 Not Signed: Whiware, Inc, Unknown 4421 GG O i BF23/2014 247120 PM
e wsaeklib.dl =) 2 Not Signed: Yiware, Inc. Unknown Wi e WWINZKE-E0
ECAT Service Compile Tin| 6/20/2014 12:02:35 &AM
=] F53_connector wrapper.exe 5 2 Nat Signed Unknawn 104
=y ECAT version 4015
(] EcatSeniceDriver32 242,55 4 2 Roat Wot trusted, Signature Expired: Ru. Unknainn 61
1 Group Default
R ACPLsys 3 2 Valid: Microsoft Corperation Unknawn 1 sl Trne 3T 55 P
e s e Last Connection Time | 6/24/2014 11,10:13 AM
[ <] % [] [status] <> "Whitelisted" EditFilter Last Scan 6/23/20114 3:27:17 PM
298 tems tota! i ‘ Last Update Time §/23/2014 2:52:40 PM
PList Scan Start Time £/23/2014 3:25:56 PM

Start Time 6/23/20114 2:52:42 Ph

@ Description 1= Event Time Source Madule Filen... Threatlevel Score Event bbb Y s
DNS 10
an Autorun unsigned winsack L5P
: Gatewny 10
Certificates Autorun only file in directory Local IF b
Autarun anly executable in directory MaC o
Whitable code section Nebort seame it 10
Duplicate section name Remate IP 10
InETilIes Campiled in last manth Machine.OperatingSystem
m Created in last month Country Usa
Y N version info Domain SYSTEMTEST
No company name Damain Rale 2
Dowsilloas o ariginal filename Languzge 033
& e s ot ‘ 5 Machine Name WIN2KE--200
1 P T 05 Build Number 7601
(RET] 12 items total 4 » ] 5 Seniice Park o6 =
Events

ECA 1
o] 8]0 2| @I rarn mEn

Lauch Other External Lookups

To launch an external lookup (other than ECAT IOC) of data from the Navigate view:

1.

Right-click a meta value for one of the following meta keys: ip-src, ip-dst, ipvé-

src, ipvé6-dst, orig ip, alias-host, domain.dst, client.

Select External Lookup in the context menu.

A submenu of external lookup options is displayed.

Google Malware Diagnostic for IPs and Hostnames

_ SANS IP History
256) -SCPS(196) - GRE(119)
McAfee SiteAdvisor for Hostnames

Copy ECAT 10C Lookup

Live Lookup

Scan for Malware
Context Lookup
Add/Remove from
Data Science
Investigation

External Lookup

List

BFK Passive DNS Collection

CentralOps Whaois for IPs and Hostnames
Malwaredomainlist.com Search
Malwaredomains.com Search

Robtex IP Search

SamSpade Search

ThreatExpert Search
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3. Select one of the lookup options.

The selected meta value opens in the selected lookup, for example, if you selected SANS IP
History, the drill point information is displayed in SANS Internet Storm Center.

Threat Level EEE]

r&mmery, @ IP Info:
\
5:_:‘_._,4 - Keyword, Domain, Port, IP or Heat m

Handler on Duty- Bojan Zdrnja

Email Password
Sign Up for Free! Forgot Password?
Contact Us NOTE: Due to excessive queries, page processing has been limited to 10 per minute. Please contact us for bulk data
access or try out our API. Do not use this data as a blocklist.
Diary
To lookup several IP addresses at the same time, or 1o just copy/paste a section of a log, use our "Color My Logs™ feature.
Podcasts
Jobs General Information
News Submitter Diversity. Low
Risk (0-10)details: 0
Tools
IP Address (click for more detail)
DATA
Hostname:
404 Project C
HTTP Header Activity ey
TCP/UDP Port Activity AS: 4565
Eorl Trends AS Name: MEGAPATH2-US - MegaPath Networks Inc., US
Presentations & Papers )
SSH Scanning Activit Network: 10.0.0.0/8 (10.0.0.0-10.255.255.255) 11.0.0.0
SSL CRL Activit Reports: - none -

Suspicious Domains

Targets: - none
Threat Feeds Activity

. SAVE $350 or get
Threat Feeds Map First Reported. N/A a new iPad or HP

Useful InfoSec Links Most Recent Report: N/A Chromebook 13 G1

InfoSec Poll Reslts Comment: - nons -

Launch a Malware Analysis Scan from the Navigate View

From within Investigate, analysts can launch an on-demand Malware Analysis scan by selecting
a service and meta value, and choosing an option from the context menu. When polling is
complete, the scanned data is available for malware analysis.

To launch a Malware Analysis scan of data from the Investigate > Navigate view:
1. Right-click a meta value (for example, OTHER, DNS, or FTP) and select Scan for
Malware in the context menu.

The Scan for Malware dialog is displayed with a suggested name for the on-demand scan
and no service selected.

2. In the Scan for Malware dialog, select a service to perform the scan, edit the name, and

select the types of files to bypass under community and sandbox.
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Scan for Malware

Malware Analysis
Service *

Mame *

Community
Bypass Executable
Bypass Office
Bypass PDF

Adhoc Scan HTTP

L]
L]
(|

Sandbox

Bypass Executable L]
Bypass Office L]
Bypass PDF ]

Cancel Scan

3. Click Scan.

The scan request is added to the Scan Jobs List dashlet and the Jobs Tray. The bypass

settings in this dialog override the default settings in the basic Malware Analysis

configuration settings.

a. Go to the Scan Jobs List in the Malware Analysis view or in the Unified dashboard.

To view the jobs, do one of the following:

Double-click a scan to view the scan.

Select a Malware Analysis Service

Malware Services
™ Default Service

Name ~

Malware - Malware Analytics

Cancel View Continuous Mode

B Scan Files

Name

Page

Malware - Malware Analytics Scan Jobs List

Static Metwork Community Sandbox

No scan jobs found

of 0 | Cho v

Progress

«

Info  User

No data to display
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b. To view the job in the Jobs tray, click E in the NetWitness Suite toolbar. When the job

is complete, scroll to the left and click View.

Jobs
|

L] Job Mame Recurring = Scheduled Component Acti
[ Extract PCAP to investi... No 2017-06-15 7:22pm Imvestigati...

[l Upload File Mo 2017-06-157:13pm  Upload

[l Extract PCAP to investi.. No 2017-06-15 1:41pm  Investigati...

[l Extract PCAP to investi... No 2017-06-15 1:40pm Investigati...

(] Extract PCAP to bigeve... No 2017-06-14 2:31pm Imvestigati... [T

View Your Jobs

|

The Malware Summary of Events for the selected scan is displayed. The scan is also
added to the list of available scans in the dialog for selecting scans in the Investigation >

Malware tab.

Visualize the Current Drill Point in Informer
This topic provides instructions for sending a drill point in the Navigate view to an Informer
visualization.

Informer must be installed in your network and accessible by the service being investigated. You
need to supply the host name and the port used on the Informer host to communicate with
NetWitness Suite.

To display a visualization in Informer of the current drill point:

1. With a drill point open in the Navigate view, click Actions > Visualize.

The Send to Visualize dialog is displayed.
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Send to Visualize
Send a Visualize request to the following
Informer service:
Informer Host

Informer Port g0

HTTPS [l

Cancel Visualize

2. Type the Informer hostname or IP address, and verify the NetWitness Suite server port used

to communicate with the Informer host.
3. (Optional) Select the HTTPS option if the Informer host uses secured communications.

4. Click Visualize.

The visualization is displayed in a new tab.
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Examining Raw Events in the Events View

Analysts who are investigating data in Investigate can view and reconstruct events associated
with a session.

o Analysts who conduct analysis using NetWitness Suite Investigate, and have the appropriate
system roles and permissions set up for their user accounts, can go from a Navigate view drill

point to the Events view.

o Analysts who do not have access to the Navigate view or want to go directly to the Events

view, can open sessions and examine the events that make up the session in the Events view.

o Analysts can select queries from their "query history" window.

Separate topics describe methods of working in the Events view:

o Add Events to an Incident for Response

o Manage Column Groups in the Events View

o Export Events in the Events View

o Add Events to an Incident for Response

o Combine Events from Split Sessions

In addition, you can use these methods of querying data and acting on results that are common to
the Navigate view and the Events view.

o Search for Text Patterns

o Create a Custom Query

o View and Modify Queries Using URL Integration

o Use Profiles to Encapsulate Custom Views

e Manage Context Hub Lists and List Values in Investigate

o View Additional Context for a Data Point

o Reconstruct an Event
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Filter and Search Results in the Events View

Analysts can filter the results in the Events view and, by searching for events or selecting the
service on which to view events, set the time range, and query meta data.

If you opened the Events view from a Navigate view drill point, the view opens to the Detail
view of events by default. Analysts who do not have permissions to use the Navigate view can
query services directly from the Events view. There are several configuration options to filter
the information displayed in the Events view.

Note: When an Archiver is the currently selected service in the Events view and you are
searching against a Broker or Concentrator, the search is slower than if searching against a
Broker or Concentrator because the data on the Archiver is compressed and there is typically
more data.

Filter Events Displayed in the Events View
To filter the data displayed in the Events view:

1. In the Investigate view, select the Events view.

The Events view is displayed.

INVESTIGATE @admin® ()
EVENTS

&= Broker63 ¥ Query @ [ Profile @ [ Detail View @ - Actions ® - Incidents Sea s = Settings
[ Event Time EventType | Event Theme Size Details

P o

€3 sessionid : 8012812

8 deviceip:

B medium: 32

& device.type : ciscoasa

[0 2017-06-14T16:57:32 Log

B 136 bytes : Firewall

etname : private src

o rection : outbound
+ showAdditional Meta B View Details B Eventt Analysis

€ ipsrc:

€3 sessionid : 8012813
B device.ip:
B medium: 32

# device.ty sdhep

[0 2017-06-14T16:57:32 Log System.Normal 322 bytes

5 Servers
Conditions pplication Servers

0001
vent.desc: Renew
ame : other src
i direction: outbound
+ showAdditional Meta B View Details B Eventt Analysis -

| page1 | ) | C | 25 ~ eventsperpage Displaying 1 - 25 of 100,000 events

‘ NETWITNESS SUITE 11.0.0.0-170612140943.1.be1dcf3

2. To select a time range other than the default (Last 3 Hours), in the toolbar, click the time
range field and select a value. For example, Last Hour.

The Events view is refreshed with the selected time range.
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3. To enter a query for the selected service and time range, in the toolbar, click Query.

The Simple Query dialog is displayed.

RN [T Profile © [ Meta | "8 Total = Descending @ B Event Count S
1
@® simple (O Advanced (O Recent

Select Meta v | |Operator v| |Value

[¥ Network [ Log [ Endpoint l
Apply Cancel Reset [ 5] ‘

4. If you want to enter a simple query using the auto-complete feature to select meta and

operators, do one of the following:

a. Click in the Select Meta field and select a meta key from the drop-down list.
b. Select an operator from the drop-down list in the Operator field.

c. Type a value to match in the Value field.

d. Select Network, Log, or Endpoint data, and click Apply.

The matching data is displayed in the Events view.

5. If you want to enter a more complex query based on your knowledge of the meta and

operators:

a. Click Advanced.
The Advanced Query dialog is displayed.

0 Simple ® Advanced (O Recent

Cancel Reset &

b. Type a query. As you type the query, beginning with the meta key, drop-down lists of
available meta keys and operators are displayed. When finished, click Apply.

6. If you want to select a query from a list of recent queries:

a. Select Recent.

The Recent Query dialog is displayed.
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O Simple O Advanced ® Recent
did = 'nwappliance2067
sessionid=13
sessionid>52
sessionid>44
sessionid>20
sessionid=>202
sessionid=200

ip.src="

ip.src =

ip.src=

ip.dst=

Apply Cancel Reset [ 5|

b. Select a query and click Apply.
The matching results for the query are displayed in the Detail View in the Events view.

The breadcrumb reflects the query.

c. In the breadcrumb, you can click any of the crumbs to display the Query menu. You can
insert a new query before a crumb, and append a new query to the end of breadcrumb.

After each edit in the breadcrumb, NetWitness Suite refreshes the results.

Search for Events in the Events View

You can search the currently displayed data in the Events view by entering a search string in the
Search field. The search string can be a regex (Regular Expression) or it can be a simple text
search. provides detailed information on these search types.

To search within the currently displayed data in the Events view:

1. To execute the search, place the cursor in the Search box, type a search string, and press
Enter or click Search.

The search results are displayed in the Events view. Events that match the search criteria
are displayed in the Event view grid. In the Details view and List view, matches are
highlighted in the Details column. In addition, when searching RAW, matches are
highlighted in the Log view Logs column. Below is an example of the search results for the

search term India in the Events Detail view. Note that search matches are not highlighted in
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any Event Reconstruction.

INVESTIGATE

EVENTS

@j admin & @

= Brokers3 ¥ Query ® [HJ Profile ® [ Detail View &

< Actions & -~ Incidents Search

- Settings

| Event Time EventType  Event Theme Size Details
€2 sessionid : 8526933

8 medium: 32

jpe s unknown

[0 2017-06-14T18:46:00 Log

i : admin
+ show Additional Meta ,@ View Details ,@ Event Analysis
€ sessionid : 8247862

B medium: 32

pe: unknown

O 2017-06-14T18:42:16 Log 146 byte efile : LD-Logs/ciscarouter_verify.log
-06-14T18:42:16  Log 46 bytes .

-

| Page 1 of1 | | C | |25

v | events per page

| NETWITNE

Displaying 1 - 6 of 6 event matches

-

11.0.0.0-170612140943.1.be1d 3

If you want to narrow the search, change the query and time as described above in Filter
Events Displayed in the Events View.

If you want to stop the search and return to the Events view, click Cancel.
Any results that are displayed remain.

To clear the search box and return to the normal Events view, click X in the search box.
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Manage Column Groups in the Events View

When viewing a list of events in Events view, you can customize the way data is displayed by
defining the meta key to display in a column, the position of the column in the grid, and the
default width of the column.

Note: In Version 11.1 and later, wherever meta keys are used, you can also use configured
meta entities.

Investigate profiles can include custom column groups. If a custom column group is used in a
profile and you are viewing events in the Events view using a custom column group, you
cannot change the view type (Detail, List, or Log).

Create Custom Column Group
1. Goto NAVIGATE > Events.

2. Select Manage Column Groups in the View drop-down menu. The View option is named
for the current value, for example, Detail View, List View, Log View, or the currently
selected column group.

The Manage Column Groups dialog is displayed.
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Manage Column Groups
+ -8B &

Proxy Data

O

Proxy Meta Data

R5A Email Analysis
RSA Endpoint Analysis
RSA Malware Analysis
RSA Outbound HTTP
RSA Dutbound SSL/TLS

R5A Threat Analysis

O ooooogo

R5A Web Analysis

3. To add a new column group in the column group panel, click + and type the name of the
new group in the resulting field.
The column definition panel opens on the right with the group name filled in. You can edit
the group name.

4. To add a column to the group, click +, and click in the empty Meta Key field to display the
Meta Key drop-down list. Select a meta key field from the list, and repeat this step until the
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column set is complete.

Manage Column Groups

Mame new column group

+ - |
M Meta Key Display Name Width
™| | 100

Meta Summary (custom.metasummary)

Raw Log (custom.logdata)

Source Info (custom.source)

Destination Info (custom.destination)

Access Point (access.point)

Action Event (action)

Active Directory Domain Destination (ad.domain.dst)
Active Directory Domain Source (ad.domain.src)

Active Directory Username Destination (ad.username.dst)
Active Directory Username Source (ad.username.src)
Active Directory Workstation Destination (ad.computer.dst)

Active Directory Workstation Source (ad.computer.src)

N PR L IS S 1Y

Save and Apply

5. (Optional) To delete a meta key from the column group, click ~ .

6. (Optional) To rearrange the sequence in which the columns appear in the Events list, drag

meta keys to the desired position.
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7. (Optional) To set the default width for a column, click in the corresponding value in the

Width column, and type a new column width.

Manage Column Groups

Name new column group
+ = |
™ Meta Key Display Name Width
r r
™  custom.source Source Info 100

Cancel Save Save and Apply

8. (Optional) To revert to the previous settings for the column group, and undo all of your

changes, click Reset.
9. When ready to save, do one of the following:

a. To save the edited column group and refresh the Events view with the column group

settings, click Save and Apply.

b. To save the edited column group without refreshing the Events view, click Save.

Select a Column Group

To select a column group:

1. With the Events view open, select Custom Column Groups in the View drop-down menu.

The option name is the default value (Detail View or the current value).
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List View

Detail View

Log View

Custom Column Groups »

Manage Column Groups

Bl RSA Web Analysis ~ [REE-Yailsl e

-~ Incidents =

Destination IP Ad TCP Destination

test

RSA Email Analysis
RSA Malware Analysis
RSA Threat Analysis
RSA Web Analysis

2. Select one of the column groups from the submenu.

The Events view is refreshed to reflect the custom column group.
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Export Events in the Events View

In the Events view, the Actions menu has an option to export events from the event being viewed
to an archive.

Note: You can only export files that you have permission to view or access.

The export function queries the service for all sessions inside the selected time range and drill
point to extract the content of each session. The details being exported are affected by both the
time range and drill point at the time of exporting. In the File Extraction dialog, you can choose
to export:

e PCAPs
o Logs
o NetWitness Endpoint event

o Meta values
The format of the exported archive: ZIP or GZIP file. After you send the request, a job is

scheduled and you can track the job in in the Jobs tray. If there is an error retrieving the log or
PCAP from the service, NetWitness Suite displays an error notification.

To extract files from an event:
1. While in the Event view, click an event.

2. Click Actions > Export..

# Actions Incidents Sec
Export > Export PCAP
View Event > Export All PCAP
Reset Filters
0:00: Export Logs
839 Export All Logs

Export Endpoint Event
Export All Endpaoint Events
Export Meta

Export All Meta

3. Select the export option.
A message informs you that the PCAP is being downloaded.
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Add Events to an Incident for Response

When conducting an investigation in the Events view , you can select one or more events and
create an incident that is available for incident responders in Respond. You can also add events
to an existing incident in Respond to which you have access.

Note: An administrator must configure the required roles and permissions as described in
"Role Permissions" and "Manage Users with Roles and Permissions" in the System Security
and User Management Guide.

1. Goto INVESTIGATE > Events.

2. Inthe Events view, select one or more events, and then Incidents > Create New Incident.

[ Create New Incident
| Add to Existing Incident

3. Complete the information in the Create an Incident dialog.

Create An Alert From These 1 Events:

Alert Summary

Severity

MName

Summary

Assignee

Categories

Priority

Manual alert for Last 3 Hours

50 0

Test Event for Documentation

Creating an alert for this event.

Admin

Social Other @

High
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Select the severity, an integer between 1 and 100, with 100 being the most severe.
Type a name for the incident and describe the incident in the Summary field.

Select an assignee for the incident from the drop-down list. This list includes the built-in
roles that have access to Respond as well as any custom roles that have been added to
your system. For example, this list might include roles for admin, analyst, dpo, operator

and roles for incident responsers.

. From the Categories drop-down list, select one of more categories of alerts that apply to

this incident.

. From the Priorities drop-down list, select a category for the incident. For example, an

incident may be critical, high, medium, or low priority.

Click Save.
The new incident is created and is available immediately in the incident queues for the

selected role in Respond.

To add one or more events to an incident, select one or more events, and then Incidents >

Add to Existing Incident.

In the Add Events to an Incident dialog, select the severity, and select one or more incidents

to which the events will be added. You can Search for an existing incident by Incident-ID or
Incident Name. When ready, click Add to Incident.

The events are added to the selected incidents and updated in Respond.
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Combine Events from Split Sessions

Analysts can identify sessions that have been split due to session size in the Events view, and
combine the fragmented sessions so that the complete session is viewable as a single query
result in the Events view. When split sessions are recombined, a single packet export of the
session in the Events view includes all of the session fragments.

Version 10.4 and earlier Decoders are configured with a default session size of 32 MB. When a
session exceeds the 32 MB limit, the Decoder splits the session and all subsequent packets
become part of a new session, fragmenting the actual network session across multiple Decoder
sessions. Split sessions are parsed without the context that it is a fragment of the larger network
session, sometimes resulting in session fragments with source and destination addresses and
ports reversed and with unidentified application protocols. Another result of split sessions can be
difficulty viewing all of the session fragments as a single query result or creating a single packet
export of all the session fragments.

Decoder enhancements in NetWitness Suite 10.5 provide improved processing of fragmented
sessions:

o Contextual fragment parsing.
o Session fragments highlighting.
« Finding session fragments.

o Exporting all packets to a single PCAP.

Contextual Fragment Parsing

In NetWitness Suite 10.5 and later, the Decoder completes session parsing before splitting the
session based on the configured maximum session size (32 MB) or the configured timeout (60
seconds). When parsing is complete, the parsed results include the proper address directionality
and application protocol, which are propagated to each subsequent session fragment to ensure
consistency with the logical network session they represent.

Note: All of the necessary Decoder configuration changes are made when upgrading to

10.5. However, Find Session Fragments requires that the tcp and udp source port meta keys
(tcp.sreport and udp.srcport) be fully indexed, which was not the default configuration prior to
10.5. This functionally limits the ability to find session fragments to sessions captured after the
Decoder was upgraded to 10.5.
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Session Fragments Highlighting

Each session fragment has an additional meta, session.split. The value of the
session.split meta for a particular session fragment indicates how many fragments precede
that fragment. When viewing sessions in the Events view, the session.split meta clearly
identifies sessions that are fragments in the Events List view and the Events Detail view.

The session split happens when the configured Decoder assembler.size.max or
assembler.timeout.session (latency between sessions) is reached. The earliest fragment
is session 0 and sessions with a later time stamp are incrementally numbered 1, 2, 3, and so on.
The session.split meta indicates the number of preceding sessions fragments; however, it
does not always indicate that there are subsequent session fragments, even with a value of 0. It
is also possible for the first fragment of the session to not have session.split meta if the
session is parsed before exceeding the maximum session size.

Once you view the session fragments, you can determine the maximum session size or session
timeout necessary for parsing to combine the split sessions into one again. For example, if you
have four fragments at 32 MB, you need to configure your test Decoder (usually a virtual
machine set up separate from main production service) with a maximum session size greater
than 128 MB. The steps are the same to find all fragments based on a session timeout. The
figures below show the Events List view and the Events Detail view with fragmented session
information highlighted.

Note: A maximum session size of 12 MB was configured at the time the screen captures
below were created.

© Investigation © ® Navigate = Events A Malware Analysis © W @ RSAsecurity Analytics
E LocalC LUBEE] b 7 Query & [ Profile & [ List View & Actions s = Settings
[7] Event Time EventType  Size Details

[ 2008-05-30T17:54:20 Network 12 MB €»10.21.2.52 -> 204.9.165.82  ©® 4550 > 80 @[{/’I

[] 2008-05-30T17:54:09 Metwork 75 bytes €»10.21.2.56 -> 123.201.79.215 & 37082 -> 40835

[] 2008-05-30T17:54:09 Network 75 bytes €»10.21.2.56 -> 62.88.70.52 &% 37082 -> 53638

[ 2008-05-30T17:54:10 Netwerk 145 bytes €»10.21.2.56 -> 121.233.184.2 e® 37082 -> 22161

[] 2008-05-30T17:5410 Network 145bytes <> 10.21.2.56->89.133.41.168  ©® 37082 -> 64203

[] 2008-05-30T17:54:10 Network 145 bytes €»10.21.2.56 -» 85.226.79.3 &% 37082 -> 16608
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& Investigation © ®Navigate ~ = Events A Malware Analysis & B @ RSASecurity Analytics

E LocalC ¥ Query & [E] Profile © EI Detail View & Actions =

[7] Event Time EventType  Event Theme Size Details

€2 00:0B:DB:0F46:C1 -> 00:1AT70:8EI69:0D
> -
& 4550 -> 80
(:__E session.split :D
<> sessionid: 1
25 payload : 11902591
B medium: 1
e epflags: 26
5 streams: 2
% packets: 12619
@ lifetime: 16
# action: get
e directory : /
+ show Additional Meta B View Details

[] 2008-05-30T17:54:20 Network HTTP 12 MB

The session.split metadata is always displayed immediately following the address and port
metadata in the details view. It is never hidden as additional metadata. These enhancements
make it possible to quickly:

« Identify sessions that are fragments of a network sessions.
o View all of the session fragments of a network session given a single session fragment.

o Export the packets for the entire network session as a single PCAP file.

Find and Combine Fragments

From within the Events view, you can find fragments of a session using the Refocus > Find
Session Fragments context menu option. NetWitness Suite composes a query using the source
and destination addresses and ports of the selected session and displays all sessions that match
that query within the current time window.

To find session fragments:
1. Inthe Events view, right-click any of the source and destination address and port
values: ip.src, ip.dst, ipv6.src, ipv6.dst, tcp.srcport, tcp.dstport,

udp.srcport, and udp.dstport) as well as session.split values.

The context menu is displayed.
Copy
Apply 'EQUALS Drill

Add/Remove from List

Data Science >
Refocus b
Refocus Mew Tab >
External Lookup »
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2. Select Refocus > Find Session Fragments or Refocus New Tab > Find Session
Fragments.
NetWitness Suite repopulates the Events list with session fragments for a single session
within the current time range. Depending on the option you selected, the refocus replaces the
current view or opens in a new tab. (All data is used in these examples but is not

recommended on production systems).

INVESTIGATE D @admin® @

EVENTS

= Concentrator ¥ Query ® [ Profile ® [J Detail View & - Actions & < Incidents Search Events <= Settings

ip.src=127.0.0.1 && ip.dst=127.0.0.1 && ... =

| Event Time EventType | EventTheme Size Details 8
¥ 00:00:00:00:00:00 -> 00:00:00:00:00:00 2
€©»127.0.0.1 -> 127.0.0.1 ®
©® 58736 -> 161 -
¥ sessionid : 1507 g
% payload: 0 Q

S
B medium: 1 C
[J 2017-07-05T11:52:00 Network SMMP 256 bytes # netname loopback sre ©

s netname: loopback dst

i direction: lateral

©® cpflags: 22

01

18 streams: 2

01 .

10 packets: 4

F Show Additional Meta B Event Analysis

| Paget | | C | 25 ~ eventsperpage Displaying 1 -1 of 1 events

‘ NETWITNESS SUITE 11.0.0.0-170703173620.1.686607¢

3. If necessary, adjust the time range to include any session fragments that may precede or
follow the current time window. You can tell that the time range needs to be expanded if the
fragments occur near the time boundary, especially if the first visible fragment does not have
a split value of 0 (or none). Alternately, inspecting the packets of the last visible session may

lead you to believe that the session continues. Here is an example:

a. If you are looking at fragments that are obviously not the first fragment, for example, 1,
2, 3, and 4 in time range 10:30 to 10:35, there should be a fragment 0. You can increase

the time range to start earlier (for this example, 10:25) to find the additional fragment.

b. If the session size of last fragment is close to maximum session size (12 MB in this
example), look for additional fragments by increasing the time window to include a later
time (for this example, 10:40).

When all of the session fragments of a network session are included within a single

Events list, the list can span multiple pages.
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4. (Optional) To export the packets for every session fragment to a single PCAP file, select
Actions > Export All PCAP.
A message informs you that the PCAP is being downloaded. When download is complete,

PCAP file includes the entire network session that was fragmented.
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Querying and Acting on Data in the Navigate and

Events Views

This topic describes methods of querying data and acting on results that are common to the
Navigate view and the Events view. Analysts can:

Search for Text Patterns

Create a Custom Query

View and Modify Queries Using URL Integration

Use Profiles to Encapsulate Custom Views

Manage Context Hub Lists and List Values in Investigate

View Additional Context for a Data Point

Reconstruct an Event
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Create a Custom Query

In the Investigate > Navigate view or the Events view, you can create a query rather than
clicking through the meta keys and values to drill down into the meta data. The dialogs for
creating a query offer syntax help with drop-down lists of applicable meta keys and operators.
When viewing the drop-down list, you can expand and collapse each meta group to view or hide
the individual meta keys in that group.

Note: In Version 11.1 and later, you can query meta entities as well as meta keys.

When you select a meta group, NetWitness Suite generates the complex query equal to a query
with all of the meta keys in that group ORed together. So if a meta group contains ip.src and
ip.dst, the query generated is ip.src = <value> OR ip.dst = <value>. If the meta
group contains meta keys that have different meta value types, the value input is disabled and the
query uses exists statements. For example, a meta group that contains ip.src, ip.dst, and
alias.host includes meta keys that have different value types; ip.src and ip.dst are ip
addresses and alias.host is text. The generated query is ip.src exists OR ip.dst
exists OR alias.host exists.

A basic query is in the following form:
<metakey> <operator> [<metavalue>]

These are a few examples:
action exists

action = 'get'

alias.host = '10.25.55.115"

extension = 'exe'

orig ip != "10.0.0.0"™ - "10.255.255.255"

Create a Query Using the Basic Method

When you create a query using the basic method, NetWitness Suite provides drop-down lists of
meta and operators.

1. Inthe Navigate view or the Events view toolbar, select Query.

The Query dialog is displayed, with the Simple option selected.
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EZNOIVIa"8ll EL] Profile ©® EJ Meta @ | M@ Total ® .= Descending @ B& Event Count & S

® Simple () Advanced (_ Recent

Select Meta v | |Operator ¥ |Value

™ Network [ Log o4 Endpoint

Apply Cancel Reset €

2. Inthe Select Meta field, click to display the drop-down list. The drop-down list has two

sections: Meta Groups and All Meta.

3. Select a single meta key under All Meta or select a meta group under Meta Groups. You

can also type in a meta key or meta group in the field.

4. In the Operator field, type an operator or click on the drop-down list to select a valid

operator.

5. (Optional) If you selected an operator that requires a value, for example, begins, in the third

field type the value for the meta key.

6. Inthe Network, Log, and Endpoint checkboxes, choose the type of data to query. Do one of
the following:

a. To limit the query to packets select Network and de-select Log and Endpoint.

b. To limit the query to logs, select Log and de-select Network and Endpoint.

¢. To limit the query to endpoint events, select Endpoint and de-select Network and Log.

d. To apply the query to packets, logs, and endpoints, select Network, Log, and Endpoint.
7. Do one of the following:

a. Click Apply.
The window is closed and the view is updated with the results of the new query. The

query is displayed in the breadcrumb.
b. Click Cancel.

The window is closed and no changes are made to the view or current query.
Create a Query Using the Advanced Method

1. Inthe Navigate view or the Events view toolbar, select Query.

The Query dialog is displayed.
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Ed Profile ® EJMeta @ | g Total & Descending & B8 Event Count & S
1
® Simple () Advanced () Recent
Select Meta v | |Operator ¥ |Value

™ Network [ Log o4 Endpoint

Apply Cancel Reset €

2. Select Advanced.
The advanced query field is displayed.

O Simple @ Advanced O Recent

Apply Cancel Reset [ 2|

3. In the field, create a query, which can include the meta key, operator, and value. When you
begin typing a meta key in the field a drop-down list of available meta keys for the selected

service is displayed.

4. Select the meta key for your query.
The display is updated. If the expression is not yet complete, the status indicates that the

query is invalid.

5. Continue with an operator, from the drop-down list, then a value if necessary. The display is
updated as you continue to enter the query. If you enter an operator, such as exists or !exists,
which does not use the value field, the value field is disabled and the invalid status is
cleared. If you enter an operator, such as =, which requires the value field, the invalid status
remains until you enter a value. When the query is valid the invalid status is no longer

displayed.
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O Simple ® Advanced O Recent

This isn't right.

) Iwvalid Expression

Apply Cancel Reset

6. Do one of the following:

o Click Apply.
The window is closed and the view is updated with the results of the new query. The

query is displayed in the breadcrumb.

o Click Cancel.

The window is closed and no changes are made to the view or current query.

Apply a Recent Query

You can view recent queries and select one to apply to the current service being investigated. To
select a recent query:

1. In the Navigate view or the Events view toolbar, select Query.

The Query dialog is displayed, with the Simple option selected.

ROl ] Profile ©® EJ Meta @ | "B Total © Descending & B3 Event Count & S
1
® simple () Advanced () Recent
Select Meta v | |Operator ¥ |Value

™ Network [ Log [¥ Endpoint

Apply Cancel Reset [ |

2. Select the Recent option.

The list of recent queries is displayed in the bottom portion of the dialog.
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O Simple O Advanced @ Recent
did = 'nwappliance3067
sessionid=13
sessionid»>52
sessionid=44
sessionid=20
sessionid=202
sessionid=200
ip.src="
ip.src=

ip.src=

ip.dst=

Apphy Cancel Reset &

3. In the list of recent queries, click to select a query.
4. Do one of the following:
o Double-click a query.

o Select a query and click Apply.
The window is closed and the view is updated with the results of the new query. The

query is displayed in the breadcrumb.

o Click Cancel.

The window is closed and no changes are made to the view or current query.

Manage Context Hub Lists and List Values in Investigate

Analysts can add lists and list values for Context Hub enrichment in the Navigate view and the
Events view. When the Context Hub service is enabled and configured, NetWitness Suite
provides enrichment data from Incident Management, custom lists, and NetWitness Endpoint
directly in the Navigate view and Events view. A visual cue highlights meta values for which
enrichment data is available in the Investigate views, and you can click on the highlighted value
to look up the contextual information and intelligence.
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In addition, from the Values panel in the Navigate view and from the Events view, you can view
lists, edit meta values in an existing list, or create a new list. When you add meta values to a
list, you can investigate the meta values using the context lookup option.

For an analyst to manage lists in Investigate, the administrator must:

Enable the Context Hub service.

Assign an analyst role with permission Manage List from Investigation to the user

who will perform Context Lookup from Investigation views.

Configure appropriate roles and permissions as described in "Role Permissions" and "Manage

Users with Roles and Permissions" in the System Security and User Management Guide.

Add Meta Values to an Existing List

To add meta value to an existing list in Context Hub:

1.

While investigating a service in the Navigate view or the Events view, right-click a meta
value (for example, values under Source IP, Destination IP, or Username) and

select Add/Remove from List in the context menu.

The Add/Remove from List dialog is displayed.

Add/Remove from List

Add the meta value to one or more lists by selecting the available list from the drop-
down aption. To remowve a list from the meta value, click the delete icon for each lisw.

Meta Value 0

List choose ...

2. In the List field, select one or more lists from the drop-down option to which the meta value

must be added.

3. Click Save.

The meta value is added to the selected lists.
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Remove a Meta Value from a Context Hub List

To remove a meta value from list:

1. Inthe Add/Remove from List dialog, in the List field, view the lists which include the meta

value.
2. Click the delete icon (x) for each list that should not include the meta value.

3. Click Save.

The meta value is removed from the deleted list.

Create a New List

To create a Context Hub list in Investigate:

1. Inthe Add/Remove from List dialog, click Create New List.

Add/Remove from List

List Mame

Description

Cancel Save

2. In the List Name field, enter an unique name for the list.
3. Inthe Description field, enter the description of the list.
4. Click Create to create the list.

5. Click Save to add the meta value to the created list.

These lists are considered as data sources for retrieving context information.
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View Additional Context for a Data Point

From the Events view or the Navigate view, you can look up details and intelligence about
elements associated with an event in the Context Hub. The data from configured sources, such
as RSA NetWitness Endpoint, can help you understand what is happening.

These elements, or entities, are identifiers, such as an IP address, a user name, a host name, a
domain name, a file name or file hash. To look up external information about a given entity,
NetWitness Suite uses the Context Hub. The Context Hub is a centralized service that
aggregates data about entities from multiple configurable data sources. This data can extend
your investigation with additional context beyond the immediate results of a specific query. For
example, the Context Hub can tell you if a given entity has been mentioned in any incidents,
alerts, feeds, or community intelligence publications.

When you right-click the entity in Investigate, the Context Hub queries the configured data
sources for relevant information. The Context Lookup panel opens from the right side of the
browser window. The Context Lookup panel is populated with the information from the Context
Hub as it becomes available.

To perform another lookup, right-click on another entity, and the Context Lookup panel is
updated with that entity’s information.

To close the Context Lookup panel, click B in the panel.

In the Context Lookup panel, you can view and explore individual data sources for further
investigation. For example, when you click on a particular Incident's value, the specific incident
details are displayed in the Respond view.

For a detailed description of the information displayed for each data source on the Context
Lookup panel, see Context Lookup Panel.

Before an analyst can view contextual information, the administrator must:

o Ensure that the Analyst has a role with the permission Context Lookup as described in
"Role Permissions" and "Manage Users with Roles and Permissions" in the System Security

and User Management Guide.
o Add the Context Hub service in RSA NetWitness Suite.

o Configure data sources for the Context Hub service as described in the Context Hub

Configuration Guide.

Note: Go to the Master Table of Contents for NetWitness Logs & Packets 11.x to find all
NetWitness Suite 11.x documents.
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To view information in the Context Summary panel:

1. Inthe Navigate view or the Events view, identify a meta value for which you want to view
additional context and hover over the meta value.
The Context Highlights panel is displayed with a quick summary of the type of context data
is available for the data source: NetWitness Endpoint, Incidents, Alerts, Hosts, Files, Feeds,

and Live Connect.

2. Right-click a meta value , and click Context Lookup in the drop-down menu to open the

Context Lookup panel.

Copy

Apply IEQUALS Drill
Context Lookup
Add/Remove from List
Refocus >

Refocus New Tab »

The Context Summary panel opens from the right side of the browser window. The Context
Summary panel is populated with the information from the Context Hub as it becomes
available.

3. To perform actions from the Context panel, click an entity such as IP address and right-click.

The following options are available: Open Link in New tab, Query in Investigate, Copy Link,
Paste, Google Lookup, Virus Total Lookup, and Query in Endpoint.
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Use Profiles to Encapsulate Custom Views

Using profiles is a quick and easy way to customize which data is displayed in the Navigate
view and the Events view. In the Manage Profiles dialog, you can use a profile to specify which
meta groups and column groups are displayed by default, to append queries to an investigation,
and to import or export profiles.

Note: Profiles are shared across users in the same NetWitness Suite network. If one user
modifies or deletes a profile it has an affect on what is available to the other users.

If you have multiple profiles, you can switch between them to quickly change to the selected
profile's preferences. If a profile is currently active, the title of the Profile menu is replaced with
the profile name.

The following figure illustrates this in the Navigate view. The profile name is displayed between
Query and Meta. In the Events view, the profile name is displayed between Query and View.

% Query = EJ RSA Email Analysis = [EJ Meta =
' ry == ¥ ==

Navigate to the Manage Profiles Dialog
1. Go to INVESTIGATE > Navigate or INVESTIGATE > Events.
2. If the Investigate dialog is displayed, select a service and click Navigate.

3. In the toolbar, select Profile > Manage Profiles.

The Manage Profiles dialog is displayed.
Manage Profiles

+-Blan

[1 RSA Email Analysis

R5A File Analysis

R5SA Threat Analysis

O oo

RSA Web Analysis
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Create and Edit Profiles

1. In the Manage Profiles dialog, either select an existing profile by clicking the checkbox

beside the name, or click + to create a new profile.

The right panel is available.

2. Edit or enter the profile name by typing in the Name field. The name must be between 2 and

80 characters.

3. Select a meta group from the Meta Group drop-down list. You can add custom meta groups

as described in Manage Meta Groups.

4. Select a column group for the Column Group drop-down list. You can add custom column

groups as described in Manage Column Groups in the Events View.

5. Type queries to filter results in the PreQuery field. PreQuery follows the same syntax as the
Query builder. The PreQuery in the figure uses a meta group called crypto exists.

6. Click Save to save the profile without using it, or click Save and Apply to save the profile
and use it immediately.
If you click Save and Apply, a confirmation dialog is displayed before setting the selected

profile as active.

Change Active Profile

If you do not see enough results or the right results in the Navigate or Events views, you may
have a profile active. If you do not want to use any profiles, you can click Deactivate Profiles
in the Profiles drop-down menu.

To use a different profile:

1. In the Navigate or Events view toolbar, open the Profiles drop-down menu.
2. Hover over the Profile option to display a drop-down list of available profiles.

3. Select the profile you want to use.
The profile settings are applied immediately.
If you want to change the active profile from the Manage Profile dialog:
1. In the Navigate or Events view toolbar, select Profiles > Manage Profiles.

The Manage Profiles dialog is displayed.

2. Select a profile from the left panel and click Save and Apply.

A confirmation dialog is displayed.

3. Click Yes.
The profile settings are applied immediately.
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Import Profiles
You can upload or import .jsn files that have been downloaded from another service.
1. Inthe Manage Profiles dialog, click & in the left panel toolbar.
The Profile Import dialog is displayed.
2. Click Browse or the Upload File field to select a file from your computer.

3. When the file is selected, click Upload.
The profile is displayed in the left panel.

Download Profiles

Profiles are downloaded as .jsn files.

1. Inthe Manage Profiles dialog, select one or more profiles from the left panel.

2. In the left panel toolbar, click [ .

The download begins immediately.
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Search for Text Patterns

You can search for text patterns withing the current set of events in both the Navigate view and
the Events view. You can perform a keyword text search or do regex (Regular Expression)
matching. In the Navigate view, you can click a meta value, such as HTTP, to drill into the data
and then enter a search string in the Search field to search for events within that subset of data.
The search opens a tab in the Events view, brings your drill and time range forward, and shows
your search results. You can also drill into the data using queries before starting a search. To
execute the search, enter a search string in the Search box, and press Enter or click Search.

Keyword Text Search

The text search provides these capabilities:

Each white space delimited word is ANDed, so that every word must be found, but the order
or location position in relation to the other words is irrelevant. For example, if you search on
Mark Albert, both Mark and Albert must be found in the session, but they need not be

together or in any specific order.

The word OR is special. If you search Mark OR Albert, either Mark or Albert must be

found in the session to match; both are not required.

You can mix or match implicit ANDs and ORs together in the search string. The explicit OR
has higher precedence than the implicit (whitespace) AND. The following examples make
the same logical statement, which requires that both the terms cheese and dumplings be
present in a match and one of toaster bread:

cheese toast OR bread dumplings

cheese AND (toast OR bread) AND dumplings

You can exclude words from search results using the - operator. For example, searching for
cheese -toast would return any result that has the word cheese, unless the word toast is

also present.
The keyword search can match metadata stored in the following patterns:

o IPv4 and IPv6 addresses. Any term that can be recognized as an [P address will be

converted to the native metadata format so that it can be found in indexed metadata.
o IPv4 CIDR ranges. You can use CIDR notation to locate IPv4 addresses within a range.

o Timestamps. Timestamps are matched against the native time meta, and any additional

time meta fields stored with the Time type.
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o Numbers. The search function will attempt to automatically identify decimal search terms
and match them against numeric meta data fields.

Options Controlling Search Behavior

To access the Search box and search options in the Navigate or Events views:

1. You can see the Search Events field in the toolbar.

Search Events w -

Troubleshooting: If you cannot see the Search Events field in the toolbar, click . on the
right side of the toolbar.

Click in the Search field to view the Search Options drop-down menu.

Search Options

v RAW
J D
™ Meta (Network/Log/Endpoint)

[ Case Insensitive  [] Regular Expression

[ Search Indexes

W e °

The options selected in this box change how the search is executed. The default search mode is
to use the search indexes for text keywords within meta and raw.

Note: Because the Search Indexes checkbox is selected by default, the search returns results
based on data that is indexed. If you want to search for a complete set of metadata or raw

data, select those checkboxes and clear the Search Indexes checkbox. The search will take
longer, but it will contain a more complete set of data.

The following table describes the Investigation search options.

e o

Search Indexes Searches the indexes first, before scanning the meta data or any

raw data. Searching the index is the fastest way to locate keywords

within a large data set. The index search utilizes any relevant

indexes present within your data collection.

Caution:

- The index search only returns results on indexed data.

- Substring matches will not be located by index searches. If you

require substring matches, clear this checkbox and use a non-
index search mode.
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e oween

Meta Searches the metadata. Your keyword or regex pattern will be

matched against any parsed meta data.

RAW Searches the log or event text. Every event is decoded and content
(Network/Log/Endpoint) .
is searched for matches on the keyword or regex pattern.

If you select all data with no filters on an Archiver, execution time

may be excessive and a warning may be displayed.

Caution: Searching raw network sessions causes sessions to be
decoded, which is very time intensive. You may want to disable
raw searches when looking at network-only collections.

Case Insensitive Ignores case when searching.

Regular Expression Searches using a Perl regular expression, rather than text. By
default executes a text search. To execute a regular expression

search, select the Regular Expression option.

Caution:

- Regular expression searches can be very slow.

- When combining regular expressions and index search options,
the regular expression pattern is matched against unique index
values instead of meta values. This produces results faster, but it
is not an exhaustive search of all the meta data or raw data.

Apply Sets the default search options to apply to a search in the Navigate
and Events views. This also updates your Investigation preferences
in your Profile (Profile > Preferences > Investigation tab). The
preferences are saved and effective immediately.

You can select search options to use for a particular search without

changing your default search preferences.

Regular Expression Search Syntax

A regular expression search uses Perl regular expression syntax, which is documented in detail
in http://perldoc.perl.org/perlre.html.
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Raw Text Keyword Search

The Log Decoder has the capability to create a raw text index for unparsed log events. This
functionality creates metadata items that form a full-text index on downstream services such as
Concentrators and Archivers. When you enable the Search Indexes option in your search
preferences, your search automatically utilizes the text index. Note that the text index produces
meta items that have a coarse granularity. For example, the default text indexer configuration
truncates text terms. By comparing the index matches against raw data, the search engine will
find accurate results for your search. However, you can improve search times by disabling the
raw search checkbox. If you do so, results will be returned faster, but you may see false positive
hits in your search results.

Search Examples

The following examples show searches from the Navigate and Events views.

Search in the Navigate View
To search within the currently displayed data in the Navigate view:
1. To drill into the data, click a meta value, such as HTTP, in the Navigate panel.

Copy

Live Lookup
Scan for Malware
Add/Remove from List

Investigation >

2. Type a search string in the Search field and press Enter or click Search.

3. To clear the search box and return to the normal Events view, click the X in the search box.

Search in the Events View
To search within the currently displayed data in the Events view:

1. Type a search string in the Search box, and press Enter or click Search.

The search results are displayed in the Events view. Events that match the search criteria
are displayed in the Event view grid. In the Details view and List view, matches are
highlighted in the Details column. In addition, when searching RAW, matches are
highlighted in the Log view Logs column.

2. If you want to narrow the search, change the query and time.

3. If you want to stop the search and return to the Events view, click Cancel.
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Any results that are displayed remain.

4. To clear the search box and return to the normal Events view, click X in the search box.
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View and Modify Queries Using URL Integration

NetWitness Investigate includes an External URL Integration that facilitates integration with

third-party products by allowing a search against the NetWitness Suite architecture. By using a
query in a URI, you can pivot directly from any product that allows custom links, into a specific
drill point in the Investigate view. This integration provides an internal presentation of the user's

query.

URL Integration allows the user to identify the service either by the host id or by the service and
port, as defined in NetWitness Suite. If NetWitness Suite is unable to resolve the service, the
analyst is redirected to the Navigate view, showing the Service selection dialog. Once the
service is selected, the Navigate view is loaded with the drill point, defined by the query.

Service Id Known

When the ID of the service to use for an investigation is known, the format for entering a URI
using a URL-encoded query is:

http://<sa host:port>/investigation/<deviceId>/navigate/query/<encoded
query>/date/<start date>/<enddate>

where

e <sa host: port>is the IP address or DNS, with or without a port, as appropriate (ssl or
not). This designation is needed only if access is configured over a non-standard port through

a proxy.

e <devicelId> is the internal Service ID in the NetWitness Suite instance for the service to
query against. The service ID can be represented only as an integer. You can see the relevant
service ID from the URL when accessing the Investigation view within NetWitness Suite.

This value changes based on the service being connected to for analysis.

e <encoded query> is the URL-encoded NetWitness Suite query. The length of query is
limited by the HTML URL limitations.

e <start date>and <end date> define the date range for the query. The format is <yyyy-
mm-dd>T<hh:mm:ss>2%. The start and end dates are required. If no date is provided then the
user defaults for that service are used. Relative ranges (for example, Last Hour) are not
supported. All times are run as UTC.

For example:
http://localhost:9191/investigation/l12/navigate/query/alias%20exists/
date/2012-09-01T00:00:002/2012-10-31T00:00:002
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Host and Port Known

When the host and port of the service to use for investigation is known, the format for entering a
URI using a URL-encoded query is:

http://<sa host:port>/investigation/<device
host:port>/navigate/query/<encoded query>/date/<start date>/<enddate>

where

e <sa host: port>is the IP address or DNS, with or without a port, as appropriate (ssl or
not). This designation is needed only if access is configured over a non-standard port through

a proxy.

e <device host:port> is the host and port of a service defined in NetWitness Suite instance
for the service to query against. NetWitness Suite attempts to resolve the host and port as a

service ID defined in NetWitness Suite.

e <encoded query> is the URL-encoded NetWitness Suite query. The length of query is
limited by the HTML URL limitations.

e <start date> and <end date> define the date range for the query. The format
s <yyyy-mm-dd>T<hh:mm: ss>Z. The start and end dates are required. If no date is
provided then the user defaults for that service are used. Relative ranges (for example, Last
Hour) are not supported in this version. All times are run as UTC.
For example:
http://localhost:9191/investigation/concentrator:50105/navigate/query
/alias%$20exists/date/2012-09-01T00:00:002/2012-10-31T00:00:00%

Examples

These are query examples where the NetWitness Server is 192.168.1.10 and the devicelD is
identified as 2.

All activity on 03/12/2013 between 5:00 and 6:00 AM with a hostname registered

o Custom Pivot: alias.host exists

e https://192.168.1.10/investigation/2/navigate/query/alias%2Ehost%20ex
ists/date/2013-03-12T05:00:00Z/2013-03-12T06:00:00%

Querying and Acting on Data in the Navigate and Events Views 148



NetWitness Investigate User Guide

All activity on 3/12/2013 between 5:00 and 5:10 PM with http traffic to and from IP address
10.10.10.3

o Custom Pivot: service=80 && (ip.src=10.10.10.3 || ip.dst=10.0.3.3)
o Encoded Pivot Dissected:

e service=80 => service&3D80

e 1p.src=10.10.10.3 => 1p%2Esrc%$3D10%2E10%2E10%2E3

e ip.dst=10.10.10.3 => ip%2Esrc%3D10%2E10%2E10%2E3

e https://192.168.1.10/investigation/2/navigate/query/service$3D80%20
%$26%26%20%281p%2Esrc%3D10%2E10%2E10%
2E3%20%7C%7C%201p%2Edst%3D10%2E10%2E10%2E3%29/date/2013-03~-
12T17:00:002/2013-03-12T17:10:00%

Additional Notes

Some values may not need to be encoded as part of the query. For example, commonly the IP src
and dst is used for this integration point. If leveraging a third-party application for integration of
this feature, it is possible to reference those without encoding applied.
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Reconstruct an Event

When viewing a list of events in Events view, you can safely create a reconstruction of the
event in a readable form that matches the original. By default, the initial view of a reconstructed
event is the most suitable format (Best Reconstruction); for example, web content is
reconstructed as a web page; an IM conversation is displayed with both parts of the
conversation. Each user can select a different default reconstruction in the Profile > Preferences
view.

You can also open a reconstruction from the Navigate view if you know the Event ID of the
event.

In the reconstruction, you can:

Select event information to view. Possible values are: request data, response data, both

request and response data.
Select the reconstruction type: details, text, hex, packets, web, mail, or IM.
Export raw logs.
Export the event as a PCAP file.
Extract any files available in the event.
Extract all the meta data associated with the event.
Caution: Be careful when clicking a link to a file in the Reconstruction. If your system

has an application associated with the file, or the browser is capable of opening them,
and the attachments are malicious, they can negatively affect your system.

Display the event in a separate window or tab (depending on your browser configuration).

If you are viewing the reconstruction as a preview in the current view, you can page forward
to the next event and back to the previous using the navigation buttons in the bottom left

corner.
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Note: Reconstruction Settings and Reconstruction Cache Settings allow an administrator to
manage application performance for Investigation. As analysts reconstruct sessions that they
are investigating, two situations can affect performance and results.

-Some events can be very large and contain many thousands of source packets.
Reconstructing these types of sessions can degrade application performance.

- In some cases, the reconstruction cache can present incorrect content; for this reason,
NetWitness Suite cleans cache that is older than a day every 24 hours. Between the daily
cache cleanings, certain actions my result in stale cache being used for a reconstruction, and
if the need arises, administrators can manually clear cache for one or more services that are
connected to the current NetWitness Server.

Reconstruct an Event from the Navigate View

You can reconstruct an event directly from the Navigate view given a known Event ID. You can
use this option without executing a query as you usually do when beginning an investigation. A
service and time range must be selected to be able to jump directly to an event using just its

eventid.

To view a reconstruction or event analysis directly from the Navigate view:

1. Goto INVESTIGATE > Navigate and select Actions > Go to event in Event Analysis or

Go to event in Event Reconstruction.

BN & Actions

Visualize
Go to event in Event Analysis
Go to event in Event Reconstruction 00)

Print

application/octet-stream {11,814)

The Go to event dialog is displayed. There are two dialogs, one for Event Analysis and one

for Event reconstruction. Both ask for the Event ID.

Go to event in Event Reconstru

Event ID

Cancel
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2. In the Event ID field, type the ID and click Go.

The specified event is reconstructed in the Event Reconstruction view or the Event Analysis

view.

Reconstruct an Event
1. Open a drill point in the Events view.

2. To show all meta data, click

+ Show Additional Meta

3. To open an event reconstruction in the current view, select an event to reconstruct and select

Actions > View Event > Preview Inline.

The Event Reconstruction opens in a popup window in the same view. By default,

NetWitness Suite displays the best reconstruction

content or the reconstruction that you have selecte

for the event determined by the event

d in the Default Session View setting for

Investigation. You can use the options in the Event Reconstruction toolbar to change the

reconstruction method, view side-by-side results, export an event, open an email attachment,

extract files, and open the event in a new tab. The

toolbar options vary depending on the type

of event being reconstructed (network event, log event, or endpoint event). This is an

example of the reconstruction for a network event.

Event Reconstruction

service id type source destination service first packet time

Concentrator 1585 Network Session 147928 150004 0 2017-07-05T12:32:01.106

Request & Response ' [B Top To Bottom ' [B] Best Reconstruction ' # Actions  |& Open Event in New Tab & Event Analysis
A

Packet 1 (id = 127808 seq = 3938823145) 2817-87-85 12:32:01.106 (71 Paylead Bytes)

POEAOBEE : G0 0@ OO 00 0D OO 00 OO 00 08 BB 00 B8 B0 45 B0 [ ........ eeen.. E.

P0eERe16 : 8@ 7h dc fo 40 @@ 48 @6 &d 64 8a 1f 7d 5 @a 1f [ .{..@8.@. Md..}... ]

P0EEEG32 : 7d 5 bb 38 c3 54 ea 4b 99 &0 2b fa Of 7e 80 18 [ }..B.T.K ..4..~.. ]

POEEOB4S : Be 33 10 96 00 @0 01 @1 08 Ba 06 02 8e 6b 86 82 [ .3...... .....k.. ]

PEAEEOS4 : B2 B5 a9 00 @1 @9 3 A PO PO 62 0O 0 @ 21 88 [ ...... L ]

POEEEGEE : B3 00 @1 05 00 @D 00 6f 00 0O 80 a0 48 00 80 b® [ ....... o ....He.l ]

POGAREOE : 48 00 00 do 45 @0 00 07 01 00 82 la 08 80 80 61 [ H...H.u. co..... a ]

POEEO112 : 67 67 G0 00 @O @O 0F 01 00 98 B2 02 08 B0 80 6T [ SE..v..r cenae.. o]

POEAR128 : 7O 04 @D 0@ @B Ge 65 78 T4 -- -- -- -= -- -- -= [ p....nex t ]

Packet 2  (id = 127810 seq = 737845118) 2017-07-05 12:32:01.106 (@ Payload Bytes)

POEEEOEE : O 0P GD 00 @D @D 02 B0 00 PO PR 08 08 BA 45 80 ]

POEAEE16 : B0 34 8 e 40 @0 48 @6 31 fd 8a 1f 7d f5 8a 1f [ ]

P0E@EB32 : 7d 5 c3 54 bb 38 2b fa 9of 7e ea 4b 9a 30 80 180 [ ]

P0eERB4s : B1 77 10 4f @0 @9 01 @1 ©8 Ba B6 @2 8 6b @6 @2 | ]

BOBAOOES : Be Bb -- -= -= —= == —m e e oo e oee ao oo [ ]

Packet 3  (id = 127811 seq = 737845118) 2017-07-05 12:32:01.166 (@ Payload Bytes)

POGEOGEE : B0 00 OO 00 OO @D 0F B0 00 08 B2 08 08 B0 45 BB [ ........ cee... E. ]

POEAEE16 : B0 34 8 Oc 40 @0 48 @6 31 fd 8a 1f 7d f5 8a 1f [ .4..8.0. 1...}... ]

P0E@e832 : 7d 5 c3 54 bb 38 2b fa 9f 7c ea 4b 9a 30 80 18 [ }..T.8+. .~.K.0.. ]

PoEEEE4S : @1 77 10 4f @0 @0 01 @1 ©8 83 86 02 8 6b @6 €2 [ .w.0.... .....k.. ] <

500 of 3,453 packets; loaded from cache & Show Recenstruction Log
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4. To preview a reconstruction of the next event, click l or to preview a reconstruction of the

previous event, click l

5. To open an event reconstruction in a new tab, do one of the following:

a. Inthe Events view, select an event to reconstruct and select Actions > View Event>
Open in New Tab.

b. Inthe Event Reconstruction toolbar of previewed reconstruction, click Open Event in
New Tab in the toolbar.

The Event Reconstruction opens in a new tab.

RSA INVESTIGATE D admin ® @

Event Reconstruction

e packet count

service d type source destination service
Concentrator 1585 Network Session 147928 150004 0

first packet time last packet time pa
2017-07-05T12:32:01.106  2017-07-05T12:34:20.266 21,

Request & Response Top To Bottom Best Reconstruction & 4 Actions &

Packet 1  (id = 127888 seq = 3930823145) 2017-67-65 12:32:01.186 (71 Payload Bytes)
00002000 : @0 08 O3 00 00 @@ 00 9@ 00 0 00 6@ 08 00 45 88 [ . s El ]
20000016 : 90 7b dc o 40 @ 42 @8 4d 1f 7d 5 @a 1f [ 1
20000032 : 7d f5 bb 38 c3 54 ea 4b of 7e 80 18 [ 1
000G0045 : e 33 18 96 00 @b 61 o1 2 8e 6b @6 82 [ . 1
86002064 : 82 05 a3 00 01 @@ 3f 8@ 00 80 62 0@ 86 @1 80 [ . 1
06002080 : @3 08 @1 05 00 @0 00 &f 00 00 00 50 43 00 @0 b8 [ . 1
80002036 : 45 08 @8 do 43 @@ 08 ©7 01 80 00 1a 00 00 80 61 [ H 1
20000112 : 67 67 02 00 90 22 00 ©1 00 @0 00 62 00 00 e &6f [ gg. . 1
00000128 : T 04 @2 00 @8 B¢ 65 78 74 -- -- -- -- -- -- -- [ p....next 1

Packet 2 (id = 127810 seq = 737845118) 2017-07-85 12:32:01.106 (@ Payload Bytes)

£00GR00R : @0 60 0O 00 00 0P 02 P@ 00 00 00 60 05 00 45 80
: 34 3 92 40 90 4@ 96 31 fd @a 1f 7d f5 ea 1f

: 7d f5 3 54 bb 38 2b fa 9f 7e ea 4b %a 30 30 10
06000043 : @1 77 10 4f @6 @0 01 @1 05 Oa 06 62 8= 6b 86 02
08000064 : Be 6b -- -- -- -= - <= == - - o= oo oo oo oo

Packet 3  (id = 127811 seq = 737845118) 2017-87-85 12:32:01.186 (@ Payload Bytes) =
500 of 3,453 packets; loaded from cache & Show Reconstruction Log

| NETWITNESS SUITE 11.0.0.0-170703173620.1.686607c

View Side by Side or Top to Bottom
To select the way requests and responses for an event are displayed:
1. Inthe Event Reconstruction toolbar, click Top to Bottom or Side by Side.

2. In the drop-down menu, select the information you want to see in the event: Side by Side or
Top to Bottom.

The reconstruction is refreshed with the selected information.

Select Event Information to View
To select what event information to view:
1. Inthe Event Reconstruction toolbar, click Request & Response.

2. In the drop-down menu, select the information you want to see in the event: Request &
Response, Request, or Response.

The reconstruction is refreshed with the selected information.
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Select Event Reconstruction Type
To select the reconstruction type for an event:

1. Inthe Event Reconstruction toolbar, click Best Reconstruction.

2. In the drop-down menu, select the reconstruction type to view: meta, text, hex, packets,
web, mail, or files.

The reconstruction is refreshed with the selected reconstruction type.

Open or Download an Email Attachment

When viewing a reconstruction of an email that has attachments, you can open supported file
types or download the files to the local system.

Caution: Be careful when selecting file attachments. If your system has an application
associated with the file attachments, or the browser is capable of opening them, and the
attachments are malicious, they can negatively affect your system.

To open or download email attachments:

1. Inthe Event Reconstruction toolbar, select the View drop-down and select View Mail.

The Event Reconstruction is displayed.

2. Inthe Event Reconstruction section of the email, click the Attachment.
If the file type is supported by the browser, the attachment will open in a new tab.
If the file type is not supported, the Download dialog is displayed so that you can download
the attachment.

Export an Event as a PCAP File

The PCAP export option downloads the sessions for the current time range and drill point to a
PCAP file. To export an event as a pcap file:

1. Inthe Event Reconstruction toolbar, click Actions.
2. Click Export PCAP.
3. A confirmation dialog is displayed.

4. Click OK.
The job is scheduled and when complete the PCAP is downloaded to the local file system.
In the Profile > Jobs tab, you can download the PCAP.
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Extract Files from a Reconstructed Event

The Extract Files option extracts and downloads the files associated with the event. To extract
files:

1. Inthe Event Reconstruction toolbar, click Actions.

2. Click Extract Files.
The File Extraction dialog is displayed.

3. Select the types of files to extract, and click OK.

4. The job is scheduled and when complete the selected file types are downloaded to the local

file system. In the Profile > Jobs tab, you can download the files.
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Analyzing Raw Events and Metadata in the Event

Analysis View

Analyzing raw events and data in the same view is possible when working in the Event Analysis
view. After you understand Recontruction Types in the Event Analysis View, you can:

o Filter Results in the Event Analysis View

o Examine Events in the Event Analysis View

e Download Data in the Event Analysis View

e Act on Data in the Event Analysis View
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Recontruction Types in the Event Analysis View

When hunting for possible threats in captured network data, you can drill into different points of
interest in the data. If a particular session contains suspicious events, you can examine the list of
events for the session and you can also safely view a reconstruction of the event with features
that help to identify patterns. (See Beginning an Investigation for the different methods to access
the Event Analysis view.)

Note: If you are analyzing events on a 10.6.x or 11.0.0.x service from an 11.1 NetWitness
Server, the download behavior in the Event Analysis view varies for files, PCAPs, logs,
payloads, and meta values. You may see an event payload on a 10.6.x or 11.0.0.x service to
which you do not have permission, but you will not be able to download files or payloads.

In the Event Analysis view, you can select the format for the reconstruction: Packet Analysis,
File Analysis, or Text Analysis, Email (Version 11.1 and later), and Web (Version 11.1 and
later). When the medium meta key tags an event as a log event or endpoint event , only the Text
Analysis is available. The default reconstruction for network events is Text Analysis; however,
for a network event the last reconstruction format that was open overrides the default. The Email
and Web reconstructions open the event in the Events view.

This figure is an example of the Network Event Details: Text Analysis panel in a web browser
window that is wide enough to display the reconstruction format options in a row.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Navigate Events Event Analysis Hosts Files Malware Analysis
- Concentrator v

Events (20336) ? X Network Event Details | Text Analysis Packet Analysis  File Analysis  Email f  Web [f

Summary List v Download PCAP - @ | DISPLAY COMPRESSED PAYLOADS

EVENT TIME EVENT TYPE THEME

NW SERVICE SESSION 1D SOURCE IP:PORT DESTINATION IP:PORT SERVICE FIRST PACKET TIME
02/26/2018 Network HTTP 112 - ¥ 149527 -l : 80

MRE™ A CLBdT T -
09:40:46 am Concentrator

02/26/2018
09:40:49.803 am

02/26/2018
09:40:52 am

2277074 bytes

LAST PACKET TIME CALCULATED PACKET $IZE  CALCULATED PAYLOAD SIZE  CALCULATED PACKET
2 9 bytes COUNT’

02/26/2018
09:40:49.813 am 3063
02/26/2018 REQUEST
09:40:46 am

GET /flashupdate64.exe HTTP/1.1 SESSIONID 112
02/26/2018 Accept: */* TIME 02/26/2018 09:40:49 am
Lok Accept-Encoding: gzip, deflate Ry 33557342
02/26/2018 User-Agent: Mozilla/4.@ (compatible; MSIE 7.0; Windows NT 6.1; WOW64; ERIEOAR 31669890
09:40:58 am Trident/4.0; SLCC2; .NET CLR 2.0.50727; .NET CLR 3.5.30729; .NET CLR MEDIUM !

3.0.30729; Media Center PC 6.0) ETH.SRE
02/26/2018 Host: A ETH.SRC.VENDOR  Intel Corporate
09:40:45 am t . ETH.DST el st AE

Connection: Keep-Alive
02/26/2018 ETH.DST.VENDOR  Cisco-Linksys, LLC
09:41:04 am ETH.TYPE 2048

Showing < 1% RESPONSE  IP-SRC

02/26/2018 1p.DST
09:40:59 am HTTP/1.1 200 0K
Server: W

0212672018
09:40:47 am Date: Sat, 15 Mar 2014 04:05:44 GMT TEPFLAGSSEEN  synrscpsh ack

4.0f 20336 events TCP.SRCPORT 49527

IP.PROTO 3
TCP.FLAGS 30

When the browser window is too narrow to display all the view options horizontally, the options
are presented in a drop-down list.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events EventAnalysis Hosts Files Malware Analysis

- Concentrator v 02/25/2018 07:06:00 pm - 02/26/2018 07:05:59 pm

Events (20336) S OX Network Event Details Text Analysis v

Packet Analysis
Download PCAP File Analysis (D) ST D Cuieresy

EVENT TIME EVENT TYPE THEME o Email 7

NW SERVICE SESSION URCE IP:PORT DESTINATION IP:PORT SERVICE FIRST PACKET TIME
&

02/26/2018 Network HTTP - 112 | Webl ¥ : 49527 S : 30 80

o e 02/26/2018
09:40:46 am Concentrator 09:40:49.803 am

LAST PACKET TIME CALCULATED PACKET SIZE gllzl.ECU\.A'IED PAYLOAD EsIﬁC"I_I'I.ATED PACKET
02/26/2018 ggﬁgﬁg‘; %3 am 2277074 bytes 2098469 bytes ==

09:40:52 am

02/26/2018 REQUEST
09:40:46 am
GET /flashupdate64.exe HTTP/1.1 SESSIONID 12
02/26/2018 Accept: */* TIME 02/26/2018 09:40:49 am
09:40:49 am Accept-Encoding: gzip, deflate Rz 3557342
027262018 User-Agent: Mozilla/4.@ (compatible; MSIE 7.0; Windows NT 6.1; WOWG4; AYLORD Elese =y
09:40:58 am Trident/4.8; SLCC2; .NET CLR 2.0,50727; .NET CLR 3.5.30729; .NET CLR MEDIUM L
3.0.30729; Media Center PC 6.9) frH.sRe
02/26/2018 ETH.SRC.VENDO
e, Host: - 4 - . Intel Corporate
Connection: Keep-Alive
02/26/2018 FTH.DST

a1 ETH.DST.VENDO

09:41:04 am Cisco-Linksys, LLC
Showing < 1% RESPONSE  ®

02/26/2018

09:40:59 am HTTP/1.1 200 OK
Server: '

IP.DST
G Date: Sat, 15 Mar 2014 04:05:44 GMT
09:40:47 am

4 of 20336 events TCP.FLAGS

ETH.TYPE 2048

IP.SRC

IP.PROTO

Within each type of analysis, settings are available to enhance your analysis. If you change a
setting, the setting is preserved between browser refreshes and logins within the same browser.
These are the preserved settings:

o The currently selected reconstruction: Text Analysis, Packet Analysis, or File Analysis.
o Whether the Event Meta panel is open or closed.

o Whether the Event header is open or closed.

o Whether the Request or Response, or both are displayed.

« Whether packet payloads are displayed in the Packet Analysis panel.

o Whether shaded bytes are displayed in the Packet Analysis panel.

o Whether other common file types are highlighted in the Packet Analysis panel.

o The number of packets per page in the Packet Analysis panel.

o Whether compressed or uncompressed text is displayed in the Text Analysis panel.

o The text decode setting in the Text Analysis panel of a network event.

The Text Analysis Panel

You can view all types of events (network events, log events, and endpoint events) in their
original text format in the Text Analysis panel.

Note: Endpoint events are available for investigation in Version 11.1 and later.
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The Text Analysis panel for some network events can be quite large. To ensure the best
rendering, the number of packets that can be rendered in a single event is limited to 2500. If the
Text Analysis panel is not showing all packets, the footer indicates that the limit of 2500 packets
has been reached; no additional packets will be rendered for this event. This figure illustrates a
reconstruction that has 2727 packets with only 2500 packets rendered; no more packets will be
rendered for this reconstruction.

Network Event Details | Text Analysis Packet Analysis  File Analysis Email I  Web EQOOMN|-

Download PCAP n @ | DISPLAY COMPRESSED PAYLOADS

NW SERVICE SESSION ID SOURCE IP:PORT DESTINATION IP:PORT SERVICE FIRST PACKET TIME

PRI i o 727653 .. 49223 H: ] 80 02/26/2018 09:40:45.957
Broker am

LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOAD SIZE Eslﬁ%u#nﬁn PACKET

02/26/2018 09:40:45.973 2186416 bytes 2031694 bytes 2727
am

Showing 4% RESPONSE
Cev e g e

SESSIONID 727653

TIME 02/26/2018 09:40:45 am
SIZE 33556874

PAYLOAD 31736522

<html>

<body>

<hl id="pBRxC" style="display:none"
title="7e6v1a414">5n5k8mI7908j968p91906c8 jPWBo8hIBI56kIBhE19d5n5kE1988h8s06k
6j988h66n6j946c9a8t616n6j8571916j6n6]8j6c7b6cIV6j6n681996c7F6j6n6181968p98
6j6n6j8188U6]6n6]7t818q818]6j6n6j966k6e6]6n6]jLB7r8p8194676n6j919591636n678md
66q887r6j6n6j7q717t6j6n6]7r6e61796]61795n5k9aR8t8s7191868h959b908 j6c7bEcUM OGP e
A96949781795n5k9a8t8571918j6q85918h8k887r7q6k6j7a6d717t16j6n6]7h84896j6n6580 TH.TVRR 2048
716c80966]6n61818s6cB@8566n6JEKG7g7q7n6]6n617h6c6ebpbror876j6n61717h6rerFEX ISR 192.168.198.136
71846j6n6]716cB87m6j6n6]84616n6]7r7q6c6t6q6j6n6j656c84948h631Z6n6]9095858h6] |p.DST 178.62.250.102
6n63j968p91906r6r7j6j6n6]7s6e6c6e94G6jKTENG] 8195616061 786r6r6j6ctnbcBhbcbnbct 1P.PROTO 5
j6e7c6j61795n5k8p8mEkIaBtNF8s719186q928h9495817949491946q81949491947h918kE TCP.FLAGS 31
16c6d7b6c65619d5n5k988h946c8194946c7b6cbe?9494RI1946¢c7h918k81786c6e6c6n6c9a TCP.FLAGS.SEEN  fin syn rst psh ack
8t857191876q928h94958177949491946qPP81949491947h918k816cWBRENGC6e8cI06e795n5 TCP.SRCPORT 49223
k8194946c6n7b6cbe7 1949491946c8281 8h959190786c6e TECENNGCIa8t857191816q928h949 TCP.DSTPORT 80
5FUI81737949491946q94818h959190ZB795n5k8194946c6n7b6c6e7j94949194KTX6c858p908 SERVICE 80

1 TOE el ol A OLO ~CFE A 02 AIOLAAAC DT FIAAAAYAIAAL 0~ OAADT FAC—CI.0- 0—L1.01A4N STREAMS 2

7 of 100000 events

MEDIUM 1

ETH.SRC 00:00:00:00:00:00
ETH.SRC.VENDOR XEROX CORPORATION
ETH.DST 00:00:00:00:00:00

PACKETS

Note: Some network events have a large number of packets but very small payload. In this
case, if the entire payload is contained within the first 2500 packets this meets the definition of
showing all packets. No message indicating that you are not viewing all of the packets is
displayed.

In the Text Analysis panel, network events, log events, and endpoint events are presented

differently.

o For network events, Investigate provides the direction of the packet (Request or Response)
and contents of each packet in text format. If you are reconstructing a network event, the Text
Analysis panel is scrollable. When you scroll, the text identification information as well as

the Request and Response labels remain visible rather than scrolling out of view.

o Log events and endpoint events have no request or response; only the raw event is displayed

in the Text Analysis panel.
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For each type of event (network, log, or endpoint), there are several differences:
o The Event header includes information relevant to each type of event.

o There are different options for exporting.

Below is an example of the Text Analysis panel for each type of event, a network event, a log
event, and an endpoint event.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis

Events (20336) X Network Event Details | Text Analysis Packet Analysis  File Analysis Email 1 Web [ OO M|~ X

Emall Analysis Download PCAP @ | DISPLAY COMPRESSED PAYLOADS

EVENT TIME EVENT TYPE SERVICETYPE I}

NW SERVICE SESSION 1D ORT DESTINATION IP:PORT SERVICE FIRST PACKET TIME
e 0

09:40:43 am 727684 149254 - - 4 80 02/26/2018 09:40:43.364
am

Broker
02/26/2018 LAST PACKET TIME CALCULATED PACKETSIZE  CALCULATED PAYLOAD SIZE  CALCULATED PACKET COUNT
1387

09:40:43 am 02/26/2018 09:56:16.295 84894 bytes 551 bytes
am

02/26/2018

08:40:43 am REQUEST

02/26/2018 GET /IP.php HTTP/1.1

0%:40:43am User-Agent: Mozilla/5.0 (Windows; U; Windows NT 6.0; en-US) AppleWebKit/535.1 (KHTML, like Gecko) Chrome/13.0.782,167
02/26/2018 Safari/535.1

09:40:43 am Referer: http://google.com

Accept-Encoding: gzip,deflate,gzip

Accept-Charset: IS0-8859-1,utf-8;q=0.7,%; q=0.7

Host: clickcashmagnet . com

02/26/2018 Connection: Keep-Alive
09:40:43 am

02/26/2018
09:40:43 am

02/26/2018 RESPONSE
09:40:43 am
HTTP/1.1 200 0K
Date: Sun, 04 May 2014 22:49:42 GMT
Server: Apache
02/26/2018 X-Powered-By: PHP/5.3,28
08:40:43 am Keep-Alive: timeout-5, max-100
Connection: Keep-Alive
20 of 20336 events

02/26/2018
09:40:43 am

02/26/2018
09:40:43 am

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Navigate Events Event Analysis Hosts Files Malware Analysis
- Concentrator (1) 02/25/2018 07:06:00 pm - 02/26/2018 07:05:59 pm

Events (100000+) : Log Event Details | Text Analysis

EVENT TIME EVENT TYPE THEME 0

NW SERVICE SESSION ID DEVICE IP DEVICE TYPE COLLECTION TIME

02/26/2018 Log rsa_netwitness_. - ws_audit  02/26/2018
09:40:41 am Concentrator 109:40:41.000 am

02/26/2018 Log rsa_netwitness._.
09:40:41 am

RAW LOG

Feb 26 2018 09:40:41 WMENL S W CEF:@|RSAINetWitness SESSIONID 4
Audit|11.1.0.0|MANAGEMENT lupload| 6l rt=Feb 26 2018 09:40:41 ey 02/26/2018 09:40:41 am
src=# & ® spt=56864 suser=escalateduser Hedd 386

02/26/2018 sourceServiceName=L0G_DECODER deviceExternal Id=m - - s L

05:40:41.am #9888 deviceProcessName=NwlLogDecoder outcome=pending msg=has MERIUM

started uploading file

02/26/2018 rsa_netwitness._.
09:40:41 am

DEVICE.TYPE
02/26/2018 rsa_netwitness_..
09:40:41 am

MSG.ID

ALIAS.HOST

02/26/72018 rsa_netwitness_. EERSIOM 11100
09:40:41 am EVENT.TYPE MANAGEMENT

EVENT.DESC upload
02/26/2018 rsa_netwitness_.

09:40:41 am

1P.SRC

NETNAME private src
02/26/2018 rsa_netwitness_. USER.SRC escalateduser
09:40:41 am B B SERVICE.NAME LOG_DECODER

PROCESS NwLogDecoder
02/26/2018 rsa_netwitness_..

RESULT pending
09:40:41 am

4 of 100000 events DEVICE.DISC 100
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN admin

Navigate Events Event Analysis Hosts Files Malware Analysis m

- Concentrator v/ ) LR - A 0§ l:l

Events (2443) & X Endpoint Event Details | Text Analysis Wl

Download XM| [A Pivot to Endpoint Thick Client

EVENT TIME EVENT TYPE o

02/0772018 Endpoint 1 NWSERVICE SESSION 1D NWE CATEGORY COLLECTION TIME EVENT TIME FILENAME
3300 File 02/07/2018 05:51:47.000 02/07/2018 06:24:17.000 libfmphelpers.dylib
pm

05:51:47 pm Concentrator

02/07/2018 Endpoint Process
05:51:47 pm RAW ENDPOINT

02/07/2018 Endpoint [ 2018-02-07T18:24:17.889Z : file event from . - * with id SESSIONID EEL
05:51:47 pm SBSAE4FE-D1AE-494A-C95C-671884C91CC8 ury 02/07/2018 05:51:47 pm
size 154

02/07/2018 Endpoint FORWARD.IP

05:51:47 pm MEDIUM 32

0240772018 Endpoint DEVICE.TYPE nwendpoint
05:51:47 pm DIRECTORY tust/local/McAfee/fmpfiib
f631c8dabe86a39ed870a5f4d2ee09

CERT.CHECKSUM
02/07/2018 Endpoint 699¢5532e9

05:51:47 pm FILE.ENTROPY 5.6263566

02/07/2018 Endpoint L 252144
05:51:47 pm cede7f5e8bdf7be3a163a3a9e00793
CHECKSUM ed6edf34ffdada3s] 480926601 ed6e
3edo
e6ach038feBcc44f010f903828787c5
CHECKSUM
02/07/2018 Endpoint 486ccfe6d
:51:47 pm b4debd32677dfd530d904ab61653d

CHECKSUM
48 of 2443 events e

02/07/2018 Endpoint
05:51:47 pm

Note: The calculated packet count, calculated packet size, and calculated payload size in the
Event header may be different than the same statistics in the Event Meta panel because the

metadata is sometimes written before event parsing completes and may include packet
duplicates.

The Packet Analysis Panel

The Packet Analysis panel is for network events only. The Packet Analysis panel is scrollable,
and the packet identification information as well as the Request and Response labels remain
visible rather than scrolling out of view.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN admin

Navigate Events Event Analysis Hosts Files Malware Analysis m

Events (10824) s Network Event Details | Text Analysis Packet Analysis File Analysis Email ' Web f Eoom| ¥

Surmmary st Downioad PcAP [ ] @ counon re sarreans @D suave svres @

EVENT TIME EVENT TYPE

DISPLAY PAYLOADS ONLY

NW SERVICE SESSION ID DESTINATION IP:PORT SERVICE FIRST PACKET TIME

RT
02/25/2018 Network - Broker 7444237 % 156553 19671 443 02/25/2018 05:34:56.053
pm

05:34:23 pm
LAST PACKET TIME CALCULATED PACKET SIZE  CALCULATED PAYLOAD SIZE  CALCULATED PACKET COUNT

0272572018 Network 02/25/2018 05:34:56.072 4223 bytes 2365 bytes 28

05:34:26 pm pm

02/25/2018 Network
05:34:26 pm

REQUEST

¢ Packet 1 02/25/2018 05:34:56.053 pm 1D 44734111 SEQ 2515443877  PAYLOAI SESSIONID 7444237

0212572018 Network 000000 <4794 13)(00 0|29 00) 45 00 o) E Ly axel TME 02/25/2018 05:34:56 pm

05:34:38 pm 000016 99 40 00 4006 94 56 @a 19 . <. JeLICDL LT size 4223
000032 €916 27 95 ee ad 00 ad 02 1] - -
02/25/2018 Network 000043 fa 00 00 02 04 05 42 35 L% -1 eavLoap 2365
05:34:54 pm 000064 00 00 00 01 03 03 MEDIUM 1
ETH.SRC
02/25/2018

05:34:56 pm

ETH.DsT
ETH.TvRE
v Packet 2 02/25/2018 05:34:56.054 pm 1D 44734112 SEQ 4181380764 PAYLOA

b.ske
el Lol w0000 bc 3600 6c 045 00 L) a%EL. 5 - vt
05:34:55 pm. 000016 40 00 (40 06 a1 57 0a 19 L<. . . (S

000032 dc 9 f9 3a @6 ab 12 ; 2 .0ST

0212512018 Network ¢ go004s 00 00 62 04 ta 62 14 ‘ NETNAME private dst
05:35:20 pm 000064 3c o1 03 omecnion o

02/25/2018 Network 1P.PROTO 6
05:35:24 pm LdTH TCP.FLAGS 3

6 0f 10824 events v PACKETS PER PAGE  TCP.SRCPORT 56553
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In the Packet Analysis panel, the headings provide the direction of the packet (Request or
Response), the packet number, the packet start time, the packet ID and the sequence, and the
payload size. All packets begin with a header, and some packets have a footer. Some packets

have a payload.

In Version 11.1 pagination controls add flexibility when paging through packets.

The metadata in the hexadecimal and ASCII data is highlighted in blue; when you place the
cursor over the highlighted metadata, the meta key/meta value information is displayed in a
hover box.

RSA RESPOND

Navigate

Events

W - Broker \/

Events (100000+)

Outbound HTTP v

EVENT TIME

02/26/2018
09:40:41 am

02/26/2018
09:40:41 am

02/26/2018
09:40:41 am

02/26/2018
0%:40:41 am

02/26/2018
08:40:41 am

02/26/2018
08:40:46 am

02/26/2018
08:40:42 am

02/26/2018
09:40:42 am

02/26/2018
09:40:42 am

EVENT TYPE

Log

Log

Log

Log

Log

INVESTIGATE

Event Analysis

DECODER SOUR. T}

MONITOR

Hosts

L

L 02/26/2018 09:40:46.119
am

L

Files

Network Event Details

Download PCAP

NW SERVICE
Broker

LAST PACKET TIME

REQUEST
v Packet 1

000000
000016
000632
000048
1000064

@8

< Packet 2

000000
000016
000632
000048
1000864

@8

Vv Packet3

11 of 100000 events

CONFIGURE

ADMIN

Malware Analysis

02/25/2018 07:17:00 pm - 02/26/2018 07:16:59 pm

Text Analysis

SESSION 1D
727539

CALCULATED PACKET SIZE

2277783 bytes

HEADER META

eth.src = 00:00:00:00:00:00

02/26/2018 09:40:46.107 am

Packet Analysis

SOURCE IP:PORT
» ¥ 149204

CALCULATED PAYLOAD SIZE

2098053 bytes

1D 1018773

08 00 45 00
38 67 (4d 78
0 0 80 02
@3 08 01 o1

1D 1018774

08 00 45 00
38 67 (4d 78
0 0 80 02
@3 08 01 o1

b 1018787

File Analysis

Email f  Web 1

@ COMMON FILE PATTERNS
DESTINATION IP:PORT
w80

SERVICE
80

CALCULATED PACKET COUNT
3151

SEQ 3311600515  PAYLOAL SESSIONID

TIME

SvAETE size

' PAYLOAD
" mebiumM
ETH.SRC
PAYLOAE
ETH.SRC.VENDOR
ETH.DST
ETH.DST.VENDOR
| Emnrvee
IP.SRC
IP.DST
IP.PROTO
SEQ 3059262882 PAYLOAL TCP.FLAGS
TCP.FLAGS.SEEN

100~ PACKETS PER PAGE  TCP.SRCPORT

@ suaveevres @

EOO0M|x X
DISPLAY PAYLOADS ONLY

FIRST PACKET TIME
02/26/2018 09:40:46.107
am

727539

02/26/2018 09:40:46 am
33555892

31549606

1

00:00:00:00:00:00
XEROX CORPORATION
00:00:00:00:00:00
XEROX CORPORATION
2048

6

26

syn psh ack
49204

Common file signatures are highlighted with an orange background. When you place the cursor
over the highlighted text, the description of the file type is displayed in a hover box.
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Network Event Details | Text Analysis Packet Analysis  File Analysis  Email 7 Web [

ownload PCAP @ common FiLe PATTERNS (i) sHADE BYTES (@ | DISPLAY PAYLOADS ON

NW SERVICE SESSION ID SOURCE IP:PORT DESTINATION IP:PORT SERVICE FIRST PACKET TIME
727640 - ¥ 149527 i : 20 80 02/26/2018 09:40:49.8
Broker am

LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOAD SIZE CALCULATED PACKET COUNT

02/26/2018 09:40:49.813 2277074 bytes 2098469 bytes 3063
am

Packet 8 40 INTERESTING BYTES SEQ 2424526949

000240 Potential DOS Executable / Windows PE file
000256

000272 90

000288

000304

000320

000336

4 of 100000 events

The File Analysis Panel

The File Analysis panel shows a list of files associated with the selected network event. This is
an example of the File Analysis panel.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis
W - Broker v/

Events (20336) X Network Event Details | Text Analysis Packet Analysis  File Analysis Email o Web ™

Email Analysis v

EVENT TIME EvENT TYPE SERVICETYPE £}

NW SERVICE SESSION ID SOURCE IP:PORT DESTINATION SERVICE FIRST PACKET TIME
Crral e HrTR WA - 727705 I #:49261 173.194.41.160: 02/26/2018 09:40:43.364
09:40:43 am Broker am

LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOAD SIZE CALCULATED PACKET COUNT
267208 02/26/2018 09:56:21.062 87207 bytes 3975 bytes 1368
09:40:43 am am

02/26/2018
09:40:43 am

[]  FILE NAME MIME TYPE FILE $1ZE HASHES

0O 727705-107-0_2gf Image/gif 35 bytes SHAT: 0f4e929dd5bb2564f7ab9c76338e04e292a42ace  SESSIONID 727705

02/26/2018 MDS: 28d6814f3090a289fB47¢69cf91194c6 TIME 02/26/2018 09:40:43 am
09:40:43 am

size
727705-107-0_3.gif Image/gif 35 bytes SHAT: 0f4e929dd5bb2564f7aboc76338e04e292a42ace

02/26/2018 MDS: 28d6814f3090a289f847¢69cf91194c6
09:40:43 am MEDIUM
727705-107-0_1._utmgif  image/gif 35 bytes SHAI: 0f4e929dd5bb256417ab9c76338e04e292a42ace  ETH.SRC

02/26/2018 MDS: 28d681413092a289847c69c(91194c6
09:40:43 am

PAYLOAD

ETH.SRC.VENDOR  VMware, Inc.
ETH.DST

02/26/2018 ETH.DST.VENDOR  VMware, Inc.
09:40:43 am ETH.TYPE 2048

IP.SRC
02/26/2018

0%:40:43 am

1p.DsT
IP.PROTO 6

02/26/2018 TCP.FLAGS 27

09:40:43 am TCP.FLAGS.SEEN fin syn psh ack

TCP.SRCPORT 49261
02/26/2018

TCP.DSTRORT
09:40:43 am

SERVICE

02/26/2018 BRG] STREAMS
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You can select one file, one or more files, or all files to export to your local file system. When
files are selected, the Export Files button becomes active and reflects the number of files
selected.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Navigate Events EventAnalysis Hosts Files Malware Analysis

02/25/2018 07:17:00 pm - 02/26/2018 07:16:59 pm

Events (20336) X Network Event Details | Text Analysis Packet Analysis File Analysis Email 7 Web [7 EOOM|X X

EVENT TIME EVENT TYPE SERVICETYPE  £F

NW SERVICE SESSION ID SOURCE IP:PORT DESTINATION IP:PORT SERVICE FIRST PACKET TIME
el LT HrTe m o 727705 W 49261 ok 4 : 80 20 02/26/2018 09:40:43.364

09:40:43 am Broker am

02/26/2018
09:40:43 am

LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOAD SIZE  CALCULATED PACKET COUNT
02/26/2018 09:56:21.062 87207 bytes 3975 bytes 1368
am

02/26/2018
09:40:43 am

FILE NAME MIME TYPE FILE SIZE HASHES

727705-107-0_2.gif Imagergif 35 bytes SHA1: 0f4e929dd5bb2564f7ab9c76338e04e292a42ace  SESSIONID 727705

02/26/2018 MDS: 28d68141309ea289f847¢69c/91194c6 TIME

02/26/2018 09:40:43 am
09:40:43 am

sl
727705-107-0 3 gif image/gif 35 bytes SHAT: 014e929d5bb2564F7ab9C76338e04e292ad2ace. 64550

pIaZE MDS: 28068147309ea289/B47C69C191194c6 LAl B
09:40:43 am MEDIUM 1

727705107-01._utm.gf  image/gif 35 bytes SHA1: 0f45829dd5bb2564f7ab9c76338e04e292ad2ace  ETH.SRC 1A
021262018 MD5: 28d68147309ea2897847c69cf91194c6 ETH.SREVENDOR  VMware, Inc.
09:40:43 am

ETH.DST 97
0272612018 ETH.DST.VENDOR  VMware, Inc.
09:40:43 am ETH.TYPE 2048

IP.SRC
02/26/2018

1P.DST
09:40:43 am

1P.PROTO 3
02/26/2018 TCP.FLAGS 27

09:40:43 am TCP.FLAGS.SEEN  fin syn psh ack

TCP.SRCPORT 49261
02/26/2018 Warning; Files contain the original raw unsecured content. Use caution when opening or downloadin
files; ﬂrgmay contain maliciglus data. i J ECEDSTRCRD &

SERVICE 80

35 of 20336 events STREAMS 2

Caution: Caution is advised when unzipping and opening files that are associated with a
default application; for example, an Excel spreadsheet may automatically open in Excel before
you have a chance to verify it is safe.

Analytical Tools for Each Type of Event Analysis

The analytical tools in the Event Analysis view are designed to help analysts find the relevant
information for different types of events (network event, log event, and endpoint event). This
table lists the actions you can take by event type. The rest of this section provides procedures for
performing the actions.

. Network | Log | Endpoint
Action

Event Event | Event

View the Text Analysis panel v v v
View the File Analysis panel v

View the Packet Analysis panel v
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Network | Log | Endpoint

Event Event | Event

Open, close, and adjust the size of panels v v v
Adjust the display of requests and responses
Show or hide the Event Header in the Text Analysis panel

Expand truncated text entries in the Text Analysis panel

L < < «

Switch between a compressed and decompressed view of

payloads in the Text Analysis panel

View highlighted bytes in the Packet Analysis panel

Highlight common file types in the Packet Analysis panel

Display only the payload in the Packet Analysis panel

< < < «

Shade bytes in the Packet Analysis panel when viewing
payload only

<

Perform URL and Base64 encoding and decoding in the
Text Analysis panel

View decompressed text for an HTTP network session in v

the Text Analysis panel

View event metadata for an event in the Text Analysis v v v

panel

Download a network event (as a PCAP file, payload only, v
request only, or response only) in the Packet Analysis

panel or the Text Analysis panel

Export files from a network event in the File Analysis v

panel
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Network | Log | Endpoint

Event Event | Event

Download the file for a log event in the Text Analysis v

panel

Download the file for an endpoint event in the Text v
Analysis panel

Open the current endpoint event in Text Analysis panel v
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Filter Results in the Event Analysis View

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

In NetWitness SuiteVersion 11.0, you submit a query in the Navigate view or the Events view,
and when you go to the Event Analysis view, a read-only breadcrumb shows the submitted
query. You need to go to back to the Events view or Navigate view if you want to enter a
different query.

In Version 11.1 and later, a query builder populates the interactive breadcrumb in the Event
Analysis view so that you can create and edit each <meta key> <operator> <meta
value> filter in the breadcrumb. In addition, you can select a different service and time range
without going back to the Navigate view or the Events view. The remainder of this section
provides information about using the Version 11.1 query builder features.

How the Breadcrumb Works

When you click the Event Analysis option in Investigate to open the view, the service and time
range selector is displayed. By default, the first service is auto selected (unless you previously
selected a service and the selected service is in localStorage). If you do not select a time range,
the default time range is used. The query builder field is an empty field to the right of the time
range. The following figure illustrates the breadcrumb with only a service and time range
selected.

Navigate Events Event Analysis Hosts Files Malware Analysis < |

When you open the Event Analysis view from the Events view or the Navigate view, the
service, time range, and any filters that were selected in the Events view or Navigate view are
displayed in the breadcrumb. The service, time range, and individual filters can be modified.

Note: The query builder supports only simple filters in the form <meta
key><operator><meta value>. If the Events view or Navigate view has a filter with
more than one operator, ||,&&, (), REGEX, or LENGTH, the filter is added, but editing is not
supported in the Event Analysis view.

As you create filters in the query builder, the breadcrumb is updated with each filter in an
editable field. When you submit the query, all of the filters are AND'd to generate results. The
query is not submitted until you click Query Events. Filters line up from left to right, representing
the sequence in which the filters were created. Each filter is a simple expression of the form
<meta key> <operator> <optional value>. As more filters are added and they cannot
be displayed in a single line, they wrap to another line and the input area expands vertically so
that all filters are visible without scrolling to the right.
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As you create and edit filters, you are assisted with suggestions for auto-complete that show
only valid meta keys and operators in the drop-down list. You can type or select from the drop-
down list. In the drop-down list, operators that take more time to execute are marked by a
stopwatch icon. Invalid filters are marked by a red outline, and if you hover the mouse over the
filter, a message that explains the error is displayed.

The Query Events button is on the right side of the breadcrumb input, and is visible as needed to
input a query. New filters are applied when you click Query Events.

Note: If you change the service, a network call for data for reconstructions or the Events
panel (for example, Load More) uses the previous service/time range/metadata filters. It will
continue to use these previous query parameters until you submit the new query. When you
have a set of results loaded and you change the service, time range, or a filter, the Query
Events button turns blue as an indicator that the data in the view is stale. Even if you start to
edit any one of the parameters, and then decide not to, the Query Events button turns blue as
an indicator that you need to resubmit the query.

Keyboard Actions to Use in the Breadcrumb

The breadcrumb is designed to allow entry, editing, and deletion of filters from the keyboard
without having to use a pointer. Although you can use the pointer, you have the option to keep
your fingers on the keyboard. This table identifies the available keyboard actions when the
cursor is located in the Query Builder portion of the breadcrumb; these do not apply to the
service selector and time range.

Update the URL and resubmit the With focus on the Query Builder, press Enter.
query.

Select the filter to the immediate left ~ With no selection in the Query Builder, press the

if one exists. Left Arrow key.

Select the filter to the immediate right ~With no selection in the Query Builder, press the

if one exists. Right Arrow key

Insert a new filter to the immediate With a filter selected, press the Left Arrow key

left of the selected filter.

Insert a new filter to the immediate With a filter selected, press theRight Arrow key.
right of the selected filter.
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Insert a new filter to the immediate
left of the selected filter, and open for
editing.

Insert a new filter to the immediate
left of the selected filter, and open for

editing.

Select all filters to the right of the

current filter.

Select all filters to the left of the
current filter.

Deselect all filters.

Delete all selected filters.

Update query with only the selected
filters.

Open a new tab with the selected
filters.

Add a Filter to the Breadcrumb

With a filter selected, press the Shift + Left Arrow

keys.

With a filter selected, press the Shift + Right Arrow
keys.

With a filter selected, press the Shift + Down

Arrow keys.

With a filter selected, press the Shift + Up Arrow
keys.

With a filter selected, press the Escape key.

With filters selected, choose the right-click > Delete
selected filters option, press Delete, or press
Backspace.

With filters selected, choose the right-click > query
with selected filters option.

With filters selected, choose the right-click > query
with selected filters in a new tab option.

To filter the data displayed in the Event Analysis view:

1. Navigate to the Event Analysis view.

2. Toinsert a filter, click in the empty query builder field, or before or after an existing filter.
If the insertion point is between two filters, a green dot marks the insertion point. If the
insertion point is at the end of the existing breadcrumb, the filter entry field opens. This is an

empty query builder field.

Navigate Events Event Analysis

- Concentrator v

Hosts Files Malware Analysis

04/02/2018 03:05:00 pm - 04/03/2018 03:04:5!

169

Analyzing Raw Events and Metadata in the Event Analysis View



NetWitness Investigate User Guide

3. Click on the insertion point and a drop-down menu lists available meta keys to use in the new
filter. The available meta keys are passed from the service being investigated. If you start
typing, the list is updated to filter the meta keys.

S| - Concentrator v [ (©) 03/28/2018 11:00:00 pm - 03/29/2018 10:5%:59 pm / Query Events

device,class (Device Class)

device.group (Event Source Group)

No results yet. Please se device host (Devica Host)
device.ip (Device IP)
device.|pvé (Device IPv6)

device.name (Device Name)

QUERY FILTER EXAMPLES device.type (Device Type)

Find outbound HTTP events with a user agent of some versian of Mozila > | direction = ‘outbound | [ service =80 | [ client contains ‘ozl

Find falled login windows events > | device type begins ‘winevent' \ [ event.cat.name = user.activit.falled login' |

4. To select a meta key do one of the following:
a. If there is only one option in the drop-down menu, press the Space bar.

b. If there are two or more options in the drop-down menu, click on the meta key or use the

up/down arrow and press Enter.

c. Type the meta key and a space. As you type the meta key, the list is further updated.
With a meta key selected, a list of valid operators for the selected meta key is displayed.

Operators that require more time to process are marked by a stopwatch icon.

=] - Concentrator \ || (¥) 03/28/2018 11:00:00 pm - 03/28/2018 10:58:59 pm / ice. wi '+ % | eventcatname Query Events

No results yet. Please select a service, time range, and subi
=

begins
S ends

‘QUERY FILTER EXAMPLES 5 contains

5. To select an operator do one of the following:
a. If there is only one option in the drop-down menu, press the Space bar.

b. If there are two or more options in the drop-down menu, click on the operator or use the

up/down arrow and press Return.

c. Type the operator and press Enter.

The drop-down list closes and you can add a value if the operator accepts a value.

6. (Optional) Type a value and press Enter.

7. To create the filter, press Enter. If you click anywhere outside the box before pressing
Enter, the filter is not created.
The new filter is inserted, and the cursor is refocused after the last filter.
If there is an error in the filter, it is outlined in red. You can hover over the filter to see a tool

tip explaining the error.

8. Fix any filters that have errors.
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9. When you are ready to execute the query in the breadcrumb, click Query Events.

10. The Events List is refreshed to reflect the query.

Edit a Filter in the Breadcrumb

To edit a filter in the Query Builder:

1. Navigate to the Event Analysis view.

2. To edit a filter, double-click it, or click the filter and press Enter.
3. When finished editing, press Enter to update the filter.

4. To deselect the filter, click another filter.

5. If you want to execute the query again, click the Query button.
The Events List is refreshed to reflect the updated filter.

Query Using Selected Filters in the Breadcrumb

With two or more filters in the breadcrumb, you can refocus the same query to include only
selected filters. The results are displayed in the current browser tab or a new browser tab.

To update the query using only selected filters:

1. Begin with a breadcrumb that includes at least two filters, for example a query has three
filters: risk.info = exists, direction ="lateral", and threat.category

exists.

2. To open a new tab with the selected filters, right-click the query direction =
"lateral" filter and select query with selected filters in a new tab in the drop-down

menu.

Query with selected filters

Query with selected filters in a new tab

Delete selected filters
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A new tab opens with the results for the selected filter.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN () admin

Navigate Events Event Analysis Hosts Files Malware Analysis

- Concentrator \/ || () 03/08/2018 01:59:00 pm - 03/09/2018 01:58:59 pm \/

EVENTTIME  EVENTTYPE  DECODERSOU.. MEDIUM TRAFFIC FLO.. | SERVICETYPE  HOSTNAMEA.. SOURCE(P AD.. DESTINATION .. IPALIASES SOURCE ORGA.. DESTINATION .. SOURCECOU.. DESTINATION.. SOURCEDC ¥

03/08/2018 Network Network lateral
01:58:11 pm

03/08/2018 Network Network lateral
015%:11pm

03/08/2018 Network Network lateral
01:59:11 pm

03/08/2018 Network Network lateral
01:59:11 pm

03/08/2018 Network Network lateral
01:59:11 pm

03/08/2018 Network Network lateral
01:59:50 pm

03/08/2018 Network Network lateral
0200:11 pm

03/08/2018 Network Network lateral
02:00:11 pm

03/08/2018 Network Network lateral
02:00:11 pm

03/08/2018 Network Network lateral
0200:11 pm

03/08/2018 Network Network lateral
02:00:11 pm

03/08/2018 Network Network lateral

3. To query the selected filters in the same tab, click direction = "lateral" and
threat.category exists. Then right-click and select query with selected filters in the
drop-down menu.

x | direction = ‘lateral' = thre
= Query with selected filters.

Query with selacted filters in a new tab

TINATION ... [P ALIASES SOURC

Delete selected filters

Delete a Filter in the Breadcrumb

To delete a filter:

1. Click X in a filter, click on the filter to select it and press Delete , or right-click one or more

filters and select Delete selected filters in the drop-down menu.

2. If you want to execute the query again, click the Query button.
The selected filter is deleted and the Events List is refreshed.
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Examine Events in the Event Analysis View

When examining raw events and meta data in the Event Analysis view, you can make simple
adjustments in the visibility and size of the panels. Within the Packet Analysis panel and the
Text Analysis panel, you use additional features to adjust the way the reconstruction is displayed
and bring interesting data into focus.

Select the Event Analysis Type
To select the event analysis type for an event, do one of the following:
1. In the Event Analysis view toolbar, click the analysis type in the toolbar.

2. In the drop-down menu, select the analysis type: File Analysis, Text Analysis, Packet
Analysis, Email (Version 11.1 and later), or Web (Version 11.1 and later).
If you chose File Analysis, Text Analysis, or Packet Analysis, the view is refreshed with
the Packet Analysis panel, File Analysis panel, or Text Analysis panel open.
If you chose Email or Web, the Events view email or web recontruction of the single event
opens in a new tab. This is the same reconstruction of an email or web session used in the
Events view. The Events view provides more functionality when viewing an email or web
reconstruction, allowing you to page through events in that view instead of viewing only one

event (see Reconstruct an Event).

Note: The Packet Analysis panel is only available for network events.

Open, Close, and Adjust the Size of the Panels in the Event Analysis View

The Event Analysis view opens with the Event list and no event selected or reconstructed. When
you select an event, the Network Event Details, Log Event Details, or Endpoint Event Details
panel opens on the right. Initially, the Network Event Details, Log Event Details, or Endpoint
Event Details panel occupies 75% of the window width by default.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Navigate Events EventAnalysis Hosts Files Malware Analysis
- Concentrator v || (1) 02/25/2018 07:06:00 pm - 02/26/2018 07:05:59 pm \/

Events (20336) 7 X Network Event Details | Text Analysis Packet Analysis  File Analysis  Email 7 Web 7 EOOCMm|~ X

Summary List Y Download PCAP @ | DISPLAY COMPRESSED PAYLOADS

EVENT TIME EVENT TYPE THEME

NW SERVICE SESSION 1D SOURCE IP:PORT DESTINATION IP:PORT SERVICE FIRST PACKET TIME
02/26/2018 Network HTTP 0T i Tl 12 W - 49527 A 20 80 02/26/2018
09:40:46 am Concentrator 09:40:49.803 am
LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOAD SIZE  CALCULATED PACKET
2277074 bytes 2098469 bytes S

02/26/2018 02/26/2018
09:40:52 am 09:40:49.813 am

02/26/2018
09:40:46 am

REQUEST

GET /flashupdate64.exe HTTP/1.1 SESSIONID 12
021262018 Accept: */* TiME 02/26/2018 09:40:49 am
Cx 25X Accept-Encoding: gzip, deflate e B
02/26/2018 User-Agent: Mozilla/4.@ (compatible; MSIE 7.0; Windows NT 6.1; WOW64; ERILOAD 31669690
09:40:58 am Trident/4.0; SLCC2; .NET CLR 2.0.50727; .NET CLR 3.5.30729; .NET CLR MERIIM d

3.0.30729; Media Center PC 6.0) ETH.SRC

02/26/2018 T 2 an o ETH.SRC.VENDOR  Intel Corporate

054045 am Connection: Keep-Alive frLosT el
02/26/2018 ETH.DST.VENDOR  Clsco-Linksys, LLC
09:41:04 am ETH.TYPE 2048

Showing < 1% RESPONSE IP.SRC

02/26/2018 1p.DST

09:40:59 am HTTP/1,1 200 0K
Server: W

TCP.FLAGS 30
0212672018
054047 am Date: Sat, 15 Mar 2014 04:95:44 GMT TCPFLAGESEEN  syn rstpsh ack

4.0f 20336 events TCP.SRCPORT 49527

IP.PROTO 6

You can adjust the size ratio of the two panels to improve readability by expanding one of the
panels, contracting one of the panels, and closing one of the panels. After closing either panel
you can reopen it. The ratio you select persists until you change it or refresh the browser.

« To reopen the Events panel, click [[] in the upper right corner.

To optimize your view:
1. To adjust the size ratio of the two panels, do any of the following:
a. Click M in the tool bar of the panel that you want to expand.

b. Click H in the tool bar of the panel that you want to contract.

2. To close either panel, restoring the open panel to its full width, click B.

This is an example of the reconstruction displayed using the full width of the browser
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window.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis
W% - Broker v 2/25/2018 07:17:00 pm - 02/26/2018 07:16:59 pm

Network Event Details | Text Analysis Packet Analysis  File Analysis  Email 1 Web [ OGN X

Download PCAP - @ common riLe pATTERNS (@) sHADE BYTES @ ) DISPLAY PAYLOADS ONLY

NW SERVICE SESSION ID SOURCE IP:PORT
e - v

DESTINATION IP:PORT SERVICE FIRST PACKET TIME
W - Broker M : 80 80

: 49527 102/26/2018 09:40:49.803 am

LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOAD SIZE CALCULATED PACKET COUNT
02/26/2018 09:40:49.813 am 2277074 bytes 2098469 bytes 3063

REQUEST
v Packet1 02/26/2018 09:40:49.803 am 1D 2660141 SEQ 1800387166 PAYLOAD 0 Bytes

000000 de 00 1b 45 (] C o+ N . . E
000016 34 () 80 [ o5 95 - - - - . h .
000032 50 6b 4f 30 0z . .
000048 0 0z 84 L o1

000064

V' Packet 2 02/26/2018 09:40:49.803 am 1D 2660142 SEQ 1800387166 PAYLOAD 0 Bytes

000000 de L) ib 45 (] s N, . . E
000016 34 20 80 6 o5 95 - . (e, - [
000032 50 6b 4f 80 02 w . P kK 0 ° . .
000048 [ 02 o4 oL 1 . ¥ ... .

000064

RESPONSE
v Packet 3 /26/2018 03:40:49.803 am 1D 2660143 SEQ 2424526948 PAYLOAD 0 Bytes

00000 58 6d s 0 R E b
000016 e | @ a8 . . e
000032 68 20 8 g0 12 . . PIA
000048 ] P § .
008064

x (X m : .
s VA -

40f 100000 events > D v PACKETS PER PAGE

3. To reopen the Events panel after closing, click [[] in the top right corner of the Navigate

view.

The Events panel opens to the last state (25%:75% or 50%:50%).

4. To reopen the Event Details panel, click an event in the Events panel.

Select a Column Group and Columns in Event Analysis

In Version 11.1 and later, you can use built-in or custom column groups in the Events panel. The
column groups are created and managed in the Events view (see Manage Column Groups in the
Events View); these groups are reflected in the Event Analysis view. When you change the
column group, the changes you make to a column group are for the current view only. When you
navigate away and come back to the Event Analysis view, the column changes do not persist in
the Events panel.

These are the built-in column groups.

o Email Analysis: Includes meta keys that are useful when investigating email-related

metadata.

o Endpoint Analysis: Includes meta keys that are useful when investigating endpoint-related

metadata.

o Malware Analysis: Includes meta keys that are useful when investigating malware-related

metadata.
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o Outbound HTTP: Includes meta keys that are useful when investigating Outbound HTTP-

related metadata.

e Outbound SSL/TLS: Includes meta keys that are useful when investigating Outbound
SSL/TTS analysis-related metadata.

o Summary List: Includes meta keys that are useful in a general investigation. This is the

default column group.
o Threat Analysis: Includes meta keys that mark potential threats in the data set.

o Web Analysis: Includes meta keys that mark anomalies in web traffic.

A column group may contain more columns than are visible without scrolling to the right. In
Version 11.1, you can select the columns that appear in Event Analysis view. The order of the
columns reflects the order in the Events view of the default column group. By default, the first
15 columns are displayed when you select a column group. For optimized viewing, it is advised
to view only 15 columns at a time; however, you can select additional columns to display and
remove columns displayed.

To select a column group:

1. From the drop-down menu next to Events, select a column group (for example, Summary
List). You can also start typing the name of the column group and select a group as the

groups appear in the drop-down menu.

Events

Summary List W

Default Column Groups

Email Analysis

Endpoint Analysis
Malware Analysis
Outbound HTTP
Outbound SSL/TLS
Summary List

The Events panel displays data in the columns that belong to the selected column group.
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To select columns to display:

1. While working in the Event Analysis view, with a column group selected, click E to display

the column selector.

e to filter the list

Event Time

Event Type

Service Type
Originating IP Address
Source IP Address
Destination IP Address
TCP Destination Port
Destination Port

Hostmame Aliases

Source Country

Destination Country
Source Organization
Destination Organization

Subject

Source E-mail Address

2. Select the meta keys or enter the name of a meta key that you want to display in additional

columns.

3. If you do not want to see a meta key displayed in a column, de-select the meta key.

The data is re-displayed using the selected columns.

Adjust the Display of Requests and Responses

For Event types that have requests and responses in them, you can make several adjustments.

Note: If the analysis type does not have requests and responses, the option is not selectable.
The File Analysis panel is an example of a reconstruction type without requests and
responses. A reconstructed log event in the Text View is another example.

To select which side of the conversation to show--Request, Response, or both--click one or both

00
of the direction icons.l. The reconstruction is refreshed with the selected information.

Note: If you do not see any data, you may have deselected both Request and Response. You
must select one of the two to see data displayed.
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View Event Metadata for an Event

When examining events in the Text Analysis panel, Packet Analysis panel, or File Analysis

panel, you can click . to show the associated metadata in an adjacent panel, the Event Meta
panel.

When viewing Text Analysis and the Event Meta panel, hovering over the meta key/meta value
pairs reveals a pair of binoculars if the meta value is searchable in the raw text. This is an
example of the binoculars icon when hovering over the Directory and / meta key/meta value
pair.

DIRECTORY fola)

FILENAME signup 1of26results ~ VvV

Clicking on the icon triggers a search for the meta key/meta value pair (case-insensitive) in the
Text Analysis panel and each instance is highlighted. In the Event Meta panel, the highlighted
row has a count of the results and a scroller that you can use to quickly find each result in the
Text Analysis panel. You can view each highlighted location of the data that triggered
generation of the meta key, going forward to view the next, and back to view the previous.

Only meta keys that have relevant values inside the RAW text are searchable. You can search
only one meta key at a time. If the value is currently hidden due to truncation of a text entry with
more than 3000 characters, the text entry is expanded to reveal the found meta value.

Clicking on the same meta key/meta value pair or a different meta key:value pair in the Event
Meta panel removes the highlighting from the raw text. The highlighting is also removed if you
close the Event Meta panel.
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To search the raw text for meta values that triggered a meta key:

1.

Open a network event in the Text Analysis panel.
RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis

Events (20336) & X Network Event Details | Text Analysis Packet Analysis ~ File Analysis Email 7 Web [ EOOCMN| X

Summary List v Download PCAP @ ) DISPLAY COMPRESSED PAYLOADS

EVENT TIME EVENT TYPE THEME

NW SERVICE SESSION ID SOURCE IP:PORT 1P:PORT SERVICE FIRST PACKET TIME
02/26/2018 Network HTTP e £ AMNILEATT - 112 > - ¥ 149527 S : 20 20 02/26/2018
09:40:46 am Concentrator 09:40:49.803 am
LAST PACKET TIME CALCULATED PACKET SIZE  CALCULATED PAYLOAD SIZE  CALCULATED PACKET

2098469 bytes s

2277074 bytes 32063

02/26/2018 02/26/2018
08:40:52 am 09:40:49.813am

021262018
09:40:46 am

REQUEST

GET /flashupdate64.exe HTTP/1.1 SESSIONID 112

Accept: */* TIME 02/26/2018 09:40:49 am
Accept-Encoding: gzip, deflate S1zE 33557342

027262018 User-Agent: Mozilla/4.0 (compatible; MSIE 7.0; Windows NT 6.1; WOW64; LLALD 31669890

09,4058 am Trident/4.0; SLCC2; .NET CLR 2.0.50727; .NET CLR 3.5.3729; .NET CLR MepiuM !

3.0.30729; Media Center PC 6.0) ETH.SRC
Host: 1§ i A ETH.SRC.VENDOR  Intel Corporate

02/26/2018
09:40:49 am

02/26/2018
08:40:45 am ETH.DST St ot o+ 24E
Connection: Keep-Alive
e — ETH.DST.VENDOR Cisco-Linksys, LLC
09:41:04 am ETH.TYPE 2048
Showing < 1% RESPONSE  IPSRC

0212672018 1P.DST

09:40:59 am HTTP/1.1 208 OK
Server: Wi

TEP.FLAGS 30
0212612018
g Date: Sat, 15 Mar 2014 @4:05:44 GMT TEPFLAGSSEEN  synrst psh ack

40f 20336 events TCP.SREPORT 49527

1P.PROTO 3

In the toolbar, click . to open the Event Meta panel. As you hover over the meta key:value

pairs in the list, a binoculars icon identifies values that are searchable in the Text Analysis

panel.

To search for the value in the raw text, click a row that has the binoculars icon, indicating it
is searchable.

If no relevant occurrence of the value is in the text, the value that you are searching for is
highlighted in the Event Meta panel and nothing is highlighted in the Text Analysis panel.

If one or more relevant instances of the value is found in the Text Analysis panel, each
occurrence is highlighted. The value that you are searching for is highlighted in the Event

Meta panel and the scroller is visible.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Navigate Events EventAnalysis Hosts Files Malware Analysis
%% - Broker v pm - 02/26/2018 07:16:59 pi

Events (20336) " X Network Event Details | Text Analysis Packet Analysis File Analysis  Email 7 Web [ EOOCHm| X

Email Analysis v Download PCAP @ | DISPLAY COMPRESSED PAYLOADS

EVENT TIME EVENT TYPE SERVICETYPE I

NW SERVICE SESSION 1D SOURCE IP:PORT DESTINATION IP:PORT SERVICE FIRST PACKET TIME
054043 am MR - 727684 W 149254 :80 80 02/26/2018 09:40:43.364
Broker am
021262018 LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOAD SIZE CALCULATED PACKET COUNT
1387

09:40:43 am 02/26/2018 09:56:16.295 84894 bytes 551 bytes
am

02/26/2018

):40: TCP.FLAGS 27
o REQUEST

02/26/2018 GET ZIP.php HTTPZ1,1

09:40:43 am User-Agent: Mozilla/5.@ (Windows; U; Windows NT 6.0; en-US) AppleWebKit/535.1 N — o
(KHTML, like Gecko) ChromeZ13.0.782.107 Safarif535.1 .

02/26/2018 SERVICE 80

e Referer: http://google.com STREAMS a
Accept-Encoding: gzip,deflate,gzip

02/26/2018 Accept-Charset: IS0-8859-1,utf-8;9-0.7,%; q=0.7

09:40:43 am Host: clickcashmagnet.com

02/26/2018 Connection: Keep-Alive

TCPFLAGS.SEEN fin syn psh ack
TCP.SRCPORT 49254

PACKETS
LIFETIME F1]
RPACKETS 43
RPAYLOAD 4959
09:40:43 am NETNAME other dst

NETNAME private src
02/26/2018 RESPONSE

DIRECTION outbound
09:40:43 am

HTTP/1.1 200 0K AcTioN get

02/26/2018 Date: Sun, 04 May 2014 22:49:42 GMT DIRECTORY ’ LY

09:40:43 am Server: Apache FILENAME 1P.php 3of 11resuits A W
= -By: EXTENSION hy

022672018 X-Powered-By: PHPZ5.3.28 php

08:40:43 am Keep-Alive: timeout=5, max-100 Mozilla/5.0 (Windows; U; Windows
Connection: Keep-Alive NT 6.0; en-US) AppleWebKit/s35.1

CLIENT
02/26/2018 20 of 20336 events. (KHTML, like Gecko)

4. To remove the highlighting, close the Event Meta panel, click the same meta key/meta value
pair in the Event Meta panel, or click a different meta key/meta value pair in the Event Meta
panel.

The highlighting is removed from the raw text.

Show or Hide the Event Header

To hide the Event Header in the Packet Analysis panel, Text Analysis panel, or File Analysis

panel, providing more vertical space for the data, click ﬁ

Page Through Events in the Packet Analysis Panel

In Version 11.1 and later, packet pagination controls allow more flexibility in paging through a
list of packets. You can select the number of packets to display per page, and your selection is
saved across logins to the NetWitness application. When a control is unavailable, the control is
dimmed; for example, when you are viewing page 1, the M and M4 controls are dimmed.

To use pagination controls:

1. With an event open in the Event Analysis view, click the current number of packets per page

(100, 300, or 500), and select the new number of packets per page from the drop-down menu.
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2. To page forward or back, use the page control icons:
Click K to go to the next page.

Click P24 to go to the last page.
Click M to go the previous page.
Click M to go to the first page.

3. To go to a specific page, type a page number in the page number field L

Expand Truncated Text Entries in the Text Analysis Panel

A reconstruction of a network event in the Text Analysis panel may include requests and
responses of many hundred thousands of characters and scrolling through a long entry of more
than 6000 characters that is not of interest can waste time. To improve the experience for
analysts, all text entries that have more than 6000 characters are truncated to show only the first
2000 characters. This example shows an entry that has more than 2000 characters and a
message in the header indicates the percentage of total characters that is being displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Navigate Events Event Analysis Hosts Files Malware Analysis
W - Broker v || (1) 02/25/201807:17:00 pm - 02/26/2018 07:16:50 pm \/

Events (100000+) " X Network Event Details | Text Analysis Packet Analysis File Analysis Email 7 Web 7

=

EVENT TIME EVENT TYPE SERVICE TYPE | £}

NW SERVICE SESSION ID SOURCE IP:PORT DESTINATION IP:PORT SERVICE FIRST PACKET TIME
i w443

02/26/2018 Network HTTP - - . 727648 - 51261 02/26/2018 09:40:48.842
09:40:46 am Broker an

LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOAD SIZE CALCULATED PACKET
02/26/2018 02/26/2018 09:40:48.854 2375738 bytes 2098312 bytes ;‘;;;T
09:40:52 am Ew

02/26/2018 Showing 60% RESPONSE

09:40:46 1
o 140212000000 . SESSIONID 727648

021262018 29021123595970691.0 -0...U....Greater TiMe 02/26/2018 03:40:48 am

09:40:49 am Manchester1.0. ..U. .. .Salford1.0...U, sizE 33556598

..COMODO CA Limited16@4..U...-COMODO RSA Domain Validation Secure Server PAVLOAD 30901562

CrO®. "0 MEDIUM 1

. *9HOO ETH.SRC

02/26/2018 .. .09, ETH.DST

03:40:45 pm o . OY99850, 0. 00I0d0.b.E. . 006.. . 60I. €. 900.9>.0001.0. ETH.TYPE

02/26/2018 GOk 066/20> hsne

09:40:45 am OL°GEAR/4QHSdOAS . 9999002059 ; | 99 OU0OG 1p.0ST
190"900000N0p. " 069-. 00600600000 01 0M90%6O IESECTO &

02/26/2018 TCP.FLAGS 27
09:41:04 am

02/26/2018
09:40:58 am

TCP.FLAGS.SEEN  fin syn psh ack
02/26/2018 TCP.SRCPORT 51261
09:40:59 am REQUEST TCP.DSTPORT

«...F...BA. 9909 SERVICE

0108V QONNOO,0. OOND' €. 950 . V4700; 0050 00EOOPISa0 IO H, ... STEAMS

PO, 00000000 PACKErS

LIFETIME

02/26/2018
09:40:47 am

02/26/2018 -
0940047 srm 6 of 100000 events R RCErTS

You can see that 60% of the characters (the first 2000) are displayed, and click Show
Remaining 40% to reveal the rest of the entry.
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QUERY EVENTS NAVIGATE EVENTS MALWARE ANALYS

Results for:  concentrator 05/01/2017 15:58:59

EVENTS ( 1000 OF 100000+ )

Network Event Details | Text Analysis Pac ) EooMm|

TIME EVENT TYPE

10/08/2008 13..  Network Download PCAP - Display Compressed Payloads

NW SERVICE SESSION ID SOURCE IP:PORT DESTINATION IP:PORT SERVICE FIRST PACKET TIME
10/0B/2008.13.. concentrator 17 80 10/15/2008
15:46:48.991

. LAST PACKET TIME PACKET SIZE PAYLOAD SIZE PACKET COUNT
10/08/2008 13..  Network 10/15/2008 92887 bytes 85905 bytes 129
15:46:52.886

10/08/2008 13.. Network

dwr.engine._execute(URIIncludeService._path, "URIIncludeService'
10/15/2008 11... 'addAdvisor', p@, callback);
}
10M52008 11..  Network URIIncludeService.addAdvisor = function(p@, pl, callback) {
dwr,engine,_execute(URIIncludeService._path, 'URIIncludeService'
'addAdvisor', p@, pl, callback);

SESSIONID 17

TIME 10/15/2008 15:46:48.000
SIZE

PAYLOAD

MEDIUM

10/15/200811..  Network ETHSRE
£ ETH.DST 00:AD:C5:CAABITE
URIIncludeService.setTargetSource = function(p@, callback) { ETH.TYPE 2048
dwr.engine._execute(URIIncludeService._path, '"URIIncludeService' IP.SRC

'setTargetSource', p@, callback); IP.DST

10/15/2008 11... Network

10/15/2008 1. Network 3 IP.PROTO
URIIncludeService.isProxyTargetClass = function(callback) { TCP.FLAGS
dwr.engine._execute(URIIncludeService._path, "URIIncludeService' TCP.SRCPORT
'isProxyTargetClass', callback); TCP.DSTPORT
3} SERVICE

10/15/2008 11.. Network

10/15/2008 11... N rk . .
e URIIncludeService.getTargetClass = function(callback) { STREAMS

dwr.engine._execute(URIIncludeService._path, 'URIIncludeService' e

If you search for metadata seen in the Event Meta panel while text is truncated in the Text
Analysis panel, the truncated text is searched. If the metadata exists inside hidden text, the text
entry expands to reveal the text with the found metadata.

Perform URL and Base64 Encoding and Decoding in the Text Analysis
Panel

If a network session being reconstructed in the Text Analysis panel contains Base64 or URL
encoded strings, you can decode a string to better understand the session. If the session contains
decoded strings for Base64 or URL, you can view a string in its encoded form in order to search
for additional instances of the encoded text in other sessions.

When viewing any network session that contains encoded text in the Text Analysis panel, you
can select a subset of the text within a single Request or Response to view in either encoded or
decoded form. Depending on the content loaded on the Decoder, there may be additional
metadata outlining that Base64 or URL encoded data is contained within the session.

Below are examples of a hover box that is displaying URL encoding and Base 64 encoded text.
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Packet View File View  Text View

Download PCAP

DEVICE SESSION MEDIUM TYPE
Concentrator64 1 1 Network

SERVICE FIRST PACKET TIME LAST PACKET TIME PACKET SIZE
80 10/31/2016 08:02:44.774 pm 10/31/2016 08:02:56.957 pm 5,912 bytes
FLAGS

Keep, Assembled, App Meta,
Network Meta

ENCODED TEXT

ORIGINAL SELECTION
Conneci httpy

Authori @ oamar W@d218bmVzcw==
Upgrads

User-A :osh; Intel Mac 0S X 10_11_4) AppleWebKit/537.36 (KHTML, like
Gecko) :;;q:g:;;;%zp 1ri/537.36

Accept. coaw nwues ppoeue oo AEmlexml ,application/xml;g=0.9, image/webp,*/*;q=0.8

Referer: http://10.25.51.226:50105/concentrator?msg=help&op=messageskhtml-view=explorer&force-
content-type=text/html

Accept-Encoding: gzip, deflate, sdch

Accept-Language: en-US,en;g=0.8

Packet View  File View  Text View EoOOm|

Download PCAP @ ) Display Compressed Payloads

DEVICE MEDIUM TYPE

Concentrator64 DECODED TEXT 1 Network 61949

SERVICE ORIGINAL SELECTION LAST PACKET TIME PACKET SIZE PAYLOAD SIZE PACKET COUNT
80 10/31/2016 08:02:56.957 pm 5,912 bytes 4,856 bytes 16

SOURCE 1P:PORT DESTINATION IP:PORT
o H - 5

0105

FLAGS
Keep, Assembled, App Meta,  sasces rormar
Network Meta

URL FORMAT

eep-alive
Authorization: Basic YWRtaW46bmV@d21@bmVzow=—
Upgrade-Insecure-Requests: 1

size
PAYLOAD
MEDIUM
User-Agent: Mozilla/5.@ (Macintosh; Intel Mac 0S X 10_11_4) AppleWebKit/537.36 (KHTML, like ETH.SRC
Gecko) Chrome/54.0.284@.71 Safari/537.36 ETH.DST
Accept: text/html,application/xhtml+xml,application/xml;q=0.9,image/webp,*/*;q=0.8 ETH.TYPE
Referer: http:// ¥ "% :50105/concentrator?msg=help&op=messages&html-view=explorer&force- H31=
content-type=text/html 1P.DST
Accept-Encoding: gzip, deflate, sdch 1P.PROTO
Accept-Language: en-US,en;q=0.8 WAL
TCP.SRCPORT
TCP.DSTPORT
SERVICE
STREAMS
HTTP/1.1 200 0K PACKETS
Content-Length: 5@ LIFETIME
Connection: Keep-Alive NETNAME private dst
Pragma: no-cache NETNAME private src
Expires: -1 DIRECTION lateral
Cache-Control: no-cache, no-store, must-revalidate AcTION get
Content-Type: text/plain; charset=utf-8 DIRECTORY ¥
FILENAME concentrator
The process is being restarted due to data reset FXTENSION SR

msg=help&op=manual&&format=htmiafor
QUERY

1 0f 100000 ce-content-type=text/htmi&m=reset

To perform encoding and decoding in the Text Analysis panel:

1. Inthe Event Analysis view, go to the Text Analysis panel of a session that contains encoded
or decoded content.
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2. To view some decoded text in encoded form, drag to select the text within a single Request

or Response.

A menu offers options to encode and

decode.

POST /e4.php?h=b31kd@agahv HITP/1 1
Accept: */% Copy Selected Text
Content-Type: app| Decode Selected Text urlencoded

Connection: Close Encode Selected Text
Content-Length: 9%

User-Agent: Mozilla¥4.@ (compatible; MSIE 7.9; Windows NT 6.1; WOW64;

Trident/4.@; SLCC2; .NET CLR 2.8.50727; .NET CLR 3.5.30729; .NET CLR
3.0.30729; Media Center PC 6.8)

Host: loverocksusa.com

Cache-Control: no-cache

y=B9fb732e76c6e69536945202273ad5be fdcab159f celaeb6e672a97524e@edad4baddecsd
47039113da638715%ab

3. Click Encode Selected Text.
The encoded text is displayed in a hover box, which remains in place until you click the B,
select different text in the Text Analysis panel, close the Events panel, select another event

for reconstruction, or switch to a different reconstruction view.

ULATED PACKET

ENCODED TEXT

ORIGINAL SELECTION

/4.0 (compatible
POST /e4.php?l T

Accept: */* LzQUMCAOY20tcGF0aW)sZQ==

Content-Type: :ncoded
URL FORMAT

Connection: C] 9%2F4.0%20(compatible
Content-Length™2%

User-Agent: Mozillaf4.@ (compatible; MSIE 7.0; Windows NT 6.1; WOWG4;
Trident/4.8; SLCC2; .NET CLR 2.0.58727; .NET CLR 3.5.3@8729; .NET CLR
3.0.30729; Media Center PC 6.8)

Host: loverocksusa.com

Cache-Control: no-cache

y=89fb732e76c6e095369485202273ad5be fdcab159f celaebbeb? 209752 4ebedad4bdddacsd

When a longer text is selected, the hover box is scrollable and large enough to fit the entire

selected text as well as the decoded text.

4. If the session contains encoded text that you want to see in decoded form, drag to select the
text within a single Request or Response.

A menu offers options to encode and decode.
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5. Click Decode Selected Text.

The decoded text is displayed in a hover box, which remains in place until you click B,

select different text in the Text Analysis panel, close the Events panel, select another event

for reconstruction, or switch to a different reconstruction view.

6. If you want to copy some text from the text reconstruction do one of the following:

a. Drag to select some text, right-click, and select Copy Selected Text from the popup

04:36:28.936 am

POST /e4.php?h=b3lkdAaachv HTTP/1.1
Accept: */* Copy Selected Text
Content-Type: app) Decode Selected Text urlencoded

Connection: Close Encode Salected Text
Content-Length: 9%

User-Agent: Mozilla/4.@ (compatible; MSIE 7.®; Windows NT 6.1; WOWG4;
Trident/4.8; SLCC2; .NET CLR 2.8.50727; .NET CLR 3.5.38729; .NET CLR
3.0.30729; Media Center PC 6.8)

Host: loverocksusa.com

Cache-Control: no-cache

y=89fb732e76c6e6953694e5202273ad5be fdcab159f celaebbeb672a97524ebedad4biddecd
47a39113da6387159ab

b. Drag to select some text, then select either Decode Selected Text or Encode Selected

Text. Within the popup, select the desired text and type Control-C.

The selected text is copied to the clipboard and available to paste in a query.

7. When finished, click B to close the hover box.

View Decompressed Text in an HTTP Network Session in the Text Analysis

Panel

When the content of an HTTP network session is compressed and you are viewing the Text
Analysis panel, NetWitness Suite displays decompressed content by default. This helps you to
determine if there are any patterns and view the readable characters. You can switch between a
compressed and decompressed view of compressed text.

Note: Decompressed text is not available for the Packet Analysis panel, the File Analysis
panel, non-HTTP network sessions, and log data.

The toggle for changing between compressed and decompressed text is only displayed in the
Text Analysis panel, and is enabled only if there is compressed text content.

1. Open the Text Analysis panel of an HTTP session that contains compressed content.

By default the session is reconstructed with the text decompressed, and above the
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reconstruction, is the Display Compressed Payloads toggle switch.

pm - 08,
Metwork Event Details | Text Analysis
Download PCAP |

NW SERVICE SESSION ID

- 288126

SOURCE IP:PORT

49212
Concentrator

LAST PACKET TIME CALCULATED PACKET SIZE

09/20/2017 53645 bytes
04:36:29.335 am

CALCULATED PAYLOAD SIZE

46139 bytes

~00"acd%hoooc R'®a.. .IDATxi%=GF0+}6AL10*0E]. .A-00
YAn+, LAfo: NgCR  [AN
%B| DAy.#0A.3.1+U|0==£5. . "ESEN*. ..0;87-K
_UkRX0Xz 881p. yle
@......\.

180 of 21934

2. To view the same text in its compressed form, click the toggle switch.

DESTINATION IF;PORT

S 80

CALCULATED PACKET
COUNT

129

SERVICE

80

SESSIONID
TIME

SIZE
PAYLOAD
MEDIUM
ETH.SRC
ETH.DST
ETH.TYPE
IP.SRC
NETNAME
IP.DST
NETNAME
DIRECTION
IP.PROTO

TCP.FLAGS

TrE EILAGE SEEN

EOoOOCHmN|

@ | DISPLAY COMPRESSED PAYLOADS

288126
05/20/2017 04;
198500

184556

1
00:00:00:00:00:00
00:00:00:00:00:00
2048

private src

other dst
outbound
(4

7

fir eum neh sk

The view changes so that the compressed text is no longer readable, and the switch indicates

the Display Compressed Packets is on.

pm - 08,

Network Event Details Text Analysis

Download PCAP

NW SERVICE SESSION ID

288126

SOURCE IP:PORT
49212
Concentrator

LAST PACKET TIME
09/20/2017
04:36:29.335 am

CALCULATED PACKET SIZE

53645 bytes

CALCULATED PAYLOAD SIZE

46139 bytes

BTN S R'®a.. .IDATxi%=GF0+}6AL10*0E]. .A-00
YA+, LAEm:  BgCR [AR
%01 DAy.#0A.3.1+U10=£y

LE_U#Rx0Xz
@......\.

SSEN*. . .0;87~K
8sip.yle

180 of 21934

DESTINATION IF:PORT

S 80

CALCULATED PACKET
COUNT

129

SERVICE

80

SESSIONID
TIME

SIZE
PAYLOAD
MEDIUM
ETH.SRC
ETH.DST
ETH.TYPE
IP.SRC
NETNAME
1P.DST
NETNAME
DIRECTION
IP.PROTO

TCP.FLAGS

TCE ELAGE SEEN

3. To return to the view of decompressed text, click the switch again.

EOOCMN|
. DISPLAY COMPRESSED PAYLOADS

FIRST PACKET TIME
09/20/2017
04:36:24.888 am

288126
09720217
198500

184556

1

00:00:00: 00
00:00:00:00:00:00
2048

private src

other dst
outbound
6

7

fin £um neh ark
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Use the Payload Only Option in the Packet Analysis Panel of a Network

Session

When viewing a reconstruction of a network session in the Packet Analysis panel, you can
choose to view only the main payload for each packet. By default, packet header and footer
bytes are displayed for each packet. You can hide these by clicking the Display Payloads Only
toggle switch. If you are viewing only the payload bytes, you can revert to the default setting by
setting the Display Payloads Only toggle switch to on. This setting persists until you change it or
refresh the browser.

« With the Display Payloads Only option off, the number of packets, packet header, packet
footer, and payload are displayed.

« With the Display Payloads Only option on, no packet header and footer bytes are displayed.
Only the packet content of 16 hexadecimal bytes per line and the corresponding ASCII per
line is displayed.

1. In the Event Analysis view, go to the Packet Analysis panel of a network session.

By default the session is reconstructed with the packet header, footer, and payload displayed.

RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN
Navigate Events EventAnalysis Hosts Files Malware Analysis
- Concentrator \/ || (3) 2018/02/20 19:19:00 - 2018/02/21 19:18:59 /

Events (100000+) " X Network Event Details | TextAnalysis Packet Analysis ~File Analysis  Email 7 Web 7 EOOCMm| X

SUmmary sy v Download PCAP [ v | @) common FiLe PATTERNS (I SHADE BYTES @) DISPLAY PAYLOADS ONLY

EVENT TIME EVENT TYPE
19:05:40 Nw sERvICE SESSION 1D SOURCE 1P:PORT DESTINATION 1P:PORT sERvICE FIRST PACKET TIME

#4 - Concentrator 886 11041 W :80 80 2018/02/21 19:05:40.083
201802721 Network LAST PACKET TIME CALCULATED PACKET SiZE CALCULATED PAYLOAD SIZE CALCULATED PACKET COUNT
19:05:40 2018/02/21 19:05:40.219 91737 bytes 85665 bytes 112

201802721 Network

REQUEST
19:05:40

Packet 1 2018/02/21 19:05:40.083 1D 462627 SEQ 4202632921 PAYLOAD 0Bytes  SESSIONID 886

000000 00 02 02)(52 54|00 00) 45 00 BE. TME S ERED
000016 bd (40 00 80) 06 (a2 RS e UL sz 180858
[} >

2018/02/21 Network:
19:05:40

000032 11000 50) fa 7f 16 % 00 00 70 02
20isn2r2s (e 000043 79 00 00 02 04 05 02 .
19:05:40 MEDIUM 1

Packet 2 2018102721 15:05:40.083 1462628 SEQA202632921  PAYLOADOBYtS  prw.smc ey

PAYLOAD 171330

201802721 Network

e 000000 00 02 02)(52 54100 08 00/ 45 00 RU....RT. .4V . JE. ETHOST 52:55:0A00:02:02
05 000016 bd (40 00)(80(06(d2 of 48 15 . 0. %@ JHLT emwavee 2048
000032 1100 50/ fa 7f 16 0 00 00 70 02 5
201802721 000048 79 00 00 02 04 05 02 .
19:05:40 NETNAME private src
response "%

NETNAME other dst

1p.sRe

201802721
19:05:40 y
Packet 3 ) 240,083 1D 462629 SEQ 12928001 PAYLOAD 0Bytes | o oon outbound

201800221 000000 SpAspot 1041 55 0a )45 8 RT.. E.  ipproto
000016 2c 01 02 4o 00 400651 db 8/ 0a 00 . 7

000032 % S0 0 c5 a4 da 60 12 L.

000048 a8 00 00 02 04 05 . Tep.snepor

Ter.osTRORT

e

19:06:07 Packet 4 2018/02/21 19:05:40.083 1D 462630 SEQ 12928001 PAYLOAD OBytes
201802721 mﬂ?@ 1§ 34 5652 55 0: - E. STREAMS
T oonic IR TR E

201802721 80f 100000 events

LIFETIME

2. To change the view to show only the payload for each packet, click the Display Payloads
Only toggle switch.

The view changes to that only the payload is visible and contiguous same-side packets are
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concatenated together to make the payload more readable and understandable.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Network Event Details e 1aly acket Analysis  File Ar

EVENT TYPE

Download PCAP H @ ) common Fiu parTens (@) suAok ovTEs | @D DISPLAY PAYLOADS ONLY

NW SERVICE session 10 SOURCE IP:PORT DESTINATION I1P:PORT strvice FIRST PACKET TIME
- 288126 149212 180 80 0972012017
09/2072017 Concentrator 04:36:24.888 am
1236:242m LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOA 2| kLl\:Ulﬁr[[l PACKET
09/20/2017 53645 bytes 46139 bytes Bt
04:36:29.335 am 129

SESSIONID 288126
TIME 017 04:36:24 am
size 198500
PAYLOAD 184556
MEDIUM

ETH.SRC

ETH.DST

ETH.TYPE

1P.SRE

NETNAME private src
1.0ST

NETNAME other dst
DIRECTION outbound

1000f 129 “

View Highlighted Bytes in the Packet Analysis Panel

When you first open a reconstruction in the Packet Analysis panel, the significant header bytes
in each packet are highlighted in blue, and the payload bytes are distinguished using shading to
help you understand the contents of the packet. This figure shows the default Packet Analysis
with highlighting and byte shading.

RSA RESPOND INVESTIGATE MONITOR IGURE ADMIN
Navigate Events E
[ —— |
Eoom
| sommary st W coumon sus parrenns () sAvEsvTEs @ DUPLAY PAYLOADS GNLY

EVERT TIME VNt TR

SEUREE ¥ 10 ar s

T TiME
1 19:05:40.083

Packet 9

Packet 10
000
LG
poeaaz

Neswork

Erh.asT
T
[r— " one n.s0e
nETHAME
e
Lo RETHAME
omEeTioN
Neswork 7 18.pnaTo

Lags

Neswork

Heswork

LirEniNe
Heswark
RRAEKETS

RRAYLOAD

Neswork = — AcTioN

BIRRETERY

FIIETT ) Heswork
v

PACKETS PER PAGE
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The Shade Bytes option adds shading to identify the different hexadecimal bytes (00 to FF) using
degrees of highlighting. Bytes near the lower range are more transparent, and bytes near 255 are
more opaque. Both hexadecimal and ASCII bytes are shaded. This is an example of the shading
applied to each hexadecimal byte.

The Shade Bytes switch controls the shading of bytes. When you set Shade Bytes on or off, your
setting persists until you change it or refresh the browser.

Highlight Common File Types in the Packet Analysis Panel

In the Packet Analysis panel, analysts can show or hide highlighting of certain common file
types based on the file signature. When the Common File Patterns feature is turned on, the
magic number bytes in the file signature are highlighted in the payload and you can hover over
the highlighting to see the potential type of file. In this example, 89 50 4e 47 is highlighted in
the hexadecimal payload and PNG is highlighted in the ASCII payload. When you hover over the
highlighted bytes, the potential file type associated with the magic number is provided in a hover
box.
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INVESTIGATE

ents  Event A

These are the files types and corresponding magic numbers that are highlighted if present in the

payload:

File Type

DOS Executable / Windows PE

Portable Network Graphics (PNG)

JPEG
JPEG/JFIF
JPEG/Exif
GIF

GIF
Non-portable Executable

BMP

Hexadecimal

Signature

4D 5A

89 50 4E 47 0D 0A

1A 0A

FF D8 FF

4A 46 49 46

45 78 69 66

47 49 46 38 37 61

47 49 46 38 39 61

5A 4D

42 4D

ASCII

Encoding

MZ

PNG

JPEG

JFIF

Exif

GIF87a

GIF89a

M

BM
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Hexadecimal ASCII
File Type

Signature Encoding

PDF 2550 44 46 %PDF

Old Office Document (doc, xIs, ppt, msg, and other) DO CF 11 E0 A1B1  Dl.ajx.a

1A El
ZIP file formats and formats based on it, such as 50 4B PK..
JAR, ODF, OOXML
7-Zip File Format (7z) 377ABC AF 27 1C  7z% '
Java Class File, Mach-O Fat Binary CA FE BA BE Ep°%
Postscript 25215053 %!PS
Unix/Linux Shell script 2321 #!
Executable and Linkable Format (ELF) executables  7F 45 4C 46 .ELF

To view common file signatures in the Packet Analysis panel:

1. Go to the Packet Analysis panel, and turn on the Common File Patterns option.

If there is more then one highlight in view, all are shown.

2. To view the hover box, place the cursor over the highlighting.

Download Data in the Event Analysis View

In the Event Analysis view, you can download events, logs, and files.

Download a Log in the Text Analysis Panel

When viewing a log reconstruction in the Text Analysis panel, you can download a log file in the
following formats using options in the Download Log drop-down menu:

o Raw log (log) using the Download Log option
o Comma-separated values (CSV) using the Download CSV option
o Extensible Markup Language (XML) using the Download XML option

« JavaScript Object Notation (JSON) using the Download JSON option
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Note: If you initiate a download and move away from the view while the log is being
extracted and before the log starts to download, the log is not downloaded in your browser. A
message notifies you that you can find the downloaded log in the job queue.

This is an example of a log reconstruction with the Download Log menu options displayed.
.

Log Event Details | Text Analysis

Download Log | v

£ | Download Log

SESSION ID
Download CSV 727538

Download XML

Download JSON
Feb 26 2018 £9:40:41 Weess aas

The downloaded log file contains the log and is named to help identify the service on which the
log was collected, the session ID, and the file type.

Note: Long running or historically downloaded files are not downloadable.

This is an example of the filename for a raw log: Concentrator_SID2.log. The exported log file
is named using the following convention:

<service-ID or host name> SID<n>.<filetype>

where:

e <service-ID or host name> is the name of the service (for example a Concentrator or

Broker) where the session was saved.
e SID<n> is the session ID number.

o <filetype> identifies the format of the downloaded log. These are the possible log types:
raw log, CSV, XML, and JSON. By default the format is a raw log.

Note: Some formats do not have time stamps or the device [P where the event was generated,
so a log downloaded in CSV, XML, or JSON format has an extra value called timestamp
along with the raw log content. The additional information inside the log is in this form: Log
timestamp="1490824512" source="10.12.35.65".
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To download the log for a session:

In the Text Analysis panel of a log event, select one of the file formats for the downloaded log.
-To download the log as a raw log (the default format), click Download Log.
-To download the log in one of the other formats, click the downward arrow on the Download

Log button, and select one of the file formats for the downloaded log.
————

Log Event Details | Text Analysis

Download Log | v

£ | Download Log
SESSION ID

Download CSV 727538
Download XML

Download JSON
Feb 26 2018 99:40:41 Wsais e

The log file is downloaded to your local file system in the format specified.

Download Network Event Data in the Text Analysis Panel or the Packet

Analysis Panel

When viewing a reconstructed network event in the Packet Analysis panel or the Text Analysis
panel, you can export network data files for further analysis. The download includes events for
the current time range and drill point. You can download the data in these forms:

o The entire event as a packet capture (*.pcap) file using the Download PCAP option.
o The payload as a *.payload file using the Download All Payloads option.
o The request payload as a *.payloadl file using the Download Request Payload option.

o The response payload as a *.payload? file using the Download Response Payload option.

This is an example of the filename for a PCAP file: C0O1 - Concentrator
SID1697309.pcap. The exported network data file is named using the following convention:

<service-ID or host name> SID<n>.<filetype>

where:

e <service-ID or host name> is the name of the service (for example a Concentrator or

Broker) where the session was saved.
e SID<n> is the session ID number.

e <filetype> is pcap, payload, payloadl, or payload2.
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The network data is downloaded directly into your browser if the download is quick. If the
download takes longer due to network factors or file size, the file is downloaded in the
background and the task is tracked in the Jobs queue. In this case, you can check your jobs in the
queue and get the file when the download is complete.

Note: If you initiate a download and move away from the view while the file is being
extracted and before the file starts to download, the file is not downloaded in your browser. A
message notifies you that you can find the downloaded document in the job queue.

To export an event as a network data file:

Go to the Packet Analysis panel of a network event, and select one of the file formats for the
downloaded file.

-To download the event as a PCAP file (the default format), click Download PCAP.

-To download the event in one of the other formats, click the downward arrow on the Download
PCAP button, and select one of the file formats for the downloaded event data.

The network data file is downloaded to your local file system in the format specified.

Download Files from a Network Event in the File Analysis Panel

When viewing reconstructed network events that contain files in the File Analysis panel, you
can select one file, one or more files, or all files to download to your local file system.

Note: If you initiate a download and move away from the view while the file is being
extracted and before the file starts to download, the file is not downloaded in your browser. A
message notifies you that you can find the downloaded file in the job queue.

When files are selected, the Download Files button becomes active and reflects the number of
files selected.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Navigate Events EventAnalysis Hosts Files Malware Analysis
W - Broker v || (0) 02/25/2018 07:17:00 pm - 02/26/2018 07:16:59 pm /

Events (20336) X Network Event Details | Text Analysis Packet Analysis File Analysis Email [ T Web 1

EVENT TIME EVENT TYPE SERVICETYPE  £F

NW SERVICE SESSION ID SOURCE IP:PORT
02/26/2018 Network HTTP RIS - 727705 e
09:40:43 am Broker

DESTINATION IP:PORT SERVICE FIRST PACKET TIME
» ":80 20 02/26/2018 09:40:43.364
am

149261

LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOAD SIZE CALCULATED PACKET COUNT
Gl el 02/26/2018 09:56:21.062 87207 bytes 3975 bytes 1368

109:40:43 am am

0212672018

109:40:43 am

FILE NAME MIME TYPE FILE SIZE HASHES

727705-107-0_2.gif Imagergif 35 bytes SHA1: 0f4e929dd5bb2564f7ab9c76338e04e292a42ace  SESSIONID 727705

02/26/2018 MDS: 28d68141309ea289f847¢69c/91194c6 TIME 02/26/2018 09:40:43 am

09:40:43 am
'27705-107-0_3 gl Image/gif 35 bytes SHA1: 0f4929dd5bb256417ab3c76338e04e292ad2ace 4550

2262015 MDS: 28d68147309a289847c69C91194c6 LAl B
09:40:43 am MEDIUM 1

727705-107-0_1._utm.gf  Image/gif 35 bytes SHA: 0f4e829dd5bb2564{7ab0c76338e04e292ad2ace  ETH.SRC F1A

02/26/2018 MDS: 28d68141309ea289fB47c69c91194c6

ETH.SRC.VENDOR  VMware, Inc.
09:40:43 am

ETH.DST 97
02/26/2018 ETH.DST.VENDOR  VMware, Inc.
09:40:43 am ETH.TYPE 2048

IP.SRC
02/26/2018

1P.DST
09:40:43 am

IP.PROTO 6
02/26/2018 TCP.FLAGS 27
09:40:43 am TCP.FLAGS.SEEN fin syn psh ack
TCP.SRCPORT 49261
02/26/2018 Warning; Files contain the original raw unsecured content. Use caution when opening or downloading
files; they may contain malicious data. AL &
SERVICE 80

35 of 20336 events STREAMS 2

Clicking the button exports the selected files as a password-protected zip archive. The password
to open the exported archive is netwitness. Exporting the files in this form ensures that:

o The archive is not quarantined by antivirus software.

« Potentially malicious files are not automatically opened by the default application and

executed.

This is an example of the filename for an archive: CO1 - Concentrator SID1697309
FC1.zip. The exported archive is named using the following convention:

<service-ID or host name> SID<n> FC<n>.zip

where:

e <service-ID or host name> is the name of the service (for example a Concentrator or

Broker) where the session was saved.
e SID<n> is the session ID number.
e FC<n> is the file count or number of files in the archive.
Caution: Caution is advised when unzipping and opening files that are associated with a

default application; for example, an Excel spreadsheet may automatically open in Excel before
you have a chance to verify it is safe.
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To export files in a reconstructed event:

1. Inthe Event Analysis view, go to the File Analysis panel of an event that contains files.
RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis

W - Broker v 02/25/2018 07:17:00 pm - 02/26/2018 07:16:59 pm

Events (20336) X Network Event Details | Text Analysis Packet Analysis  File Analysis Email & Web [ EOOMN|~ X

EVENT TIME EVENT TYPE SERVICETYPE | ¥

ww seRvice session 1D SoURCE 1P:pORT DESTINATION 1P:pORT seavice FIRST PACKET TIME
L] Network He WA - 727705 W 49261 ot : 80 80 02/26/2018 09:40:43.364

09:40:43 am Broker &

LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOAD SIZE CALCULATED PACKET COUNT
v2r2e/zu18 02/26/2018 09:56:21.062 87207 bytes 3975 bytes 1368
09:40:43 am am

02/26/2018
09:40:43 am

FILE NAME MIMETYPE  FILESIZE HASHES

727705-107-0_2gif image/gif 35 bytes SHA1; 0f4e929dd5bb2564f7ab9c76338e04e292a42ace  SESSIONID 727705

02/26/2018 MDS: 28068147309¢a2897847c69cf91194c6 TIME

02/26/2018 09:40:43 am
09:40:43 am
size 64590
727705-107-0_3gif image/gif 35 bytes SHA1; 0f4e929dd5bb2564f7ab9c76338e04e292a42ace

ezl MDS: 280681413092a289fBA7C69c191194¢6 LR Bzl
09:40:43am mEDIUM 1

727705107-0_1._utm.gif  Image/gif 35 bytes SHA1: 0f4e929dd5bb2564f7ab9c76338e04292a42ace  ETH.SRC

02/26/2018 MDS: 2806814f309ea289f847c69cf91194c6 ETH.SRC.VENDOR

VMware, Inc.
09:40:43 am

ETH.DST
02/26/2018 ETH.DST.VENDOR  VMware, Inc.
09:40:43 am ETH.TYPE 2048

P.sRC
02/26/2018

1P.DST
09:40:43 am

1».PrOTO 6
02/26/2018 TCP.FLAGS 27
09:40:43 am TCP.FLAGS.SEEN  finsyn psh ack
TCP.SRCPORT 49261
02/26/2018 Warning: Files contain the original raw unsecured content. Use caution when opening or downloading
files; they may contain malicious data. WAL &
seRvice &

35 0f 20336 events STREAMS 2

2. Click one or more files that you want to extract, and click Download Files.
The job is scheduled and when complete the selected file are downloaded, in the form of a

password-protected zip archive, to the local file system.

3. To open the archive on your local file system, enter the following password when prompted:

netwitness.

Act on Data in the Event Analysis View

When you have found data of interest in the Event Analysis view, you can do internal lookups to
NetWitness Endpoint and RSA Live, as well as external lookups of meta values in community
resources such as SANS IP History and ThreatExpert Search.

Open an Endpoint Event in the NetWitness Endpoint Thick Client

When viewing an endpoint event in the Text Analysis panel, you can pivot to analyze the same
event in NetWitness Endpoint. The NWE thick client offers additional features beyond the built-
inbcapabilities in NetWitness Endpoint Insights.
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Note: Version 4.4 of the NetWitness Endpoint (NWE) thick client must be installed on the
same server, the NWE meta keys must exist in the table-map.xml file on the Log Decoder,
and the NWE meta keys must exist in the index-concentrator-custom.xml file. The
NWE thick client is a Windows only application. Complete setup instructions are provided in
the NetWitness Endpoint User Guide for Version 4.4.

To open an event in NetWitness Endpoint:

1. Starting from the Navigate view:

a. Inthe Query drop-down, select Advanced, and enter one of the following queries:
nwe.callback id exists or device.type='nwendpoint'

Endpoint data is displayed in the Values panel.
b. Right-click an event, and select Event Analysis in the menu.

2. (Version 11.1 and later) Go to INVESTIGATE > Events Analysis. In Query drop-down,
select Advanced, and enter one of the following queries: nwe.callback id exists or
device.type="'nwendpoint'

Endpoint data is displayed in the Events panel.

3. Select an event.

The Event Analysis opens with the selected event displayed in the Text Analysis.
IRSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN "7 admin _\

Navigate Events Event Analysis Hosts Files Malware Analysis [ ]

Events (2443) S X Endpoint Event Details | Text Analysis WX

Download XML [% Pivot to Endpoint Thick Client
&

EVENT TIME EVENT TYPE

02/0712018 Endpoint 1 NW SERVICE SESSION 1D NWE CATEGORY COLLECTION TIME EVENT TIME FILENAME
EELY File 02/07/2018 05:51:47.000 02/07/2018 06:24:17.000 libfmphelpers.dylib
pm

05:51:47 pm Concentrator

020772018 Endpoint Process
05:51:47 pm RAW ENDPOINT

02/07/2018 Endpoint Dot 2018-02-87T18:24:17.889Z : file event from o * with id R 3300
05:51:47 pm SBSAE4FE-D1AE-494A-(95C-671884C91CC8 ullld 02/07/2018 05:51:47 pm
size 154

020772018 Endpoint FORWARD.IP

055147 pm MEDIUM 2

PR e DEVICE.TYPE nwendpoint

05:51:47 pm DIRECTORY IusrfiocaliMcafeesfmpriib
631cBdabe86a3Ved870asidd2ee09

02/0772018 Endpoint CERT.CHECKsSUM

05:51:47 pm

699c5532e9
FILE.ENTROPY 5.6263566
0240712018 Endpoint FILENAMESIZE 252144
05:51:47 pm cede7fSe8bdf7be3a163a3a9e0b793

CHECKSUM ed6ed(34fdada361d80926e01 edGe
020772018 Endpoint
05:51:47 pm

3ed0
e6ach038feBce44f010fo03828787¢5
CHECKSUM
0240712018 Endpoint 486ccfe60

05:51:47 pm cHECKsUM b4deba32677dfd530d904ab61653d
038

48 0f 2443 events

4. Inthe Event Header click Pivot to Endpoint.
A new browser tab with the url ecatui://<id> opens and the NWE Thick Client is
launched . If the NetWitness Endpoint Thick Client is not installed, no data is displayed and

the following message is displayed: Applicable for hosts with 4.x Endpoint
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agents installed, please install the NetWitness Endpoint Thick

Client.

Perform Lookups of Meta Values in Event Analysis

In the Event Analysis view you can further investigate meta values in an event by right-clicking
certain meta values and using the options in a drop-down menu. Not all fields have right-click
actions. To perform internal and external lookups:

1. Inthe Event Analysis view, right-click a meta value in the Events List, the Event Meta

panel, or the Event Header. Some meta values have a drop-down menu.

Network Event Details | Text Analysis Packet Analysis  File Analysis Email 7 Web &F EOOHN| ¥ X

NW SERVICE SESSION ID SOURCE IP:PORT DESTINATION IP:PORT SERVICE FIRST PACKET TIME
PacketHybrid - 1 0 02/20/2018
Concentrator 10:56:00.136 am

Copy
LAST PACKET TIME CALCULATED PACKET SIZE giRZI.ECULATEE

02/20/2018 6704 bytes

10:56:23.156 am 2216 bytes| Refocus Investigation in New Tab

Apply Drill in New Tab
FILE NAME MIME TYPE FILE SIZE HASHE!
Apply IEQUALS Drill in New Tab
[0 1-107-Oaw  applicationfoctet-stream 2.2 KB SHA1: Z 2ab3... SESSIONID 1
MDs5: 0| Hosts Lookup TIME 02/20/2018 10:56:00 am
Endpoint Thick Client Lookup SIzE ez
PAYLOAD 4432
Live Lookup MEDIUM 1
Extemal Lookup ETH.SRC 00:00:00:00:00:00
ETH.DST 00:00:00:00:00:00
ETH.TYPE 2048
IP.SRC

1 of 61201 events IP.DST

2. Select one of the following internal lookups:
Copy: Copies the meta value to the clipboard.
Refocus Investigation in New tab: Launches the another investigation in a new tab with the
focus on the selected meta value.
Apply Drill in New Tab: Applies the drill and launches it in a new tab to drill the data in
Navigate view.
Apply !EQUALS Drill in New Tab: Applies ('lEQUALS) to the meta and launches a new
tab, effectively excluding the meta value from the results.
Hosts Lookup: Looks up the value in the Investigate > Hosts view.
Endpoint Thick Client Lookup: Analyzes the meta value in the Endpoint Thick Client (for
clients which have Endpoint Agent).

Live Lookup: Looks up a meta value on Live for further analysis.
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3. For an external lookup, hover over a meta value, right-click and select External Lookup.

DEVICE CLASS EVENT CATEGORY
Anti Virus Other.Default

Apply Drill in New Tab SANS IP History

Apply IEQUALS Drill in New Tab | CentralOps Whois for IPs and Hostnames
Hosts Lookup Robtex IP Search

Endpoint Thick Client Lookup 1PVoid

Live Lookup URLVoid

External Lookup > | ThreatExpert Search

4. In the submenu select one of the available external lookups:
Google: Looks up a meta value on Google.com
SANS IP History: Looks up a meta value on SANS IP History, domain =
http://isc.sans.org/ipinfo.html?ip=ipaddress
CentralOps Whois for IPs and Hostnames: Looks up a meta value on CentralOps Whois
for IPs and Hostnames, domain =
http://centralops.net/co/DomainDossier.aspx?addr=domain&amp;dom
whois=true&amp;dom_dns=true&amp;net whois=true
Robtex IP Search: Looks up a meta value on Robtext IP Search, domain =
https://www.robtex.com/cidr/domain.ipaddress
IPVoid: Looks up a meta value on IPVoid, domain = http://www.ipvoid.com/scan/domain/
URLYVoid: Looks up a meta value on URLVoid, domain =
http://www .urlvoid.com/scan/ipaddress/
ThreatExpert Search: Looks up an I[P meta value on ThreatExpert Search, domain =

http://www .threatexpert.com/reports.aspx?find=IP address
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Investigating Hosts and Files

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

Analysts can use the RSA NetWitness Suite Hosts and Files views to investigate hosts or files.

Analysts who conduct analysis using Investigate need to have the appropriate system roles and
permissions set up for their user accounts. An administrator must configure roles and
permissions as described in Roles and Permissions for Endpoint Analysts. For more information
on roles and permissions, see System Security and User Management Guide.

Analysts can:
o Investigate Hosts

o Investigate NetWitness Endpoint 4.4.0.2 or Later Hosts

o Investigate Files
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Investigate Hosts

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

To conduct an investigation on hosts:

1. Goto INVESTIGATE > Hosts.
A list of hosts is displayed.

2. Select the hosts that you want to scan and click Start Scan. For more information, see
Investigate Hosts.

3. After completing the process of scanning the hosts, click the host name to investigate the

scan results. For more information, see Investigate Hosts.

Note: To investigate NetWitness Endpoint 4.4 hosts, see Investigate NetWitness Endpoint
4.4.0.2 or Later Hosts.

Filter Hosts

You can filter hosts on the operating system or select the fields in the Add Filter drop-down
menu.

Note: While filtering on a large amount of data, use at least one indexed field with the
Equals operator for better performance. The following fields are indexed in the database -
Hostname, IPV4, Operating System, and Last Scan Time.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis

Filter: Add

Saved Filters Hosts (2)
Linux [0 HOST NAME & AGENT LAST SEEN AGENT SCAN STATUS LAST SCAN TIME OPERATING SYSTEM USERNAME
Windows ] an hour ago Idle 01/15/2018 04:48:57 am  linux root

Mac [m} an hour ago Idle 01/15/2018 04:43:41 am windows

To search multiple values within a field, set the filter option to Equals, anduse || as a
separator.

For example,
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o Using Equals operator for multiple IPV4 values with a separator | |.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Events Event Analysis Hosts Files  Malware Analysis

\dd Filter v Save

| 110. 41110,

Equals © Contains
4  AGENT LAST SEEN

Update

Note: To search multiple values, use | | as a separator

a few seconds ago

a few seconds ago

o Using 1N operator for Last Scan Time to filter agents that are scanned in the last 6 hours.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Navigate Events Event Analysis Hosts Files Malware Analysis
Filter: im U dd Filter v e Reset

LAST 5CAN TIME

Saveé

IN O NOTIN

Fire| 6HOURS 4  AGENT LAST SEEN

Lin O Custom Date a few seconds ago

Win 3 minutes ago

a minute ago

Click Save to save the search and provide a name (up to 250 alphanumeric characters). The
filter is added to the Saved Filters panel on the left. To delete a filter, hover over the name and

click .

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving
the filter.

Scan Hosts

You can either perform an on-demand scan or schedule a scan to run daily or weekly. For
information on scheduling a scan, see RSA NetWitness Endpoint Insights Configuration Guide.

Note: You cannot perform a scan for the NetWitness Endpoint 4.4 agents from the
NetWitness Suite user interface.
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On-demand Scan
You may want to perform an on-demand scan if:
o A file in the Global Files section is found to be malicious.

A malicious file is present on different hosts in the network.

You want to investigate a host that is infected.

o Get the latest snapshot of the host.

When the hosts are scanned, the Endpoint Agent retrieves the following data that can be used for
investigation:
o Drivers, processes, DLLs, files (executables), services, and autoruns running on the host.

o Host file entries and scheduled tasks.

o System information such as network share, installed Windows patches, Windows tasks,

logged-in users, bash history, and security products installed.

To start a scan:
1. Goto INVESTIGATE > Hosts.
2. Select one or more hosts (up to 100) at a time for on-demand scan, and click Start Scan.

3. Click Start Scan in the dialog.
This performs a quick scan of all executable modules loaded in memory. It takes

approximately 10 minutes.

The following are the scan statuses:

e
Idle No scan is in progress.
Scanning Scan is in progress.

Starting ~ Scan request is sent to the server but the agent will receive the request the next

Sormm time it communicates with the server.

Stopping  Stop request is sent to the server but the agent will receive the request the next

Scan time it communicates with the server.
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Pivot to the Navigate and Event Analysis Views

If you need to investigate a particular host, IP address (IPV4), or username to look for related
activity across a time range, you can pivot to both the Navigate and Event Analysis views to get
the entire context of the activity. By default the time range is set to 1 day. You can change the
time range accordingly.

Note: Pivoting to the Navigate or Event Analysis view is not supported for IPV6.

To pivot to the Navigate or Event Analysis view:

1. Goto INVESTIGATE > Hosts or INVESTIGATE > Files.

A
2. Click beside the Hostname.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Navigate Events Event Analysis Hosts Files Malware Analysis

Filter: d Filter Save  Reset

Saved Filters Hosts (6)

Linux [ wosTNAmME AGENT ID AGENT LAST SEEN AGENT MODE AGENT SCAN STATUS  AGENT VERS|
Windows 8830BAEE-OCED... aday ago userModeOnly  Idle 11.1.00
Mac B6FOCOED-6F54-.. aday ago userModeOnly  Idle 11.1.0.0

5DCE32EE-FBF1... 9 minutes ago userModeOnly Idle 11.1.0.0

Alternately, in the Overview tab, you can right-click on host name, IP address (IPV4), or

logged-in users to pivot.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Events Event Analysis Hosts Files Malware Analy
rview Process Autoruns Files Drivers Libraries System Information
Pi o Investigate

OPERATING SYSTEM AGENT SCAM STATUS AGENT LAST SEEN LAST SCAN TIME AGENT VERSION
windows Idle a few seconds ago 01/19/2018 07:40:27 am 11.1.0.0

snapsHoT ime  01/19/2018 07:40:27.493 am  ~ Start Scan Pivot to Endpoint Export to ][SON

¢ 10.30.95.72/fe80::7ce8:30df:749c:681b%3 | MAC Address: D4:81:D7:28:8D:EQ

¢ 192.168.17.1/fe80::e48e:f413:1b15:8cf7%8 | MAC Address: 00:50:56:C0:00:01

&5 192.168.235.1/feB0::¢32:f5d7:183b:5875%6 | MAC Address: 00:50:56:C0:00:08

SESSION ID SESSION TYPE GROUPS
1 interactivenetwork

3. Inthe Select Service dialog, select any of the services required for investigation.

4. Click Navigate or Event Analysis to analyze the data.
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Investigate Host Details

To look for suspicious files on a host, click the host name and view the details of the host, or
start an on-demand scan to get the most recent information.

[RSA REsPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Events  Event sts  Files Malware Analysis

stem Information

Start Scan ‘ Pivot to Endpoint Export to JSON

/ fe80:c54cb004:26b6:2173%11 | MAC Address: 00:0C:29:42.ECAT

Alphabetical O Status

Allow Access Datasource Domain IEDep Task Manager
Display Mixed Content 1€ Enhanced Security = osoft Windows 7 Enterprise
Intranet Zone Notification
LA ction 3
Registry Tools Windows Update elNome _ ntoskrnl.exe
Cross site Script Filter ‘Smart Screen Filter 2010011 20702:30.020002

Firewall System Restore

Search on Snapshots

To investigate a host or to check if it is infected with a known malware, you can search for
occurrences of the file name, file path, or SHA-256 checksum.

Note: To search for a SHA-256 checksum, provide the entire hash string in the search box.

The result displays details, such as file name, signature information, along with its interaction
with the system (ran as process, library, autorun, service, task, or driver). To view more details
for these results, click on the category.

For example, a user has clicked and executed a malicious attachment through a phishing email,
and downloaded it to C: \Users. To investigate this file:

1. Goto INVESTIGATE > Hosts.
2. Select the host that you want to investigate.

3. Inthe Overview tab, enter the file path C:\Users in the search box.
The search displays all the executables in this folder. In this example, the file

NWEMalware.exe, is an unsigned file that might be malicious.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis T‘

a Overview Process Autoruns Files Drivers Libraries System Information [ciusers\]

OPERATING SYSTEM AGENT SCAN STATUS AGENT LAST SEEN LAST SCAN TIME AGENT VERSION
windows Idle aminute ago 02/23/2018 08:17:56 am 11.1.00

sNapsHOT TIME  02/23/2018 08:17:56.258 am Pivot to Endpoint Export to JSON

/ fe80::f492:d372:f1cd:241d%19 | MAC Address: A4:4C:C8:B6:BD:DS
/1 fe80::3076:b28:84a5:327a%6 | MAC Address: 00:50:56:C0:00:01
/ fe80::3dad:adf:2832:369d%20 | MAC Address: 00:50:56:C0:00:08

This file has run as a Process.

4. To view details of this file, click Process in the result.

This opens the Process tab where you can view the process details.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analy Hosts Files Malware Analysis

2 Overview Process Autoruns Files Drivers Libraries  System Information [cwsers\]

OPERATING SYSTEM AGENT SCAN STATUS AGENT LAST SEEN LAST SCAN TIME AGENT VERSION
windows idle aminute ago 02/23/2018 08:17:56 am 11.1.00

snapsHoT TIME  02/23/2018 08:17:56.258 am Pivot to Endpoint Export to JSON

/ fe80:f492:d372:f1cd:241d%19 | MAC Address:
/ fe80::3076:b28:84a5:327a%6 | MAC Address:
/ fe80:3dad:adf:2832:369d%20 | MAC Address: 00:

Analyze Processes

In the Hosts view, select the Process tab. You can view the processes that were running for the
selected host at the time of scan. The process name and process ID (PID) columns are displayed
either as a:

o Tree view - You can drill down to each process and view the child or parent process

associated with it.

o List view - You can sort the process name and PID columns.

Click B to switch the views.

The following is an example of the tree view:

Investigating Hosts and Files 206



NetWitness Investigate User Guide

P =

FROCESS NAME

'  systemd

BSEproonyT

systermd-udevd

epmd

'  bash

java

MwwAppliance

'  reyslogd

rsa_audit onramp
auditd
apetty
systermd-journald
nipd

python2 7

When reviewing processes, it is important to see the Launch Arguments. Even legitimate files
can be used for malicious purposes, so it is important to view all of them to determine if there is
any malicious activity.

For example,
e rundll132.exe is a legitimate Windows executable that is categorized as a good file.

However, an adversary may use this executable to load a malicious DLL. Therefore, when

viewing processes, you must view the arguments of the rund1132.exe file.

e LSASS.EXE is a child to WININIT.EXE. It should not have child processes. Often malware
use this executable to dump passwords or mimic to hide on a system (1ass.exe,

lssass.exe, lsasss.exe, and so on).

o Most legitimate user applications like Adobe, Web browsers, and so on do not spawn child
processes like cmd. exe. If you encounter this, investigate the processes.

Analyze Autoruns

In the Hosts view, select the Autoruns tab. You can view the autoruns, services, tasks, and
cron jobs that are running for the selected host.
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For example, in the Services tab, you can look for the file creation time. The compile time is
found within each portable executable (PE) file in the PE header. The time stamp is rarely
tampered with, even though an adversary can easily change it before deploying to a victim's
endpoint. This time stamp can indicate if a new file is introduced. You can compare the time
stamp of the file against the created time on the system to find the difference. If a file was
compiled a few days ago, but the time stamp of this file on the system shows that it was created
a few years ago, it indicates that the file is tampered.

Analyze Files

In the Hosts view, select the Files tab. You can view the list of files scanned on the host at the
time of scan. By default, the table displays 100 files. To display more files, click Load More at
the bottom of the page.

For example, many trojans write random filenames when dropping their payloads to prevent an
easy search across the endpoints in the network based on the filename. If a file is named
svchOst.exe, sevhost.exe, Or svchosts.exe, it indicates that the legitimate Windows file
named svchost.exe is being mimicked.

Analyze Libraries

In the Hosts view, select the Libraries tab. You can view the list of libraries loaded at the time
of scan.

For example, a file with high entropy gets flagged as packed. A packed file means that it is

compressed to reduce its size (or to obfuscate malicious strings and configuration information).

Analyze Drivers

In the Hosts view, select the Drivers tab. You can view the list of drivers running on the host at
the time of scan.

For example, using this panel, you can check if the file is signed or unsigned. A file that is
signed by a trusted vendor such as Microsoft and Apple, with the term valid, indicates that it is
a good file.

Analyze System Information

In the Hosts view, select the System Information tab. This panel lists the agent system
information. For Windows operating system, the panel displays the host file entries and network
shares of that host.

For example, malware might use host file entries to block antivirus updates.

Delete a Host

To delete hosts manually from the Ul:
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1. Go to INVESTIGATE > Hosts.

2. Select the hosts that you want to delete from the Hosts view and click Delete.

This deletes all the collected Endpoint data for the selected hosts.

Note: If you accidentally delete a host from the Hosts view, the Endpoint Server forbids all
requests from this agent. The agent must be uninstalled manually from the host and reinstalled
for it to appear on the Hosts view.

Set Hosts Preference

By default, the Hosts view displays a few columns and the hosts are sorted based on the last
scan time. If you want to view specific columns and sort data on a specific field:

1. Goto INVESTIGATE > Hosts view.

2. Select the columns by clicking . in the right-hand corner. The following example shows the

screen displayed while adding columns:

3. Sort the data on the required column.

to filter the list

[ Agent - Blocking Enabled

[ Agent - Blocking Updarte Time

[ Agent - Driver ErrorCode

[ Agent - Install Time

[ Agent - Package Time

[ Agent - Service Start Time

[] Agent - Service Status

[ Agent - User Mode Compile Time

[ Agent Group
O Agent ID
Agent Last Seen
[ Agent Mode
Agent Scan Status

[ Agent Version

[ ] Hardware - Bios

Note: This is set as your default view every time you log in to the Hosts view.
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Export Host Attributes

You can export up to 100k host attributes at a time. To extract the host attributes to a comma-
separate values (csv) file.

1. Goto INVESTIGATE > Hosts.
2. Filter the hosts by selecting the required filter options.
3. Add columns by clicking . in the right-hand corner.

4. Click Export to CSV.

You can either save or open the csv file.

Investigate NetWitness Endpoint 4.4.0.2 or Later Hosts

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

If you have NetWitness Endpoint 4.4.0.2 or later in your deployment, you can view the endpoint
data of these hosts in the INVESTIGATE > Hosts and INVESTIGATE > Files views.

If you do not see the NetWitness Endpoint 4.4.0.2 hosts listed here, see "Integrating NetWitness
Endpoint 4.4.0.2 or Later with NetWitness Endpoint 11.1" in the RS4 NetWitness Endpoint
Insights Configuration Guide.

The NetWitness Endpoint 4.4.0.2 hosts can be identified in the Hosts View using the Agent
Version. You cannot perform an on-demand scan on these hosts. To investigate these hosts, you
must use the NetWitness Endpoint 4.4.0.2 or later user interface.

Note: To pivot to the thick client from the NetWitness Suite user interface, the NetWitness
Endpoint 4.4.0.2 or later must be installed.

To investigate a host in the NetWitness Endpoint user interface:

1. Goto INVESTIGATE > Hosts.
2. Select the 4.4 host from the table.

3. Click Pivot to Endpoint.

Note: The Pivot to Endpoint option is not applicable for the NetWitness Endpoint
Insights11.1 hosts.
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Investigate Files

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

Analysts can use the Files view (INVESTIGATE > Files) to identify suspicious files by
examining the file name, file size, entropy, format, company name, signature, and checksum.

For example, when looking at a file name, if an environment is infected by the WannaCry
ransomware, using this file name, the analyst can filter the list. You can also look for this
ransomware using the checksum.

The file size can be an indicator when assessing a file. Trojans are usually less than 1 MB, and
the majority of them are less than 500 KB.

Filter Files

You can either filter the files on the operating system, or select the fields in the Add Filter drop-
down menu.

Note: While filtering on a large data set, use at least one indexed field with the Equals
operator for better performance. The following fields are indexed in the database - Filename,
MDS5, Operating System, First Seen Time, and Format.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Events Event Analysis Hosts Files Malware Analy

Saved Filters Files (3722)

WINDOWS ENTROPY FILENAME FIRST SEEN TIME

LINUX 5.231551509824062 sleep 04/10/2018 01:40:32.000 am

MAC 4.919086915000668 libnss_myhostname.so.2 04/03/2018 0
5.95105954924721 libneurses.50.5.9 03/27/2018 0
5.5756608862107715 libprocps.s0.4.0.0 03/27/2018 05:39:22.000 am
5.852280001451916 top 03/27/2018 05:39:22.000 am
5.354835451618952 libnuma.se.1 03/27/2018 05:39:22.000 am

.529715566552897 anacron 03/15/2018 03:09:00.000 pm

4.980057490114215 ailf 03/10/2018 06:02:46.000 pm

Click Save to save the search and provide a name (up to 250 alphanumeric characters). The
filter is added to the Saved Filters panel on the left. To delete a filter, hover over the name and

click .
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Note: Special characters are not allowed except underscore () and hyphen (-) while saving
the filter.

For example, filtering files with the filename malware usingthe Equals operator.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysi Hosts Files Malware Analy

Filter:

Savq maware (4345)

Equals O Contains
WIN FILENAME

Update
LIN pd 509824062 sleep

4.919086915000668 libnss_myhostmame.so.2

Note: For the file size, 1 KB is calculated as 1024 bytes. For example, if the actual size of the
file is 8421 bytes, the UI will display it as 8.2 KB instead of 8.22 KB. It is recommended to
search using the bytes format when using the Equals operator.

Pivot to Navigate and Event Analysis Views

If you need to investigate a particular filename or hash (SHA256 and MD5) in the global files to
look for related activity across a time range, you can pivot to both the Navigate and Event
Analysis views to get the entire context of the file. By default the time range is set to 1 day. You
can change the time range accordingly.

To pivot to Navigate or Event Analysis view:

1. Goto INVESTIGATE > Files.

A
2. Click beside the Filename or Hash.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Navigate Events Event A!TEI‘}"S'\S Hosts Files Malware Ana
Filter: Add Filter W/ Save  Reset

Saved Filters Files (2802)

WINDOWS ENTROPY FILENAME FIRST SEEN TIME M OPERATING SY.. SHA256
LINUX 3 8 libmspack.s0.0.1.0 % 02/07/: :13:41.000am  linus ff20d0a0fdbeea?’ 611756 70bfdB6644d35f7d07560baaf08618770f1 505bc
MAC 82073 NwlogDecoder 02/07/2018 10:13:41.000 am  linusx 75a0267b870c88a28881960a1885e41bd 1 70fffdacedcc65949641477ab90

entropy less than 3 98256 dm-mirror.ko.xz 02/1 41.000am  linux o cFelfb 7£43040e- 0862472601 17f763a85b52

test search and filter 5.147136007423362 libwrap.s0.0.7.6 02/07/2018 10:13:41.000am  linux c6b2d1d8ac0a207dd77e8397cd%e193b2c7c158b6e eece530AST5315a6

3. Inthe Select Service dialog, select any of the services required for investigation.

4. Click Navigate or Event Analysis to analyze the data.
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Note: While pivoting to the Navigate or Event Analysis view, if the values are not indexed,
the results take time to load. For more information, see Troubleshooting NetWitness Investigate.

Set Files Preference

By default, the Files view displays a few columns and the files are sorted based on the first seen
time. If you want to view specific columns and sort data on a specific field:

1. Goto INVESTIGATE > Files.

2. Select the columns by clicking . in the right-hand corner. The following example shows

the screen displayed while adding columns:

to filter the list

[ ELF.Clas= Type

[] ELF.Data

[ ELF.Entry Point

[0 ELF.Features
| [0 ELFImported Libraries
i [ ELF.Section Names

O ELRType
Entropy

FileName
First Seen Time
Format
Omw
MD5
I [0 MachO.Features
[1 MachQ.Flags

3. Sort the data on the required column.

Note: This is set as your default view every time you log in to the Files view.

Export Global Files

To extract the list of global files to a CSV file.

Note: While filtering on a large data set, use at least one indexed field with the Equals
operator for better performance. You can export up to 100k files at a time.
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3.

4.

Go to INVESTIGATE > Files.

Filter the files by selecting the required filter option.

Add columns by clicking . in the right-hand corner.

Click Export to CSV.

You can either save or open the CSV file.
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Conducting Malware Analysis

Analysts can use the RSA NetWitness Suite Malware Analysis service to detect malware in
selected data and files.

Analysts who conduct analyses using NetWitness Suite Malware Analysis need to have the
appropriate system roles and permissions set up for their user accounts.

The following procedures provide instructions for using Malware Analysis:

o Begin a Malware Analysis Investigation.

o Upload Files for Malware Analysis Scanning.

o Implement Custom YARA Content.

o Filter Dashlet Data in the Summary of Events View.

o Examine Scan Files and Events in List Form

e View Detailed Malware Analysis of an Event.
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Malware Analysis Functions

NetWitness Suite Malware Analysis is an automated malware analysis processor designed to
analyze certain types of file objects (for example, Windows portable executable (PE), PDF, and
MS Office) to assess the likelihood that a file is malicious.

Malware Analysis detects indicators of compromise using four distinct analysis methodologies:

o Network Session Analysis (network)

Static File Analysis (static)

o Dynamic File Analysis (sandbox)

Security Community Analysis (community)

Each of the four distinct analysis methodologies is designed to compensate for inherent
weaknesses in the others. For example, Dynamic File Analysis can compensate for Zero-Day
attacks that are not detected during the Security Community Analysis phase. By avoiding
malware analysis that strictly focuses on one methodology, the analyst is more likely to be
shielded from false negative results.

In addition to the built-in indicators of compromise, Malware Analysis supports indicators of
compromise written in YARA. YARA is a rule language, which allows malware researchers to
identify and classify malware samples. This allows IOC authors to add detection capabilities to
RSA Malware Analysis by authoring YARA rules and publishing them in RSA Live. These
YARA-based IOCs in RSA Live will automatically be downloaded and activated on the
subscribed host, to supplement the existing analysis that is performed in each analyzed file.

Malware Analysis also has features that support alerts for Incident Management.

Functional Description

This figure depicts the functional relationship between the Core services (the Decoder,
Concentrator, and Broker), the Malware Analysis service, and the NetWitness Server.
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The Malware Analysis service analyzes file objects using any combination of the following
methods:

o Continuous automatic polling of a Concentrator or Broker to extract sessions identified
by a parser as potentially carrying malware content.

o On-demand polling of a Concentrator or Broker to extract sessions identified by a
malware analyst as potentially carrying malware content.

o On-demand upload of files from a user-specified folder.
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When automatic polling of a Concentrator or Broker is enabled, the Malware Analysis service
continuously extracts and prioritizes executable content, PDF documents, and Microsoft Office
documents on your network, directly from data captured and analyzed by your Core service.
Because the Malware Analysis service connects to a Concentrator or Broker to extract only
those executable files that are flagged as possible malware, the process is both rapid and
efficient. This process is continuous and does not require monitoring.

When on-demand polling of a Concentrator or Broker is chosen, the malware analyst uses
Investigation to drill into captured data and choose sessions to be analyzed. The Malware
Analysis service uses this information to automatically poll the Concentrator or Broker and to
download the specified sessions for analysis.

On-demand upload of files provides a method for the analyst to review files captured external to
the Core infrastructure. The malware chooses a folder location and identify one or more files to
be uploaded and analyzed by Malware Analysis. These files are analyzed using the same
methodology as files automatically extracted from network sessions.

Analysis Method

For the Network analysis, the Malware Analysis service looks for characteristics that seem to
deviate from the norm, much as an analyst does. By looking at hundreds to thousands of
characteristics and combining the results into a weighted scoring system, legitimate sessions that
coincidentally have a few abnormal traits are dismissed, while the actual bad ones are
highlighted. A user can learn patterns that indicate anomalous activity in the sessions as
indicators that warrant further investigation, Indicators of Compromise.

The Malware Analysis service can perform Static analysis against suspicious objects it finds on
the network and determine whether those objects contain malicious code. For Community
analysis, new malware detected on the network is pushed to the RSA Cloud for checking against
RSA's own malware analysis data and feeds from the SANS Internet Storm Center, SRI
International, the Department of the Treasury, and VeriSign. For Sandbox analysis, the services
can also push data into major security information and event management (SIEM) hosts (the
ThreatGrid Cloud).

Malware Analysis has a unique method for analysis that is partnered with industry leaders and
experts, so their technologies can enrich the Malware Analysis scoring system.

NetWitness Server Access to the Malware Analysis Service

The NetWitness Server is configured to connect to the Malware Analysis service and import

tagged data for deeper analysis in Investigation. Access is based on three subscription levels.

o Free subscription: All NetWitness Suite customers have a free subscription, with a free trial
key for ThreatGrid analysis. The Malware Analysis service is rate-limited to 100 file samples
per day. The number of samples (within the set of files from above) submitted to the

ThreatGrid Cloud for sandbox analysis is limited to 5 per day. If one network session had 100
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files in it, customers would hit the rate limit after processing the one network session. If 100

files were manually uploaded, that would cause the rate limit to be reached.

« Standard subscription tier: The number of submissions to the Malware Analysis service is
unlimited. The number of samples submitted to the ThreatGrid Cloud for sandbox analysis is
1000 per day.

o Enterprise subscription tier: The number of submissions to the Malware Analysis service is
unlimited. The number of samples submitted to the ThreatGrid Cloud for sandbox analysis is
5000 per day.

Scoring Method

By default, the Indicators of Compromise (IOC) are tuned to reflect industry best practices.
During analysis, the IOCs that trigger cause the score to move upward or downward to indicate
the likelihood that the sample is malicious. The tuning of IOCs is exposed in NetWitness Suite
so that the malware analyst can choose to override the assigned score or to disable an IOC from
being evaluated. The analyst has the flexibility to either use the default tuning, or to completely
customize the tuning to specific needs.

Y ARA-based IOCs are interleaved with the built-in IOCs within each built-in category and are
not distinguished from native IOCs. When viewing IOCs in the Service Configuration view,
administrators can select Y ARA from the Module selection list to see a list of YARA rules.

After a session is imported into NetWitness Suite, all of the viewing and analysis capabilities in
Investigation are available to further analyze Indicators of Compromise. When viewed in
Investigation, YARA 10Cs are distinguished from the built-in native IOCs by the tag vara

rule.

Deployment

The Malware Analysis service is deployed as a separate RSA Malware Analysis host. The
dedicated Malware Analysis host has an onboard Broker which connects to the Core
infrastructure (either another Broker or a Concentrator). Prior to this connection, a collection of
parsers and feeds must be added to the Decoders that are connected to the Concentrators and
Brokers from which the Malware Analysis service pulls data. This allows suspicious data files
to be marked for extraction. These files are malware analysis tagged content available
through the RSA Live content management system.
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Malware Scoring Modules

RSA NetWitness Suite Malware Analysis analyzes and scores sessions and the embedded files
within these sessions by scoring four categories: Network, Static Analysis, Community, and
Sandbox. Each category comprises many individual rules and checks that are used to calculate a
score between 1-100. The higher the score, the more likely the session is to be malicious and
worthy of more in-depth follow-on investigation.

Malware Analysis can facilitate a historical investigation into events leading up to a network
alarm or incident. If you know that a certain type of activity is taking place on your network, you
can select only the reports of interest to examine the content of data collections. You can also
modify behavior for each scoring category based on the scoring category or the file type
(Windows PE, PDF, and Microsoft Office).

Once you become familiar with data navigation methods, you can explore the data more
completely through:

o Searching for specific types of information

o Reviewing specific content in detail

Category scores for Network, Static Analysis, Community, and Sandbox are maintained and
reported independently. When events are viewed based on the independent scores, as long as
one category detects malware, it is evident in the Analysis section.

Network

The first category examines each core network session to determine if the delivery of the
malware candidates was suspicious. For example, benign software being downloaded from a
well-known safe site, using proper ports and protocols, is considered less suspicious than
downloading software known to be malicious from a known dubious download site. Sample
factors used in the scoring of this criteria set may include sessions that:

Contain threat feed information

o Connect to well-known bad sites

Connect to high-risk domains/countries (for example, .cc domain)

Use well-known protocols on non-standard ports

Contain obfuscated JavaScript
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Static Analysis

The second category analyzes each file in the session for signs of obfuscation in order to predict
the likelihood of the file behaving maliciously if allowed to run. For example, software that links
to networking libraries is more likely to perform suspicious network activity. Sample factors
used in the scoring of this criteria set may include:

o Files found to be XOR encoded

o Files found embedded within non-EXE formats (for example, PE file found embedded in a
GIF format)

o Files linking to higher risk import libraries

o Files highly deviating from the PE Format

Community

The third category scores the session and files based on the collective knowledge of the security
community. For example, files whose fingerprint/hash is already known to be good or bad by
respected anti-virus (AV) vendors is scored accordingly. Files are also scored based on
knowledge that a file was delivered from a site known to be good or bad by the security
community.

Community scoring also indicates whether the AV on your network flagged the files as
malicious. It does not indicate that the resident AV product acted to protect your system.

Sandbox

The fourth category examines the behavior of the software by actually running it in a sandbox
environment. By running the software to watch its behavior, a score can be calculated by
identifying well-known malicious activity. For example, software that configures itself to
autostart on each reboot and make IRC connections would score higher than a file with no
known bad behavior.
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Begin a Malware Analysis Investigation

You can investigate data that has been scanned, flagged, and rated by Malware Analysis as
containing Indicators of Compromise. This includes all types of Malware Analysis scans:
continuous mode polling, on-demand polling, and on-demand uploaded files. Continuous mode
polling must be enabled when the administrator configures basic settings for the Malware
Analysis service.

NetWitness Suite provides several methods of launching a Malware Analysis investigation.

Fastest: Instant Launch from Malware Analysis Dashlets

The fastest way to begin a Malware Analysis investigation is an Instant launch from the
NetWitness Suite Dashboard using one of the Malware Analysis dashlets that lists events or
files that are likely to contain malware. The dashlets are described as part of the RSA
NetWitness Content in Dashlets. From one of these dashlets, you can go directly to the Analysis
Results for a specific event that has been listed as worthy of investigation:

o Top Listing of Highly Suspicious Malware
o Top Listing of Possible Zero Day Malware

o Malware with High Confidence IOCs and High Scores Dashlet

On-Demand Polling from a Meta Value in the Navigate View

You can initiate on-demand polling from within an investigation by right-clicking a meta value in
the Navigate view, and choosing an option from the context menu. When polling is complete, the
scanned data is available for malware analysis (see Launch a Malware Analysis Scan from the

Navigate View).

Investigate a Specific RSA Service

You can also begin a Malware Analysis investigation of a service in the Investigate > Malware
Analysis view. For Malware Analysis investigation on a service basis, a service must be
specified in the Investigate > Malware Analysis view:Inve

1. Investigate opens the Malware Analysis view with the user-specified default service

selected.

2. If no default service is currently specified, a dialog allows you to select the Malware

Analysis service to investigate.

3. When a service has been selected in the Malware Analysis view, the Summary of Events for

the selected service and continuous scan data for the service is displayed.

This topic provides instructions for all methods of launching a Malware Analysis investigation.
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Launch a Malware Investigation from a Malware Analysis Dashlet

A prerequisite for this procedure is that one of the following dashlets must be visible in the
NetWitness Suite dashboard or in the Malware Analysis view, and must be populated with listed
events or files. If you do not see the dashlets, add them and configure the dashlets.

o Top Listing of Highly Suspicious Malware
o Top Listing of Possible Zero Day Malware

o Malware with High Confidence IOCs and High Scores Dashlet

To launch a Malware Analysis investigation from a dashlet:

1. Log in to NetWitness Suite and look for one of the above dashlets in the Monitor view or in

the Malware Analysis view

2. In the dashlet, double-click an event or file for deeper analysis. A detailed analysis of the
event in the Events List or the event with which the file in the File List is associated is

displayed in the Malware Analysis view.

INVESTIGATE @ admin © (@)

MALWARE ANALYSIS

% Actions

Analysis Results for Event 27238

Malware Analysis Service 10.31.125.249 #Files Static Score

2017-07-17T06:42:35 1 \i:.rq:l/;:l? 60

Manual Upload

op 10 Indicators of Compromise

Q Sandbox - Network Activity: More than 1 Unique Outbound Network Connection
255.255.255.255:67(UDP), 52.173.193.166:123(UDP)

Sandbox - Network Activity: Unknown Protocol (outbound)
(protocel: UNKNOWN_L7_PROTOCOL, transport: UDP) (local: 192.168.1.252:123, remote 52.173.193.166:123)

Sandbox - Network Activity: UDP Traffic (outbound)
(protocol: UNKNOWN_L7_PROTOCOL, transport: UDP) (local: 192.168.1.252:123, remote 52.173.193.166:123)

Sandbox - Network Activity: Unknown Protocol (inbound)
(protocol: UNKNOWN_L7_PROTOCOL, transport: UDP) (local: 0.0.0.0:68, remote 255.255.255.255:67)

9 sandbox - Network Activity: UDP Traffic (inbound)
(protocel: UNKNOWN_L7_PROTOCOL, transport: UDP) (local: 0.0.0.0:68, remote 255.255.255.255:67)

‘ NETWITNESS SUITE 11.0.0.0-170709005430.1.9127d8d

To learn more about configuring the Malware Analysis dashlets in the Monitor dashboard, see
"Dashlets" in the Getting Started with NetWitness Suite Guide.

To learn about the ways you can configure and filter information in dashlets in the Malware
Analysis view, refer to Filter Dashlet Data in the Summary of Events View.

To learn about the actions you can perform in the Analysis Results, refer to View Detailed
Malware Analysis of an Event.
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Begin a Malware Analysis Investigation (No Default Service)

To begin an investigation with no default service specified:

1. Select Investigation > Malware Analysis.

The Select a Malware Analysis Service dialog is displayed, with available Malware
Analysis hosts and services for the current user in the left panel and available scan jobs in
the right panel. This scan jobs panel contains the same columns as the Malware Scan Jobs
dashlet in the Unified dashboard. In addition, it has a toolbar and View options, which are

described in Select a Malware Analysis Service Dialog.

Select a Malware Analysis Service

Malware Services | Malware - Malware Analytics Scan Jobs List
¥ Default Service B scan Files Fe

Mame ~ Name Static Network Community Sandbox Progress Info  User

Malware - Malware Analytics )
No scan jobs found

Page of 0 | C 1w o~ No data to display

Cancel View Continuous Mode

2. In the list of Malware Analysis hosts, select a host and a list of scan jobs is displayed in the
right panel. These jobs are created when you scan an event or a file (see Upload Files for

Malware Analysis Scanning and Launch a Malware Analysis Scan from the Navigate View.

3. To begin analyzing a scan, do one of the following:
a. Select a scan and click View Scan.

b. Click View Continuous Mode.
The Summary of Events for the selected scan is displayed with the default dashlets
open. Each user can add, modify, and delete default dashlets, which persist through
different scan investigations. Users can also restore default dashlets as described in Filter

Dashlet Data in the Summary of Events View.
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INVESTIGATE (&) admin ©

MA RE ANALYSIS

Summary of Events

= Malware Analytics | MA + add v ¥F & Actions ¥

Scanned service re e Network End Time Scanned Start Time Scanned End Time

2017-07-18T14:40:59 2017-07-17T06:42:26  2017-07-17T06:42:38

Total High Confidence

Events Created Files Processed Events Created Files Processed

5 1
gffceFes @ ; Files E Files gffCEFES @

Meta Treemap

High Confidence Only
Source IP v |10 v | Static v || Average Score

NETWITN U 11.0.0.0-170709005430.1.9127d8d

Set or Clear the Default Service

You can set the default service and clear the default service in the Select a Malware Analysis
Service dialog.

To set a default service:

1. Click the service name in the Summary of Events toolbar.

The Select a Malware Analysis Service dialog is displayed.

Select a Malware Analy

Malware Services | Malware - Malware Analytics Scan Jobs List
™ Default Service B 5can Files F4
Mame ~ Name Static Network Community Sandbox Progress Info  User

Malware - Malware Analytics

3N jobs found

Page of 0 C 1o~ No data to display

Cancel View Continuous Mode
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2. Select a service on the list of available Malware services, and click V) Default Service
The service becomes the default, (indicated by ™ in front of the host name).

3. To clear the default service, select the default service in the grid, and click
V! Default Service

No default service is set.

Upload and Scan Files

A Malware Analyst with permissionto Initiate Malware Analysis Scan can upload files
to scan using the Scan Files option in the Select a Malware Analysis Service dialog (see Upload
Files for Malware Analysis Scanning. An administrator can upload packet capture files to a
Decoder for Malware Analysis in the Services System view as described in "Upload Packet
Capture File" in the Decoder and Log Decoder Configuration Guide.

Begin an Investigation (Default Service Specified)
To begin an investigation with a default service specified:

1. Select Investigation > Malware Analysis.
The Summary of Events for a continuous scan of the selected service is displayed with the
default dashlets open. Each user can add, modify, and delete default dashlets, which persist
through different scan investigations. Users can also restore default dashlets as described in

Filter Dashlet Data in the Summary of Events View.

INVESTIGATE (@) admin @

MALWARE ANALYSIS

Summary of Events
= Malware Analytics  MA + add @ £~ & Actions ©

e Network End Time Scanned Start Time Scanned End Time

2017-07-18T14:40:59 2017-07-17T06:42:26  2017-07-17T06:42:38

High Confidence

Events Created

1

E Files

p
1

Meta Treemap

High Cenfidence Only

Source IP ~ 10 v |5tatic ~ | Average Score

ITNESS SUITE 11.0.0.0-170709005430.1.9127d2d
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Apply Time Parameters Filter for Results

You can apply a Threshold filter to refresh the results of the chosen dashlets.

1.

To select a different time range, select either Continuous Mode or a different scan from the

toolbar.

The Malware Summary of Events for the selected scan is displayed.

2. To select a new time range for the scan, click in the range selection list in the toolbar.

Ranges available are: Last 5 minutes, Last 10 minutes, Last 15 minutes, Last 30 minutes,
Last Hour, Last 3 Hours, Last 6 Hours, Last 12 Hours, Last 24 Hours, Last 2 Days, Last 5
Days, Early Morning, Morning, Afternoon, Evening, All Day, Yesterday, This Week, Last

Week, or Custom.

G? Last 5 Minutes
@ Last 10 Minutes
@ Last 15 Minutes
@ Last 30 Minutes
@ Last Hour

G Last 3 Hours
] Last & Hours
& Last 12 Hours
“ Last 24 Hours
= Last 2 Days

:: Last 5 Days

Wt e al s B8 i Sm

-

The results are updated immediately.

3. To refresh a continuous mode scan with new data, click % .

Apply a Threshold Filter to Continuous Mode Results

You can apply a new threshold filter to an instance of the Malware with High Confidence IOCs
and High Scores dashlet, the Meta Treemap dashlet, the Score Wheel dashlet, and the Event
Timeline dashlet.

To customize the scoring applied to the scan, in the toolbar, do the following:

1. Select ¥ ' > Apply Threshold Filter.
The Apply Threshold Filter dialog is displayed.
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Apply Threshold Filter

Static by = W
Metwork &/ 2= v
Community &/ 2= w
Ssandbox & 2= W
Apply threshold to the following dashlets

[] Event Timeline ] Meta Treemap

] Seore Wheel

Cancel Apply

2. If you want to limit the number of events displayed to events that were given a score above a

certain number, do the following:
a. Drag the slider in the Static, Network, Community, and Sandbox slider bars.
b. To select the dashlets in which the thresholds apply, select the appropriate checkboxes.

c. Click Apply.

Delete or Resubmit an On-Demand Scan with New Bypass Settings

You can delete an on-demand scan or resubmit an on-demand scan with different bypass settings
than those specified in the Service Configuration view for a Malware Analysis service.

To delete a scan while viewing an on-demand scan, do the following:
1. Select Actions > Delete Scan.

A dialog asks for confirmation that you want to delete the scan.
2. Click Yes.

The selected scan is deleted.
To apply different bypass settings to the current scan:

1. Select Actions > Resubmit Scan.

The Scan for Malware dialog is displayed.
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Scan for Malware

Malware Analysis

Service * ”

Mame * Adhoc Scan HTTP

Community Sandbox

Bypass Executable L] Bypass Executable L]
Bypass Office L] Bypass Office L]
Bypass POF ] Bypass POF ]

Cancel Scan

2. Select the bypass settings that you want to use on the new scan, and click Scan.
Malware Analysis resets cache and resubmits the file for a new scan, and the scan jobs are

added to the jobs queue.

3. When the job is complete, scroll to the left and select View.

The Malware Summary of Events for the selected scan is displayed.

View the Files List

You can view a list of files for an event from the Malware Analysis Summary of Events and
from each of the Visualization charts: Event Timeline, Meta Breakdowns, Meta Treemap, and
Score Wheel.

To view the Files List, do one of the following:
o Inthe Summary of Events, click on the number of files in the Total row or the High

Confidence row under Files Processed, PE Files, Office Files, or PDF Files. The Files
List is displayed.

o In any visualization dashlet, click the number next to the Files field in the top right corner of
the dashlet.
The Files List for the selected drill point is displayed.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis

Files List
[High Confidence Only
< BacktoSummary | . Download Files sortBy |DateArchived ~ 42| Choose.. v 4= | Filter ©
O & Static Network | Community = Sandbox AV File Name File Type MDS5 Hash Source Address Destination Address Date Archived ¥ size
0% DD IS D B 1165392787-107..  x86 PE £p9c0881907db21675eb 6081240561 2018-03-07T01:44:49 72148 KB
O C ] 0 [ ) 1165392787-107... %86 PE 85761680020038558021865763f93190 2018-03-07T01:44:49 310.5KB
0% @ | I C [ ) 1165392787-107... %86 PE 026f2201708f86361b0480687fc46283 2018-03-07T01:44:149 162KB
0% IS DI I s 1165392787-107... 86 PE 7e4681324e2¢903522¢91f2aeefedde 2018-03-07T01:44:49 61.5K8
0% DN D D s 1164993132-107...  PDF 3edecfo67759e9e762999F4f34601F19 2018-03-07T01:4422  110.92KB
0% IS DD s 1164993132-107...  PDF 67e68ac5a05f0055a91 ected83775eed 2018-03-07T01:4422  57.19KB
O C | I C ]l € ) €_Documentsa..  MS Office 8e05a090879¢2b64759¢e8d9d2ad365 2018-03-07T01:44:112 403 KB
04 C | I C ]l € ) Student demogr... M5 Office 9c62cc148642df1 6efbed33fadbetbf 2018-03-07T01:43:48 22K8
04 C | I C ]l € ) Student demogr... M5 Office 9c60cfIf0eeB80dc871daf41966862bb9 2018-03-07T01:43:12 26 KB
0% EEDEE DN s keygen.exe 86 PE 2fd40091a1abbi3ebcadBba0ccBIead 2018-03-07T01:42:46 52.5KB
O 4 l @ ] C ]l € ) 2ITS Brochure .. PDF S1abbdcedBefe66f9eTdadae7504ced 2018-03-07T01:41:55 2.36 MB
O [ ] @ I C ] € ) 1.ITS Onelog Bro...  PDF a1388b3{768b0cfbedbdcfbf58b6742 2018-03-07T01:41:55 132M8
O % | I C ] € ) 1164269965-107..  PDF 9df61c038aaal230618fcdBc7ed1 46d 2018-03-07T01:41:33 892KB
O % | I C ) ) MS Office 63ad20669a7de6b616dcc712¢909a176 2018-03-07T01:41:29 28KB
0% IS CNS S s 1.05_SecureSph...  PDF af7d07261f127azaa0bfed3ae5 1 eeass 2018-03-07T01:41:26  417.02KB
O % C [ 1 L ]l € ) st27.pdf PDF 896ce4992c8dasfez1df29950175492e 2018-03-07T01:41:26 5262 KB
0% O S D s 5t36.pdf PDF 0bB0cbOcec79eb1b950d2447057fef7c 2018-03-07T01:41:21 13MB
O [ 12 1 L [ ) RESEARCHONC.. PDF 0644125cc375(750021 cacd25ef2cdc? 2018-03-07T01:41:12 807KB
| Page 1 of1 | | C s v Displaying 1-22 of 22
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From the Files List, you can search for a file by filename or MD5 file hash, sort the list using
two criteria and ascending or descending order, and download files as described in Examine Scan
Files and Events in List Form.

To return to the Summary of Events, click Back to Summary.

View the Events List

From the Malware Analysis Summary of Events and from each of the visualization charts (Event
Timeline, Meta Breakdowns, Meta Treemap, and Score Wheel), you can select events to view
in the Events grid.

To view the Events List, do one of the following:

o Inthe Summary of Events, click the number of Events Created in the Total row or the High

Confidence row. The Events List is displayed.

« In any visualization dashlet, click the number next to the Events field in the top right corner of
the dashlet.
The Events List for the selected time is displayed.
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Implement Custom YARA Content

In addition to the built-in indicators of compromise, Malware Analysis supports indicators of
compromise written in YARA. YARA is a rule language that allows malware researchers to
identify and classify malware samples. RSA makes built-in YARA-based Indicators of
Compromise (IOCs) available in RSA Live; these are automatically downloaded and activated
on subscribed hosts.

Customers with advanced skills and knowledge can add detection capabilities to RSA Malware
Analysis by authoring Y ARA rules and publishing them in RSA Live or placing YARA rules in
a watched folder for the host to consume.

As malware and the threat landscape evolve, it is important to review and examine existing
custom rules. Updates are often necessary to incorporate new detection methods. RSA also
updates YARA rules in Live from time to time. To receive updates, you can subscribe to the
RSA Blog and RSA Live at http://blogs.rsa.com/feed.

This document provides information to help customers implement custom Y ARA rules in
Malware Analysis.

Prerequisites

The host on which you are adding custom rules must be configured to support authoring of
Y ARA rules as described in "Enable Custom YARA Content" in the Malware Analysis
Configuration Guide.

YARA Version and Resources

RSA Malware Analysis is packaged with YARA version 3.7 (rev:167). To find out the exact
version, you can run yara -v on the Malware Analysis host as shown in this example:

[root@TESTHOST yaral] # yara -v
yvara 3.7 (rev:167)

Meta Keys in YARA Rules

Malware Analysis is compliant with other sources of YARA rules, and it also consumes
additional meta keys that are specific to Malware Analysis. Each YARA rule is equivalent to an
Indicator of Compromise (IOC) within Malware Analysis. The example below illustrates the
meta definitions in a rule:

meta:

iocName = "FW.ecodedGenericCLSID"
fileType = "WINDOWS PE"
score = 25

ceiling = 100
highConfidence = false
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iocName (Required) This is the name that MA uses as the rule name. It is specific to

Malware Analysis and is required to add the rule to the IOC list.

fileType Specifies the files type. Possible values are: WINDOWS PE, MS OFFICE,
and PDF. If not specified, the default value is WINDOWS PE.

score This value that is added to the static score if the YARA rule is triggered. If

not specified, the default value is 10.

ceiling This is the maximum amount that is added to the static scores when a rule is
triggered multiple times in one session. For example, if each time a rule is
triggered, 20 points are added to the static, and you do not want more that 40
points added when the rule is triggered more than two times, you can specify

a ceiling of 40. If not specified, the default value is 100.

highConfidence This sets the High Confidence flag, which is set on IOCs when there are
high confidence indicators that malware is present. If not specified, the

default file value is false.

Note: Refer to the following URL for YARA resources: https://code.google.com/p/yara-
project/downloads/list. NetWitness Suite uses YARA 3.7, not YARA 2.0.

YARA Content

RSA Live contains 3 sets of Yara rules:

o PE Packers
o PDF Artifacts

o PE Artifacts

The following figure illustrates YARA content available as YARA rules in NetWitness Suite
Live.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN (&) admin @)

Live Content nt Rules

Search Criteria Matching Resources

Keywords Show Results = | | 3 Package ~

yara [0 subscribed Name Created Updated Type Description
Category O ne RSA Malware PDF Artifacts 2013-11-21 3:37 PM 2013-11-21 3:37 PM Malware Rules Yara |0Cs which ¢

[IFEATURED O re RSA Malware PE Packers 2013-11-21 3:36 PM 2013-11-21 3:37 PM Malware Rules Yara O

» CITHREAT O ne RSA Malware PE Artifacts 2013-11-21 337 PM 2013-11-21 337 PM Malware Rules Yara 10Cs which :
» CJIDENTITY

b [JASSURANCE

» [ ORERATIONS
[ISPECTRUM
[ MALWARE ANALYSIS

Resource Types
Medium

Required Meta Keys

»
3 Matching Resources

On the Malware Analysis host, the YARA rules reside in /var/lib/netwitness/malware-
analytics-server/spectrum/yara, as shown in the example below

[rOOt@TESTHOST yaral# pwd
/var/lib/netwitness/malware-analytics-server/spectrum/yara
[rOOt@TESTHOST yaral# ls *.yara
rsa mw_pdf artifacts.yara rsa mw pe artifacts.yara rsa mw pe

packers.yara

The individual rules are listed as IOCs in the Malware Analysis Service Config view >
Indicators of Compromise tab. To view them, use the Yara module as the filter. You can adjust
the configuration of an individual in the same way that you configure other IOCs.

# Change Service | @@ Malware Analysis |  Config
General Indicators of Compromise [EleIeS{¥ 1y TNV s [1 -4 Hash Proxy ThreatGRID  Integration
Module Description Search Enable Al Disable All Reset All

[J Enabled | HighConfidence  Description Score File Type

a ™~ O Static (PDF): contains suspicious string artifacts O PDF

a ™~ =4 Static (PE) - Artifact: Anti-Reversing Debugger Check - Kernel Hook (KHook) @Ex Windows PE
] 4 ™ Static (PE) - Artifact: Anti-Reversing Debugger Check - SoftICE (NTice, OsiData) & Windows PE
a IE3 =4 Static (PE) - Artifact: Anti-Reversing Debugger Check - Syser (SyserLanguage, SdbgMsg, SyserDbgMsg) & Windows PE
a ™~ ™ Static (PE) - Artifact: Anti-Reversing Debugger Check - Sysinternals DbgView (DbgMsg) &x Windows PE
a ™~ ™ Static (PE) - Artifact: Anti-Reversing Debugger Check - Sysinternals Livekd (LiveKd) 1&x Windows PE
] 4 ™ Static (PE) - Artifact: Anti-Reversing VMWare Check - {Registry Artifacts) & Windows PE
O 4 =4 Static (PE) - Artifact: Anti-Reversing VMWare Check - (Services/Disk/Enum) & Windows PE
a ™~ O Static (PE) - Artifact: AutoStart File (Task Scheduler Folder) 1&x Windows PE
a ™~ O Static (PE) - Artifact: AutoStart File (Users Startup Folders) 1Ex Windows PE
[m} ™ O Static (PE) - Artifact: AutoStart File (autoexec.bat) O Windows PE
m] [ ] Static (PE) - Artifact: AutoStart File (autoexec.nt) O Windows PE
a ™~ O Static (PE) - Artifact: AutoStart File (auterun.inf) 1&x Windows PE
a ™~ O Static (PE) - Artifact: AutoStart File (boot.ini) O Windows PE
[m} ™~ O Static (PE) - Artifact: AuteStart File (config.nt) O Windows PE
] 4 O Static (PE) - Artifact: AutoStart File (config.sys) O Windows PE

| Page 1 of10 | )} ) | C 25  Indicators of Compromise Per Page Displaying Indicators of Compromise 1 - 25 of 228
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Add Custom YARA Rules

To introduce custom YARA rules from other sources:

1. To ensure that the YARA rules follows the correct format and syntax, use the YARA
command to compile the YARA rule as shown in the following example. If the rule compiles
with no errors, this indicates that the YARA rule has the correct syntax.

[root@TESTHOST yaral# yara rsa mw_pe packers.yara dummy.txt
[rOOt@TESTHOST vyaral#

2. Ensure that custom rules do not duplicate existing YARA rules from RSA or other sources.

All YARA rules are in /var/lib/netwitness/malware-analytics-

server/spectrum/yara

3. Ensure that the meta keys that RSA supports are included to organize the YARA rules as
part of the configurable IOCs, and name the file with the yara extension (<filename>.yara).
For better organization, make sure that the i ocName meta is included in the meta section as

shown in the following example.

Example:
rule HEX EXAMPLE
{

meta:
author = "RSA"
info = "HEX Detection"
iocName = "Hex Example"
strings:

Shexl = { E2 34 Al C8 23 FB }
Swide string = "Ausov" wide ascii
condition:

Shexl or Swide string

}
4. When ready, place the custom YARA file in the folder that the Malware Analysis service

watches:
/var/lib/netwitness/malware-analytics-server/spectrum/yara/watch
The file is consumed within one minute.

Once consumed, NetWitness Suite moves the file to the processed folder, and the new
rule is added to the Malware Analysis Services Config view > Indicators of Compromise
tab.
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Examine Scan Files and Events in List Form

When viewing the Summary of Events in a Malware Analysis scan, you can click a file count or
an event count to view the Files List or the Events List for the scan (see Begin a Malware
Analysis Investigation). In the Files List and Events List, you can search for a file by filename or

MDS5 file hash, sort the list using two criteria and ascending or descending order, and download
files. When you find an event or file of interest in the Events List or Files List, you can view
many details about the event in the Event Details view.

For each event in the Events List, NetWitness Suite provides the following information:

Flagged as a High Confidence event, which is considered likely to contain Indicators

of Compromise.

The numeric score for each scoring module: Static, Network, Community, and Sandbox.
Antivirus vendor scores.

The Influenced by customized rule flag.
The date the event was archived.

The session time.

The MDS5 hash filter.

The number of files in the event.

The source [P address of the event.

The Identity.

The destination IP address.

The destination country.

The name of the alias host.

The event type, for example, Network.
The service used by the event.

The destination organization

For each file in the Files List, NetWitness Suite provides the following information:

Flagged as a High Confidence event, which is considered likely to contain Indicators

of Compromise.

The numeric score for each scoring module: Static, Network, Community, and Sandbox.
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o Antivirus vendor scores.

o The filename.

o The file type.

o The MDS5 hash filter.

o The source IP address of the event that contained the file.
o The destination IP address.

o The date the event that contained the file was archived.

o The file size.

Sort the Files List or Events List

You can sort the Files List and Events List by column name in ascending and descending order.
You can choose one or two columns.

To sort the list:
1. Inthe first Sort By drop-down list, choose a column name and sort direction: for

descending order or = for ascending order.

2. (Optional) In the second Sort By drop-down list, choose a column name, and sort direction,

for descending order or = for ascending order.

The column titles reflect the selected sort order.

Filter the List by Filename or MDS5 File Hash

You can filter the Files List and Events List by filename or file hash. With this feature, you can
specify a limited subset of the original data based on the search criteria.

Note: When you perform a search, you search the scan that you are currently displaying, not
all scans.

Filter @
1 Click Gl

The Filter dialog is displayed.
2. Enter a value in File Name or MD5 Hash and click Filter. The File Name and Hash field

are not case sensitive. Wild card or regular expressions are not supported. The filter is based
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on exact matches. You can drag across a filename or hash to select from the Files list or

Events list, then copy and paste it in the dialog.
3. Click Filter.

Malware Analysis filters the list to display only files or events with the selected hash

Filter -
4. To revert to the unfiltered list, click 2 L2 . When the Filter dialog is displayed, click

Reset.

Download Files from the Files List

NetWitness Suite lets you select and download files from the Files List or the Events List.

Caution: Use caution when downloading files from Malware Analysis; some files may
contain harmful code. File Download is a specific permission that can be configured, refer
to "Define Roles and Permissions for Malware Analysts" in the Malware Analysis
Configuration Guide for more details.

To download files from the Files List or Events List:

1. In the Files List or Events List, select the checkbox next to one or more rows.

2. In the toolbar, select 'L Download Files .
The Malware File Download dialog is displayed.
3. Do one of the following:
a. If you decide not to download the file, click Cancel.

b. If you want to download the file, select click the Download button.
The file or files selected are downloaded in a zip archive with the name Malware

Files.zip.

Delete Events from the Scan

In the Events List, you select one or more events and delete them from the scan. This is useful
for removing events that are not of interest.

To remove an event from the scan being viewed:

1. Inthe Events List, select one or more events.

2. In the toolbar, click '8 Delete Events .

NetWitness Suite asks for confirmation that you want to delete the events.

3. In the confirmation dialog, click Yes.

The selected events are deleted.
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Return to the Summary of Events

To leave the Files List or Events List and return to the Summary of Events, click Back to

Summary.

Open the Detailed Analysis for an Event

While you examine events or files in the Files List or Events List, you can double-click any
event or file to open a detailed analysis of the event in the Events List or the event with which
the file in the Files List is associated (see View Detailed Malware Analysis of an Event).
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Filter Dashlet Data in the Summary of Events View

The Summary of Events provides a summary of the scan being investigated with selectable
dashlets. The Summary of Events is fixed, but Analysts can configure each dashlet to filter out
information and drill into the data.

The rest of this topic provides instructions for managing and configuring dashlets.

Configure the Score Wheel Dashlet

The Score Wheel is a high-level visualization of analyzed sessions that scored high, medium, or
low in each of the scoring categories: Static, Network, Community, and Sandbox. The Score
Wheel is a quick way to drill into sessions to review them. Each ring represents a different
scoring category so that you can visually compare results by category.

Score Wheel X

High Confidence Only Events:1 Files:1

4= Up 4= Down
Ring 1%  Static

Ring 2 Sandbox
Ring 3 Cammunity

Ring 4 Network

* Innermost ring

You can change the order of the rings to highlight indicators of compromise that were flagged in
one category but not in another category. Comparing the same results in a different sequence of
the rings provides visibility into additional vulnerabilities in a session, and you can drill into
sessions of interest. The following examples show two possible use cases.

Zero-Day Candidates Example

This example shows how to drill into sessions that the Community did not flag as malicious, but
all other scoring categories did. The resulting list of sessions highlights zero-day candidates.
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1. Configure the Score Wheel rings in the following sequence:

Community (innermost) > Static > Network > Sandbox (outermost)

2. Click the red slice in the outermost (Sandbox) ring that aligns with a green slice on the
innermost ring (Community): green (innermost) -> Static: red -> Network: red -> Sandbox:

red (outermost).

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis

Events List
[High Confidence Only

¢ BacktoSummary | TS Delete Events % Download Files SortBy DateArchived v 42| Choose . v ¥ | P Filter ©
O & static Network Community | Sandbox AV ™ Date Archived v Session Time #Files | Source Address  Identity Destination Addr| Destination Country  Alias Host EventType  Service Destination Organiza
¥ % I EIE N 2018-03-07T01:44:...  2018-03-07T01:14:.. 4 e e - United States OnDem.. HTTP Google

0 % | ] CE 1 ) 2018-03-07T01:44:...  2018-03-07T01:14:... 2 United States OnDema.. HTTP  University of Cali..
O % ] | ] C ) L l 2018-03-07T01:44: 2018-03-07T01:14.... 1 United States blackboardjason.org  OnDema.. HTTP  Centurylink
[ [ ) C  C ) 2018-03-07T01:43....  2018-03-07T01:14.. 1 United States OnDema.. HTTP  Google

O % C ] ] C ] C ) 2018-03-07T01:43....  2018-03-07T01:14:... 1 United States OnDema.. HTTP  Google

O % EEEE N S 2018-03-07T01:42: 2018-03-07T01:14.... 1 Netherlands OnDema.. HTTP  LeaseWeb Neth...
O % ] @ ] C ) € ] 2018-03-07T01:41:...  2018-03-07T01:14:... 2 United States wwwitsltduk.co.uk OnDema.. SMTP  The George Was..
0O % C ] I C L ) 2018-03-07T0T:415...  2018-03-07T01: 141 1 United States OnDema.. HTTP  Blackboard
[ ] | o ) C l 2018-03-07T01:41:..  2018-03-07T01:14:... 1 United Kingdom OnDema.. HTTP  Yahoo! UK Servic...
O % ] | ] C ) L l 2018-03-07T01:41 2018-03-07T01:14.... 1 United States www.gwu.edu OnDema.. HTTP  The George Was..
O % N N TN s 2018-03-07T01:41 2018-03-07T01:14.... 1 United States domaindnszones.su...  GnDema.. SMTP  The George Was...
O % C ] B ] C ) 2018-03-07T01:41:...  2018-03-07T01:14:... 1 United States www.gwu.edu OnDema.. HTTP  The George Was..
O % I ] & ] C ] | ] 2018-03-07T01:41 2018-03-07T01:14:... 1 United States www.gwumc.edu OnDema.. HTTP  The George Was..
O 4% HEEE O s 2018-03-07T01:41:...  2018-03-07T01:14:... 1 Netherlands OnDema.. HTTP  LeaseWeb Neth...
O % ] | o ) L l 2018-03-07T01:41:..  2018-03-07T01:14.... 1 United States Www.gwu.edu CnDema.. HTTP  The George Was..
O % C [ o ] C ] 2018-03-07T01:40:...  2018-03-07T01:14:... 1 United States OnDema.. HTTP  Google

[ ] IO 1 ) 2018-03-07T01:40:...  2018-03-07T01:14:... 1 United States GnDema.. HTTP  Level3 Commun..

| Page 1 of1 | 1 Cls v Displaying 1-17 0f 17

Malicious Sessions Example

This example shows how to drill into sessions in which all scoring categories identify the
resulting list of sessions as malicious, indicating Malware Analysis has the most confidence that
they are malware.

1. Configure the Score Wheel rings in the following sequence:

Community (innermost) > Static > Network > Sandbox (outermost)

2. Click the red slice of the outermost (Sandbox) ring that aligns within a red slice on the
innermost ring (Community): red (innermost) -> Static: red -> Network: red -> Sandbox: red

(outermost).

Arrange the Ring Sequence by Scoring Module

In the Score Wheel, you can arrange the sequence of the rings by scoring module. Initially, the
sequence of rings from inside to outside is Static, Network, Community, and Sandbox.

To change the ring sequence:

241 Conducting Malware Analysis



NetWitness Investigate User Guide

1. Do one of the following:
a. Click and drag each scoring module up or down.
b. Select each scoring module and use the Up and Down buttons to move it.

2. When the ring sequence is the way you want it, click the Update button.

The Score Wheel is refreshed with the new sequence.

Configure the Meta Treemap Dashlet

In the Meta Treemap chart, you can visualize and filter meta breakdowns by meta type, count,
and analysis type. Use the three selection lists to set the filter, and the Meta Treemap chart is
refreshed immediately.

Meta Treemap aHX
High Cenfidence Only Events:1 Files:1
Source IP ~ |10 ~||5tatic v || Average Score A4

Configure the Meta Breakdowns Dashlet

The Meta Breakdowns dashlet is a visualization of values for a specific meta key in a pie chart.
In the Meta Breakdowns chart, you can filter meta breakdowns by meta type and count. Use the
two selection lists to set the filter, and the Meta Breakdowns chart is refreshed immediately.
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Meta Breakdowns 2 X
High Cenfidence Only

Source IP V(3 v

L 127.001

Configure the Events Timeline Dashlet
The Events Timeline dashlet is a visualization of the events along a timeline. No additional

filters are available for the Event Timeline.

Event Timeline 2 X
Filter : Events: 0 Files: 0

No data returned for Event Timeline

View Events

Open All Events in the Events List

From within the Event Timeline, you can open the entire list of events in the Events List. To do

so, click ViewEvents | This option is not the same as clicking the count next to Events,
which is the same for all visualization charts and opens the current drill point in the Events List.
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Configure the Top Listing of Highly Suspicious Malware Dashlet

The Top Listing of Highly Suspicious Malware Dashlet presents the Top 10 most suspicious
events in the Events List or the Files List. This dashlet is also available in the Monitor
dashboard, and the configuration options are described as part of the RSA NetWitness Content
in Dashlets..

Top Listing of Highly Suspicious Malware 28X

O '&e" Static »= Network >= Community >= i Sandbox >= AV | File Name MD5 Hash Date Arg
¥
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Configure the Malware with High Confidence IOCs and High Scores Dashlet

The Malware with High Confidence IOCs and High Scores dashlet presents Indicators of
Compromise that have both high scores and high confidence that the events are likely to contain
malware. The dashlet is also available in the Unified dashboard, and the configuration options
are described as part of the RSA NetWitness Content in Dashlets..

Malware with High Confidence I0Cs and High Scores A X
High Cenfidence Only,
O 'ﬁe“ Static == Network == Community >= Sandbox AV ™ Date Archived v #Files  Source Address Destination Addr| Alias b

Configure the Top Listing of Possible Zero Day Malware Dashlet

The Top Listing of Possible Zero Day Malware dashlet presents potential zero day events in the
Events List or the Files List. The dashlet is also available in the Unified dashboard, and the
configuration options are described as part of the RSA NetWitness Content in Dashlets.

Top Listing of Possible Zero Day Malware A X
High Confidence Only,
O f& Static »= Network >= Community <= Sandbox Av ™ Date Archived v #Files  Source Address = Destination Addr  Alias F
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Upload Files for Malware Analysis Scanning

There are two methods for analysts to upload files for Malware Analysis scanning.

A Malware Analyst with permission to Initiate Malware Analysis Scan can upload files to scan
using the Scan Files option in the Select a Malware Analysis Service dialog.

It is also possible to upload a file for scanning using a watched file share.

Upload Files Manually

This topic provides instructions for initiating on-demand scanning of an uploaded file. When you
upload a file for scanning, NetWitness Suite starts the upload job and adds it to the jobs queue.
When the job is complete, you can view the scan in Malware Analysis.

To upload a file to scan:
1. Goto INVESTIGATE > Malware Analysis.

The Select a Malware Analysis Service dialog is displayed, with available Malware

Analysis hosts and services for the current user in the left panel.

Select a Malware Analysis Service

Malware Services | Malware - Malware Analytics Scan Jobs List

™ Default Service B scan Files o
Mame ~ Name Static Network Community Sandbox Progress Info  User

Malware - Malware Analytics )
No scan jobs found

Page of 0 | o o~ No data to display

View Continuous Mode

2. Click View Scan.
The Scan for Malware dialog is displayed.
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Scan for Malware

+ -—

File Mame

Mame *

Community Sandbox

Bypass Executable ] Bypass Executable
Bypass Office L] Bypass Office
Bypass PDF Bypass PDF

Cancel

3 Click T

A view of the files system is displayed so that you can choose files to upload.

4. Select one or more files from the list and click Open.

The file names are added. Malware Analysis escapes the filename characters before

processing a file. The maximum number of filename characters after escaping is 200. If the

filename is greater than 200 characters, Malware Analysis truncates the filename characters

and displays the truncated filename in the NetWitness Suite user interface.

Continue adding and deleting files until you have a list of the files that you want to upload.

Name the scan and select the types of files to bypass. This is useful for a zip archive that

contains different types of files, and overrides the default bypass settings.

7. Click Scan.

The scan job is submitted and NetWitness Suite displays a confirmation message for

successful submission. The scan request is added to the Scan Jobs List dashlet. The bypass

settings in this dialog override the default settings in the basic Malware Analysis

configuration settings.
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8. The job is added to the Scan Jobs List in the Select a Malware Analysis Service dialog and
in the Unified dashboard Scan Jobs List dashlet.

9. To view the scan when complete, double-click the scan.

The Malware Summary of Events for the selected scan is displayed.

Upload Files from a Watched Folder

To upload files from a watched folder, you can drop files into a watched file share for Malware
Analysis. Analysts can share YARA rules, hash files, and infected zip archives with Malware
Analysis.

Malware Analysis watches a file share and automatically consumes files placed in specific
folders in the file share. This feature is useful for:

o Bulk import of hash files from /var/1lib/rsamalware/spectrum/hashWatch

o Addition of custom-Y ARA rules to the Indicators of Compromise (IOC) list on the host from

/var/lib/netwitness/malware-analytics-server/spectrum/yara/watch.

o Creation of on-demand scan jobs from a zip archive of infected zip files from

/var/lib/rsamalware/spectrum/infectedZipWatch/watch.

Analysts need to prepare the files for consumption in accordance with requirements, the file
extension must be correct, and the file must be copied to the correct watched folder in the file
share.

Import a Hash List

To import a hash list from the watched directory, the hash list must be in the specified format
and must be sorted on mdS. You can drop a file formatted into a folder
(/var/lib/rsamalware/spectrum/hashWatch) on the Malware Analysis host, and it is
automatically imported into the local hash database. This is described in "Configure Hash Filter
in the Malware Analysis Configuration Guide.

"

To import a hash list using the watched folder method:

1. Copy the hash lists that you want to import into the
/var/lib/rsamalware/spectrum/hashWatch directory
NetWitness Suite Malware Analysis automatically watches this folder and processes files

placed there.
a. Malware Analysis adds every hash found in the hash lists to the hash filter.

b. If there are processing errors, they are logged in:

/var/lib/rsamalware/spectrum/hashWatch/error
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c. Processed files are cataloged

here: /var/lib/rsamalware/spectrum/hashWiatch/processed
d. Processed files are not removed from the hashWatch directory.
2. After importing hashes in bulk, the System Administrator can use a cronjob to clean up old
processed files.
Import YARA rules to the IOC List

Customers with advanced skills and knowledge can add detection capabilities to RSA Malware
Analysis by authoring Y ARA rules and publishing them in RSA Live or placing YARA rules in
a watched folder for the host to consume. Implement Custom YARA Contentprovides complete
information on the prerequisites for using custom YARA content and authoring rules.

When the rules are ready, place the custom YARA files in the folder that the Malware Analysis
service watches:
/var/lib/netwitness/malware-analytics-server/spectrum/yara/watch

The file is consumed within one minute.

Once consumed, NetWitness Suite moves the file to the processed folder, and the new rule is
added to the Malware Analysis Service Config view > Indicators of Compromise tab.

& Change Service | @M@ Malware Analysis |  Config
General Indicaters of Compromise [E{eIeS{¥T 1y T, VRNENVTs[1 -4 Hash Proxy ThreatGRID  Integration
Module Description Search Enable All Disable All Reset Al

[J Enabled | HighConfidence  Description Score File Type

a ™~ O Static (PDF): contains suspicious string artifacts 0 PDF

] 4 ™ Static (PE) - Artifact: Anti-Reversing Debugger Check - Kernel Hook (KHook) & Windows PE
O 4 [£4 Static (PE) - Artifact: Anti-Reversing Debugger Check - SoftICE (NTice, OsiData) 10 Windows PE
a ™~ ~ Static (PE) - Artifact: Anti-Reversing Debugger Check - Syser (SyserLanguage, SdbgMsg, SyserDbgMsg) &x Windows PE
a ™~ ™ Static (PE) - Artifact: Anti-Reversing Debugger Check - Sysinternals DbgView (DbgMsg) 1&x Windows PE
O ™ ™ Static (PE) - Artifact: Anti-Reversing Debugger Check - Sysinternals Livekd (Livekd) O Wwindows PE
m] £4 4 Static (PE) - Artifact: Anti-Reversing VMWare Check - (Registry Artifacts) 0 Windows PE
a IE3 =4 Static (PE) - Artifact: Anti-Reversing VMWare Check - (Services/Disk/Enum) 0 Windows PE
a ™~ O Static (PE) - Artifact: AutoStart File (Task Scheduler Folder) 0 Windows PE
[m} ™~ O Static (PE) - Artifact: AuteStart File (Users Startup Folders) 1&x Windows PE
0 ~ O Static (PE) - Artifact: AutoStart File {autoexec.bat) 5 Windows PE
O 4 O Static (PE) - Artifact: AutoStart File (autoexec.nt) O Windows PE
a ™~ O Static (PE) - Artifact: AutoStart File (auterun.inf) 1&x Windows PE
[m} ™~ O Static (PE) - Artifact: AutoStart File (boot.ini) 0 Windows PE
0 ~ O Static (PE) - Artifact: AutoStart File (config.nt) 5 Windows PE
O =4 O Static (PE) - Artifact: AutoStart File (config.sys) O: m Windows PE

| Page 1 of10 | ) ¥ | C 25 2 Indicators of Compromise Per Page Displaying Indicators of Compromise 1 - 25 of 228

Import Files into the Scan Jobs List

When you obtain samples from perimeter security solutions and would like to perform further
analysis on the files, you can zip the files and password protect the archive with infected,
then add to the watched folder for consumption by Malware Analysis. This zipped archive is
ready to be placed in the watched folder:
/var/lib/rsamalware/spectrum/infectedZipWatch/watch.
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Note: The maximum size of the archive is 100 MB.

To analyze infected, password-protected zip files, Malware Analysis consumes archives place

in a watched folder and creates an on-demand job that is added to the Scan Jobs List.

1. While logged on as administrator, place the files to be processed in a zip file with password
infected at /var/lib/rsamalware/spectrum/infectedZipWatch/watch
In a minute or two Malware Analysis consumes the archive and creates an on-demand job
in the Scan Jobs List. The scan job name is the name of the file, the user is file share, and

the Event Type is 1. The archive is moved to

/var/lib/rsamalware/spectrum/infectedZipWatch/processed

2. After the job is added to the Scan Job List, run a script or cronjob to clean up the zip file in

/var/lib/rsamalware/spectrum/infectedZipWatch/processed.
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View Detailed Malware Analysis of an Event

When viewing the list of individual events in a Malware Analysis scan in the Malware Analysis
Events grid, you can double-click an event to view the detailed analysis results for the event.

View Malware Analysis Details for an Event

1. Start an investigation in the Malware Analysis tab.
The Malware Summary of Events is displayed, and includes four charts, including the Event

Timeline.
2. Do one of the following:
a. To view all events in the Event Timeline, click the View Events button.

b. Double-click data in the Meta Breakdown, Meta Treemap Chart, or Score Wheel.
The Events List is displayed.

3. Double-click an event.

The Analysis Results for the event are displayed.

INVESTIGATE

MALWARE ANALYSIS

# Actions

2017-07-17T06:42:35

Manual Upload

op 10 Indicators of Compromise

o Q Sandbox - Network Activity: More than 1 Unique Outbound Network Connection
255.255.255.255:67(UDP), 52.173.193.166:123(UDP)

o Q sandbox - Network Activity: Unknown Protocol (outhound)
(protocol: UNKNOWN_L7_PROTOCOL, transport: UDP) (local: 192.168.1.252:123, remote 52.173.193.166:123)

o Q sandbox - Network Activity: UDP Traffic (outbound)
(protocel: UNKNOWN_L7_PROTOCOL, transport: UDP) (local: 192.168,1.252:123, remete 52.173.193.166:123)

o 9 sandbox - Network Activity: Unknown Protocol (inbound)
(protocel: UNKNOWN_L7_PROTOCOL, transport: UDP) (local: 0.0.0.0:68, remote 255.255.255.255:67)

sandbox - Network Activity: UDP Traffic (inbound)
(protocel: UNKNOWN_L7_PROTOCOL, transport: UDP) (local: 0.0.0.0:68, remote 255.255.255.255:67)

11.0.0.0-170709005430.1.9127d8d

4. (Optional) If you want to delete an event, select Actions > Delete Event.

5. If you want to view a reconstruction of the network session, select Actions > View
Network Session.

The session opens in the Navigate view > Event Reconstruction.
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Pivot Network Analysis Results

You can pivot the Network Analysis Results in several ways:

1. Scroll down to the Network Analysis Results.

N/A  Network Analysis Results

Meta Highlights [Show All]

* Source Address
© 127.0.0.1 =

Source Port

MN/A

Seszsion |d

M/A

Alias Host

M/A

1 Referrer

MN/A

File Name
MN/A

Destination Address

10.31.125.249 ~

Destination Port

MN/A

Destination Country
Unavailable =

Destination Organization

MN/A

Direcrory

M/A

2. Hover over a meta value and left-click.
The context menu is displayed.
127.0.0.1 &

# Start Investigation »
Open in Web Browser »
127.0.0.1

3. To view the selected meta value in the Navigate view, select Start Investigation and a time

option.

4. To view the selected meta value in a browser, select Open in Web Browser > Open in

Google.

Use File Actions in the Static Analysis Results

1. Scroll down to the Static Analysis Results.
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60  Static Analysis Results

Company ’ Digital Signature
N/A — TRUST_E_NOSIGNATURE
. File Size k. File Type
1.04 MB (1,085,440 bytes) PE32
. File Version k. Internal Name
N/A . N/A
1’) Language a MD5
EnglishUnitedStates =8 71c2ea2b936ba80f4bad80937b369adf
E Subsystern Type Original File Name
2 B |MAGE_SUBSYSTEM_WINDOWS_GUI N/A
B PE Size |||I|I|||| Product Name
1.04 MB (1,085,440 bytes) o N/A
|||I|I|||| Product Version m SHAT
T NAA =8 78c3bc1e295354134784593446a58f2deda7bads

SHA256 HASH
@ 4883006d63a2e488caa81bd9cs647324c8a6e088a0ded55e5af0fbdBaded227d

2. If you want to download a file, select the file name and either Download File (zipped) or
Download File (natively) in the drop-down menu. It is safer to download a file in zipped

format.

235645659702-107-0_1.exe ~

Download File (zipped)
Download File (natively)
% Filter File Hash »
Open in Web Browser »

2356455509702-107-0_1.exe

71c22a2b936ba80f4badB0537h0

3. If you want to mark the file as safe or unsafe in the hash list, select Filter File Hash and
Mark hash as good or Mark hash as bad.

View Community Analysis Results Details

The Community Analysis Results summarizes results from the community, identifying Indicators
of Compromise that were flagged as a risk or identified as good.

In addition, this view lists the results from Installed AV Vendors and Not Installed AV Vendors.
You can compare results of the installed AV vendors that were configured for the current
Malware Analysis service versus Community results. You can also see results from a list of AV
vendors that are not configured as installed for the current Malware Analysis service.
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Each row of AV vendor results includes the shield icon to show whether the IOC was

discovered by a Primary (ﬁ) or Secondary AV (ﬁ) vendor in the community, the name of the
Installed or Not Installed vendor, and the name of malware or risk detected by the community
and AV vendor. If the AV vendor did not detect a risk, -- Not detected -- is displayed instead of
the name of the risk.

The Not Installed AV Vendors section is expandable to view all entries, but is collapsed by
default to minimize the need to scroll. Clicking the + expands the list.

If no installed AV vendors have been configured for the current Malware Analysis service, the
following message is displayed: No AV vendors were marked as installed. Please go to the
Malware Analysis Service configuration page to identify installed AV vendors.

@) admin &

SERVICES
& ChangeService | O Malware Analytics |  Config @

General Indicators of Compromise  10C Summary Auditing Hash Proxy ThreatGRID  Integration

Select the AV vendors you are using
Primary AV Vendors
£4 AVG @‘;‘-‘ BitDefender ¥ @ ClamWin En F-prot
™ & Fsecure 4 %25 Fortinet 4 K Kaspersky 4 W McAfee-Gateway
™ @ Microsoft @S Sophos 4 , Symantec
[ ##) TrendMicroHauseCall
Secondary AV Vendors
™ & AegisLab ™ € Agnitwm ™ Ay Ahnlab ™ £ Antiy
™ (R, Avira ¥ @ ByieHero ™ @ Commeouch ¥ 1) ESET
¥ @ Emsisoft @ Filseclab ™ GFI GFI ™ Vj Hauri
¥ &3 lkaru ™ dijf Jiangmin ™ [y ™ (@ Kingsoft
™ L Lavasoft ™ [ NANC ™ m Nerman ™ () QuickHeal
4 0 SUPERANGSpyware ¥ @ TotalDefense & @ virlT ¥ A VirusBlokAda
™ @ Zillya! ¥ @ Zoner ™ BN nProtect o

‘ NETWITNESS SUITE 11.0.0.0-170709005430.1.9127d&d

View Sandbox Analysis Results in the ThreatGrid User Interface
If you have registered with ThreatGrid, you can view the Sandbox results directly in ThreatGrid.

1. Scroll down to the Sandbox Analysis Results.
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100

L

s
1

i ® = @ B

Sandbox Analysis Results

Number Files Downloaded

0

Number Processes Spawned

16

Number Incoming Sockets

0

Number of Sockets Listening

0

Vendor Name

ThreatGrid

MNumber of UDP Sockets

9

Number of Firewalled Connections

0

o M2 sl
P %)

L

Number Qutgeoing Sockets

0

Mumber Sockets with Unknown Protocol

8

Process Runtime

0

Process Status

M/A

Analysis Id
52bba6514d37h1760d78a44h082b735f

Number of Registry Modifications

1

Number of File Medifications

9

2. Click the Analysis ID and select Open In ThreatGrid.
The analysis report in ThreatGrid is displayed.
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Troubleshooting NetWitness Investigate

This section provides information about possible issues when using NetWitness Investigate.

Event Analysis Issues

Investigation Profiles/OOTB column groups are not present

in Event Analysis

Post upgrade to RSA NetWitness v11.1, the default column groups - Endpoint
Analysis, Outbound SSL and Outbound Http are not added under column groups.

Also, few of the Investigation Profiles are missing post upgrade.

It is observed that this issue occurs only when you have created a custom
column group with the name which is same as one of the new 11.1 OOTB
custom column group name. For example, if you create a custom column group
in 11.0 with name RSA Endpoint Analysis then after upgrade to 11.1. Due to
the same name already existing in 11.1, OOTB column groups and OOTB
profiles will not be available in the Ul

To fix this, change the name of custom column group to something else and
restart the jetty server by using the following command on the NetWitness
server:

systemctl restart jetty

Applicable for hosts with 4.x Endpoint agents installed,

please install the NetWitness Endpoint Thick Client.

When you click Pivot to Endpoint in the Event Analysis view, no data is

displayed and the message is displayed.

Version 4.4 of the NetWitness Endpoint Thick Client must be installed on the
same server, the NWE meta keys must exist in the table-map.xml file on the
Log Decoder, and the NWE meta keys must exist in the index-

concentrator-custom.xml file. The NWE Thick Client is a Windows only
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application. Complete setup instructions are provided in the NetWitness

Endpoint User Guide for Version 4.4,

Event Analysis requires all core services to be NetWitness
11.1. Connecting prior versions of services to the 11.1
NetWitness Server results in limited functionality (see
"Investigate in Mixed Mode" in the Physical Host Upgrade
Guide) .

When attempting to investigate a service that has not been updated to Version

11.1 in the Event Analysis view, the informational message is displayed.

When an analyst opens the Event Analysis view in mixed mode (that is, some
services are upgraded to 11.1 and some are still on 11.0.0.x or 10.6.x), Role-
Based Access (RBAC) is not applied uniformly. This affects viewing and
downloading content, and validation of filters in the interactive breadcrumb.
You will see this informational message when you open Event Analysis. As you
select a service, services that are not up to date are displayed in a red box, with
the message that the service is not up to date. When your administrator has

upgraded all connected services to 11.1, these features work as expected.

Forbidden. You cannot access the requested page.

When attempting to access the Event Analysis view, the view opens with the

message.

Your administrator has prevented access to the Event Analysis view using role

and permissions.

Insufficient permissions for the requested data.

While attempting to access an event in Event Analysis by any means, the

reconstruction is not displayed and the message is displayed.
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You have entered an event ID for an event that you do not have permission to
view. The administrator may have placed some restrictions to limit access by

role and permissions.

Invalid session ID: <<eventId>>

No sessionId matches the sessionId that you queried.

The reason for an invalid session ID can vary. Perhaps you edited the session
ID manually, and no such session exists. Another case may be when you query
a Broker, and the aggregated data has not been refreshed, you may see this

error for a session that no longer exists.

No text data was generated during content reconstruction.

This could mean that the event data was corrupt/invalid, or
that an administrator has disabled the transmission of raw
endpoint events in the Endpoint server configuration. Check

the other reconstruction views.

When you reconstruct an event as text in the Event Analysis view, no data is

displayed and the message is displayed.

If you do not see the raw text in other Event Analysis views or Events view
reconstructions, and you believe the data is not corrupted or invalid, your
administrator has likely disabled transmission of raw endpoint events on the
NetWitness Endpoint server. Contact your administrator for additional

information.

Session is unavailable for viewing.

While querying an event ID, the reconstruction is not displayed and the message

is displayed.
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The query you entered is trying to look at restricted data, for example, if you are
allowed to see only log data and you are using a link to network data that you

were allowed to see yesterday.

The session i1id is too large to be handled:<<eventId>

The sessionld integer that you typed in, edited, or got from the Events view or

Navigate view is too large.

If you manually typed the sessionld or edited a sessionld in the Event Analysis
view, you may have created an integer that is too large for Event Analysis to

process.

While creating a filter in the Event Analysis view, you cannot enter a complex
expression using the AND or OR operator in Query Builder.

The query builder in the Event Analysis view supports only simple expressions

in the form <meta key><operator><meta value>.

If you want to enter a filter that uses the AND or OR operator, you need to enter
the query it from the Navigate view or Events view and then open it in the
Event Analysis view. You can enter some complex expressions as two separate
filters in the Event Analysis view. The filters will be AND'd when you execute
the query.

Hosts View Issues

An error has occurred. The Endpoint Server may be offline

or inaccessible.

When attempting to access the Hosts or Files view, the view opens with the

message.

Endpoint Server or Nginx Server is not running. Check the status of the Endpoint
Server under Admin > Service or check if the Endpoint Server host IP address
is registered with the Admin Server. For more information, see the RSA
NetWitness Suite Physical Host Installation Guide or RSA NetWitness Suite
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Virtual Host Installation Guide. 1f the service is not running, start the Endpoint
Server.

The Hosts and Files views do not load in the Safari browser.

When you open the Ember pages in the Safari browser with a non-trusted SSL
certificate, the Hosts and Files views do not load. To load the views.

1. Click the Show Certificate pop-up menu.

2. Enable the Always trust NetWitness when connecting to <IP Address>
checkbox.

3. Click Continue.
4. Enter your username and password.

5. Click Update Settings.

No process information was found.

When attempting to access the Process or Libraries tab in the Host Details
view, the detailed host information is not available, and the view opens with the

message.

Scan data is not available due to any of the following reasons:

o First time scan is not complete

o Data retention policy has deleted all scan snapshots

Files View Issues

Meta values will take time to load.

Meta values are not set to index by values.

During investigation, while pivoting to the Navigate or Event Analysis view
from the Files view, if the filename or hash (SHA256 and MDS5) are not set to
index by values, the matching results take time to load as the Concentrator must
generate the index by accessing the meta database and retrieving value of the
meta for each event. You have to manually index the values before pivoting.
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Filtering files takes a longer time to load results on the UI.

In the Files view, while filtering files with the Contains operator, the results
takes a few seconds to load on the UI. You must use at least one indexed field
with the Equals operator while filtering the files.
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Investigate Reference Materials

This section provides is intended to help you understand the purpose and application of
NetWitness Investigate views. For each view, there is a brief introduction and a "What Do You
Want To Do" table with links to related procedures. In addition some of the reference materials
include workflows and Quick Looks to highlight important features in the user interface.
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Add Events to an Incident Dialog

In the Add Events to an Incident dialog, analysts can add alerts to an existing incident so that
incident responders look at the associated events as part of an incident response. To access this
dialog while investigating a service in the Events view, select Incidents > Add to Existing
Incident from the toolbar.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event
Metadata

(Navigate View)

You are here

Browse Raw Events

(Events View)

Analyze Raw Events
and Metadata
(Events Analysis
View)

Triage an Incident
(Pivot from Respond
View)

Investigate Endpoints
(Hosts View)

Find Suspicious
Endpoint Files
(Files View)

Scan Files and Events
for Malware
(Malware Analysis
View)

4

Act on an Event or Endpoint

Reconstruct an Event

Export Events and
Files

Perform Internal Create an Incident in
Lookups Respond

Export Host
Attributes and Global
Files

Perform External
Lookups

What do you want to do?

User Role

1141

Documentation

Threat Hunter

browse event metadata

Begin an
Investigation in the

Navigate or Events
View
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1.1
User Role

Documentation

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis

View
Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts
Threat Hunter find suspicious endpoint files (Version Investigate Files
11.1)
Threat Hunter scan files and events for malware Conducting Malware
Analysis
Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide
Threat Hunter or Incident add one or more events to an existing Add Events to an
Responder incident or to a new incident*® Incident for
Response

*You can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Events View

264 Investigate Reference Materials



NetWitness Investigate User Guide

Quick Look

The following figure is an example of the Add Events to an Incident dialog. The table describes
the information and options in the Add Alerts to an Incident dialog .

Add Events to an Incident

Alert Summary Manual alert for Last 3 Hours
Severity 50 3

Enter | it-| | . 9

[[v] Mame Date Created - Priority
¥ INC-16 Test Event for Documentation 2017/07/18 15:07  High
[0 INC15 Test Disable Rule 2017/07/1813:47  Critical
[0 INC14 Test Rule 2017/07/1813:42  Critical
[0 INC13 Test last 48 hrs 2017/07/1813:24  Critical
O Nca2 Test Mew Rule 2017/07M18 1241 Critical
[ INC-11 High Risk Alerts: ESA 2017107181235 Critical
[ Nc-10 test 2017/071812:03  Critical
O INCg Incidemnt 2017/07/18 11:55  Critical
[ INC-8 Test Broker Service 2017/071811:53  Medium
O INC-7 Test New 2017/07/1811:428  Medium

| Page 1 of1 | | C
Cancel Add to Incident
Alert The Alert Summary field is filled by the query that produced the select alerts,

Summary which you selected to create this incident. The Severity field reflects the Severity

of the selected alert, an integer between 1 and 100.

Search Allows you to search for an existing event.
ID The ID of the incident. You can sort IDs in ascending or descending order.
Name The incident name. You can sort the Name in ascending or descending order.
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e o

Date Displays the date and time the incident was created. You can sort the dates in
Created  ascending or descending order.

Priority ~ Displays the priority of the incident: either low or critical.

Cancel Closes the dialog without saving changes.

Add to Adds the alerts to the incident. A dialog confirms that alerts are successfully
Incident  added
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Add/Remove from List Dialog

When working in Investigate, you may find an IP address or user name that you want to watch in
the Navigate view or the Events view. In the Add/Remove from List dialog, you can add meta
values for the Source IP, Destination IP, or Username meta keys to an existing context
hub list or you can create a new list containing the meta values. When you add meta values to a
list, you can look up additional context on those meta values.

To display the dialog. right-click a meta value under Source IP, Destination IP, or
Username) and select Add/Remove from List in the context menu.

Workflow

The following workflow diagram shows the high-level workflow for Investigate with the location
of the Add to List task highlighted.

Begin or Continue an Investigation from an Investigate View.
ora Pivot from the Respond View

Incident in

What do you want to do?

1141

Documentation

User Role

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events
View
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User Role

1.1

Documentation

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Incident Responder

Threat Hunter

Related Topics

browse raw events

analyze raw events and metadata

investigate endpoints (Version 11.1)

find suspicious endpoint files (Version
11.1)

scan files and events for malware

triage an incident in Investigate

create or add meta values to a Context

Hub List*

o View Additional Context for a Data Point

o Navigate View

o Events View

Begin an
Investigation in the

Navigate or Events
View

Begin an
Investigation in the

Event Analysis
View

Investigate Hosts

Investigate Files

Conducting Malware

Analysis

NetWitness

Respond User
Guide

Manage Context

Hub Lists and List

Values in Investigate
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Quick Look

The following figure is an example of the dialog when initially opened.

Add/Remove from List

Add the meta value to one or more lists by selecting the available list from the drop-
down option. To remove a list from the meta value, click the delete icon for each list.

Meta Value a

List choose ... ~

Cancel Save

The following figure shows the dialog when you select Create New List.

Add/Remove from List

List Name

Description

Cancel Save

The following table describes the features of Add/Remove from List and Create New List
dialogs.

e Jowemen
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e Jowemn

Meta The selected meta value to be added to the existing or new list.
Value
List The list to which the selected meta value must be added. A drop-down menu

provides a list of available lists to which you can add the meta value.

Create Opens a new dialog in which you can create a new list for the selected meta

New List value.
List Name The name of the new list.

Description The description of the new list.

Create Create a new list after entering the required fields.

Back In the new list mode, cancels the new list creation and returns to the original
dialog.

Cancel Cancels the addition of the meta value to a list and closes the dialog.

Save Saves the changes made to the lists and closes the dialog.
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Context Lookup Panel

After an administrator configures the Context Hub service, you can view the contextual
information for the meta values in the Navigate view and the Events view of the Investigate. The
Context Hub service is pre-configured with default meta type and meta key mapping. For
information about the mapping of the context hub meta value with investigation meta key, see
"Manage Meta Type and Meta Key Mapping" in the Context Hub Configuration Guide.

The Context Lookup panel is displayed on the right side of the Navigate view and Events view.
Meta values that have been added to a Context Hub list are highlighted in gray in the Navigate
view or Events view results. When you right-click a highlighted value and select Context
Lookup in the resulting context menu, the lookup results are displayed in the Context Lookup
panel for configured sources for the selected meta value. You can select a source in the Context
Lookup panel icon bar to view the contextual information.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event

Triage an Incident
(Pivot from Respond
View)

Investigate Endpoints
(Hosts View)

Metadata
(Navigate View)

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

|
|
|
|
You are here |
|
|
|
|

Analyze Raw Events Scan Files and Fvents
and Metadata for Malware
(Events Analysis (Malware Analysis
View) View)

4

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups

What do you want to do?
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User Role

1.1

Documentation

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Incident Responder

Threat Hunter

browse event metadata

browse raw events

analyze raw events and metadata

investigate endpoints (Version 11.1)

find suspicious endpoint files (Version
11.1)

scan files and events for malware

triage an incident in Investigate

look up additional context for a meta

value

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Events View

o Navigate View

Begin an
Investigation in the

Navigate or Events
View

Begin an
Investigation in the

Navigate or Events
View

Begin an
Investigation in the

Event Analysis
View

Investigate Hosts

Investigate Files

Conducting Malware

Analysis

NetWitness

Respond User
Guide

View Additional

Context for a Data

Point

o "NetWitness Feedback and Data Sharing" in the Live Services Management Guide
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Quick Look

The following figure is an example of the Context Lookup panel, and controls and features are
described in the table.

RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE  ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis

B - Concentrator [ B ¥ Query© ElProfile © ElMeta © | [ETotal © .= Descending © &5 EventCount © | SaveEvents® - Actions Settings
< Context Lookup 1>
2018 | % | 16:52:00 (+00:00) All Data 2018 % 19:10:59 (+00:00) Alerts sort [Date - Newestto Ol | &
100 M st Updated: s tewsecondsago Time Window 7 cays
5 127.0.0.1
Py
sox A A seveny ncident from Investigate
5| 50 Created  2018/02/21,15:17 (0 days ago)
\ Incident 1D INC-29
oo Sources  NetWitness Investigate
Events 200
o L=
E 3§ Options | 2 Hide SEVERITY. nvestigate
50 Created  2018/02/21, 15:07 (0 days ago)
Incident 1D INC-23
s  Destination IP address (20 of 20+ values) & Shurces Nettness Investigate
7171 - (15,153) - (14,725) - (14,094) - (13715) - (7334) - 9 (7,209) - 3,168) Bents 200
. (2,565) - N (2.254) - (1,500) - (1,493) - (1,428) - (1,324) - IR (1,304) - (1,096) SeveRTY
. nvestigate
- (I (1,036) - () (957) - (943) - (882) ...show more 50 Created  2018/02/21,15:07 (0 days age)
Incident 1D INC-22
o> - Source IPv6 Address (20 of 20+ values) Sources  NetWitness Investigate
TR TR (4G) - (40) - W (14) - 14) - (14) - » (12) Fvems 200
L ——— (12) - (12) - - (8) - " " (6) - - 6) SEVERITY ncident Created From Investigate
- - (5) - - . (5) - . B () - @) - @ 50 Created  2018/02/21,15:05 (0 days age)
@ - - @ - - @ - (2) ...show more Incident 1D INC-21
Sources  NetWitness Investigate
(s> - Destination IPv6 address (20 of 20+ values) £ Events 200
72) - @4 - @0) - (12) - ® - ® - - © sevemy RSA_01_Rule_HighConfidence
(@) - (@) - - () - . - @ - @ 100 Created  2018/02/21, 14:47 (0 days ago)
@ - @- @ - @- @ - @) ..show more Incident 1D INC-19
Sources  Malware Analysis
4 . Action Event (8 values) £ Events
get (36,465) - sendto (4,639) - sendfrom (3,882) - put (3,569) - login (2,107) - attach (1,544) - delete (11) - logoff (2)
User Account (20 of 20+ values) £
1 - 5 Alerts (First 50 Results)
o Do

| NETV

Description

Source Displays the icons for the available sources: Endpoint, Incidents, Alerts, and Lists.
Options
Bar

Source Displays the source name based on the selected icon:

Name « Endpoint
o INCIDENTS
o ALERTS

o LISTS
Sort Provides a drop-down of sort options for the listed context information. Possible

sort options are Severity - High to Low, Severity Low to High, Date - Oldest to

Newest. and Date - Newest to Oldest. The sorting options vary by source type.

@

Refreshes the lookup results.
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e o

n items The footer provides a count of the total number of results, and the count of results

(First n currently displayed. For example, 50 Alerts (First 50 Alerts).
Results)

Lookup Results

The Context Lookup panel displays the following information when retrieving the context data
from the configured sources.

Incidents

Incidents are displayed based on time first (Newest to Oldest) and then priority status. The
following information is displayed for incident lookups:

o Incident Name and ID

o Priority status of the incidents

o Risk Score value of the incidents

o Date when the incident was created
o Status of the incident

o Assignee for the incident

o Last Updated: Indicates when contextual data was last fetched from data source and updated

to cache.

o Time window: This is based on the value that is set for the "Query Last (Days)" field in the
Configure Respond window. For details, see the "Configure Respond as a Data Source" topic
in the Context Hub Configuration Guide.

o Sort: This drop-down field provides options to change the sorting of result based on time or
priority.
Alerts

Alerts are displayed based on the Severity. ;The following information is displayed for alert
lookups:

o Alert Name
o Severity value of the alerts

o Date when the alert was created
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Incident ID: This is the ID of the incident that the alert is associated with (If any).
Sources: Event source name
Number of events associated with the alert.

Last Updated: Indicates when contextual data was last fetched from data source and updated

to cache.

Time window: This is based on the value that is set for the "Query Last (Days)" field in the
Configure Respond window. For details, see the "Configure Respond as a Data Source" topic
in the Context Hub Configuration Guide

Sort: This drop-down field provides option to change the sorting of result based on time or

priority.

Lists

The following information is displayed for list lookups.

List Name

Owner who created the list
Created Date

Last Updated Date

Description of the list

Endpoint

The following information is displayed for Endpoint lookups.

Machine name and IP address of the machine.
By clicking on the IP or Endpoint machine name, you will be navigated to Endpoint UI to

perform further investigation.

Last Updated: Indicates when contextual data was last fetched from data source and updated

to cache.

Machine Score: A machine IIOC score is aggregated based on the module scores.
Number of modules: Number of active files for the selected machine.

Last Updated: Indicates when the scan results were last updated in Endpoint database.
Last Login User

Machine MAC Address
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o Operating System Version
o Admin Notes (if any)
o Admin Status (if any)

o Top Suspicious Modules (Modules that have an I[IOC score > 500). This is based on the value
set for "Minimum IIOC Score" field in the Configure Endpoint window. The default value for
"Minimum IIOC Score" is 500.

¢ Machine IIOC Levels
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Create an Incident Dialog

In the Create an Incident dialog, analysts can create an incident from selected events in the
Events view. The incident is then available to incident responders working in Respond.

To access this dialog, while investigating a service in the Investigation > Events view, select
Incidents > Create New Incident from the toolbar.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event
Metadata

Triage an Incident
(Pivot from Respond
View)

Investigate Endpoints
(Hosts View)

(Navigate View)

You are here

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events

(Events View)

Analyze Raw Events Scan Files and Events
and Metadata for Malware
(Events Analysis (Malware Analysis
View) View)

4

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups

What do you want to do?

1141

Documentation

User Role

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events

View
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1.1

Documentation

User Role

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis

View
Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts
Threat Hunter find suspicious endpoint files (Version Investigate Files
11.1)
Threat Hunter scan files and events for malware Conducting Malware
Analysis
Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide
Threat Hunter or Incident add one or more events to an existing Add Events to an
Responder incident or to a new incident*® Incident for
Response

Related Topics

o How NetWitness Investigate Works

e Navigate View

o Events View

Quick Look

The following figure is an example of the Create an Incident Dialog, and the features are
described in the table.
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Create an Incident

Create An Alert From These 1 Events:

Alert Summary Manual alert for Last 3 Hours

Severity 50 o

Test Event for Documentation

Creating an alert for this event.

Assignee Admin
Categories Social: Other @

Priority High

P [ossrotor

Create The Alert Summary field is filled by the query that produced the select alerts,

Summary  which you selected to create this incident. The Severity field reflects the Severity

from of the selected alert, an integer between 1 and 100.

These

Events

Name (Required) Specifies a name to identify the incident. In the example, the name is

Sample Incident. You can provide a name that clearly identifies the nature of

events that will be added to this incident

Summary  (Optional) Specifies a description for the incident. A good summary clearly

identifies the incident for other analysts and responders.

Assignee  (Optional) Assigns the incident to a user in the SOC. Clicking Assignee opens a
drop-down list showing the user names of SOC personnel who respond to

incidents.
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e o

Categories (Optional) Identifies categories of incidents. Clicking Categories, opens a drop-

down list of Incident categories and subcategories. You can select one or more
categories to which the incident belongs. Categories fall into these major groups:

Environmental, Error, Hacking, Malware, Misuse, and Social.

Priority Identifies the priority for the incident. Clicking Priority opens a drop-down list of
priorities: Critical, High, Medium, or Low displayed in the drop-down list.

Cancel Closes the dialog without saving changes.

Save Saves the incident and closes the dialog. A message confirms that the incident

was created successfully.
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Event Analysis View

In the Event Analysis view analysts can view raw events and meta data with interactive features
that enhance the ability to find meaningful patterns in the data. This is an alternative to the static
Event Reconstruction view. You can examine network, log, and endpoint events in the Event
Analysis view. The Event Analysis view offers packet, text, and log reconstruction, and does not
support email and web reconstruction directly. However, in Version 11.1 and later, you can open
an email or web reconstruction of the current results in the Events view email or web
reconstruction.

Note: The administrator sets permission for analysts to access this view. If your administrator
has not given you access, and you navigate to the Event Analysis view by any means, the
following message is displayed: Forbidden. You cannot access the requested
page . For example, if you are viewing a reconstruction from the Events view and attempt to
view the same reconstruction in the Event Analysis view, you will see the Forbidden
message.

The events displayed in the Events Analysis view are for the current drill point in the Navigate
view or Events view. Beginning with Version 11.1, the events can be the results of a query
entered in the Event Analysis view breadcrumb. Whatever the source of the query, the Event
Analysis view lists events in order by time. You can rearrange and resize the columns, In
Version 11.1 and later, you can also choose the columns that you want to see and select one of
the built-in column groups or a custom column group.

When you click an event, the Network Event Details, Log Event Details, or the Endpoint Event
Details panel opens in the same browser window. Each type of event has one or more types of
analysis: Text Analysis, Packet Analysis, and File Analysis.

There are multiple access points to this view, which are described in Begin an Investigation in the

Event Analysis View.
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Workflow

The following figure is a high-level workflow illustrating the tasks you can do in NetWitness
Investigate, with the Event Analysis view tasks highlighted in red.

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event Triage an Incident
Metadata

(Navigate View)

Investigate Endpoints

Pivot fi R d
(Hosts View) (Pivot from Respon

View)

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

: Analyze Raw Events : Scan Files and Events
and Metadata for Malware

I (Events Analysis | (Malware Analysis

| |

| |

View) View)

4

Act on an Event or Endpoint

You are here

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups

What do you want to do?

111

Documentation

User Role

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events
View

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events

View
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1.1

Documentation

User Role

Threat Hunter analyze raw events and metadata* Begin an
Investigation in the

Event Analysis

View
Threat Hunter query events in the Event Analysis view  Filter Results in the
(Version 11.1)* Event Analysis
View
Threat Hunter export events and files in the Event Download Data in
Analysis view* the Event Analysis
View
Threat Hunter reconstruct events in Event Analysis Analyzing Raw
view* Events and Metadata

in the Event
Analysis View

Threat Hunter perform external lookups from the Event ~ Act on Data in the
Analysis view (Version 11.1)* Event Analysis
View
Threat Hunter query events in the Navigate view Investigating

Metadata in the

Navigate View

Threat Hunter query events in the Events view Examining Raw
Events in the Events
View

Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts

Threat Hunter find suspicious endpoint files (Version Investigate Files
11.1)

Threat Hunter scan files and events for malware Conducting Malware

Analysis

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

*Y ou can perform this task in the current view.
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Related Topics

How NetWitness Investigate Works

Event Analysis View - Packet Analysis Panel

Event Analysis View - Text Analysis Panel

Event Analysis View - File Analysis Panel

Quick Look

When you first open Investigate, input fields for a query are displayed so that you can select a
service and time range, and type an optional query.

Version 11.0 has the input fields in the Navigate view and the Events view.

Version 11.1 has the input fields in the Navigate view, the Events view, and the Event

Analysis view.

When you open a drill point in the Event Analysis view, the service being investigated counts the
results of the initial query up to a limit of 100,000 events, and the first 100 events (packets, logs,
and endpoint) are loaded in the Events panel. The columns in the Events panel are the Event
Time, Event Type (Network, Log, or Endpoint), Event Size, and Summary. You can:

Scroll through the list and click Load More to see the next 100 events.
Select a column group (Version 11.1 and later).

Select the columns that you want to include (Version 11.1 and later).
Drag the columns to rearrange the order.

Make columns wider or narrower.

View the event analysis of an event.

The following figure highlights the major features of the Event Analysis view for Version 11.1
and later.
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RSA RESPPND INVESTIGATE MONITOR CONHIGURE ADMIN

Navigate | Events Event Analysis Hosts Filds  Malware Analysis

EVENT TIME

02/26/2018
09:40:46 am

02/26/2018
09:40:52 am

02/26/2018
09:40:46 am

02/26/2018
09:40:49 am

02/26/2018
09:40:58 am

02/26/2018
09:40:45 am

02/26/2018
09:41:04 am

02/26/2018
09:40:59 am

02/26/2018
09:40:47 am

EVENT TYPE

SESSION 1D SOURCE IP:PORT
™ b LR - 112 - \ ;49527 02/26/2018
Concentrator 14 09:40:49.803 am

1 2 DESTINATION IP:PORT SERVICE FIRST PACKET TIME
Network e o ;80 80

LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOAD SIZE  CALCULATED PACKET
02/26/2018 2277074 bytes 2098469 bytes L
09:40:49.813 am 3063

REQUEST

GET /flashupdate64.exe HTTP/1.1 SESSIONID 112

Accept: */* TIME 02/26/2018 09:40:49 am
Accept-Encoding: gzip, deflate Size 33557342
User-Agent: Mozilla/4.@ (compatible; MSIE 7.0; Windows NT 6.1; WOWG4; EANLEND 31669890
Trident/4.0; SLCC2; .NET CLR 2.0.50727; .NET CLR 3.5.30729; .NET CLR MERILM g

3.0.30729; Media Center PC 6.0) ETH.SRC 00:1B:21;CAFEDT
Host: 5.149.248.85 ETH.SRCVENDOR  ntel Corporate

5 5 ETH.DST et e - AE
Connection: Keep-Alive
ETH.DST.VENDOR  Cisco-Linksys, LLC

ETH.TYPE 2048
Showing < 1% d | wsnc 192.168.1.104
1P.DST 5.149.248.85

HTTP/1.1 200 0K IP.PROTO 6

Server: nginx TCP.FLAGS 30
Date: Sat, 15 Mar 2014 94:05:44 GMT TCP.FLAGS.SEEN sy rstpsh ack

4.0f 20336 events TCP.SRCPORT 49527

Interactive Breadcrumb: When a service is selected, displays the service selector, time
range selector, and the queries you have entered. In Version 11.1 and later, you can select

a service as described in Begin an Investigation in the Event Analysis View and refine the

filters in the query as described in Filter Results in the Event Analysis View. Clicking the

Submit Query button submits the query and sends a request to the selected service to load

the data.
The type of event being analyzed is reflected in the heading: Network Event Details,
Log Event Details, or Endpoint Event Details. Each view is discussed in detail in

Analyzing Raw Events and Metadata in the Event Analysis View.

The types of analysis available for the event type. Network events can use all types of

analysis: text, packet, and file. Log and endpoint events use only text analysis.

The Email and Web analysis types open the current event as an email or web

reconstruction in the Events view.

These options vary for the different types of analysis. They are discussed in detail in

Analyzing Raw Events and Metadata in the Event Analysis View.

Controls to show or hide the Event Header, show or hide requests and responses, and open
the Event Meta panel (16). These controls are described in Analyzing Raw Events and

Metadata in the Event Analysis View.

Controls to change the size of the panel and close the panel.
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n Reopens the Events panel or the Event Meta panel if you have closed it.

n Sets preferences for the Event Analysis view (see Configure the Event Analysis View.

Il The Events panel for Version 11.1 is interactive, displaying query results as you submit
updated queries. The Events panel includes a count of the events. You can rearrange and
resize columns. You can scroll to the bottom of the list, and load more events (see
Analyzing Raw Events and Metadata in the Event Analysis View).

IVl The Column Group drop-down lists built-in and custom column groups that you can apply
to the Events panel. The built-in column groups are Email Analysis, Endpoint Analysis,
Malware Analysis, Outbound HTTP, Outbound SSL/TLS, and Summary List. Summary
List is the default column group.

IRN Scttings to select the columns included in the Events panel.

I The Event Header provides summary information about the event. This information is
different for the different event types (packet, log, and endpoint).

IBM The event data (sometimes called a payload for packets). The event data for a log event or
endpoint event is typically a line of text from the raw log rather than request and response
shown for a packet.

Il The Event Meta panel lists the meta keys and values found in the data. Some meta data

Iare searchable; they have a binoculars icon, which you can click to see the associated

data highlighted in the event data (see Analyzing Raw Events and Metadata in the Event

Analysis View.

The following figure highlights the major features of the Event Analysis view for Version
11.0.0.x.
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INVESTIGATE MONITOR

GET /bio.html HTTP/1.1 ses
Accept: image/gif, image/x-xbitmap, image/ipeg, image/pipeg, spplication/vnd.ms- Time DB/26/2017 10:59:43 pm
excel, application/wvnd.ms-powerpoint, application/msword, application/x- size 439118

e PAYLOAD

Referer: http://ivoteog.com/index.html L1
Accept-Language: en-us 11 s
UA-CPU: XBE

Accept-Encoding: gzip, deflate

User-Agent: Mozilla/4.@ (compatible; MSIE 7.9; Windows NT 5.1; .NET CLR 1.1.4322)

Host: ivoteog.com

Connection: Keep-Alive

12 of 100000

The read-only breadcrumb displays the selected service, time range, and query entered in
the Navigate view or Events view.

This is a read-only list of events based on the query made in the Navigate or Events view.
The Events panel includes a count of the events. You can rearrange and resize columns.

You can scroll to the bottom of the list, and load more events (see Analyzing Raw Events

and Metadata in the Event Analysis View).

R Controls to change the size of the panel and close the panel.

3 The type of event being analyzed is reflected in the heading: Network Event Details, Log
Event Details, or Endpoint Event Details. Each view is discussed in detail in Analyzing

Raw Events and Metadata in the Event Analysis View.

The types of analysis available for the event type. Network events can use all three types
of analysis: text, packet, and file. Log and endpoint events use only text analysis.
These options vary for the different types of analysis. They are discussed in detail in

Analyzing Raw Events and Metadata in the Event Analysis View.

Controls to show or hide the Event Header, show or hide requests and responses, and open
the Event Meta panel (12). These controls are described in Analyzing Raw Events and

Metadata in the Event Analysis View.
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n Reopens the Events panel or the Event Meta panel if you have closed it.

I8 The Event Header provides summary information about the event. This information is
different for the different event types (packet, log, and endpoint).

IO The event data (sometimes called a payload for packets). The event data for a log event or
endpoint event is typically a line of text from the raw log rather than request and response
shown for a packet.

iVl The Event Meta panel lists the meta keys and values found in the data. Some meta data
are searchable; they have a binoculars icon, which you can click to see the associated

data highlighted in the event data (see Analyzing Raw Events and Metadata in the Event

Analysis View.
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Event Analysis View - File Analysis Panel

In the File Analysis panel (Event Analysis > File Analysis), you can safely view a list of files
and download one or more files in an event.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event Triage an Incident
Metadata

(Navigate View)

Investigate Endpoints

(Hosts View) (Pivot from Respond

View)

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

I |

| Analyze Raw Events | Scan Files and Events
and Metadata for Malware

| (Events Analysis I (Malware Analysis

| View) | View)

| |

4

Act on an Event or Endpoint

You are here

Perform Internal Create an Incident in

Reconstruct an Event eratiee Respond

Export Events and Perform External BICREAEE:

Files Lookups

Attributes and Global
Files

What do you want to do?

111
User Role .
Documentation
Threat Hunter browse event metadata Begin an

Investigation in the

Navigate or Events

View
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User Role

1.1

Documentation

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

browse raw events

analyze raw events and metadata

query events in the Event Analysis view

(Version 11.1)

export events and files in the Event

Analysis view*

reconstruct events in Event Analysis

view

perform external lookups from the Event

Analysis view (Version 11.1)

query events in the Navigate view

query events in the Events view

investigate endpoints (Version 11.1)

find suspicious endpoint files (Version
11.1)

scan files and events for malware

Begin an
Investigation in the

Navigate or Events
View

Begin an
Investigation in the

Event Analysis
View

Filter Results in the

Event Analysis
View

Download Data in

the Event Analysis

View

Examine Events in

the Event Analysis
View

Act on Data in the

Event Analysis

View

Investigating
Metadata in the

Navigate View

Examining Raw
Events in the Events

View

Investigate Hosts

Investigate Files

Conducting Malware

Analysis
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1.1
User Role

Documentation

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

*You can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Event Analysis View

Event Analysis View - Text Analysis Panel

o Event Analysis View - Packet Analysis Panel

Quick Look

The File Analysis panel displays a list of files associated with a network event. You can
download files in this view.

Below is an example of the File Analysis panel with labeled features.

Note: The Email and Web reconstruction types at the top of the figure are available in
Version 11.1 and later.
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Network Event Details | Text Analysis Packet Analysis  File Analysis Email 7 Web

Download Files (3) |«———— 1

NW SERVICE SESSION ID SOURCE IP:PORT DESTINATION IP:PORT SERVICE FIRST PACKET TIME
S 408 - 727705 - 40261 . ™:80 80 02/26/2018 09:40:43.364
Broker am

LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOAD SIZE  CALCULATED PACKET COUNT
02/26/2018 09:56:21.062 87207 bytes 3975 bytes 136! 2
am

FILE NAME MIME TYPE FILE SIZE HASHES o4

R ———
727705-107-0_2.gif Image/gif 35 bytes SHA1: 0f4e929dd5bb2564f7ab9c76338e04e292a4 2ace SESSIONID 727705
MDS: 28d6814f3092a289f847c69cf91194c6 TIME 02/26/2018 09:40:43 am
SIZE 64590

PAYLOAD 51870

727705-107-0_3.gif Iimage/gif 35 bytes SHA1: 0f4e929dd5bb2564f7ab3c76338e04e292a42ace

MDS: 28d6814f309ea289f847c69cf91194c6
MEDIUM 1

727705-107-0_1._utm.gif  image/gif 35 bytes SHA1: 0f4e929dd5bb2564f7ab9c76338e04e292a4 2ace ETH.SRC »1A
MD5: 28d6814f309ea289f847c69¢f91194c6 ETH.SRC.VENDOR  VMware, Inc.
ETH.DST 87
ETH.DST.VENDOR  VMware, Inc.
ETH.TYPE 2048
IP.SRC
IP.DST
IP.PROTO 6
TCP.FLAGS 27
TCP.FLAGS.SEEN  fin syn psh ack
I TCP.SRCPORT egzm_ R 4

Warning: Files contain the original raw unsecured content. Use caution when opening or downloadiny -
ﬁles:ﬂlngzymay contain mali:lglusdata. = i “Tcp.DSTPORT

80
SERVICE 80
2

35 of 20336 events STREAMS

Click to download one or more selected files.

AN The Event Header displays summary information for the network event that contains the

files.
Scrollable list of associated files that you can select and download.

Reminder that caution is necessary when downloading potentially malicious files.

292 Investigate Reference Materials



NetWitness Investigate User Guide

Event Analysis View - Packet Analysis Panel

In the Packet Analysis panel (Event Analysis > Packet Analysis), you can safely view and
interactively analyze the packets and payload of an event.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event Triage an Incident
Metadata

(Navigate View)

Investigate Endpoints

(Hosts View) (Pivot from Respond

View)

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

I |

| Analyze Raw Events | Scan Files and Events
and Metadata for Malware

| (Events Analysis I (Malware Analysis

| View) | View)

| |

4

Act on an Event or Endpoint

You are here

Perform Internal Create an Incident in

Reconstruct an Event eratiee Respond

Export Events and Perform External BICREAEE:

Files Lookups

Attributes and Global
Files

What do you want to do?

111
User Role .
Documentation
Threat Hunter browse event metadata Begin an

Investigation in the

Navigate or Events

View
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User Role

1.1

Documentation

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

browse raw events

analyze raw events and metadata

query events in the Event Analysis view

(Version 11.1)

export events and files in the Event

Analysis view*

reconstruct events in the Event Analysis

view*

perform external lookups from the Event

Analysis view (Version 11.1)*

query events in the Navigate view

query events in the Events view

investigate endpoints (Version 11.1)

find suspicious endpoint files (Version
11.1)

scan files and events for malware

Begin an
Investigation in the

Navigate or Events
View

Begin an
Investigation in the

Event Analysis
View

Filter Results in the

Event Analysis
View

Download Data in

the Event Analysis

View

Examine Events in

the Event Analysis
View

Act on Data in the

Event Analysis

View

Investigating
Metadata in the

Navigate View

Examining Raw
Events in the Events

View

Investigate Hosts

Investigate Files

Conducting Malware

Analysis
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1.1

Documentation

User Role

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

*You can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Event Analysis View

Event Analysis View - Text Analysis Panel

o Event Analysis View - File Analysis Panel

Quick Look

Only network events can be analyzed in the Packet Analysis panel. The Packet Analysis panel
lists each packet in the event. The list of packets is scrollable. When you scroll, the packet or
text identification information as well as the Request and Response labels remain visible rather
than scrolling out of view.

In Version 11.1 and later, you can use pagination controls to go backward and forward through
the pages, go to a specific page, and select the number of packets to display per page (100, 300,
or 500).

Each packet is displayed with shading and highlighting to help identify common file patterns:
significant header and payload bytes, hexadecimal and ascii bytes, and common file signatures.
In addition, you can adjust the request/response display, and display or hide the packet summary.

Below is an example of the Packet Analysis panel with labels to identify features. For details
and examples of each feature, see Analyzing Raw Events and Metadata in the Event Analysis View.
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02/25/2018 07 J pm -02/26/2018 07:16:59 pm

1

Netwcrf Event Details | Text Analysis Packet Analysis File AnalysilemaH 7 Web ] oGO0 .l

Download PCAP ' @ common riLe paTTERNS () sHADE BYTEs @) | DISPLAY PAYLOADS ONLY

NW SERVICE SESSION 1D SOURCE IP:PORT DESTINATION IP:PORT SERVICE FIRST PACKET TIME
o . St 727653 . 49223 . 180 80 02/26/2018 09:40:45.957
Broker am

LAST PACKET TIME CALCULATED PACKET SIZE CALCULATED PAYLOAD SIZE EBII:ICMUI!.A‘ED PACKET

02/26/2018 09:40:45.973 2186416 bytes 2031694 bytes
am 2727

REQUEST
Packet 6 02/26/2018 09:40:45.957 am ID 966968  SEQ 2261201143 PAYLOAD 0 Bytes SESSIONID 727653
000032 fa 66/c0 470050 86 c7 30 f7 14 af 5c155010 GFAG.P ¢ @ & . - "'ME 0272672018 G2:40:45 am
000048 fa O 97 £2 00 00 00 00 02 00 00 00 68 &... . . . . . sz 33556874

PAYLOAD 31736522

~ Packet 7 02/26/2018 09:40:45.957 am 1D 966969 SEQ 2261201143 PAYLOAD E
MEDIUM 1

000000 00 00 00 00 00 00 00 00 00 00 00 08 00 45 00 ETH.SRC %00:00:00:00

000016 €2 04 o8 (40 008006 bf 57/ch aB cb 88 (b2 3e N LIEIBP: 6

200032 66/cb 47 09 S0 86 c7 30 f7 14 af 5c 15 50 18 = . L ETH.SRC.VENDOR ' ......JX CORPORATION
fo 42 00 00 00 G ole o ETH.DST 00:00:00:00:00:00

ETH.DST.VENDOR  XEROX CORPORATION
ETH.TYPE 2048

IP.SRC

IP.DST

IP.PROTO 6

TCP.FLAGS 3

TCP.FLAGS.SEEN  fin syn rst psh ack
TCP.SRCPORT 49223

TCP.DSTPORT 20

7

SERVICE

STREAMS—
SRS - “
7 of 100000 events > oo» v PACKETS PER PAGE PACKETS

Options for exporting a network event. You can export a PCAP, all payloads, request
payloads, or response payloads for deeper analysis and to share with others.

The option to identify common file signatures is activated by default. Common file
signatures are highlighted in orange; hovering over the highlight reveals the file type.
The Shade Bytes option adds shading to identify the different hexadecimal bytes (00 to
FF) using degrees of highlighting.

The option to display payloads only hides the packet headers, leaving more space for the
payload.

The Event Header.

Significant bytes are highlighted in a blue background; as you move the cursor over the

highlighting the meta data is displayed in a hover box.

\]-

(Version 11.1 and later) Packet pagination controls allow more flexibility in paging
through a list of packets. When a control is unavailable, the image is dimmed; for
example, when you are viewing page 1, the &4 and M controls are dimmed.

- Go to the first page
- Go to the previous page
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- Go to a specific page

- Go to the next page
- Go to the last page

- Select the number of packets per page
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Event Analysis View - Text Analysis Panel

In the Text Analysis panel (Event Analysis > Text Analysis), you can safely view and analyze
the raw text payload of an event. The Text Analysis panel includes features that can show
decompressed or compressed text, expand truncated entries, perform URL and Base64 encoding
and decoding, and download network events, logs, and endpoint events. The Text Analysis panel
is available for all types of events: network, log, and endpoint.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event Triage an Incident

Metadata s E_ndpomts (Pivot from Respond
(Hosts View)

(Navigate View) View)

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

I |

| Analyze Raw Events | Scan Files and Events
and Metadata for Malware

| (Events Analysis | (Malware Analysis

| View) | View)

| |

4

Act on an Event or Endpoint

You are here

Perform Internal Create an Incident in

Reconstruct an Event st Respond

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups

What do you want to do?

1.1
User Role

Documentation

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events

View
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User Role

1.1

Documentation

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

browse raw events

analyze raw events and metadata

query events in the Event Analysis view
(Version 11.1)

export events and files in the Event

Analysis view*

reconstruct events in Event Analysis
view*

perform external lookups from the Event

Analysis view (Version 11.1)*

query events in the Navigate view

query events in the Events view

investigate endpoints (Version 11.1)

find suspicious endpoint files (Version
11.1)

scan files and events for malware

Begin an
Investigation in the

Navigate or Events
View

Begin an
Investigation in the

Event Analysis
View

Filter Results in the

Event Analysis
View

Download Data in

the Event Analysis

View

Analyzing Raw
Events and Metadata

in the Event
Analysis View

Act on Data in the

Event Analysis

View

Investigating
Metadata in the

Navigate View

Examining Raw
Events in the Events

View

Investigate Hosts

Investigate Files

Conducting Malware

Analysis
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1.1
User Role

Documentation

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

*You can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Event Analysis View

o Event Analysis View - Packet Analysis Panel

o Event Analysis View - File Analysis Panel

Quick Look

The Event Analysis view displays the text of a single event in the Text Analysis panel. When
you click an event in the Event list panel, the adjacent panel shows the Text Analysis. Only the
raw log for log events and endpoint events is shown in the Text Analysis panel. For network
events, the direction of the packet (Request or Response) and contents of each packet are
provided in text format. For more examples of the Text Analysis, see Analyzing Raw Events and
Metadata in the Event Analysis View. For detailed procedures, see Examine Events in the Event

Analysis View.
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Network ELfer'lt D 5 ysis y File \ T W EOoOMm|

v

Download PCAP |~ @ | DISPLAY COMPRESSED PAYLOADS

SOURCE IP:PORT DESTINATION IP:PORT SERVICE IRST PACKET TIME

f2017 08:21:56.974 pm

ATID PACKET SIZE

c
4562584 bytes 4096868 bytes

GET /att/GetAttachment.aspx?file=71825274-08ba-4c6d-891e- b AL AR
a789dbdf1dll. tifhct=oN1hZ2UvdGimZg_3d_3dknome=UE1BMTASNZzUudGLm&inl ine=0&rfc=fhempty=Falsefi
mgsrc=khm__login=justinmwtestihm__domain=hotmail.comiip=1@.1.106. 8&d=d25948mf=08hm__ts=Mon%
Z2CK2Z02THZB0CtE202008%2019%3031%3050%20GMTEhm__ha=3005983b9446842110ef f17b21303 febc2@@041bko
neredir=1 HTTP/1.1

Host:

User-Agent: Mozilla/5.@ (Windows; U; Windows NT 5.1; en-

US; rv:1.9.8.3) Gecko/2008092417 Firefox/3.0.3

Accept: text/html,application/xhtml+xml,opplication/xml;q=8.9,*/*;q=0.8

Accept-Language: en-us,en;q=8.5

Accept-Encoding: gzip,deflate

Accept-Charset: I50-8859-1,utf-8;q=0.7,%;q=0.7

Keep-Alive: 30@

ETH.TYPE

NETHAME private sre
65.55.131.121
NETNAME

Connection: keep-alive
Referer: http://byl26w.bayl26.mail.live.com/mail/InboxLight.aspx?n=747489514

HTTP/1.1 208 OK

Date: Mon, 27 Oct 2008 19:31:51 GMT

Server: Microsoft-I15/6.0

P3P: CP="BUS CUR CONo FIN IVDo ONL OUR PHY SAMo TELo"™

JBll Options for exporting a log, a PCAP, or files for deeper analysis and to share with others.

This download menu is for network data.
The event header information.
Click to view the network payload in compressed or decompressed form.

"3 The payload for a network event includes requests and responses. This is the request side

of the packet.

RI This is the response side of the packet. Only 1% of the response is displayed because it
has been truncated to allow viewing of more packets. When you scroll down, you can
click an option to display the rest of the payload.

This message is displayed when the threshold of 2500 packets is reached, a measure to
optimize performance. Additional packets will not be displayed. Y ou may want to

download the event to view all of the packets.
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Event Reconstruction View

The Event Reconstruction view provides a reconstruction of a selected event from the Events
view. By default, NetWitness Suite displays the best reconstruction for the event determined by
the event content, or the default reconstruction that you have selected in the Default Session
View setting for Investigate. You can use the options in the Event Reconstruction toolbar to
change the reconstruction method, view top-to-bottom or side-by-side results, select request and
response views, export an event, export meta values, extract files, open an email attachment,
and open the event in a new tab.

To access this view, do one of the following:

o In any Events view, double-click an event.

« In the Events view with Detail View selected, right-click Event Analysis at the end of the

event, and select Event Reconstruction.

o Inthe Event Reconstruction toolbar of previewed reconstruction, click Open Event in New
Tab.

« In the Navigate view, select Actions > Go to event in Event Reconstruction, and enter an

event ID.
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Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event Triage an Incident

Investigate Endpoints

Metadata .
(Hosts View)

(Pivot from Respond

(Navigate View) View)

You are here

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Analyze Raw Events Scan Files and Events
and Metadata for Malware
(Events Analysis (Malware Analysis
View) View)

$

Act on an Event or Endpoint

Perform Internal Create an Incident in
Lookups Respond

Reconstruct an Event

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups

What do you want to do?

111

Documentation

User Role

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events
View

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis
View
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1.1

Documentation

User Role

Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts
Threat Hunter find suspicious endpoint files (Version Investigate Files
11.1)

Threat Hunter scan files and events for malware Conducting Malware
Analysis

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

Threat Hunter reconstruct an event Reconstruct an
Event

Threat Hunter extract files from a reconstructed event ~ Reconstruct an
Event

*You can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Event Analysis View

Quick Look

This figure is an example of the Event Reconstruction view. The following table describes the
toolbar options.
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‘ent Reconstruction

service id type source destination service first packet time

Concentrator 1585 Network Session 147928 1150004 0O 2017-07-05T12:32:01.106

Request & Response [ Top To Bottom @ [M] Best Reconstruction 4 Actions ©  [El Open Event in New Tab  [B Event Analysis
:

Packet 1 (id = 127888 seq = 3938823145) 2017-87-85 12:32:01.106 (71 Payload Bytes)

£OGROGA0 : B2 90 90 90 B0 0 0P 00 0O 00 0@ 68 65 8@ 45 80

2020616 : 88 7b dc TO 46 90 42 06 4d 64 8a 1T 7d f5 @a 1T

20820032 : 7d f5 bb 38 3 54 ez 4b 99 e9 2b fa of 7e 80 18

BOEROG4E : Be 33 1A 96 @0 8@ 01 ©1 68 Aa A6 02 Be Bb 6 82

POAROGES : 52 @5 a0 @0 @1 0P 3T 00 00 00 62 09 89 69 81 80

BOGROBES : A3 04 @1 85 @0 8P 00 6f 00 0O AR aB 48 02 @ bP

POAROBI6 : 45 @0 @0 do 45 0P 00 07 Ol 00 00 la @@ 8@ B 61

20020112 : 67 67 09 00 20 90 92 91 00 02 @2 82 0@ 6@ ed 6T

POARO12E : 7O @4 @0 OO @@ G 65 7B T4 -- -- -- -= —= = -

Packet 2 (id = 127810 seq = 737845118) 2017-87-@5 12:32:01.106 (@ Payload Bytes)

AOARGG0 : AR BA OA OO GO 0P 0P 0O OO PO AR OA B BB 45 BB [ ........ ......E. ]

POAROAL1E : B2 34 TS Oe 40 00 42 06 31 fd @a 1f 7d 5 @a 1f [ .4..@.@. 1...}... ]

80080032 : 7d f5 c3 54 bb 38 2b fa Of 7e ea 4b 9a 3@ B@ 18 [ }..T.8+. .~.K.B.. ]

20000048 : @1 77 10 4f @0 0@ 01 01 OF 03 06 02 8e 6b @6 82 [ .w.0 k]

BOOBOBES : Be Bh -- -= -= = = = = - - —= oo —= —= —= [ .k ]

Packet 3  (id = 127811 seq = 737845118) 2@17-87-05 12:32:81.106 (@ Payload Bytes)

POAROGA0 : B2 90 90 00 00 0P 0 00 OO 00 00 88 65 BB 45 80 [ ........ ......E. ]

A0OROA16 : AR 34 f8 9e 40 00 48 86 31 fd @a 1f 7d 5 @a 1f [ .4..8.0. 1...}... ]

20000032 : 7d f5 ¢3 54 bb 38 2b fa Oof 7¢ ea 4b 9a 3@ 5@ 18 [ }..T.8+ L]

20020048 : @1 77 1@ 4f 20 90 @1 @1 08 Os @6 82 3e 6b @6 B2 [ .w.0 -] -

500 of 3,453 packets; loaded from cache ow Reconstruction Log

Description

Request & Displays a drop-down menu for selecting whether the view displays:
Response « Request & Response

e Request

e Response
Organization Displays a drop-down menu for selecting whether the information is displayed

top to bottom or side by side.
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e o

View Displays a drop-down menu for selecting what information is displayed. By

default, Best Reconstruction is selected. Other options are:
o View Meta

e View Text

o View Hex

o View Packets

o View Web

e View Mail

o View Files

Actions Displays a drop-down menu with the actions available in the Event

Reconstruction view.

Open Event ~ Opens the event in a new browser tab.

in New Tab

Beneath the toolbar is a list of meta keys and values. Some of the keys offer a drop-down menu
with available actions.

The bar at the bottom of the view offers several options.

o o —

l Displays the previous event.
l Displays the next event.
Show Displays the reconstruction log at the bottom of the view. Once you click this

Reconstruction button, it changes to Hide Reconstruction Log.

Log
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Events View

In the Events view a list of events associated with a session is available; this view is optimized
for viewing raw events in sequence by time. You can display the events list in several forms,
filter events, search for events, and open a reconstruction of an event.

There are two ways to display the Events view:

e Go to INVESTIGATE > Events. NetWitness Suite runs a default query on the last three
hours for the default service (if one is set) or displays a dialog in which you can select a
service and then runs the default query. The default query selects all events and the Events

view displays events on the selected service, with the oldest events first.

o From within the Navigate view, double-click an event. The Events view displays the events

on the selected service based on the drill point in the Navigate view.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event
Metadata

Triage an Incident
(Pivot from Respond
View)

Investigate Endpoints

(Navigate View) (esis s,

You are here

Find Suspicious

Endpoint Files
(Files View)

(Events View)

|
|
I Browse Raw Events
|
I

Analyze Raw Events
and Metadata
(Events Analysis
View)

Scan Files and Events
for Malware
(Malware Analysis
View)

¥

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups
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What do you want to do?

User Role

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Incident Responder

Threat Hunter

Threat Hunter

Threat Hunter

browse event metadata

browse raw events*

analyze raw events and metadata

investigate endpoints (Version 11.1)

find suspicious endpoint files (Version
11.1)

scan files and events for malware

triage an incident in Investigate

set user preferences for the Events

view*

reconstruct an event*

export events and Files*

1.1

Documentation

Begin an
Investigation in the

Navigate or Events
View

Begin an
Investigation in the

Navigate or Events
View

Begin an
Investigation in the

Event Analysis
View

Investigate Hosts

Investigate Files

Conducting Malware

Analysis

NetWitness

Respond User
Guide

Configure the

Navigate View and

Events View

Reconstruct an

Event

Export Events in the

Events View
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1.1

Documentation

User Role

Threat Hunter perform internal lookups View Additional
Context for a Data
Point

Threat Hunter perform external lookups Launch an External

Lookup of a Meta

Key

Threat Hunter or Incident add one or more events to an existing Add Events to an

Responder incident or to a new incident* Incident for
Response

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Examining Raw Events in the Events View

Combine Events from Split Sessions

Filter Results in the Event Analysis View

Manage Column Groups in the Events View

Quick Look

The Events view provides three built-in presentations of event data: the Detail view, the List
view, and the Log view. The List view and Detail view are intended for viewing packet data
events, and they provide more information for each event including the timestamp, event type,
event theme, and size.

o The List View shows corresponding source and destination address and port information for

events in summary form in a grid.
o The Detail View shows all metadata collected for the event in a paged view.

o The Log View is optimized for viewing log information, and provides more information for

each log including the timestamp, event type, service type, service class, and the logs.
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You can use queries, the time range setting, and profiles to filter the events listed in the Events
view. From any view type in Events view, you can extract files; export events, logs, and meta
values; open the Event Reconstruction panel, and open Event Analysis.

The following figure is an example of events in the Detail View. The Context Lookup panel is
visible only if the Context Hub service is configured.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis

= S - Concentrator [EEEILTEEEEE ¥ Query @ [ Profile @ [ Detail View © <+ Actions © -~ Incidents Search Events v

Context Lookup
| Event Time EventType  Theme Size Details
Alerts Sort Date-Newestto Ok v &
€ sessionid: 1
i device.p: _/ LastUpdated: afewsecondsago  Time Window: 7 days
8 medium: 32 T e
W .
L st S3smiEr 50 sevemmy Failed Logins Followed by Successful Login
[] 2018-03-08T11:24:58 Log ciscorouter 191 bytes CEiml=s [ 70 Created  2018/03/08, 13:58 (0 days ago)
header.id : 0033 ) Incident ID
msg.id : ciscorouter_osr:01 = Sources  Event Stream Analysis
event.catname : System.Normal Conditions bt Events &
W .
1“““5“1'“' i) B SEVERITY Failed Logins Followed by Successful Login
Show Additional Meta Event Analysis 70 Created 2018/03/08, 13:58 (0 days ago)
€ sessionid: 2 Incident ID
& d . Sources Event Stream Analysis
B device.ip: (A bvents 6
8 medium: 32
i devicetype: ciscorouter SEVERITY Failed Logins Followed by Successful Login
w . Created  2018/03/08, 13:58 (0 days ago)
[] 2018-03-08T11:2458 Log ciscorouter 193 bytes device.class : Router 70 \ncident ID
header.id : 0033
@ d: " 01 Sources Event Stream Analysis
i magd : ciscorouter_osr e &
event.catname : System.Normal Conditions
i devicedisc: 100 SEVERITY Failed Logins Followed by Successful Login
+ show Additional Meta B Event Analysis 70 Created  2018/03/08, 13:58 (0 days ago)
Incident ID
€ sessionid : 3 Sources Event Stream Analysis
i device.ip: Events 6
8 medium: 32 B
@ N : SEVERITY Failed Logins Followed by Successful Login
evice.ype : ciscorouter 70 Created  2018/03/08, 13:58 (0 days ago)
[ 2018-03-08T11:24:58 Log ciscorouter 185 bytes device.class : Router Incident ID
header.id : 0033 Sources  Event Stream Analysis
msg.d : ciscorouter_osr01 Events 6
i eventcatname : System.Normal Conditions
SEVERITY
@ devicedisc: 100 —
| Page1 | ) | C | 25 ~ eventsperpage Displaying 1 - 25 of 100,000 events 50 Alerts (First 50 Results)

The following figure is an example of events in the List View.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis

=] S - Concentrator ¥ Query @ [ Profile ® [ ListView ® - Actions ® - Incidents &

[ eventTime EventType  Size Details )
[ 2018-03-08T11:24:58 Log 191 bytes %
[] 2018-03-08T11:24:58 Log 193 bytes ®
[ 2018-03-08T11:2458 Log 185 bytes g
[] 2018-03-08T11:24:58 Log 183 bytes 2
[ 2018-03-08T11:24:58 Log 191 bytes _g
[ 2018-03-08T11:24:58 Log 185 bytes

[0 2018-03-08T11:24:58 Log 230 bytes

[1 2018-03-08T11:24:58 Log 239 bytes

[ 2018-03-08T11:24:58 Log 138 bytes

[0 2018-03-08T11:24:58 Log 181 bytes

[ 2018-03-08T11:2458 Log 185 bytes

[ 2018-03-08T11:24:58 Log 185 bytes

[ 2018-03-08T11:24:58 Log 193 bytes

[ 2018-03-08T11:2458 Log 191 bytes

[0 2018-03-08T11:24:58 Log 139 bytes

[1 2018-03-08T11:24:58 Log 139 bytes

[ 2018-03-08T11:24:58 Log 148 bytes

[0 2018-03-08T11:24:58 Log 139 bytes

[ 2018-03-08T11:24:58 Log 161 bytes

[ 2018-03-08T11:24:58 Log 133 bytes

[] 2018-03-08T11:24:58 Log 139 bytes

[ 2018-03-08T11:2458 Log 136 bytes

| Page1 | » | C' | 25 v eventsperpage Displaying 1 - 25 of 100,000 events

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis

= S - Concentrator [ERETMICEEEN 7 Query @ [ Profile © [ LogView = - Actions = - Incidents Search Events

O EventTime EventType  Service Type Service Class Lo; [
P yp L o)
e ! <4> HActianceEvents: 12+4Proxy IMANnullj AM4733MCoach- 3
-03-( 4
[ 2018-03-08T11:2458  Log clscorouter Router Allowed ANl AMNUIAA ARZAAT 2ANDANGAA 352836698984MA-1ADAANUIAAT ANnUIT) I~
by
5 <4> $ActianceEvents: 1244 Proxy IMAM DUl A4T33AN[cense- ~
03 ”
01 2018.03-08711:24:58 Log discorouter Router Allowed A nUITAHNUIAAT AA3AAT ZAADARDAR] 3528366989847 1 A 2AA (UM AN{nul) 5
. <4> HActianceEvents: 1244 Proxy =]
03 245!
L1 2018-03.08T11:24:58  Log ciscorouter Router I e ( (UL 1AM3AAT 2000A 0N 35283669BIBAN1AM2ANRUIIAAT A (UL z
e
] e <4> $ActianceEvents: 1244Proxy
] 2018-03-08T11:24558  Log ciscorouter Router I AAAT3IAMAlRFTAA (N 1AABAA] 2AAOAAOAA] 352B36698084A-1 ADAM LI AM Ll
as . <4> HACTANCREVENTS: 12°4Proxy IMA(null %4733 Coach-
03 25
O 201803-.08711:2458 Log ciscorouter Router BIOCKeAAANUIY(NLIYIAAAT 2AM0M0M] 352B3669BIBAM-1A2AN ML AL
e <t> HActianceEvents: 1244Proxy
[ 2018-03-08T11:24:58 Log ciscorouter Router ok 733 Blocked ol JAIRAZAA 12RO 135 Azl Al
- <4> wAcuvidentity: 1| | localhost| | | |2006-06-27 16:26:22.000| |432 || john2| |NIC Group| | | |Userid john2 ACCEPTED
03 ”
O 2018-03-08T11:24:58  Log ciscorouter Router using token 0740778488 with synchronous password.| | || | |3604
e ’ <4>%Actividentity: 2| | localhost| | | 12006-06-27 16:45:34.000] |91 [john2| | NIC Group| | | |Userid john2 REJECTED
-03- 4
[ 2018-03-08T11:24:58  Log discorouter Router using token 0740778488 with synchronous password (Bad OTP). | || | | | 2584
[ 2018-0308T11:24:58 Log ciscorouter Router <4> HActividentity: 25000| | MASTER| | 2006-07-27 06:36:21.000| |engvsaaa| |15277| |null)| | MASTER| || |||
; <4> %ActianceEvents: 1244Proxy
03 245 .
[ 2018-03-08T11:2458 Log iScorolter Rauter IMAA(U A ANETIFANLOEMNUIAMANUIAN AMBAN] 2ANDANDANT 352836698984AA1ANZANAUIIAR A{null)
] e <4> $ActianceEvents: 1244Proxy
[ 2018-03-08T11:24:58 Log ciscorouter Router ok hoj - ullptangant 135 Az ANl
; <4> BACTaNCREVents: 1274P0;
03-08T11:24:5:
O 201803-.08711:2458 Log ciscorouter Router IMAA(nUA AAETIZMNCOAChRMA(NUIMAMUIMT MM 2ANAOAN 352836 6989B4M-1A2ZANNUINAAANNLIT
T <4> HActianceEvents: 12+Proxy IMA(nully* AM4T3IAN cense-
[ 2018-03-08T11:24:58  Log ciscorouter Router BlockedAA(NUIAA{NULYA T AA3AA] 240 0A0AN 3528366989B4A- 1AM 24A(NUIIAM AN(null)
5 <4> BActianceEvents: 1244Proxy IMAM(nul AMG733AMQuota-
03 ”
O 201803.08711:24:58  Log discorouter Router Limited AnullA(nuliA1413A01 135 AARZA (Ul ANl
[ 2018-03-08T11:24:58 Log ciscorouter Router <4>%Actividentity: 25003| | MASTER| |2006-06-27 15:29:18.000| | NIC| |24000] |0| | RADIUS | |defaultrad] | ||
1 18 03 AETH14ES 1an P - A At nntin g FEAAE L IRASTED L1908 NE 97 153048 AANLINICT 17AAAAL 1AL LDARILIE L Linfauis raddl 111
| Page1 | ) | C | 25 v eventsperpage Displaying 1 - 25 of 100,000 events
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Detailed Description

The Events view has a toolbar at the top with the following options.

s Jowerpten

Select Service

Time Range

Query

Profile

Displays the selected service name next to the icon. Opens the
Select a Service dialog, in which you can select a service for

which the event list is displayed.

Displays a drop-down menu for selecting the time range to
apply to the event list. You can choose one of the standard

options or specify a custom time range.

Displays the Create Filter dialog, in which you can enter a
custom query directly instead of drilling down the data (see

Create a Custom Query)

Displays the Use Profile menu; the currently selected profile is
displayed in the toolbar. A profile allows you to manage and
use profiles that can include custom meta groups, a default
column group, and a beginning query. The Profiles apply to the
Navigate view (meta groups and queries) and the Events view

(column groups and queries).
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View Type Drop-down Displays a drop-down menu for selecting the event view type.

o Detail View shows events in a paged format with detailed

information for each event.

o List view shows the events in grid form with a summary of

each event in a separate row.

o Log View shows a log-oriented events grid with a summary

of each log in a separate row.

o Custom Column Groups displays the event list using a
column group selected from a drop-down list of custom

column groups.
o Manage Column Groups displays the dialog for creating and
editing custom column groups.
Actions Displays a drop-down menu with actions in the Events view:

o Extract Files, export events as a PCAP file, export logs, or

export meta values.

« View an event reconstruction in a popup window or in a new
tab.

o View Event Analysis

o Reset all filters in the Events view.

Incidents Create a new incident in Respond and add the selected events,
or add selected events to an existing incident in Respond.

Search Displays the Search Events options, which allow you to specify
the export log and export meta value format with additional

options explained in Search for Text Patterns
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e oo

Settings Displays the Investigation settings for the Events view (which

are also available in the Profile view) so that you can change
Investigation settings without navigating away from the Events
view. When you change a setting In the Events view the setting

is also changed in the Profile view (see Configure the Navigate

View and Events View).
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Files View

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

In the Files view, a list of unique executable files found in the deployment is available. To
access this view, go to INVESTIGATE > Files. By default, the Files view displays 100 files.
To display more files, click Load More at the bottom of the page.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event Triage an Incident

Investigate Endpoints ;
Metadata -
([¥losis iz (Pivot from Respond

(Navigate View) View)

Find Suspicious

I I
Browse Raw Events I [
| Endpoint Files I
I I
I I

(Events View) ) ;
(Files View)

You are here
Analyze Raw Events Scan Files and Events
and Metadata for Malware
(Events Analysis (Malware Analysis
View) View)

$

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups

What do you want to do?

1141

Documentation

User Role

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events
View
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1.1
User Role

Documentation

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis

View

Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts

Threat Hunter find suspicious endpoint files (Version Investigate Files

11.1)*

Threat Hunter scan files and events for malware Conducting Malware
Analysis

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

Threat Hunter export host attributes and global files* Investigate Files

*Y ou can perform this task in the current view

Related Topics

o How NetWitness Investigate Works

o Investigating Hosts and Files

Quick Look

Below is an example of the Files view:

CONFIGURE
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Add Filter Drop-down Menu. You can filter the files by choosing an operating system
(Windows, Linux, or Mac), saved filters, or by selecting the options in the Add Filters

drop-down menu. For more information, see Filter Files.

Saved Filters. The Saved Filters panel lists the saved filters. For more information, see

Filter Files.

Sort Columns. You can sort the list by:
Filename - Name of the file.
First Seen Time - First time the hash was seen in the host.

Signature - Indicates if the file is signed or unsigned, valid or invalid, and provides
signatory information.

Size - Size of the file.
Entropy - Determines if the contents are compressed or encrypted.

Format - Format of the file - Windows (PE), Linux (ELF and scripts), and Mac
(Macho).

PE.Resources.Company - Company name.

Settings Menu. You can set Files view preferences by selecting columns from the

Settings menu. For more information, see Set Files Preference.

Export to CSV - Extracts global files to a CSV file. For more information, see

Investigate Files.

Pivot to Navigate and Event Analysis views. To investigate a particular filename or
hash (SHA256 and MDS5), you can pivot to both Navigate and Event Analysis views.
For more information, see Pivot to Navigate and Event Analysis Views.
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Investigate Dialog

In the Investigate dialog, analysts can select a service or a collection to investigate. The dialog
is automatically displayed when you first go to the Navigate view or Events view and have not
selected a default service to investigate. To access the dialog from a current investigation, select
the current service name in the toolbar.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event
Metadata

(Navigate View)

You are here

Browse Raw Events

(Events View)

Analyze Raw Events
and Metadata
(Events Analysis
View)

Triage an Incident
(Pivot from Respond
View)

Investigate Endpoints
(Hosts View)

Find Suspicious
Endpoint Files
(Files View)

Scan Files and Events
for Malware
(Malware Analysis
View)

4

Act on an Event or Endpoint

Reconstruct an Event

Export Events and
Files

Perform Internal Create an Incident in
Lookups Respond

Export Host
Attributes and Global
Files

Perform External
Lookups

What do you want to do?

User Role

1141

Documentation

Threat Hunter

browse event metadata

Begin an
Investigation in the

Navigate or Events

View

318

Investigate Reference Materials



NetWitness Investigate User Guide

1.1

Documentation

User Role

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis

View

Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts

Threat Hunter find suspicious endpoint files (Version Investigate Files

11.1)

Threat Hunter scan files and events for malware Conducting Malware
Analysis

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

Threat Hunter select a service to investigate™ Begin an

Investigation in the

Navigate or Events

View

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Navigate View

o Events View
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Quick Look

vesligate
Services Collections

¥ Default Service

Name ~ Address Type
BrokerG3 Eroker
Concentratorfd Concentrator
Concentrator6? Concentrator
Decoder220 Decoder
Decodert3 Decoder

Log Decoder227 Log Decoder

Cancel Navigate

The Investigate dialog has two tabs: Services and Collections.

Note: Collections are also known as workbench collections. You can only view workbench
collections that you have created, and only administrators can create a workbench collection.

The Services tab includes a list of services available for investigation, and three buttons. All
features are described in the following table.

P peserpn

Default  Clicking this button sets or clears the default service to investigate. When a
Service  service has been set as the default service, the word (Default) is appended to the

service name.
Name The name of the service.
Address  The IP address of the service.
Type The type of service.
Cancel Closes the dialog.

Navigate Opens the selected service in the Navigate or Events view.
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The Collections tab has two buttons and two panels: Workbench and Collections.

The Workbench panel lists available Workbench services by name. After a Workbench service
is selected, you can select a collection from the Collections panel.

The Collections panel lists available collections to investigate. After a collection is selected, you
can click Navigate to view the collection.

The following table describes the features of the Collections panel.

CENCTTI

Name The name of the collection.
Type The type of collection.
Size The size of the collection.

Data Type The type of data within the collection.

Date Created The date the collection was created.
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Investigation Tab - User Preferences Panel

In the Profile view > Preferences panel > Investigation tab, users can set several preferences
that affect the performance and behavior of NetWitness Suite when analyzing data, viewing

events, and reconstructing events in NetWitness Investigate. To access this tab, select - >
FMEER. When the Profile view is displayed, select Preferences > Investigation. You can
change user preferences at any time when you are working in NetWitness Suite.

What do you want to do?

T T [

Threat Hunter view and change user preferences for Configure the
Investigate* Navigate View and

Events View

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Navigate View

o Events View

Quick Look

This figure is an example of the Investigation tab, and the following table describes the
Investigation preferences.
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RSA| RESPOND INVESTIGATE

I Preferences
Notifications

Jobs

MONITOR CONFIGURE ADMIN

Preferences

General

Investigation

Threshold 100000
Max Values Results 1000
Max Session Export 100000

Max Log View Characters 1000

Max Meta Value &0

Characters

Export Log Format v
Export Meta Format v

] Use Per

1 Append

is checked,

Device Local Cache

1 Show Debug Information

Events in Events Panel

1 Autoload Values
] Download Completed PCAPs
 Live Connect: Highlight Risky Values

| Dptimize Investigation page loads (When this

random page access is disabled)

Default Session View

Best Reconstruction v

[ Enable CSS Reconstruction for Web View

Search Options

[ Meta

[+ Raw
(Network/Log/Endpoint)

¥ Case Insensitive ¥/ Regular Expression

[# Search Indexes

Apply

11.0.0.0-170831135340,1.375d24¢

Description

Threshold

Max Values

Results

Max Session

Export

This setting controls the count shown for a Meta Key value in the
Navigate view during the load. A higher threshold allows more accurate
counts for a value. However, a higher threshold causes longer load times.
When the threshold is reached, NetWitness Suite displays the count and
the percentage of time used to reach the count in comparison to the time
necessary to load all sessions with that value.

For example, (>100000 - 18%) indicates that the threshold was set at
100000 and this load took only 18% of the time it would have taken with
no threshold set. The default value is 100000.

This setting controls the maximum number of values to load in the
Navigate View when the Max Results option is selected in the Meta Key

Menu for an open Meta Key. The default value is 1000.

This setting controls the maximum number of sessions that can be

exported. The default value is 100000.
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e o

Max Log View

Characters

Export Log Format

Export Meta

Format

Use Per Device
Local Cache

This setting controls the maximum number of characters to be displayed

on Investigation > Events > Log Text. The default value is 1000.

This setting specifies the default format for exporting logs from
Investigation. Available options are Text, XML, CSV, and JSON. There
is no built-in default value for the log export format. If you do not select a
format here, NetWitness Suite displays a selection dialog when you
invoke export of logs. When you select one of the options from the Export
Log Format drop-down menu and click Apply, the setting goes into effect

immediately.

This setting specifies the default format for exporting meta values from
Investigation. Available options are Text, XML, CSV, and JSON. There
is no built-in default value for the meta export format. If you do not select
a format here, NetWitness Suite displays a selection dialog when you
invoke export of meta. When you select one of the options from the
Export Meta Format drop-down menu and click Apply, the setting goes

into effect immediately.

Show Debug When this option is selected, NetWitness Suite displays the where clause

Information beneath the breadcrumb in the Navigate view. For each meta value load,
the load time is displayed. If the service is a Broker, then the elapsed
time for each aggregated service is reported. The default value is Off.
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e o

Append Events in ~ When this option is selected, the events displayed in the Events Panel

Events Panel are added incrementally rather than overwriting the currently displayed
events. Each time you click the next page icon, the additional events are

appended to the previous events; 1 -25, then 1 -50, then 1 -75 and so on.

Note: This option is available, only if the Optimize Investigation Page
Loads option is enabled

Autoload Values When this option is selected, the service values are automatically loaded
in the Navigate view. When not selected, NetWitness Suite displays a
Load Values button, allowing the user the opportunity to modify the
options. The default value is Off.

Download This setting automates the downloading of extracted PCAPs in the
Completed PCAPs Investigate so that you do not have to manually download and open
extracted PCAP files in an application, such as Wireshark, that can

handle viewing data in a PCAP format.

Live
Connect: Highlight
Risky Values

Optimize This option is enabled by default (checked) and controls how the Events

Investigation Page view retrieves events. When optimized, results are returned as quickly as

Loads possible. This sacrifices the original ability to go to a specific page in the
event list. Unchecking this box changes the Events list pagination to
allow you to go to a specific page in the list (or to the last page). Being
able to go to any page in the list sacrifices some speed in returning the

results due to additional overhead determining the events in advance.

Default Session This setting selects the default reconstruction type for the initial
View reconstruction view. By default events are reconstructed using the

reconstruction type most appropriate to the event.
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Enable CSS This setting controls how web content reconstruction is performed. If

Reconstruction for enabled, the web reconstruction includes cascaded style sheet (CSS)

Web View styles and images so that its appearance matches the original view in a
web browser. This includes scanning and reconstructing related events,
and searching for stylesheets and images used in the target event. The
option is enabled by default. Uncheck this option if there are problems

viewing specific websites.

Note: The appearance of the reconstructed content may not match the
original web page perfectly if related images and stylesheets could not
be found or were loaded from the web browser's cache. Also, any
layout or styling that is performed dynamically via client side javascript
will not render in the reconstruction because all client side javascript is
removed for security purposes.

Search Options This setting sets the default search options to apply to a search in the

Navigate and Events views. Search for Text Patterns provides detailed

information.

Apply Saves your preferences and puts them into effect immediately.
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Investigate View

The Investigate view ( INVESTIGATE ) is the primary entry point to NetWitness Investigate.
The Investigate view has five submenus, which open different views that allow you to analyze
events from different perspectives. The submenus are: Navigate, Events, Event Analysis, Hosts,
Files, and Malware Analysis.

Note: The Event Analysis, Hosts, and Files submenus are available in Version 11.1 and later.
Configured permissions per user role and user determine which submenus are displayed .

You can use the submenu options to move between the different views.

o The Navigate view, Events view, and Event Analysis view offer linkages to each other to
look at the current results from a different perspective, which provides some continuity for the

investigation as you move between views.

o The Hosts view and Files view integrate NetWitness Endpoint into Investigate, and provide a
view of all hosts with a NetWitness Endpoint agent installed and a view of unique executable

files found in the deployed environment.

o The Malware Analysis view provides the ability to scan files found in one of the other views

or collected by continuous scanning of network traffic.

Workflow

The workflow below depicts the high-level tasks when investigating events.
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Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event Triage an Incident

Metadata LvesHEale E_nclpm it (Pivot from Respond
(Hosts View) -
View)

(Navigate View)

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Analyze Raw Events Scan Files and Events
and Metadata for Malware
(Events Analysis (Malware Analysis
View) View)

4

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host

Export Events and Perform External Attributes and Global

Files Lookups

Files

What do you want to do?

Threat Hunter browse event metadata Begin an
Investigation
in the

Navigate or
Events View

Threat Hunter browse raw events* Begin an
Investigation
in the

Navigate or
Events View

Threat Hunter analyze raw events and metadata* Begin an

Investigation
in the Event

Analysis
View

Threat Hunter investigate endpoints (Version 11.1)* Investigate
Hosts
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Threat Hunter find suspicious endpoint files (Version Investigate
11.1)* Files

Threat Hunter scan files and events for malware* Conducting

Malware

Analysis
*You can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

e Beginning an Investigation

o Configuring NetWitness Investigate Views and Preferences

o Navigate View

o Events View

o Event Analysis View

o Hosts View
o Files View

o Malware Analysis View

Quick Look

The Investigate view consists of five views, each representing a different approach to analyzing
data. By default, Investigate opens to the Navigate view. You can change the default view to
one of the other views. See How NetWitness Investigate Works for an introduction to the uses for
each view. The following figure illustrates the submenus under INVESTIGATE.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis
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Hosts View

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

In NetWitness Investigate, the Hosts view provides a list of all hosts with an Endpoint agent
installed. The table displays a set of default columns for the host. You can customize this view

by setting the Hosts preferences.

To access this view, go to INVESTIGATE > Hosts.

Workflow

The following figure shows the high-level Investigate workflow with Investigate Endpoints

highlighted.

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event

Metadata :
(Hosts View)

(Navigate View)

I I
I I
[l Investigate Endpoints |
I I
I I
| You are here I
Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Scan Files and Events
for Malware
(Malware Analysis
View)

4

Act on an Event or Endpoint

Analyze Raw Events
and Metadata
(Events Analysis
View)

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host

Export Events and Perform External
Files Lookups

Files

Triage an Incident

(Pivot from Respond
View)

Attributes and Global
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What do you want to do?

1.1
User Role

Documentation

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events
View

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis
View

Threat Hunter investigate endpoints (Version 11.1)* Investigate Hosts

Threat Hunter find suspicious endpoint files (Version Investigate Files
11.1)

Threat Hunter scan files and events for malware Conducting Malware

Analysis

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

Threat Hunter export host attributes and global files* Investigate Hosts
*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Investigating Hosts and Files

e Hosts View - Overview Tab

o Hosts View - Process Tab
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e Hosts View - Autoruns Tab

e Hosts View - Files Tab

e Hosts View - Drivers Tab

o Hosts View - Libraries Tab

e Hosts View - System Information Tab

Quick Look

In the Hosts view, you can export host attributes and global files, perform an on-demand scan,
set host preferences, view a list of hosts, and investigate in the Navigate or Events view.

Below is an example of the Hosts view:

[RSA RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events  Event Analysi sts  Files

Export to Csv

o opERATING sYSTEM

Fiter: AddFilter v Sa 1]

Saved Filters Hosts (11) [
Firewallpisable O wosmuaue Acewtio - AgwT scan starus [———
Linux o

Windows

Mac

Add Filter Drop-down Menu. You can filter the hosts by choosing an operating system

(Windows, Linux, or Mac), saved filters, or by selecting the options in the Add Filters

drop-down menu. For more information, see Filter Hosts.

Al Saved Filters. The Saved Filters panel lists the saved filters. For more information, see

Filter Hosts.
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RN Actions in the toolbar:
Start Scan - Starts a scan for the selected hosts.
Stop Scan - Stops a scan for the selected hosts.
Export to CSV - Extracts host attributes to a CSV file. For more information, Export_
Host Attributes.
Pivot to Endpoint - Lets you investigate the NetWitness Endpoint host (version 4.4.0.2

or later). For more information, see Investigate NetWitness Endpoint 4.4.0.2 or Later Hosts.

Delete - Lets you delete hosts manually from the user interface. After deletion, the

Endpoint server does not process any request from this host.

Note: Make sure that the agent is uninstalled from the host before deleting it from the
user interface. For more information, see Delete a Host.

3 Settings Menu. You can set Hosts view preferences by selecting columns from the

Settings menu. For more information, see Set Hosts Preference.

Bl Pivot to Navigate and Event Analysis views. To investigate a particular host,
IP address, or username, you can pivot to both Navigate and Event Analysis views. For
more information, see Pivot to the Navigate and Event Analysis Views.
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Hosts View - Autoruns Tab

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

The Autoruns panel provides a list of autoruns, services, tasks, and cron jobs running on the host.
To access this tab, select a host from the Hosts view and click the Autoruns tab.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event
Metadata

Triage an Incident

(Pivot from Respond
View)

(Hosts View)

(Navigate View)

You are here

|
I
Investigate Endpoints |
I
I
I

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Scan Files and Events
for Malware
(Malware Analysis
View)

4

Act on an Event or Endpoint

Analyze Raw Events
and Metadata
(Events Analysis
View)

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Export Events and Perform External P

Files Lookups

Attributes and Globa
Files

What do you want to do?

User .
11.1 Documentation

Role

Threat browse event metadata Begin an Investigation in the
Navigate or Events View

Hunter
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User .
11.1 Documentation

Role

Threat browse raw events Begin an Investigation in the
Navigate or Events View

Hunter

Threat analyze raw events and metadata Begin an Investigation in the Event
Analysis View

Hunter

Threat investigate endpoints (Version 11.1)* Investigate Hosts

Hunter

Threat find suspicious endpoint files (Version 11.1)  Investigate Files

Hunter

Threat scan files and events for malware Conducting Malware Analysis

Hunter

Incident triage an incident in Investigate NetWitness Respond User Guide

Responder

Threat view the autoruns, services, tasks, and cron ~ Analyze Autoruns

Hunter jobs running on the host*

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Investigating Hosts and Files

o Hosts View

Quick Look

Below is an example of the Autoruns tab:
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Ev Event Analysis

ectory\ShellEx\CorntextMlenuHandlers\7-Zip @CLSID

fes with values only

Categor
y

Description

Autoruns  Files that are executed at start-up. It displays the following columns:

o File name - cmd.exe

o Registry path - HKEY LOCAL
MACHINE\SYSTEM\CurrentControlSet\Control\SafeBoot
@AlternateShell

Services  Files that are running as a service for the selected host. It displays the following
columns:

o Service name - acsock

o Running status - stopped

« File creation time - 07/11/2017 11:47:00 am
o Signature - Microsoft, signed, valid

o File path - C:\Windows\System32\drivers
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Categor

Description
y

Tasks/Cro Files that are configured to run as scheduled tasks along with the trigger. It

. displays the following columns:
n jobs
e Name - shell32.d11

° Hash =
cafabe706a9220e7c805ea476a89a78800f48bb48co6fe5£935057940d
£3909c

o Lastruntime - 01/19/2018 05:34:50 pm
o Nextruntime - 12/30/1899 05:30:00 am

o Trigger - No Trigger

Autoruns Properties Panel

This panel displays all properties of the selected file. It is grouped as follows:

General General information about the file, such as file name, entropy, size, and format.

Signature Provides signatory information.

Hash Hash type of the file (MDS5, SHA256, and SHAT).
Time Time when the file was created, modified, or accessed.
Location Location of the file.

Image Loaded image.
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Hosts View - Drivers Tab

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

The Drivers tab lists the drivers running on the hosts at the time of scan. To access this tab,
select a host from the Hosts view and click the Drivers tab.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event
Metadata

Triage an Incident

Investigate Endpoints .
> : (Pivot from Respond

(Navigate View) View)

I
I
I
(Hosts View) |
I
You are here I

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Analyze Raw Events
and Metadata
(Events Analysis

View)

Scan Files and Events
for Malware
(Malware Analysis
View)

4

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Export Events and Perform External P

Files Lookups

Attributes and Globa
Files

What do you want to do?

User Role

Threat Hunter browse event metadata

Threat Hunter browse raw events

11.1 Documentation

Begin an Investigation in the Navigate or

Events View

Begin an Investigation in the Navigate or

Events View
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User Role 11.1 Documentation

Threat Hunter analyze raw events and metadata  Begin an Investigation in the Event
Analysis View

Threat Hunter  investigate endpoints (Version Investigate Hosts
11.1)*
Threat Hunter  find suspicious endpoint files Investigate Files

(Version 11.1)

Threat Hunter  scan files and events for malware  Conducting Malware Analysis

Incident triage an incident in Investigate NetWitness Respond User Guide
Responder

Threat Hunter ~ view the drivers running on the Investigate Hosts

host*

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Investigating Hosts and Files

e Hosts View

Quick Look

Below is an example of the Drivers tab:

POND INVESTIGATE MONITOR CONFIGURE ADMIN

Events EventAnalysis Hosts  Files

em Information

01/23/2018 05:22:3
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oo

Filename Name of the file. For example, acpi.sys.

Signature Indicates if the file is signed or unsigned, valid or invalid, and provides

signatory information.

Path Path of the file. For example, C: \Windows\System32\drivers.

File Creation Time when the file was created.
Time

Driver Properties Panel

This panel displays all properties of the selected file. It is grouped as follows:

General General information about the file, such as file name, entropy, size, and format.

Signature Provides signatory information.

Hash Hash type of the file (MDS5, SHA256, and SHAT1).
Time Time when the file was created, modified, or accessed.
Location Location of the file.

Image Loaded image.
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Hosts View - Files Tab

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

The Files tab displays all files scanned on the host. To access this tab, select a host from the
Hosts view and click the Files tab. By default, it displays 100 files. To display more files, click
Load More at the bottom of the page.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

I
) I
Browse Event
Metadata |
I
I
|

Investigate Endpoints .
4 P (Pivot from Respond

View)

(Hosts View)

(Navigate View)

I
| )
[ Triage an Incident
I
I

You are here I

Find Suspicious

Endpoint Files

(Files View)

Browse Raw Events
(Events View)

Analyze Raw Events
and Metadata
(Events Analysis
View)

Scan Files and Events
for Malware
(Malware Analysis
View)

4

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups

What do you want to do?

1141

Documentation

User Role

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events

View
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1.1

Documentation

User Role

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis

View

Threat Hunter investigate endpoints (Version 11.1)* Investigate Hosts

Threat Hunter find suspicious endpoint files (Version Investigate Files

11.1)

Threat Hunter scan files and events for malware Conducting Malware
Analysis

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

Threat Hunter view the files scanned on the host* Analyze Files

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Investigating Hosts and Files

o Hosts View

Quick Look

Below is an example of the Files tab:
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ND  INVESTIGATE NITOR  CONFIGURE ADMIN

nformation

082272013 05:08:16 pm

ies with values only

BOOTVIDOLL

Description

Filename Name of the file. For example, 7-zip.d11.

Entropy  Entropy of the image data, excluding the PE headers. It determines if the contents
are packed (compressed or encrypted).

Size Size of the file. It can be an indicator when assessing a file.

Path Path of the file. Sometimes malware authors put the file on directories where there
are typically no such files. Malicious files are typically standalone files (for
example, a file in the root C: \Programbata) versus a group of files in a
legitimate folder (for example, files in C: \Program Files\<folder name>\).

Signature Indicates if the file is signed or unsigned, valid or invalid, and provides signatory
information.

Created  Time stamp of the file.

User User of the file (for Linux). For example, root.

Name

Group Group to which the user belongs (for Linux). For example, root (0).
Name

File Properties Panel

This panel displays all properties of the selected file. It is grouped as follows:

Category | Description

General General information about the file, such as file name, entropy, size, and format.
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Signature Provides signatory information.

Hash Hash type of the file (MDS5, SHA256, and SHAT1).
Time Time when the file was created, modified, or accessed.
Location Location of the file.

344 Investigate Reference Materials



NetWitness Investigate User Guide

Hosts View - Libraries Tab

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

The Libraries tab lists the libraries loaded at the time of scan. To access this tab, select a host
from the Hosts view and click the Libraries tab.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event
Metadata

Triage an Incident

(Pivot from Respond
View)

(Hosts View)

(Navigate View)

You are here

|
I
Investigate Endpoints |
I
I
I

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Scan Files and Events
for Malware
(Malware Analysis
View)

4

Act on an Event or Endpoint

Analyze Raw Events
and Metadata
(Events Analysis
View)

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Export Events and Perform External P

Files Lookups

Attributes and Global
Files

What do you want to do?

111
User Role .
Documentation
Threat Hunter browse event metadata Begin an

Investigation in the
Navigate or Events

View
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1.1

Documentation

User Role

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis

View

Threat Hunter investigate endpoints (Version 11.1)* Investigate Hosts

Threat Hunter find suspicious endpoint files (Version Investigate Files

11.1)

Threat Hunter scan files and events for malware Conducting Malware
Analysis

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

Threat Hunter view the libraries loaded* Analyze Libraries

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Investigating Hosts and Files

o Hosts View

Quick Look

Below is an example of the Libraries tab:
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POND INVESTIGATE MONITOR CONFIGURE ADMIN

Even

01/23/2018 07:18:52.000 pm

b37d63141a37cb33da196a15bd..

1269132f16.
7cb33da196a151bdbee3.

Description

Process  Name and PID of the process that has loaded the library in the memory. For
Context  example, explorer.exe: 1916.
Filenam Name of the file. For example, 7-zip.d11.

(S

Signatur  Indicates if the file is signed or unsigned, valid or invalid, and provides signatory
e information. For example, signed, valid.

File Path Path of the file. For example, C: \Program Files\7-Zip.

Hash SHAZ256 of the file. For example,
c3bb3b42dcdf80446c622219513070757e618c06atfd9eelac3/cbceSbefcb8

97.
File Time when the file was created.
Creation
Time
Last Time when the file was modified.
Modified
Time

Library Properties Panel

This panel displays all properties of the selected file. It is grouped as follows:
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General General information about the file, such as file name, entropy, size, and format.

Signature Provides signatory information.

Hash Hash type of the file (MDS5, SHA256, and SHAT1).
Time Time when the file was created, modified, or accessed.
Location Location of the file.

Process Details of the process, such as image size and PID.
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Hosts View - Overview Tab

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

The Overview tab provides detailed scan results of the selected host. By default, the latest scan
result is displayed. To access this view, go to INVESTIGATE > Hosts, and select a host from
the Hosts view.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

I
) I
Browse Event
Metadata |
I
I
|

Investigate Endpoints .
4 P (Pivot from Respond

View)

(Hosts View)

(Navigate View)

I

| )

[ Triage an Incident
[

[

I

You are here

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Analyze Raw Events

and Metadata
(Events Analysis
View)

Reconstruct an Event

Export Events and
Files

Scan Files and Events
for Malware
(Malware Analysis
View)

4

Act on an Event or Endpoint

Perform Internal
Lookups

Perform External

Create an Incident in
Respond

Export Host

Attributes and Global

Lookups

What do you want to do?

User Role

Files

11.1 Documentation

Threat Hunter

Threat Hunter

browse event metadata

browse raw events

Begin an Investigation in the Navigate or

Events View

Begin an Investigation in the Navigate or

Events View
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User Role 11.1 Documentation

Threat Hunter analyze raw events and metadata  Begin an Investigation in the Event
Analysis View

Threat Hunter  investigate endpoints (Version Investigate Hosts
11.1)*
Threat Hunter  find suspicious endpoint files Investigate Files

(Version 11.1)

Threat Hunter  scan files and events for malware  Conducting Malware Analysis

Incident triage an incident in Investigate NetWitness Respond User Guide
Responder
Threat Hunter  view summary of the host* Investigate Hosts

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Investigating Hosts and Files

o Hosts View

Quick Look

Below is an example of the Overview tab:

INVESTIGATE  MONITOR  CONFIGURE ADMIN
Analysis  Hosts  Files  Malv

m Information

32 pm

/7eB0:140C:95b:85¢1:8916%3| MAC Address: 00:50:56:01:2E:6C
ies with values only

€510909D-2 1-DA90-353295DA.

Alphabetical O Status

Allow Access D:
Allow Display M

Antivirus

Bad Certificate Warning Warning Post Red
Cookies Cleanup et Windows Update
Cross Site Script Fiter

Firewall System Restore
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Agent and Scan Details. You can view the following agent and scan details of the
selected host:

Host name - Name of the host. For example, WIN-ABC.
Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or
Stopping Scan. For more information, see Investigate Hosts.

Agent Last Seen - Time when the agent last communicated with the server.

Last Scan Time - Last time the agent was scanned. The date and time is as per the time
zone set in the User Preferences and is local to the server.

Agent Version - Version of the agent. For example, 11.1.0.0.

AN Actions in the toolbar:
Snapshot Time - Lists scanned time stamps. To view the scan history, select the
snapshot time from the drop-down menu.
Start Scan - Starts scan for the selected hosts. For more information, see Investigate
Hosts.
Export to CSV - Extracts host attributes to a CSV file. For more information, see

Export Host Attributes.

Pivot to Endpoint - Lets you investigate the NetWitness Endpoint host (version 4.4.0.2

or later). For more information, see Investigate NetWitness Endpoint 4.4.0.2 or Later Hosts.

Export to JSON - Extracts host attributes and endpoint data to a JSON file of the

selected snapshot.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-

256 checksum). For more information, see Search on Snapshots.

Summary of the selected host. Displays the following fields:
IP Addresses - [P addresses associated with the host. For example, 10.10.10. 3.
Logged-in users - Users logged in to the host. For example, abc.

Security Configuration - Security configuration details on the host. For example,
firewall disabled or enabled, smart screen filter disabled or enabled. This field is only
applicable for Windows and Mac.

Note: The Agent Version, [P Addresses, Logged-in users, and Security Configuration
may change for each scan.
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R Host Properties Panel. Displays all properties of the selected host. It is grouped as

follows:

Agent - Agent-related information, such as agent ID, driver error code, install time, and
agent mode.

Operating System - Operating system version and build information.

Hardware - Information related to the architecture.

Network Interfaces - Network adapter information, such as Mac Address, Gateway.
User - Information related to the user.

Locale - Time zone and language that is local to the host.

352 Investigate Reference Materials



NetWitness Investigate User Guide

Hosts View - Process Tab

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

The Process panel provides a list of processes running on the host. To access this tab, select a

host from the Hosts view and click the Process tab.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event
Metadata

Triage an Incident

(Pivot from Respond
View)

(Hosts View)

(Navigate View)

You are here

|
I
Investigate Endpoints |
I
I
I

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Analyze Raw Events Scan Files and Fvents

and Metadata
(Events Analysis
View)

for Malware
(Malware Analysis
View)

4

Act on an Event or Endpoint

Create an Incident in
Respond

Perform Internal

Reconstruct an Event
Lookups

Export Host
Export Events and Perform External P

Files Lookups

Attributes and Global
Files

What do you want to do?

User Role
Threat Hunter browse event metadata
Threat Hunter browse raw events

11.1 Documentation

Begin an Investigation in the Navigate or

Events View

Begin an Investigation in the Navigate or

Events View
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User Role 11.1 Documentation

Threat Hunter analyze raw events and metadata  Begin an Investigation in the Event
Analysis View

Threat Hunter  investigate endpoints (Version Investigate Hosts
11.1)*
Threat Hunter  find suspicious endpoint files Investigate Files

(Version 11.1)

Threat Hunter  scan files and events for malware  Conducting Malware Analysis

Incident triage an incident in Investigate NetWitness Respond User Guide
Responder

Threat Hunter  view the processes running on the  Investigate Hosts

host*

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Investigating Hosts and Files

e Hosts View

Quick Look

Below is an example of the Process tab:

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @ admin = @
Navigate Events Event Analysi sts  Files

Autoruns  Fi Drriv Libraries  System Information
- oo
w Oz3018 052292633 pm Pt totndpom | |_ewortoon
a
rties with values only

signed.valid,imon Tatham C:\Users\Administrator\Desktop.

e putty.

£000000000000011C:6174

701:04:57.000 am
d595623a538005€eb520.

The Process panel displays the following information:
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* Process Details

N

Process Name Name of the process. For example, server.exe.

PID ID of the process. For example, 492.

Parent Name and process ID of the parent. For example, 4.

Process

(PPID)

Owner Owner of the process. For example, SYSTEM.

Signature Indicates if the file is signed or unsigned, valid or invalid, and provides

signatory information.

Path Path of the file associated with the process on the disk. For example,
C:\Windows\System32.

Launch Command line arguments passed to the process when it is launched. For

Arguments example, -k LocalServiceNoNetwork.

Creation Time Time when the process was created. For example, 01/19/2018
11:32:29.908 am.

o List of loaded libraries for the selected process, such as DLLs (for Windows), Dylibs (for
Mac), or .SO (for Linux).

o List of autoruns (if configured).

Process Properties Panel

This panel displays all properties of the selected process. It is grouped as follows:

General General information about the file, such as file name, entropy, size, and format.

Signature Provides signatory information.
Hash Hash type of the file (MDS5, SHA1, and SHA256).

Time Time when the file was created, modified, or accessed.
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Location Location of the file.
Process Details of the process, such as image size and PID.
Image Image details loaded by the process.
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Hosts View - System Information Tab

Note: The information in this topic applies to RSA NetWitness® Suite Version 11.1 and later.

The System Information tab lists the agent system information. To access this tab, select a host
from the Hosts view and click the System Information tab.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event
Metadata

Triage an Incident

(Pivot from Respond
View)

(Hosts View)

(Navigate View)

You are here

|
I
Investigate Endpoints |
I
I
I

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Analyze Raw Events Scan Files and Fvents

and Metadata
(Events Analysis
View)

for Malware
(Malware Analysis
View)

4

Act on an Event or Endpoint

Create an Incident in
Respond

Perform Internal

Reconstruct an Event
Lookups

Export Host
Export Events and Perform External P

Files Lookups

Attributes and Global
Files

What do you want to do?

User Role
Threat Hunter browse event metadata
Threat Hunter browse raw events

Documentation

Begin an Investigation in the Navigate or

Events View

Begin an Investigation in the Navigate or

Events View
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User Role

Threat Hunter analyze raw events and metadata

Threat Hunter  investigate endpoints (Version
11.1)*

Threat Hunter  find suspicious endpoint files
(Version 11.1)

Threat Hunter scan files and events for malware

Incident triage an incident in Investigate

Responder

Threat Hunter view the agent system

information*

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Investigating Hosts and Files

e Hosts View

Quick Look

Below is an example of the System Information tab:

RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events /ent Analysis  Hosts  Files  Malware Analys

a Overv Process Autoruns Files Drivers Libraries

LAST SCAN TIME AGENT VERSION
0172372018 07:18:52 pm 1.1.00

OPERATING SYSTEM AGENT SCAN STATUS
linux Idle

AGENT LAST SEEN
afew seconds ago

svoT Time ~ 01/23/2018 07:18:52.000 pm

Host File Entries  Mounted Paths

1P ADDRESS DNS NAME

127004 Iocalhost localhost.localdomain, localhost.l  Jocaldomaind

10.40.7.45 LinAgent.rsa.lab.emec.com,LinAgent

10.40.12.15 PrimaryCS

Documentation

Begin an Investigation in the Event
Analysis View

Investigate Hosts

Investigate Files

Conducting Malware Analysis

NetWitness Respond User Guide

Analyze System Information

System Information

Start Scan Pivot to Endpoint Export to JSON

Bash History
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o Jowemn

Host
File

Entries

Network

Shares

Security
Products

Window
S

Patches

Mounted
Paths

Bash
History

All network redirections written in the host file. For example, I[P Address -
10.10.10.3 and DNS Name -

localhost, localhost.localdomain, localhost4, localhost4.localdom

aind

Network name of the shared resource (for Windows only). For example, Name -
Admin$, Description - Remote Admin, Path - C:\, Permissions - None, Type -
disk, special, Max Users - 4294967295, Current Users - 0.

Installed security products (for Windows only). For example, Display Name -
Windows Defender, Instance - D68DDC3A-831F-4FAE-9E44-DA132C1ACF46,
Features - Enabled, Type - antiVirus.

List of patches applied by Windows update (for Windows only). For example,
KB2959936.

Path mounted on. For example, Path - /, File System - rootfs, Remote Path -

rootfs, Options - rw.

User name and command run. For example, User Name - root and Command -

1s.

Note: For Mac hosts, the Mounted Paths and Bash History fields are empty.
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Malware Analysis View

In NetWitness Investigate, the Malware Analysis view provides the user interface for
conducting a malware analysis. The Malware Analysis view is in the form of a customizable
dashboard, in which default dashlets in the initial view are based on the user role
(Administration or Analyst) and user customizations. Initially, the Summary of Events dashlet is
displayed in the Malware Analysis view. Additional dashlets present different visualizations of
the events being viewed, and each representation is configurable to further refine your view as
you search for Indicators of Compromise. The Malware Analysis dashlets available in the
Dashboard are also available in the Malware view.

To access this view, select INVESTIGATE > Malware Analysis.. If a default service has not
been selected, the Select a Malware Analysis Service dialog is displayed. Select a service, then
click View Continuous Mode.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event Triage an Incident

Metadata Dt EI_"dpDI nts (Pivot from Respond
(Hosts View) Vo)

(Navigate View)

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Analyze Raw Events l Scan Files and Fvents !
and Metadata I for Malware l
(Events Analysis | AT |
I I

| |

View)

You are here

¥

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups
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What do you want to do?

1.1
User Role

Documentation

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events
View

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis
View

Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts

Threat Hunter find suspicious endpoint files (Version Investigate Files
11.1)

Threat Hunter scan files and events for malware* Conducting Malware

Analysis

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

Threat Hunter export events and Files* Examine Scan Files

and Events in List

Form

Threat Hunter perform external lookups* View Detailed

Malware Analysis of

an Event

*Y ou can perform this task in the current view.
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Related Topics

o How NetWitness Investigate Works

o Launch a Malware Analysis Scan from the Navigate View

Quick Look

Below is an example of the Malware Analysis view.

INVESTIGATE (@ admin ©

Summary of Events

= Malware Analytics  MA + add © $¥ ¥ # Actions ¥

Scanned service kStart Time  Metwork End Time Feprt S Scanned End Time

2017-07-18T14:40:59 2017-07-17706:42:26  2017-07-17T06:42:38

Total High Confidence

Events Created Files Processed Events Created

5 5 1
3 B gffcé Files IE PDF Files B E Files Ia gﬂ’cé Files @ 0

Meta Treemap AgrX

High Confidence Cnly Events:1 Files:1

Source IP ~ | 10 v | Static ~ || Average Score

‘ NETWITNESS SUITE 11.0.0.0-170709005430.1.9127d8d

The Malware Analysis view consists of the Summary of Events panel and four dashlets unique
to this view. Each of the unique dashlets have identical Options dialogs. The Malware Analysis
dashlets in the MONITOR vieware also available, and are described in the Dashlets topic in the
RSA Content for the RSA NetWitness® Suite space.

Summary of Events Panel

In the Summary of Events panel, you can select the service, the scan mode, and the time range.
In addition, you can select a data point and view the events associated with the event.

The following table describes all features in the Summary of Events panel.

o o —— =

= Selects a service to display.
Scan Displays a drop-down list of available scan modes.
Mode
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e o

Time Displays a drop-down list of time ranges to view events.

Range

Start When Time Range is set to custom, offers a calendar from which to choose the
Date start date of the time range.

End Date When Time Range is set to custom, offers a calendar from which to choose the

end date of the time range.

+ - Displays a drop-down list of dashlets you can add to the view.

L+ JC Displays a drop-down list of actions you can perform in this view:
o Restore Default Configuration
e Order Dashlets

o Apply Threshold Filter

r Refreshes the Malware Analysis view.

Options Dialog

In the Options dialog, you can customize the results displayed in the dashlet. This dialog can be

accessed by clicking the & icon in the top right corner of each dashlet. The following table
describes the features of the Options dialog.

Foawrs  Josectpten

Title Indicates whether the data shown is restricted to events flagged as high

confidence or not. If the data is not restricted, this line will not be

displayed.
Influenced By Indicates whether the data shown is restricted to events flagged as high
High Confidence  confidence.

Only
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e oo

Static, Network,  Allows you to filter results based on the scores in the scoring modules.

Community,

Sandbox

Cancel Closes the dialog without saving any changes.

Apply Applies changes to the dashlet immediately and closes the dialog.

Meta Breakdowns

Meta Breakdowns presents events in the form of a pie chart, with each slice representing a meta
value for the specified meta key. You can select the meta key and the count of meta values for
that key to render in the chart, starting with the meta value having the most events. Hovering
over an event displays the count.

Meta Breakdowns 28X

High Confidence Only

Source IP V|5 v

L 127.001

The following table describes the options in the Meta Breakdowns dashlet.

e

High Indicates whether the data shown is restricted to events flagged as high
Confidence confidence or not. If the data is not restricted, this line will not be displayed.

Only

Meta Key  Drop-down list of available meta keys.
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Fouwrs Josectpten

Count Drop-down list specifying how many of the top results are displayed.

Meta Treemap

Meta Treemap presents events in the form of a heat map. You can select the meta key and the
count of meta values for that key to render in the chart, starting with the meta values having the
most events. In addition, you can select the module that detected the meta value in the events:
static, network community, or sandbox.

Meta Treemap ~8X
High Confidence Only Events: 1  Files: 1
Source IP ~ |10 ~||5tatic v || Average Score A4

The following table describes the options in the Meta Treemap dashlet.

Feature | Description

High Indicates whether or not the results are restricted to events flagged as high
Confidence confidence or not. If the results are not restricted, this line will not be displayed.

Only
Meta Key  Drop-down list of available meta keys to select as a filter.
Count Drop-down list specifying how many of the top results are displayed.

Module Drop-down list specifying which module results will be pulled from.
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e Lo

Value Drop-down list specifying what information will be displayed when the mouse is

hovering over a result (for example, Average Score).

Score Wheel

The Score Wheel offers a view of events as concentric rings with colors representing scores for
events based on Indicators of Compromise and the scoring module. You can arrange the position
of the rings using the Up and Down arrows to obtain a view that highlights events that were
detected by one scoring module (red) and not detected by other scoring modules.

Score Wheel ALX

High Cenfidence Only Events:1 Files:1
4= Up ¥= Down
Ring 1*  Startic
Ring 2 Sandbox
Ring 3 Community

Ring 4 MNetwork

* Innermost ring

The following table describes the features of the Score Wheel dashlet.

e

High Indicates whether or not the results are restricted to events flagged as high

Confidence confidence or not. If the results are not restricted, this line will not be displayed.

Only
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Module Displays the order of the rings in Score Wheel, Ring 1 being the innermost ring

Order grid  and Ring 4 being the outermost ring. You can click the Up and Down buttons to
reorder the modules, then click Update to apply the changes.

Event Timeline

The Event Timeline offers a view of events organized by the time of occurrence in a bar graph.
Clicking and dragging to select a time range within the chart zooms in on the selected time.

Event Timeline DX

Filter : Events: 0 Files: 0

No data returned for Event Timeline

View Events

The following table describes the features of the Event Timeline dashlet.

e

High Indicates whether or not the results are restricted to events flagged as high
Confidence confidence or not. If the results are not restricted, this line will not be displayed.

Only

View Displays the Investigation > Events view.

Events
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Malware Analysis Events List and Files List

The Malware Analysis Events List and Files List provide a detailed view of events or files. You
can double-click on an event or file in either of the lists to display the Analysis Results view in a
new browser tab.

To access this view, go to INVESTIGATE > Malware Analysis > Select a Malware Analysis
Service dialog. Select a service from the left panel, then select a job from the right panel, and
click View Scan. In the Summary of Events view do one of the following:

o In either the Total panel or the High Confidence panel, click the number in the Events

Created section.

o If you want to view the Files List, click the number in the Files Processed section.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event . . Triage an Incident
Investigate Endpoints

(Hosts View)

Metadata (Pivot from Respond

(Navigate View) View)

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Analyze Raw Events l Scan Files and Events |
and Metadata [ for Malware l
(Events Analysis (B (Malware Analysis |
I I

| I

View)

You are here

¥

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups
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What do you want to do?

1.1
User Role

Documentation

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events
View

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis
View

Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts

Threat Hunter find suspicious endpoint files (Version Investigate Files
11.1)

Threat Hunter scan files and events for malware* Conducting Malware

Analysis

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

Threat Hunter export events and Files* Examine Scan Files

and Events in List

Form

Threat Hunter perform external lookups* View Detailed

Malware Analysis of

an Event

*Y ou can perform this task in the current view.
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Related Topics

o How NetWitness Investigate Works

Quick Look

This is an example of the Events List view.

RSA RESPOND

INVESTIGATE MONITOR

CONFIGURE ADMIN

Files Malware Analysis

AV " Date Archived v

2018-03-07T01:44:...

2018-03-07T01:44:...

2018-03-07T01:44:...

2018-03-07T01:43:

2018-03-07T01:43;

2018-03-07T01:42:...

2018-03-07T01:41:...

2018-03-07TD1:41:

2018-03-07T01:41:...

2018-03-07T01:41:...

2018-03-07T01:41:

2018-03-07TD1:41:

2018-03-07T01:41:...

2018-03-07T01:41

2018-03-07T01:41:

2018-03-07T01:40:

2018-03-07T01:40

Navigate Events Event Analysis Hosts
Events List
High Confidence only
< BacktoSummary | T Delete Events % Download Files
O & static Network Community  Sandbox
¥ % | ] | | | |
0 & DI O S s
O & ] | ] | |
O & | | | | ] ]
O % ] ] ( | |
0O &% EEDEE D O
[ | & ] | |
O & | | | | ] ]
O 4% ] | ] ( | |
O & ] | ] ] | |
O % N | | | ] ]
0 &% O B S s
O % [ | E ] ( l |
O &% EEDEE D S
O & ] | ] | |
O % | | | | ] ]
0 & S N T s
| Page 1 of1 | Clas ~

Session Time

2018-03-07T01

2018-03-07T01:

2018-03-07T01:

2018-03-07T01:

2018-03-07T01

2018-03-07T01:

2018-03-07T01:

2018-03-07T01:

2018-03-07T01:

2018-03-07T01:

2018-03-07T01:

2018-03-07T01:

2018-03-07T01:

2018-03-07T01:

2018-03-07T01:

2018-03-07T01:

2018-03-07T01:

A

B #ries

4

2

Source Address

Identity

SortBy Date Archived

Destination Addr Destination Country ~ Alias Host
e United States

United States

United States blackboard,jason.org

United Stares

United States

Netherlands

United States wnwitsltduk.co.uk

United Stares

United Kingdom

United States Wiy, edu
United States domaindnszones su...
United States WIW.gWU. edu

United States ww.gwumc.edu

Netherlands
United States ww.gw.edu
United States

United States

v 42| | Choose
EventType  Service
OnDem.. HTTP
OnDema... HTTP
OnDema.. HTTP
OnDema.. HTTP
OnDema.. HTTP
OnDema... HTTP
OnDema.. SMTP
OnDema.. HTTP
On Dema... HTTP
OnDema... HTTP
OnDema.. SMTP
OnDema.. HTTP
On Dema... HTTP
OnDema... HTTP
OnDema.. HTTP
OnDema.. HTTP
OnDema... HTTP

v 4| | ¥ Filter
Destination Organiza
Google
University of Cali...
CenturyLink
Google
Google
LeaseWeb Neth...
The George Was...
Blackboard
Yahoo! UK Servic...
The George Was...
The George Was...
The George Was...
The George Was...
LeaseWeb Neth...
The George Was...
Google

Level 3 Commun...

Displaying 1-17 of 17
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This is an example of the Files List view.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Navigate Events Event Analysis Hosts Files Malware Analysis

Files List
High Confidence Only
< BacktoSummary | & Download Files sortBy | DateArchived v 42| Choose.. ~ 4= | T Filter ©
O & static Network | Community = Sandbox | AV File Name File Type MDS Hash Source Address Destination Address Date Archived v size
04 I DI N 1165392787-107...  x86 PE 4b3c088b190fdb21675eb6f081240561 + - A 2018-03-07T01:44:49 72148 KB
O4% DI DI S s 1165392787-107...  x86 PE 8576168002003855802186b7b3f93190 2018-03-07T01:44:49 3105K8
O+ I D TS e 1165392787-107...  x86 PE 026fa2b1 76886361 b048A687fcA6283 2018-03-07T01:44:49 162 KB
0% D D s s 1165392787-107...  X86 PE 7e4681324e2c9d3522c01f2aeefcdde 2018-03-07T01:44:49 61.5K8
0 & D S s 1164993132-107..  PDF 3edecfb67750e9e76209914134601 19 201803-07T01:44:22  110.92KB
04 E OIS s s 1164993132-107..  PDF 67e68ac5a0570055a91 ecded83775eed 201803-07T01:44:22  57.19KB
04 DN I S C_Documentsa..  MS Office 8e05a0908f79e2b64759ce8d9d2ad365 2018-03-07T01:44:12 403K8
04 I I N s Student demogr...  MS Office 9c62cc1486424f1 6efled3f3fadbe1bf 2018-03-07T01:43:48 22K8
O+ D D TS Student demogr...  MS Office 9c60cf90eeB0dcB71daf41966862bb9 2018-03-07T01:43:12 26 KB
04 EEDEE DN S keygen.exe 86 PE 2fd4009fataGb3ebcadbalccBIeal 2018-03-07T01:42:46 52.5K8
0 & D (S s (. 2/TS Brochure .. PDF 51abbdced8efef6le7dadar7504ced 2018-03-07T01:41:55 236 M8
04 En N O s 1.ITS Onelog Bro...  PDF a1388b3(768b0cfbesbdclbf95806742 2018-03-07T01:41:55 132 M8
04 D I S 1164269965-107...  PDF 9df61c038aaaf230618fcdBc71ed146d . 2018-03-07T01:41:33 8.92K8
O4% DI I S s Frens20dossier...  MS Office 63ad20669a7de6b6f6dcc712¢909a176 2018-03-07T01:41:29 28K8
O4% D O TS 1.DS_SecureSph...  PDF af7d0726ff127aaaa0bfed3ae51 eeadl 2018-03-07T01:41:26  417.02 KB
O4% D D TS st27.pdf PDF 89624992 Bda%fe21df2995b175492¢ 2018-03-07T01:41:26 52.62KB
04 D O D st36.pdf PDF 0b80cbOcec79eb1 b950d2447b57fef7c 2018-03-07T01:41:21 13M8
04 I S s s RESEARCHON C..  PDF d6441250c37575e021 cacd25ef2cdc? 2018-03-07T01:41:12 8.07KB
| Page 1 of1 | | Clas v Displaying 1 - 22 of 22

| NETWITN

These are the features in the Events List toolbar, and the Files List toolbar is the same, except it
has no option to delete events.

¢ BacktoSummary | &g Delete Events }. Download Files Sort By |Date Archived ~ 42| Choose ... v 4= | T Filter

Description

Back to Summary Returns to the Summary of Events view.

Delete Events Removes the selected events from the current events

list.

Download Files Displays the Malware File Download dialog, which

allows you to download available files.
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Choose ... v 4= Displays a drop-down menu from which you can decide

how to sort the list. These are the options for sorting:
« High Confidence
o Static

o Network

o Community

« Sandbox

o AV

o File Name

o File Type

o Hash

o Date Archived

o Size
The button directly to the right of this drop-down
indicates whether the list will be sorted by ascending or

descending values.

Choose ... v A= Displays a drop-down menu from which you can select a
secondary sorting order. This menu includes an option
forNetWitness SuiteNone, so selecting a secondary

sorting order is not necessary.

% Filter ~ Displays a drop-down window in which you can filter
the list by filename or MDS5 Hash.

These are the features in the Events List.

R =

& Indicates whether the event is influenced by the high

confidence flag.
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T

Static, Network, Community,

Sandbox

AV

Date Archived

Session Time

#

# Files

Source Address
Identity

Destination Address
Destination Country
Alias Host

Event Type

Service

Destination Organization

Displays the scores for each scoring module.

Indicates whether the AV flagged this event as

suspicious.

Indicates whether the event is influenced by a

customized rule.
Displays the date and time the event was archived.
Displays the time of the event's session.

Indicates whether the hash value is marked as trusted.

Displays the number of files included in the event.
Displays the address of the event source.
Displays the identity of the event source.
Displays the address of the event destination.
Displays the country of the event destination.
Displays the hostname of the alias.

Displays the type of event. For example, Manual
Upload.

Displays the service on which the event occurred.

Displays the organization of the destination.

These are the features in the Files List grid.

s e
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& Indicates whether the event is influenced by high
confidence flag.

Static, Network, Community, Displays the scores for each scoring module.

Sandbox

AV Indicates whether the AV flagged this event as
suspicious.

File Name Displays the name of the file.

File Type Displays the type of the file (for example, PDF or x86
PE)

MDS5 Hash Displays the MD5 hash.

Source Address Displays the address of the file source.

Destination Address Displays the address of the file destination.

Date Archived Displays the date and time the file was archived.

Size Indicates the size of the file.
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Manage Column Groups Dialog

You can customize the way data is displayed by defining the meta to display in a column, the
position of the column in the grid, and the default width of the column. In the Manage Column
Groups dialog, you can add, delete, import, export, and edit column groups to display specific
meta keys. At fresh installation, out-of-the-box (OOTB) column groups are available for use in
the Manage Column Groups dialog. The OOTB column groups are prefixed with RSA for
identification and can be duplicated but cannot be edited or deleted. You can also create custom
column groups.

To access this dialog, go to INVESTIGATE > Events and in the View drop-down list select
Manage Column Groups. The View option is named for the current value, for example, Detail
View, List View, Log View, or the currently selected column group.

@ GEERNVLEGENNSCEEE -~ Actions » -* Incidents
List View
Detail View
Destination IP Ad TCP Destination
Log View
Custom Column Groups > | tast

Manage Column Groups

RSA Email Analysis

RSA Malware Analysis
RSA Threat Analysis

RSA Web Analysis
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Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event Triage an Incident

Metadata ISt EI:\deI I (Pivot from Respond
(Hosts View) .
View)

(Navigate View)

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

You are here
Analyze Raw Events Scan Files and Events
and Metadata for Malware
(Events Analysis (Malware Analysis
View) View)

¥

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups

What do you want to do?

1141

Documentation

User Role

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events

View

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events

View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis
View
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User Role

11.1

Documentation

Threat Hunter

Threat Hunter

Threat Hunter

Incident Responder

Threat Hunter

investigate endpoints (Version 11.1)

find suspicious endpoint files (Version
11.1)

scan files and events for malware

triage an incident in Investigate

configure column groups

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Events View

Investigate Hosts

Investigate Files

Conducting Malware

Analysis

NetWitness
Respond User
Guide

Manage Column

Groups in the Events

View
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Quick Look

Manage Column Groups
+ -B &

Proxy Data

O

Proxy Meta Data

RSA Email Analysis
RSA Endpoint Analysis
RSA Malware Analysis
RSA Qutbound HTTP
RSA Outbound SSL/TLS
RSA Threat Analysis

Oooooood

RSA Web Analysis

The Manage Column Groups dialog has two panels: Groups and Settings.

At the bottom of this dialog are four buttons: Close, Cancel, Save, and Save and Apply. The
following table provides descriptions of these buttons.

=

Close Closes the dialog without saving.
Cancel Cancels all unsaved changes.
Save Saves all changes without closing the dialog.

Save and Apply Saves and applies all changes immediately, closing the dialog.
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Groups Panel

The left panel is the Groups panel. This is where you can add, delete, import, or export column
groups. At the top of the panel is a toolbar which provides actions. Below the toolbar is a list of
added column groups, where you can select one or more groups.

The following table lists the actions in the toolbar.

s o —

+ Adds a column group. Clicking this button highlights the Settings panel on the right,
where you can name the column group and add or delete meta keys. At least one

meta key is required to add a group.

Deletes a column group. A confirmation dialog is displayed before the selected

group is deleted.

& Displays the Import Column Groups dialog, where you can select a file to upload.

g Exports one or more selected groups to your computer.

Settings Panel

The right panel is the Settings panel. This is where you can create and edit column groups. This
panel contains the Name field, a toolbar, and a grid.

The following table describes the features of the Settings panel.
m
Name The name of the selected column group.

+ Adds a new row to the list of meta keys, where you can open a drop-down menu to

select a new meta key.

Deletes one or more selected meta keys. Displays a confirmation dialog before

deleting.
Reset Returns column group to its most recently saved settings.
Meta Lists the meta keys added to the selected column group.
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Display  Lists the names of the meta keys as they will be displayed in the Events view.

Name

Width Specifies the width of each meta key's column. The width can be set between 10
and 1000. The default width is 100.
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Manage Default Meta Keys Dialog

In the Manage Default Meta Keys dialog, analysts can specify the meta keys to be displayed
during navigation for a specific service. This can help you find the desired data more quickly and
prevents the loading of meta data that is not of interest. To access this dialog, in the Navigate
View toolbar, select Meta > Manage Default Meta Keys.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event Triage an Incident

Metadata Tinesiigeie E|I'1dp0| nts (Pivot from Respond
(Hosts View)

(Navigate View) View)

You are here

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Analyze Raw Events Scan Files and Fvents
and Metadata for Malware
(Events Analysis (Malware Analysis
View) View)

¥

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Export Events and Perform External p

Files Lookups

Attributes and Global
Files

What do you want to do?

1.1
User Role .
Documentation
Threat Hunter browse event metadata Begin an

Investigation in the
Navigate or Events
View
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1.1

Documentation

User Role

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis

View
Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts
Threat Hunter find suspicious endpoint files (Version Investigate Files
11.1)
Threat Hunter scan files and events for malware Conducting Malware
Analysis
Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide
Threat Hunter configure default meta keys for a Filter Results in the
service* Navigate View

*Y ou can perform this task in the current view.

Related Topics

o Manage Meta Groups

o Manage Meta Groups

Quick Look

The following figure illustrates the Manage Default Meta Keys dialog, which has a list of meta
keys, toolbar, Close button, and Apply button. In the list, you can view, sort, and manage default
meta keys. If you click and drag meta keys, you can rearrange their order. The following table
describes columns in the list.
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Manage Default Meta Keys

Meta Key
Translated Destination Fort

User Account

Secondary User Account
Destination Host

Source Hostname

All Domain Keys

All Event Catagorization Keys
All Email Address Keys

All Ethernet Address Keys

All Analysis Keys

Meta Key This column displays the meta keys available for the service. In

Version 11.1 and later, default meta entities are also included, for

example All Domain Keys and All Email Address Keys.
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View This column displays the type of view assigned to each meta key. By

clicking on the view in each row, you can assign the meta key a
different default view. There are four views:

o Auto: Reverts to the default view for meta keys as specified in the

service index file.

o Close: The values of this meta key are closed by default, and can be

opened manually.

o Hidden: These meta keys are hidden by default, and are not shown

in Investigation at all.

e Open: The values of this meta key are displayed by default.
When you modify the default meta keys for a non-indexed meta key,
you cannot set the key to Open. If you change the default view for a
group of meta keys to Open and some of the meta keys are non-
indexed, the non-indexed meta keys revert to Auto. As a result, the
meta key is automatically loaded only if it is indexed, and non-

indexed meta keys are Closed until opened manually.

The following table describes the toolbar options and buttons.

e o ——

o Clicking the Actions menu allows you change the default view of all the meta

keys. There are four views:

o Auto: Reverts to the default view for meta keys as specified in the service

index file.
o Close: The values of this meta key are closed by default.
o Hidden: The values of this meta key are hidden by default.

o Open: The values of this meta key are displayed by default.
Close Closes the dialog. Any unsaved changes are lost.

Apply Applies the changes, and they become effective immediately.
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Manage Meta Groups Dialog

At fresh installation, OOTB meta groups are available in the Manage Meta Groups dialog. The
OOTB meta groups are prefixed with RSA for identification and can be duplicated but cannot be
edited or deleted. In the Manage Meta Groups dialog, you can add, delete, import, and export
meta groups.

To access this dialog in the Investigation > Navigate view toolbar, select Meta > Manage
Meta Groups

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event Triage an Incident

Investigate Endpoints .
Metadata -
(Hosts View) (Pivot from Respond

(Navigate View) View)

You are here

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Analyze Raw Events Scan Files and Events
and Metadata for Malware
(Events Analysis (Malware Analysis
View) View)

4

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups
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What do you want to do?

1.1
User Role

Documentation

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events
View

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis
View

Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts

Threat Hunter find suspicious endpoint files (Version Investigate Files
11.1)

Threat Hunter scan files and events for malware Conducting Malware

Analysis

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

Threat Hunter add, edit, and delete meta groups™ Manage Meta
Groups

*Y ou can perform this task in the current view.

Related Topics

o Filter Results in the Navigate View

o How NetWitness Investigate Works

Quick Look
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Below is an example of the dialog for Version 11.1, in which additional OOTB meta groups are
available: RSA Endpoint Analysis, RSA Outbound HTTP, and RSA Outbound SSL/TLS. The
Manage Meta Groups dialog has two panels. The following table describes the buttons at the
bottom of the dialog.

Manage Meta Groups
+-B amn

(] Group Name ~

Proxy Data

Proxy Meta Data

R5A Email Analysis

RSA Endpeoint Analysis

RSA Malware Analysis

RSA Outbound HTTP

RSA Outbound S55L/TLS

R5A Query Hosts

RSA Query IPs

RSA Query Mail

RSA Query Users

RSA Threat Analysis

Ooo0o0oooooooogonood

R5A Web Analysis

T

Close Closes the dialog.
Cancel Cancels all changes.
Save Saves all changes.

Save and Apply Saves and immediately applies all changes.

The Meta Groups panel is on the left side of the Manage Meta Groups dialog. This is where you
can add, delete, import, and export meta groups.

The following table describes the features of the Meta Groups panel.
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o o

+

=

g

Group

Name

Adds a meta group using the Settings panel on the right side of the Manage Meta
Groups dialog.

Deletes the selected meta group. A confirmation dialog is displayed before the
meta group is deleted.

Displays the Meta Group Import dialog, where you can upload a file.

Exports the selected meta group to your computer.

Lists all meta group names.

The Settings panel is on the right side of the Manage Meta Groups dialog. This is where you
create and edit meta groups. Below the Name field is the Meta Keys grid.

The following table describes the features of the Settings panel.

G e

Name Displays the name of the selected meta group.
+ Displays the Available Meta Keys dialog, where you can select meta keys to add
to the group.
= Deletes the selected meta keys.
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o o

L+ JC Displays a drop-down menu, where you can select the view for all meta keys.

There are four options based on the possible values for the defaultAction

property used to define a key in the custom index file for the service:

o Hidden: These meta keys are hidden by default, and are not shown in

Investigation at all.
e Open: The values of this meta key are displayed by default.

o Close: The values of this meta key are closed by default, and can be opened

manually.

o Auto: Reverts to the default view for meta keys as specified in the service

index file.

Display  Indicates the name that is displayed for the key in Investigation views, and is

Name defined by the description property for the key in the custom index file for
the service..

Key Indicates the name of the meta key as defined in the custom index file for the

Name service.

View Indicates which view the meta key is set to. You can change this by either:

o Clicking v in the View column header, then selecting a view in order to change

all meta key views.

o Clicking a single meta key in the View column, then opening the drop-down
menu in which all available views are displayed, in order to change an

individual meta key view.
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Manage Profiles Dialog

Profiles allow you to set up custom views in the Navigate view and the Events View. At fresh
installation, OOTB profiles are available in the Manage Profiles dialog. The OOTB profile
groups are prefixed with RSA for identification and can be duplicated but cannot be edited or
deleted. In the Manage Profiles dialog, you can configure, add, delete, import, and export
profiles.

To access this dialog in the Investigation > Navigate or Events view toolbar, select Profile >
Manage Profiles.

What do you want to do?

11
User Role

Documentation

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events
View

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis
View

Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts

Threat Hunter find suspicious endpoint files (Version Investigate Files
11.1)

Threat Hunter scan files and events for malware Conducting Malware

Analysis

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

390 Investigate Reference Materials



NetWitness Investigate User Guide

1.1

Documentation

User Role

Threat Hunter configure profiles for the Navigate view  Use Profiles to
or Events view* Encapsulate Custom
Views

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Navigate View

o Events View

Quick Look

This is an example of the Manage Profiles dialog.

R5A Email Analysis

R5A File Analysis

O
[l RSA Threat Analysis
0

R5A Wek Analysis

The Manage Profiles dialog has two panels. At the bottom of the dialog there is a row of buttons.
The following table describes the buttons.

C

Close Closes the dialog.
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CENCTTI

Cancel Cancels all changes.

Save Saves all changes.

Save and Apply Saves and applies all changes immediately.

The Profile panel on the left side of the dialog displays available profiles and allows you to add,
delete, import, and export profiles. The following table describes the fields in the Profile panel.

P oseion

+ Adds a new profile using the Settings panel on the right side of the Manage
Profiles dialog.

Deletes the selected profile. A confirmation dialog is displayed before the

profile is deleted.

& Displays the Profile Import dialog, where you can upload a file.
o] Exports the selected profile to your computer.

Profile Lists all profile names.

Name

The Settings panel on the right side of the dialog offers options to configure profiles. It can only
be used when one profile is selected. The following table describes the fields in the Settings
panel.

m
Name Displays the name of the profile.

Meta Displays a drop-down menu listing available meta groups.

Group
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e o

Column  Displays a drop-down menu listing available column groups. Three groups are

Group available by default:
o List View
e Detail View
o Log View
PreQuery Defines a limiting query for filtering Investigation results. This query is used when
the associated profile is activated and the preQuery applies to any queries used in

the Investigation Navigate and Events views. This is an example of a preQuery:

'service=80,25,110".

Investigate Reference Materials 393



NetWitness Investigate User Guide

Navigate View

The Navigate view ( INVESTIGATE > Navigate) displays event metadata--the meta keys and
meta values-- that were found in captured data for the selected service. The data is filtered and
displayed in accordance with the options you set for profile, time range, meta group, and query.
You can also drill into the data by clicking meta keys and meta values. The Navigate view is the
default entry point to NetWitness Investigate; you can change the default entry point to one of

the other views in the User Profile preferences.

Workflow

The figure below depicts the high-level workflow for investigating event metadata.

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

I
Browse Event | : i T
Metadata | nvestigate Endpoints
I
I

(Hosts View)

View)

(Navigate View)

You are here

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Analyze Raw Events
and Metadata
(Events Analysis
View)

Scan Files and Events
for Malware
(Malware Analysis
View)

¥

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event

Triage an Incident
(Pivot from Respond

Export Events and
Files

Lookups

Perform External
Lookups

Respond

Export Host

Attributes and Global

Files

These are the tasks that you can perform in the Navigate view:

o Select a service to investigate and load data.

o View query results and filter by time range, profile, meta group.

o Sort the results and select a quantification method.

« Save events, go to an event using the event ID, visualize an event, and print the event.

394
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o View additional contextual data for specific meta keys and values.

« Go to the Events view or the Event Analysis view, where you can see a chronological list of
events, reconstruct an event, and conduct an interactive analysis of an event. When viewing

and analyzing events, you can export events, files, and logs to your local file system.

What do you want to do?

1141

Documentation

User Role

Threat Hunter browse event metadata*® Begin an
Investigation in the
Navigate or Events

View

Threat Hunter browse raw events* Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis

View
Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts
Threat Hunter find suspicious endpoint files (Version Investigate Files
11.1)
Threat Hunter scan files and events for malware Conducting Malware
Analysis
Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide
Threat Hunter set user preferences for the Navigate Configure the
view* Navigate View and

Events View
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User Role

1.1

Documentation

Threat Hunter submit a query or drill into the data set*
Threat Hunter refine query results*

Threat Hunter perform internal lookups*

Threat Hunter perform external lookups*

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Events View

o Event Analysis View

e Malware Analysis View

Investigating
Metadata in the

Navigate View

Querying and

Acting on Data in

the Navigate and

Events Views

View Additional
Context for a Data

Point

Launch an External

Lookup of a Meta

Key

396 Investigate Reference Materials



NetWitness Investigate User Guide

Quick Look

RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE  ADMIN (@ admin

Navigate Events Event Analysis Hosts Files Malware Analysis

= 4444 - Concentrator ¥ Query ® EJProfile © E]Meta © | ETotal © = Descending © BB EventCount © | SaveEvents @ - Actions Settings
< Context Lookup
2018 9 16:52:00 (+00:00) All Data 2018 2 | 19:10:59 (+00:00) Alerts Sort | Date-Newestto Ol v &
M o Updated: s fewseconds ago  Time Window: 7 cays
s 127.0.0.1
w® ncident from Investigate
5| 50 Created  2018/02/21, 15117 (0 days age)
Incident ID INC-29
..................................................................................................................................... e mess Ivestgate
- Evems 200
4 Options | A Hide nvestigate
50 Created  2018/02/21,15:07 (0 days age)
IncidentID INC-23
4  Destination IP address (20 of 20+ values) £ Shurces . Netwitness Investigate
17,171) - (15153) - 14,725) - (14,094) - (13,715) - (7,334) - (7,209) - (3,168) Events 200
- (2,565) - (2,254) - (1,500) - (1,493) - (1,428) - (1,324) - (1,304) - (1,096) .
- JF, . . nvestigate
- (1,036) (e5) (943) (882) ...show more 50 Cremet 2018702721, 1507 (0 days g}
IncidentID INC-22
(o> - Source IPv6 Address (20 of 20+ values) o Sources  NetWitness Investigate
- - ¥ () - (40) - 14) - 4 - (14y - 12 Events 200
(12) - (12) - ®) - ) - (6) Incident Created From Investigate
(5) - (5) - (@) - (3) - @ 50 Created  2018/02/21, 15:05 (0 days ago)
@ - ) - @ - (2) ...show more Incident ID INC-21
Sources  NetWitness Investigate
(s> - Destination IPv6 address (20 of 20+ values) £ Events 200
72) - @4 - @0 - (12) - ® - ® - - © RSA_01_Rule_HighConfidence
@ - () - ) - @) - (2 - {vi] 100 Created  2018/02/21,14:47 (0 days ago)
@ - @- @- @- @- @) . show more Incident 1D INC-19
Sources  Malware Analysis
£ - ActionEvent (3values) L Events 1
get (36,465) - sendto (4,639) - sendfrom (3,882) - put (3,569) - login (2,107) - attach (1,544) - delete (11) - logoff (2)
9 User Account (20 of 20+ values) £
- 5 Alerts (First 50 Results)

The Navigate view consists of these features:

o Toolbar

o Pause/reload button and breadcrumb
o Time banner

o Optional debug information.

o Collapsible Visualization panel

o Values panel

o Context Lookup panel

o Context menus

Toolbar
The toolbar provides a way to:
« Change the service being investigated.

o Control the range of data displayed: You can select use profiles, set a time range, use meta

groups, and create queries to apply to the data.

o Set the quantification method and sorting method for data in the Values panel.

Investigate Reference Materials 397



NetWitness Investigate User Guide

o Perform actions on the results. You can export and print results, open an event for which you

have an event ID in the Events view or Event Analysis view, and pass a query to Informer.

o Configure Investigate settings without navigating away from the Investigate views.

Some of the toolbar options are labeled with the default value or the selected value rather than
displaying the name of the option. For example, the time range option in the example above is
labeled Last 5 Minutes to reflect the currently selected value. These are the toolbar options.

CE e

Displays the selected service name next to the icon. Clicking the icon

(1]

opens the Investigate a Service dialog, in which you can select a
service to investigate and set the default service to investigate (see

Begin an Investigation in the Navigate or Events View). Changing the

service does not cause a reload of the data.
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o o

Time Range

Query

Displays the Time Range options; the currently selected option is

displayed in the toolbar (see Filter Results in the Navigate View).

Possible choices are:

o All Data

o Last5, 10, 15, or 30 Minutes
o Last Hour, Last 3, 6, 12, or 24 Hours
o Last2 or 5 Days

o Early Morning

o Morning

o Afternoon

o Evening

o All Day

o Yesterday

o This Week

o Last Week

o Custom

Note: If you specify custom start or end times in seconds, the value
for start time in seconds always defaults to :00, and the value for end
time in seconds always defaults to :59. For example, if you are using
time to drill down into an issue, the drill time will be interpreted as
HH:MM:00 - HH:MM:59. Seconds display in this format in
Investigate functions.

Displays the Query dialog, in which you can enter a custom query
directly instead of drilling down the data. See Query Dialog for a
description of the dialog.

Investigate Reference Materials

399



NetWitness Investigate User Guide

o o

Profile

Meta

Sort Field

Sort Order

Displays the Profile menu; the currently selected profile is displayed in
the toolbar. A profile allows you to manage and use profiles that can
include custom meta groups, a default column group, and a beginning
query. The Profiles apply to the Navigate view (meta groups and
queries) and the Events view (column groups and queries). See Use

Profiles to Encapsulate Custom Views for more information.

Displays the Meta Group menu. You can use Default Meta Keys or a
custom Meta Group. You also have the option to make changes to both

group types (see Manage Meta Groups).

Displays the Sort Field menu; the currently selected option is displayed
in the toolbar. The menu has two options: Order by Total and Order by
Value. The Sort Field is a complement to the Sort Order option; the data
for each meta key is ordered based on the total (green number) or the

meta value (blue text) (see Filter Results in the Navigate View).

Displays the Sort Order menu; the currently selected option is displayed
in the toolbar. The menu has two options: Sort in Ascending Order and
Sort in Descending. The Sort Order is a complement to the Sort Field
option; the selected field for each meta key is ordered in ascending or

descending order (see Filter Results in the Navigate View).

400
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o o

Quantification Displays the Quantification Method menu; the currently selected option

Method is displayed in the toolbar. The Quantification Method only applies to
the meta key results in the Values panel. It does not apply to the
timeline.
The drop-down menu contains three options for calculating the quantity
(green number in parentheses) for a meta value: Quantify by Event
Count, Quantify by Event Size, and Quantify by Packet Count (see Filter

Results in the Navigate View).

These are applied differently depending on the type of data in view.
For packet data:

o Quantify by Event Count shows the number of sessions.
o Quantify by Event Size shows the size in bytes.

o Quantify by Packet Count shows the number of packets.
For log data:

o Quantify by Event Count shows the number of logs.
o Quantify by Event Size shows the size in bytes.

o Quantify by Packet Count shows the number of logs.

Save Events Displays the Save Events menu, in which you can use options to:
extract files associated with an event, export the current drill point as a
PCAP file, and export the current drill point as a log file (see Export a
Drill Point).

Actions The Actions menu includes actions that you can perform in the

Navigate view (see Investigating Metadata in the Navigate View). In

Version 11.0.0.x, the options are: Visualize, Go To Event, and Print. In
Version 11.1 and later, the options are Visualize, Go to event in Event

Reconstruction, Go to event in Event Analysis, and Print).
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o o

Search Events Enables you to search for text patterns within the current set of events.

If you click in the Search field, it shows a drop-down menu with search
options. If you click Apply, it saves the selected options and also
updates the search options in the Events view and the Investigations

profile (see Search for Text Patterns).

Settings Displays the settings for the Navigate view (which are also editable in
the Profile view) so that you can change Investigate settings without
navigating away from the Navigate view. When you change a setting In
the Navigate view the setting is also changed in the Profile view (see

Configure the Navigate View and Events View).

Pause/Reload Button and Breadcrumb

The breadcrumb tracks each query as you drill down through the metadata for the service. Each
query is listed with a drop-down menu in a pipe separated string. The last point is the current
point, also called the tip. The icon in front of the breadcrumb allows you to pause the loading of
meta values and to reload meta values.

The breadcrumb does not include the service name and appears only if a query is in effect. If too
many drill points exist for display, the overflow is shown as double angle brackets, >>, at the
end of the breadcrumb.

Each drop-down menu in the breadcrumb is the same, with slight variation based on the position
of the crumb.

The following table describes the controls and menu options in the breadcrumb.

N

n

' Pause Pause and Reload button. Controls the loading of data in the view. It has
three possible functions: pause loading, continue loading, and reload.
Navigate Here Opens the selected drill point in the current Values panel.
Navigate Here Opens the selected drill point in a new tab.
(new tab)
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Insert Before Inserts a query before the current drill point. The Create Filter dialog

opens and you can define a custom query to insert in the breadcrumb

(see Create a Custom Query).

Append Appends a query after the current drill point. The Create Filter dialog
opens and you can define a custom query to append to the end of the

breadcrumb (see Create a Custom Query).
Remove Removes the selected drill point from the breadcrumb.

Edit Opens the selected drill point in the Create Filter dialog so that you can
edit the query.

>> Clicking the angle brackets displays a drop-down menu of the

breadcrumb overflow.

(Optional) Debug Information

If you have activated the Show Debug Information setting and the service you are navigating is a
10.4 or later Broker, NetWitness Suite displays the debug information beneath the breadcrumb.

The debug information is the where clause from the current query. The only time there is no
where clause is when the time range is all data and there are no drill points. If the Broker has
at least one aggregate service that is offline, the debug information also lists the offline service.

For example:

(attachment exists) && (tcp.dstport = '80'")&& (risk.info
exists) $$time='2014-05-04 18:50:00"-"2014-05-09 18:59:59 (attachment
exists) && (tcp.dstport = '80') && (risk.info exists) && time="2014-05-

04 18:50:00"-"2014-05-09 18:50:59"

In addition, the time taken to load is displayed at the end of each meta key in the Values panel.

Time Banner

Just below the breadcrumb and debug information (if present), the time banner shows the time
range used to create the chart.

Investigate Reference Materials 403



NetWitness Investigate User Guide

Visualizations

At the top of the Navigate view is a visualization of the current drill point. You can use this to
drill into data from the Visualization panel (see Filter Results in the Navigate View). You can
show or hide the visualization, and choose one of the the visualization options: Timeline or
Coordinates. The Visualization opens initially to the last saved Visualization.

Timeline Chart

The timeline is the count of the number of events that occur at a specific instance. The timeline
provides event counts so that you can see if the number of events increases drastically at a given
point in time. The timeline displays activity for the specified service and time range as a line
chart or a bar chart based on your choice in the Options menu. The second figure illustrates a
line chart and third figure illustrates a bar chart.

Visualization Timeline

Chart Type '.me Chart

2015 3 14:30:90 (+00:00) Custom 2015 3 14:30:16 (+00:00)

5 wesigus | & onies 5 v
2015 | 33| 14:30:10 (+00:00) Custom 2015 5| 14:30:16 (+00:00)
250
‘ ‘w ! \‘ \‘L
, ENEERREERERETY L |‘h‘:‘.'¥nl\“\h|“ Ik | I‘\‘h‘a‘l. IIMHI NENEEREErENEN L;
12:00 16:00 20:00 25, Mar 04:00 08:00 12:00 16:00 20:00 26. Mar 04:00 08:00
[© Investigate | £ Options A Hide

The timeline displays activity for the specified service and time range, as a line chart or a bar
chart based on your choice in the Options menu.

o Towmen

Number of Events The Y axis of the chart based on thousands of events.

(Timeline)

Time Line The X axis of the chart based on the time the events occurred.
(Timeline)

Event point If you want to explore a specific section, simply select the range from
(Timeline) the chart. The new time range will be reflected in the chart.
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e oween

Investigate Displays the meta values for the selected subset.

(Timeline)

Reset Zoom To return to the original time range, click Reset Zoom.

(Timeline)

Options Displays the Visualization Options dialog. Data points can be displayed

as a Line chart (default), a Bar chart, or Coordinates chart. When a

chart type is select, the relevant options are displayed.

Hide Collapses the chart.

Parallel Coordinates Chart

The Parallel Coordinates chart is one of the choices in the Options menu for visualizing the
current drill point. With Coordinates selected in the Visualization Options dialog, you can select
the meta data to be displayed (see Visualize Metadata as Parallel Coordinates).

& Investigation & Navigate = Events & Mahware Analysis

B Decoder for ¥ Query £ Profile = £ Meta

" 3015-07-01 14:58:007."2015-07-01 175755

2015 §  10:58:00 (-04:00)

Only a subset of events is displayed & 2007 Events Found | 55 Unigue Paths *DNE T £F Opaiens | Hide

- Service Type Mot Indexed [8 values)

OTHER (68,739] - HTTF (526) - DNS (275) - S5L(183) - NETBEOS (96) - 55H [3) - ADL IM (1] - SHMP 1)
Loaded in 10382 sece Total running time 1,033 secs,

A admin | i english (Unked States) | GMT-0400 Send Us Feedback | 10.5.0,1.18678-5

Fours Joseetpten

Axes Each axis is a meta key. The number of meta keys affects the load time

for the chart. All meta keys are loaded, but it there the number of events

per meta key is limited.
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Lines

Options

Only a subset of
events is

displayed.

Events Found |

Unique Paths

DNE

Lines represent events and they connect values on the axes to show the

correlation between multiple meta keys.

Displays the Visualization Options dialog. Data points can be displayed
as a Line chart (default), a Bar chart, or Coordinates chart. When a chart

type is select, the relevant options are displayed.

This message is a notification that not all events in the values panel are
drawn in the chart. Removing axes or filtering the data in the Values

panel can help to display all events.

Displays the total number of events charted versus the number of unique
paths charted. Setting the All Meta Keys Must Exist in an Event option

redraws the chart so that it is more targeted and legible.

Indicates that there is no values for this meta key in the event.

In the Visualization Options dialog for Coordinates, you can select the meta keys to chart.

Fews Jossetpten

Visualization

selection

All Meta Keys Must

Exist in an Event

+

Displays a drop-down list of visualization types: Timeline and

Coordinates

Limits the data represented in the visualization to only those events that
include all selected meta keys. This can result in a cleaner, more

targeted visualization.

Displays the Add Keys to Parallel Coordinates Visualization dialog so
that you can add axes to the visualization. This is useful if you are
looking for relationships between the default meta keys and some

additional ones.

Deletes the selected keys so that they do not appear as axes in the
visualization. This can help to make the visualization less cluttered and

allow for more data points to be included in the visualization.

406
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Axes

Cancel

Apply

Reverts to the default meta keys for visualization, which consist of all

meta keys in the current drill point.

Controls the display of additional information about the number of
selected axes versus the recommended count. This helps to make you

aware of possible performance improvements by removing axes.
Lists the meta keys selected as axes in the visualization.
Cancels any changes made to the visualization options.

Saves the changes made to the visualization options and applies to the

current visualization.

In the Add Keys to Parallel Coordinates Visualization dialog, you can select the meta keys or
meta groups to use as axes the Parallel Coordinates visualization.

e o ——

Visualization

selection

With the Selected
Meta Keys...

Cancel

Add

Values Panel

Select Keys: Two options for selecting meta keys are:
o From Default Meta Keys

o From Meta Groups

Each option offers a drop-down list from which to select.

The options for the method of adding meta keys allow you to:
o Replace the current list of keys
o Append to the current list of keys

o Insert at beginning of the current list of keys
Closes the dialog and does not add any keys.

Closes the dialog and adds the selected keys as specified.

The major feature of the Navigate view is the Values panel, which you can use to analyze data
(see Filter Results in the Navigate View).
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The default view is for the last 3 hours of collection, using the default meta keys and non-
indexed meta keys closed. The meta keys within the meta groups are displayed in the order that
NetWitness Suite queries the keys. As the data loads into the Values panel, NetWitness Suite is
optimized to show partial results, loading progress, and service status as the data loads.

The loading behavior is determined by several configuration settings. The highest level settings
are configured by the administrator for each user. These are:

o The maximum amount of time allowed for this user to run a query (Query Timeout).

o The limit at which NetWitness Suite stops counting the number of meta values in a session

(Session Threshold). If a threshold is set for a session, the Navigate view shows that the
threshold was reached and the percentage of results loaded. Any session that does not show a
percentage is accurate and was processed to completion. If there is a percentage, that reflects
how much processing was completed. The percentage displayed is estimated by extrapolating
from the value at the time processing finished, considering the amount of work remaining.

Larger percentages are generally more accurate because they require less extrapolating

o The limit at which NetWitness Suite stops counting the number of meta values in a session

(Session Threshold). If a threshold is set for a session, the Navigate view shows that the
threshold was reached and the percentage of query time used to reach the threshold.

Note: The values for non-indexed meta keys take longer to load in the Values panel. To
optimize loading, NetWitness Suite does not open non-indexed meta keys by default. Refer to
Manage and Apply Default Meta Keys in an Investigation for a detailed description of non-
indexed meta keys in Investigation.

When you have launched an investigation of a service, NetWitness Suite displays results in the
Values panel.

1.

NetWitness Suite loads meta keys and meta values in the Values panel. For each meta key

load, the stages of load are:
a. Waiting to Be Loaded or Closed. If Closed, no data for that key is loaded.
b. Loading
i. Loading progress: NetWitness Suite is receiving and displaying progress messages.

ii. Partial results: NetWitness Suite is receiving values messages and partial results

are displayed in the Values panel.

c. Load Complete: All results are finished loading.

2. As each meta key load is completed, and final values are displayed, the next meta key is

started. The number or values rendered for each meta key is specified by the Render
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Threads value in the Investigation Preference settings. Loading continues until all keys to be
loaded have finished.

3. If Show Debug Information is active and the service you are navigating is a 10.4 or later
Broker, NetWitness Suite displays load time information beneath the values for each meta
key and displays additional load details for the aggregated services. NetWitness Suite also

displays the debug information beneath the breadcrumb.

Iterative results

Iterative results provide feedback on the status of queries within the interfaces to provide
additional context for how long the data load will take and if any service data is missing. For
example, if you are querying a Broker that is aggregating from two Concentrators, NetWitness
Suite starts displaying the results from the first Concentrator as soon as it is available, even if
the second Concentrator is still waiting for results.

Iterative results also include a notification that service data is missing because the service is
unreachable.

Partial results

When partial values from the Core service are returned but not completed, a message at the end
of the meta key listing shows the progress of values loaded. For example, Currently looking at 38
ip.src values 71% indicates that loading of values for the meta key is 71% complete.

Debug Information

If the Show Debug Information setting is in effect, a field at the end of the values displays the
status for the different systems against which you are querying within NetWitness Suite. For
example, when you are querying against a 10.4 broker pulling from multiple concentrators,
NetWitness Suite displays the status of the query on each of the Concentrators, which provides
insight into the relative speed of data loading from each of the Concentrators. Each service that
participated in the query is listed with the total elapsed time for the query.

Each service that participated in the query is listed with the total elasped time for the query. In
the example above, two services returned in 3.207 seconds, localhost:50005 took 2 seconds to
return the results. In addition, the where clause of the query is displayed below the breadcrumb.
You can copy this syntax directly into an application rule or Reporting where clause of a rule.

Load Complete

For each meta key, there is a list of values (blue text) and counts (green text) found in the
current drill point. When you click a value to drill down into a subset of the currently selected
data, the display is updated and the new drill point is recorded in the breadcrumb. You can
specify the sorting and quantification methods for the values list using the option in the toolbar.

Note: Title, values, and counts for non-indexed meta keys are not drillable; the Values and
counts are shown in black.
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Meta Key The name of the meta that is listed, for example, Service

Type is a meta key.

Number of values rendered ~ The number or values rendered is specified by the Render

vs number of values Threads value in the Investigation Preference settings. In the

available to load example above, the meta key is Service Type, and 20 of 20+
values are currently displayed. You can display additional

values by clicking ...show more.
jo Clicking @ on an indexed meta key opens the Search dialog in

which you can enter a filter for the current meta key. The
search function is not available for non-indexed meta keys, and
is based on the actual meta value rather than the alias. Drilling
in the Search dialog using aliases is not supported.

NOTE: Check with your administrator to obtain a list of
aliases used for a meta key in Investigation. When an alias is
used, this search dialog does not provide results. Instead, you
must query the meta key using the Right-click query capability
or the Query dialog.

Offline Services: Lists offline services queried by a 10.4 Broker.

XXX.XXX.XXX.XxX:50004

Meta Count, for example The number of instances found for a particular meta in the
3) session.

Meta Value, for example The specific name associated with the found meta.

other src

...show more If the number of meta values has been limited (for example,

20), clicking this displays additional meta values for the

selected meta key.

410 Investigate Reference Materials



NetWitness Investigate User Guide

e o

Loaded in 0.418 secs. Total ~ Debug stats display load times based on the Show Debug

running time 0.434 secs. Information setting.
(localhost:50005 loaded in 1

SCCS....

Meta Key Drop-Down Menus

The Meta Keys in the Values panel have drop-down menus. Next to each meta label, a drop-
down arrow displays the options that can apply to that item. You can use these to change the
way the results for the meta key are displayed in the current view. Changes made to meta keys
are displayed in the current view and persist until you refresh the page or select a new service in
the Navigate view toolbar. See Drill into Data in the Values Panel

Refresh reverts to the current view of meta keys as defined in the Manage Default Meta Keys
dialog (see Manage and Apply Default Meta Keys in an Investigation). If you have never made
modifications in the Manage Default Meta Keys dialog, NetWitness Suite restores the default
meta keys from the core service.

o More Results
o Max Results
o Hide Results
o Meta Key Info

e View as CSV (Version 11.0.0.x) or Export Values (Version 11.1 and later)

Context Lookup Panel

The Navigate view and the Events view have a Context Lookup panel on the right side. The
Context Lookup panel is displayed only if you have installed and configured the Context Hub
service. For more information on configuring the Context Hub service, see the Context Hub
Configuration Guide.

The Context Lookup panel displays relevant data when an analyst looks up contextual data for a
meta value in the Values panel.
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RSA RESPOND  INVESTIGATE  MONITOR  CONFIGURE  ADMIN (@ admin

Navigate Events Event Analysis Hosts Files Malware Analysis

B R el All Data B ¥ Query© ElProfile © ElMeta © | [ETotal © .= Descending © &5 EventCount © | SaveEvents® - Actions
< Context Lookup
2018 | & | 16:52:00 (+00:00) All Data 2018 & | 19110559 (+00:00) Alerts sort |ate - Newestto Ol v| &
M st Updated: s fewsecondsago Time window: 7 cays
5 127.0.0.1
B sovery ncident from Investigate
5 50 Created  2018/02/21,15:17 (0 days ago)
Incident 1D INC-29
..................................................................................................................................... e rmess Ivestgate
Events 200
£ Options | 2 Hide ST investigate
50 Created  2018/02/21,15:07 (0 days ago)
Incident 1D INC-23
s  Destination IP address (20 of 20+ values) & Shurces Nettness Investigate
7171 - (15,153) - (14,725) - (14,094) - (13,715) - (7,334) - 7.209) - (3168) Events 200
E (2565) - (@.254) - (1,500) - (1,493) - (1,428) - (1,324) - I (1,304) - (1,096) —
. 2L : 7 veRrTy nvestigate
E (1,036) - (951) (943) (882) ...show more 50 Created  2018/02/21,15:07 (0 days age)
Incident 1D INC-22
o> - Source IPv6 Address (20 of 20+ values) @ Sources  NetWitness Investigate
iy - 4 (@6) - (40) - 4 - (4 - (14) - 2) Fvents 200
(12) - (12) - ®) - 1) - (6) SEVERTY ncident Created From Investigate
©) - ©)- @ - @) - @ 50 Created  2018/02/21,15:05 (0 days age)
@ - @ - @- (2) ...show more Incident 1D INC-21
Sources  NetWitness Investigate
(s> - Destination IPv6 address (20 of 20+ values) £ Events 200
@2 - @4 - @0) - (12) - ® - ® - M- ® severry RSA_01_Rule_HighConfidence
@) - () - @) - @) - @) - {vi] 100 Created  2018/02/21, 14:47 (0 days ago)
@ - @- @- @- @ - @) ..show more Incident 1D INC-19
Sources  Malware Analysis
4 . Actionvent (3 values) £ Events
get (36,465) - sendto (4,639) - sendfrom (3,882) - put (3,569) - login (2,107) - attach (1,544) - delete (11) - logoff (2)
9 User Account (20 of 20+ values) £
A Y 5 Alerts (First 50 Results)

After the administrator configures the Context Hub service, you can view the contextual
information for the meta values in the Navigate view and the Events view. For more information
on configuring the Context Hub service, see the Context Hub Configuration Guide. For
information about performing Context Lookup for meta values, see View Additional Context for a

Data Point.

The Context Hub service is pre-configured with default meta type and meta key mapping. For
information about the mapping of the context hub meta value with investigation meta key, see
"Manage Meta Type and Meta Key Mapping" in the Context Hub Configuration Guide

You can view the type of context data that is available for a highlighted meta value by hovering
the mouse over a highlighted meta value. An inline indicator shows which type of context data is
available for the meta: Endpoint, Incidents, Alerts, or Lists.

Right-clicking a meta value opens a menu with the context lookup option. The following figure
illustrates the Context Lookup option when you right-click a meta value.
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256) - 5CPS(196) - GRE(119)

Copy

Live Lookup
Scan for Malware
Context Lookup

Add/Remove from List

Data Science >
Investigation »
External Lookup b

Google Malware Diagnostic for IPs and Hostnames
SAMS IP History

hMcAfee SiteAdvisor for Hostnames

ECAT IOC Lookup

BFK Passive DNS Collection

CentralOps Whois for IPs and Hostnames
Malwaredomainlist.com Search
Malwaredomains.com Search

Robtex IP Search

SamSpade Search

ThreatExpert Search

For meta keys such as IP, Host and Mac Address, the details of the values that are flagged are
collected from Endpoint, Incident, Alerts, and Lists.

For meta keys such as File, File Hash, Domain, User, the details of the values that are flagged
are collected from Incidents, Alerts, and Lists.

The data is displayed in the context panel, only if there is any data available .

For more information about the lookup results and contextual information for different data

sources, see Context Lookup Panel.
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Query Dialog

In the Navigate view or Events view, you can create a query rather than clicking through the
meta keys and values to drill down into the meta data. The dialogs for creating a query offer
syntax help with drop-down lists of applicable meta keys and operators. To access this dialog in
the Navigate or Events view toolbar, select Query.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event
Metadata

Triage an Incident
(Pivot from Respond
View)

Investigate Endpoints
(Hosts View)

(Navigate View)

You are here

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events

(Events View)

Analyze Raw Events Scan Files and Events
and Metadata for Malware
(Events Analysis (Malware Analysis
View) View)

4

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups

What do you want to do?

1.1

Documentation

User Role

Threat Hunter browse event metadata* Begin an
Investigation in the

Navigate or Events
View
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1.1

Documentation

User Role

Threat Hunter browse raw events* Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis
View

Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts

Threat Hunter find suspicious endpoint files (Version Investigate Files
11.1)

Threat Hunter scan files and events for malware Conducting Malware

Analysis

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

Threat Hunter create a custom query* Create a Custom

Queg y

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

Quick Look

£ Profile

E]Meta ™ | & Total Descending ~ B3 Event Count

»@ Query

® simple (O Advanced () Recent

Select Meta v | Operator v | |Value

™ Network ™ Log 4 Endpoint

Apply Cancel Reset [ 3|
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The Query dialog has three views:
o Simple
o Advanced

e Recent

In the Simple view, you can create a query using the options displayed in the dialog. In the
Advanced view, you can create a query without guidance. In the Recent view, you can select a
query from a drop-down list of recent queries.

Simple View

ENeNTYYAR [ Profile @ EJ Meta ® | B Total & Descending = B8 Event Count =

r 1
® Simple () Advanced () Recent
Select Meta v | Operator v | |Value

™ Network ™ Log 4 Endpoint

Apply Cancel Reset [ 3|

Advanced View

O Simple ® Advanced (O Recent

Apply Cancel Reset [ =]
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Recent View

O Simple O Advanced ® Recent

did = 'nwappliance3067"
sessionid=13
sessionid=52
sessionid=44
sessionid=20
sessionid=202
sessionid=200
ip.src="

ip.src =

ip.src=

ip.dst=

Apply Cancel Reset &

The following table describes features of the Query dialogs.
m
Select Meta Displays a drop-down list of meta groups.

Operator Displays a drop-down list of operators (=, NetWitness

Suite!=,NetWitness Suiteexists,NetWitness Suitel!exists)

Value Allows you to enter a value to complete the query.
Network Limits the query to packets if Log is not selected.
Log Limits the query to logs if Network is not selected.
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e Jowamn

Query box Allows you to enter a query in the Advanced view. When you begin typing,

a drop-down list of available meta keys for the service is displayed, then a
drop-down of operators is displayed as you type. If the expression currently
entered in the query box is invalid, a warning appears near the box. When

the query is valid, the warning is removed.

Query list Allows you to select a query from a list of recent queries in the Recent

view. Double-clicking a query automatically applies it.

Apply Applies the new query to the current Investigation view.
Cancel Closes the dialog without applying changes.
Reset Resets all fields.
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Scan For Malware Dialog

In the Scan for Malware dialog, Malware Analysis analysts can upload files to investigate in

Malware Analysis.

To access this dialog go to the Malware Analysis view. In the Select a Malware Analysis

Service dialog, select a service in the left panel, then click B scan Files i e right panel.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event Triage an Incident

Metadata IinEsiE EI_']dpm nts (Pivot from Respond
(Hosts View) W)

(Navigate View)

Find Suspicious
Endpoint Files
(Files View)

Browse Raw Events
(Events View)

Analyze Raw Events | Scan Files and Events
and Metadata I for Malware l
(Events Analysis | (Malware Analysis |
View) | View) |
I I

You are here

¥

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups

What do you want to do?

User Role

1.1

Documentation

Threat Hunter browse event metadata

Begin an
Investigation in the

Navigate or Events
View
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1.1

Documentation

User Role

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis

View

Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts

Threat Hunter find suspicious endpoint files (Version Investigate Files

11.1)

Threat Hunter scan files and events for malware* Conducting Malware
Analysis

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Begin a Malware Analysis Investigation

o Launch a Malware Analysis Scan from the Navigate View

Quick Look

The figure below illustrates the Scan for Malware dialog, and The following table describes the
features available in the dialog.
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Scan for Malware
Malware Analysis o
Service *
Mame * Adhoc Scan HTTP
Community Sandbox
Bypass Executable Ll Bypass Executable Ll
Bypass Office Ll Bypass Office Ll
Bypass PDF L] Bypass PDF L]

m Description

+ Uploads a file from your computer.

Deletes a file from the list.

File Name Displays the names of the files added to the list.
Name Allows you to name the scan job.

Community Displays options for Community to bypass or ignore certain types of files:
o Bypass Executable
o Bypass Office

o Bypass PDF

Sandbox Displays options for Sandbox to bypass or ignore certain types of files:
o Bypass Executable

o Bypass Office

o Bypass PDF
Cancel Closes the dialog without performing any actions.
Scan Scans the uploaded files.
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Select a Malware Analysis Service Dialog

The Select a Malware Analysis Service dialog is accessible in the Malware Analysis view. In
this dialog, Malware Analysis analysts can select a service to investigate, choose a scan on that
service to investigate, upload a file to scan, and begin a continuous scan of the service.

Workflow

Begin or Continue an Investigation from an Investigate View
or a Pivot from the Respond View

Browse Event
Metadata
(Navigate View)

Browse Raw Events
(Events View)

Analyze Raw Events
and Metadata
(Events Analysis
View)

Triage an Incident
(Pivot from Respond
View)

Investigate Endpoints
(Hosts View)

Find Suspicious
Endpoint Files
(Files View)

Scan Files and Events
for Malware

View)

I I
I I
| (Malware Analysis I
I I
I I

You are here

¥

Act on an Event or Endpoint

Perform Internal Create an Incident in

Reconstruct an Event
Lookups Respond

Export Host
Attributes and Global
Files

Export Events and Perform External
Files Lookups

What do you want to do?
11.1

Documentation

User Role

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events

View
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1.1

Documentation

User Role

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events
View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis

View

Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts

Threat Hunter find suspicious endpoint files (Version Investigate Files

11.1)

Threat Hunter scan files and events for malware* Conducting Malware
Analysis

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

o Begin a Malware Analysis Investigation

o Launch a Malware Analysis Scan from the Navigate View

Quick Look
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Select a Malware Analysi

Malware Services | Malware - Malware Analytics Scan Jobs List
) Default Service B scan Files c
Name ~ | Name Static Network Community  Sandbox Progress Info  User
Malware - Malware Analytics
Mo scan jobs found
| Page of 0 | C o v No data to display

View Continuous Mode

The Select a Malware Analysis Service dialog has a Malware Services panel on the left and a
Scan Jobs List on the right. The Scan Jobs List panel has a toolbar, list, and buttons to view
scans.

The Malware Services panel is a list of services available for malware analysis. In this panel,
you can select the service to investigate and you set a default service using the Default Service
icon. When you select a service, the available scan jobs for that service are listed in the Scan
Jobs list.

These are the features in the Scan Jobs List toolbar.

N

B scan Files Displays the Scan for Malware dialog, in which you can upload

a file to the service for scanning.

Delete scan job (= ) Deletes one or more selected scan jobs, NetWitness Suite

displays a confirmation dialog before deleting scan jobs.

Cancel scan job (/&) Pauses or continues one or more scan jobs.
Refresh (ZF) Refreshes the list of scan jobs.

These are the columns in the Scan Jobs list. This list is also available in the Malware Scan Jobs
dashlet.

424 Investigate Reference Materials



NetWitness Investigate User Guide

o

Name

Static, Network,

Community, Sandbox

Progress

Info

User
Events

Dropped

Event Type

Scheduled

Displays the name of the job.

Filters the results based on the scores for each scoring module.

Displays the current progress made on the job.
o Green: The job is finished.
o Black: The job is in progress.

e Red: An error occurred.

Provides additional information. Displays the query for the job.
If the job is not complete, it also displays more detailed

description of the status.
Displays the name of the user who created the job.
Counts the number of events for the job.

Counts the number of files/events in the job that were dropped

because the scores are below their configured threshold.

Displays the type of job: Manual Upload, On Demand, or

Resubmit.

Displays the date and time when the job was executed.

These are the available actions in the dialog.

frm e

Cancel button

View Scan button

View Continuous Mode

button

Cancels the selected scan job.

Displays the Summary of Events for the selected scan with the
default dashlets displayed.

Displays the Summary of Events for the selected scan with the
default dashlets displayed.
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Settings Dialogs for Investigate Views

NetWitness SuiteVersion 11.0 has two settings dialogs, one for the Navigate view and one for
the Events view. With the addition of the settings dialog for the Event Analysis view in Version
11.1, Investigate has three settings dialogs.

The settings in the Navigate view and Events view Settings dialogs are a subset of the
Investigation settings made in the Profiles > Preferences panel > Investigations tab. By providing
the settings within the Investigation view, NetWitness Suite saves time for analysts. If you
change a setting here, the same setting is changed in the Profiles view, and if you change a
setting in the Profiles view, the same setting is changed here.

To access this dialog, go to the Navigate or Events view, and select the Settings option in the
toolbar.

The settings in the Event Analysis view have no corresponding settings in the Profiles >
Preferences panel.

What do you want to do?

111

Documentation

User Role

Threat Hunter browse event metadata Begin an
Investigation in the

Navigate or Events
View

Threat Hunter browse raw events Begin an
Investigation in the

Navigate or Events

View

Threat Hunter analyze raw events and metadata Begin an
Investigation in the

Event Analysis

View
Threat Hunter investigate endpoints (Version 11.1) Investigate Hosts
Threat Hunter find suspicious endpoint files (Version Investigate Files
11.1)
Threat Hunter scan files and events for malware Conducting Malware
Analysis
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11.1

Documentation

User Role

Incident Responder triage an incident in Investigate NetWitness
Respond User
Guide

Threat Hunter configure preferences for Investigate* Configuring
NetWitness
Investigate Views

and Preferences
*Y ou can perform this task in the current view.

Related Topics

o How NetWitness Investigate Works

Quick Look

The Settings dialogs in the Navigate view and Events view have several features in common.

Several Investigation settings in the Navigate view influence the performance of when loading
values in the Values panel. Default values are set based on common usage, and individual
analysts can adjust these settings for their own investigations. The image below is an example of
the dialog, and the following table describes the features.

IS-:&-':I‘ Events VI Search . £F Settings ]

Threshold 100000
Max Values Results 1000
Max Session Expaort 100000

Max Log View Characters 1000

Max Meta Value Characters | &0

Export Log Format ~
Export Meta Format v
[[] Use Per Device Local Cache

[ Show Debug Information

[J Autoload Values

[[] Download Completed PCAPs

[ Live Connect: Highlight Risky Values

m Cancel L7
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e o

Threshold Sets the threshold for the maximum number of sessions loaded for a

meta key value in the Values panel. A higher threshold allows accurate

counts for a value, and also causes longer load times. The default value

is 100000.
Max Values Sets the maximum number of values to load in the Navigate View when
Results the Max Results option is selected in the Meta Key Menu for an open

Meta Key. The default value is 1000.

Max Session Sets the maximum number of sessions able to be exported. The default

Export value is 100000.

Export Log Format  Sets the file format of exported logs. There are four formats available:
o Text
« SML
« CSV
« JSON

Export Meta Sets the file format of exported meta values. There are four formats
Format available:

o Text
« SML
« CSV
« JSON

Use Per Device When unchecked, Investigate sends a fresh query to the database rather
Local Cache than displaying cached data in the Investigate views after the initial

load. If checked, Investigate uses the data from local cache.

Show Debug This option controls the display of the where clause beneath the
Information breadcrumb in the Navigate view and the elapsed load time for each
aggregated service on a Broker. When checked the debug information is

displayed. The default value is Off (unchecked).
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e o

Append Events in

Event Panel

Autoload Values

Download

Completed PCAPs

Live Connect:

Highlight Risky IPs

Apply

Cancel

This option affects paging in the Events panel. When checked, the next
group of events is appended to the already displayed events. When
unchecked, the previous page of events is replaced by the next page.

The default value is Off (unchecked)

This option controls automati loading of values for the selected service
in the Navigate view. When checked, values are automatically loaded
when you select a service to investigate. When not checked, Investigate
displays a Load Values button, allowing the opportunity to modify
options. The default value is Off.

This setting automates the downloading of extracted PCAPs in the
Investigation module so that you do not have to manually download and
open extracted PCAP files in an application, such as Wireshark, that can

handle viewing data in a PCAP form.

If this option is unchecked, all the meta values that have context
available in Live Connect are highlighted in the Navigate view Values
panel. If the option is checked, among the values that have context in
Live Connect, only those values deemed Risky/Suspicious/Unsafe by the

community are highlighted. By default this option is unchecked (Off).

Applies the settings immediately and they are visible the next time you

load values. The same changes are also applied in the Profiles view.

Cancels the editing operation and closes the dialog, leaving the settings

unchanged.

Events View Settings Dialog

The following image is an example of the Settings dialog for the Events view, and the following
table describes the features.
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I Search Events hd _M]

Export Log Farmat ~

Export Meta Format ~
[] Use Per Device Local Cache

[] Download Completed PCAPs
[[] Live Connect: Highlight Risky Values

[ Optimize Investigation page loads (When this
is checked, random page access is disabled)

Default Sessian View

Best Reconstruction

[ Enable CSS Reconstruction for Web View

Cancel L7

Fowrs _ [pesroion

Export Log Format Sets the file format of exported logs. There are four formats available:

o Text
« SML
« CSV
« JSON

Export Meta Format  Sets the file format of exported meta values. There are four formats
available:

o Text
« SML
« CSV
« JSON

Download Completed This setting automates the downloading of extracted PCAPs in the
PCAPs Investigation module so that you do not have to manually download
and open extracted PCAP files in an application, such as Wireshark,

that can handle viewing data in a PCAP form.
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Live Connect:

Highlight Risky IPs

Optimize
Investigation page

loads

Default Session View

Enable CSS
Reconstruction for

Web View

Apply

Cancel

When checked, Investigate uses a filter to fetch only IP addresses that
are considered as risky by RSA community. When not selected,
NetWitness Suite displays all IP addresses. By default, this option is
not selected (Off).

Sets a paging option. When optimized, results are returned as quickly
as possible, sacrificing the original ability to go to a specific page in
the event list. Unchecking this box changes the Events list pagination
to allow you to go to a specific page in the list (or to the last page).

The default value is enabled.

Selects the default reconstruction type for the initial reconstruction in
the Events view. The default value is Best Reconstruction in which
events are reconstructed using the reconstruction method most

appropriate to the event.

This setting controls how web content reconstruction is performed. If
enabled, the web reconstruction includes cascaded style sheet (CSS)
styles and images so that its appearance matches the original view in
a web browser. This includes scanning and reconstructing related
events, and searching for style sheets and images used in the target
event. The option is enabled by default. Uncheck this option if there

are problems viewing specific websites.

Applies the settings immediately and they are visible the next time you

view events. The same changes are also applied in the Profiles view.

Cancels the editing operation and closes the dialog, leaving the

settings unchanged.
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Event Analysis View Preferences Panel

Beginning with Version 11.1, the Event Analysis view has user preferences that you can
configure in the Event Analysis view > Event Preferences panel. These settings persist so that
they are applied each time log in and go to the Event Analysis view. The following table
describes the options.

Fours oo

Default Event Selects the default event analysis view that is displayed every time you
open the Event Analysis view. For example, if you select File
Analysis, the File Analysis panel is highlighted and displayed every
time you investigate an event in the Event Analysis view. These are
following options:

Analysis View

o Text Analysis: View and analyze the raw text payload of an event.

o Packet Analysis: View and interactively analyze the packets and

payload of an event.

o File Analysis: View a list of files and download one or more files in
an event.
Default Log Format ~ Selects the default format for downloading logs:
o Download Log: Raw log (log) using this option.
o Download CSV: Comma-separated values (CSV) using this option.
o Download XML: The Extensible Markup Language (XML) file
using this option.

o Download JSON: The JavaScript Object Notation (JSON) file

using this option.
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e v

Default Packet

Format

Time Format for

Query

Download extracted
files automatically

Selects the default packet format for downloading packets.

o Download PCAP: To download the entire event as a packet capture

(*.pcap) file.

o Download All Payloads: To download the payload as a *.payload
file.

o Download Request Payload: To download the request payload as a
* payloadl file.

o Download Response Payload: To download the response payload

as a *.payload? file.

The Event Analysis view can display results based on the database
time or the current clock time. The default setting for this preference is
Database Time, which is the same time format used to display query
results in the Navigate view and Events view.

When Database Time is selected, the start and end time for a query is
based on the time that the event was captured.

When Wall Clock Time is selected, the query is executed using the
end time based on the current browser time; the start time is calculated
based on that end time and the time range.

Enables the automatic download of files if they are in the selected
default format in the Default Log Format and Default Packet format
fields from the Event Preferences panel.

Select the checkbox to enable downloading the selected format
automatically to local folder. Otherwise, the download job goes to the
job queue, and you can download it manually.
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